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Introduction

Complete A+ Guide to IT Hardware and Software, ninth edition, is a textbook and optional lab manual intended for one 
or more courses geared toward CompTIA A+ Certification and computer repair. It covers all the material needed for the 
CompTIA A+ Core 1 (220-1101) and CompTIA A+ Core 2 (220-1102) exams. The book is written so that it is easy to 
read and understand, with concepts presented in building-block fashion. The book focuses on hardware, software, mobile 
devices, virtualization, basic networking, and security.

Some of the best features of the book include the coverage of difficult subjects in a step-by-step manner, carefully 
developed graphics that illustrate concepts, photographs that demonstrate various technologies, reinforcement questions, 
critical thinking skills, soft skills, and hands-on exercises at the end of each chapter. Also, this book is written by teachers 
who understand the value of a textbook as we both are very active in the classroom and community.

What’s New in the Ninth Edition?
This edition has been revised to include more relevant coverage of hardware, including SSD migration and a few new 
network concepts, such as updated wireless standards, updated browser security settings, and DNS material. Some refer-
ences to Windows 7 were left where it is quite different from Windows 8, 10, or 11. More scripting is included as well. 
The following are a few of the many new features of this edition:

> This book conforms with the latest CompTIA A+ exam requirements, including those of the CompTIA A+ Core 1 
(220-1101) and CompTIA A+ Core 2 (220-1102) exams.

> Chapter 2 now includes information on Cat 8 and direct burial cable, as well as updated graphics showing mother-
board ports.

> Chapter 3 now includes information regarding ARM processors.
> The video information in Chapter 4 has been moved to Chapter 8. Chapter 4 introduces TPM, which is covered in 

more depth in Chapter 18.
> The book has always been filled with graphics and photos, but even more have been added to target those naturally 

drawn to the IT field. This edition is full color.
> There are questions at the end of each chapter, and even more questions are available in the test bank available from 

the Pearson Instructor Resource Center.

Organization of the Text
The text is organized to allow thorough coverage of all topics and also to be a flexible teaching tool. It is not necessary 
to cover all the chapters, nor do the chapters have to be covered in order.

> Chapter 1 provides an introduction to IT and careers that need the information in this book. It identifies computer 
parts. Chapter 1 does not have a specific soft skills section, as do the other chapters. Instead, it focuses on common 
technician qualities that are explored in greater detail in the soft skills sections of later chapters. Finally, Chapter 1 
provides a great introduction to using Notepad, the Windows Snipping Tool, and internet search techniques.

> Chapter 2 is about connecting things to a computer and port identification. Details are provided on video, USB, 
and sound ports. The soft skills section is on using appropriate titles.

> Chapter 3 details components, features, and concepts related to motherboards, including processors, caches, ex-
pansion slots, and chipsets. Active listening skills are the focus of the soft skills section.

> Chapter 4 deals with system configuration basics. BIOS options, UEFI BIOS, and system resources are key topics. 
The soft skills section covers the importance of doing one thing at a time when replacing components.
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> Chapter 5 steps through how to disassemble and reassemble a computer. Tools, ESD, EMI, and preventive main-
tenance are discussed. Subsequent chapters also include preventive maintenance topics. Basic electronics and 
computer power concepts are also included in this chapter. The soft skills section involves written communication.

> Chapter 6 covers memory installation, preparation, and troubleshooting. The importance of teamwork is empha-
sized as the soft skill.

> Chapter 7 deals with storage devices, including SATA SCSI, SAS, and SSDs. RAID is also covered. Phone com-
munication skills are covered in the soft skills section of this chapter.

> Chapter 8 covers video and multimedia devices, including optical drives, sound cards, cameras, scanners, and 
speakers. The chapter ends with a section on having a positive, proactive attitude.

> Chapter 9 provides details on printers and multifunction devices. A discussion of work ethics finishes the chapter.
> Chapter 10 is on mobile devices, including details on mobile device operating systems, configuration, backup, 

security, and troubleshooting. The soft skills section takes a brief foray into professional appearance.
> Chapter 11 covers computer design. Not only are the specialized computers and components needed within the 

types of systems covered, but computer subsystem design is also included. Because design and troubleshooting use 
higher levels of critical thinking skills, the chapter also includes a review of troubleshooting, including logic, er-
ror codes, and troubleshooting flowcharts. The soft skills section provides recommendations for dealing with irate 
customers.

> Chapter 12 handles internet connectivity, virtualization, and cloud technologies. It covers internet browser con-
figuration, along with the soft skill mentoring

> Chapter 13 introduces networking. Basic concepts, terminology, and exercises make this chapter a favorite. Ap-
pendix A provides an introduction to subnetting that can be used in conjunction with this chapter. The focus of the 
soft skills section is being proactive instead of reactive.

> Chapter 14 provides an introduction to operating systems in general and discusses basic differences between the 
Windows versions and how to function in the various Windows environments. The soft skills section includes tips 
on how to stay current in this fast-paced field.

> Chapter 15 provides an introduction to scripting and includes how to function from the command prompt and 
the basics of scripting in Python, JavaScript, shell scripting, VBScript, batch files, and PowerShell. The soft skills 
section discusses looking at a problem from the user’s perspective and being more empathetic.

> Chapter 16 covers Windows 8, 10, and 11. Details include how to install, configure, and troubleshoot the environ-
ment. Avoiding burnout is the soft skill discussed in this chapter.

> Chapter 17 discusses the basics of macOS and Linux. It provides a basic introduction to these two environments 
to help a technician become familiar with the environment and a few tools. The soft skills section talks about being 
humble.

> Chapter 18 describes computer, mobile device, and network security. The soft skills section is on building cus-
tomer trust.

> Chapter 19 guides the student through operational procedures such as workplace safety, recycling, disposal, a 
review of power protection, change management, and communication skills.

> Appendix A is an introduction to subnetting and variable length subnet mask (VLSM).





Introduction to the World of 
IT Labs1

Lab 1.1 Getting Started in Windows 10 or 11

Objective:  To be able to use Windows 10 or 11 to locate and launch applications and locate Control Panels used in future labs

Parts: Windows 10/11 computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer. If the computer is locked, the method use to unlock a Windows desktop depends on the type of computer 
you have:

  > Touch screen: Press your finger on the screen and move upward.

  >  Desktop computer: Press any key and release, click the mouse anywhere, click the mouse near the bottom of the screen, or 
hold the mouse button down while moving the cursor upward.

  >  Laptop: Press any key and release, click the mouse anywhere, hold down the left trackpad section or button, or move the cur-
sor upward.

2. Type the password or PIN. Contact the instructor or lab assistant if the password is unknown.

 Note: Anywhere in this lab when the direction is to “click” or “select” something, if a touch screen is available, you can tap with 
your finger instead.

3. Windows 10 and 11 were designed for both traditional desktop and mobile (touch) devices. The Windows 10 or 11 desktop is dif-
ferent from previous Windows version, as shown in Lab Figure 1.1. You can press the  key on the keyboard at any time to bring 
up the Start menu.
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Start button Search box Task view

LAB FIGURE 1.1 Windows 10 desktop

4. Notice the leftmost Windows icon; this is the Windows 10 or 11 version of the Start button. Select the 
Start button to access apps, as shown in Lab Figure 1.2.

LAB FIGURE 1.2 Windows 10 Start button

5. Again select the Windows (Start) icon to return to the desktop.

 List one icon of a commonly used application that is on your desktop.

  _________________________________________________________________________________

6. Select the Start button again. The most commonly used apps are at the top. Scroll through the 
options. Notice that the list contains both applications and folders.
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7. In Windows 10, locate and select the Windows Accessories folder to expand it. In both Windows 10 
and 11, locate and select the Notepad app and launch it.

 What is the name of the first menu item shown on the far left inside the Notepad app?

  _________________________________________________________________________________

8. Notice the three buttons in the top-right corner in the Notepad window (see Lab Figure 1.3). These 
buttons are found in almost every window that opens. Lab Table 1.1 details the purpose of each of 
these buttons.

Maximize/
Restore down

Minimize
Close

LAB FIGURE 1.3 Windows buttons within a window

LAB TABLE 1.1 Windows top-right window buttons

Button Purpose

Minimize (straight 
line)

Keeps the program running but removes it from being active on the screen. Use 
å+† to re-access the app.

Maximize/Restore 
down (rectangle)

Used to make the window that holds the app full screen (maximize) or, if you 
size the window, restore it to its default size.

Close (X) Used to close an app.

9. Select the Minimize button (straight line). Notice that the application icon displays at the bottom of 
the screen in the taskbar as a small blue spiral notebook.

10. Click on the Notepad application icon at the bottom of the screen on the taskbar. The Notepad appli-
cation opens on the screen. Click the Close button (X) to close the application.

11. Another way to locate and launch an app is by using the Search textbox. Select the icon that looks 
like a magnifying glass or click inside the textbox and type the word note but do not press ®. 
Notice that the Notepad desktop app is listed at the top of the screen. Any other app that has note in 
the app name also appears.

 List one other app that is shown that has the letters “note” in its name. Write “None” if no other apps 
appear.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Note: When you have two or more applications open in Windows 10, you can hold down the å key 
and press the † key to cycle through any open applications.

12. Seach for, select, and launch the Calculator app. The Calculator app opens.

 Which leftmost icon is directly below the word Calculator? [ clock | plus sign | 3 bars | left arrow ]

13. Close the Calculator app.
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14. Select the Start button. Launch one of the other apps.

 Which app did you choose?

  _________________________________________________________________________________

Instructor initials: _____________

15. Close the application by selecting the Close button.

Lab 1.2 Using a Search Engine

Objective:  To use Google to effectively search for information

Parts: Windows computer with internet access

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer. Log in or unlock the screen.

2. Windows 7 users: Select the Start button in the bottom-left corner, select All Programs, and then 
select a web browser.

 Windows 8 users: Access and launch a browser app such as Windows Edge, Google Chrome, or 
Mozilla Firefox from the Windows start screen. If one is not readily visible, click on the Windows 
icon in the bottom-left corner to get a customized view of the applications. (On a mobile device, this 
may be a Windows symbol that you touch on the front side of the device to access these apps. You 
can then click the  that is inside the circle in the bottom left to view all apps and pick a browser 
app from there.)

  Windows 10 users: Access and launch a browser app such as Microsoft Edge, Google Chrome, or 
Mozilla Firefox from the Windows start screen. If one is not readily visible, select the Start button 
and scroll through the list to locate a browser app. Click on the browser app name to launch it.

3. In the browser window, type the following: www.google.com

 If a computer user has a Dell Windows 10 computer that the user complains is slow to boot, what 
search terms would you put in the browser window? List at least three.

  _________________________________________________________________________________

4. In the search textbox, type the following: Windows 10 computer problems

 Approximately how many results list at the top of the screen under the menu?

  _________________________________________________________________________________

5. Change the search criteria to Windows 10 computer problem (removing the s from problems).

 Approximately how many results list at the top of the screen under the menu?

  _________________________________________________________________________________

6. Go into the first three problems by clicking on the first title line. To return to the search results, click 
the Back arrow (≤).

 Do any of the problems have anything to do with slow booting?

  _________________________________________________________________________________

7. In the search textbox, type the following: Windows 10 slow boot

 Access the first result by clicking on the title line.

 What was the solution given in the resulting web link?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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TECH TIP

8. Sometimes suggestions for computer solutions contain links to software that might not be free after 
so many days and may contain malware or a virus. Only click on a link or use software tools from 
trustworthy vendors. Return to the search criteria by clicking on the Back arrow (≤) or retyping 
www.google.com in the search textbox. Now change the search to Microsoft Windows 10 
slow boot. Look at the number of results listed and then access the first result.

 Approximately how many results are available?

  _________________________________________________________________________________

 Access the first result by clicking on the title line.

 What was the solution given?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Do you think that this might be a good solution for the person who owns the Dell computer?

 [ Yes | No | I have no idea ]

  _________________________________________________________________________________

9. Now add the word Dell to the search criteria, searching for the following: Microsoft Windows 
10 Dell slow boot

 Approximately how many results are available?

  _________________________________________________________________________________

 Access the first result by clicking on the title line.

 What solution was given?

  _________________________________________________________________________________

Lab 1.3 Performing a Screen Capture

Objective:  To use the Microsoft Windows Snipping Tool and Snip & Sketch tool to effectively capture 
information

Parts: Windows computer with the Snipping Tool application and the Snip & Sketch tool

Procedure: Complete the following procedure and answer the accompanying questions. If you are not 
familiar with launching an application, complete Lab 1.1 before doing this lab.

How to do a quick screen capture

On a Windows machine, press the Print Screen key and use the Paste function to paste the image 
into an application.

To take a screenshot on a Mac, hold these three keys down, one at a time (keeping each 
one down as you add another key): Í+∑+3. To capture a portion of the screen, use 
Í+∑+4. To capture a window or menu, use Í+∑+4+∆. By default, the screen-
shots save to the desktop, and you can move them to a folder later.

1. Power on the computer. Log in or unlock the screen.

2. Access a web browser. Leave it on the screen.

3. Many times when you are solving a problem, performing a task, or helping someone else, a picture is 
worth a thousand words. Locate and launch the Snipping Tool by expanding Windows Accessories or 
searching using the Windows Search textbox. The Snipping Tool application starts, as shown in Lab 
Figure 1.4
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LAB FIGURE 1.4 Snipping Tool application window

4. The Snipping Tool enables you to capture everything that shows on the screen (full-screen snip), a 
particular window that is open on the screen (window snip), a particular section of the screen that 
could be captured in a rectangle (rectangular snip), a particular part of the screen that is oddly shaped, 
or simply an icon or a symbol (free-form snip). Click the  beside the Mode menu option. Four 
options display. The default one has a  beside it.

5. Click on the Tools > Options menu item. One particular option that you can select by clicking inside 
a box is the Ink color to select a color along with the Show selection ink after snips are captured op-
tion. This feature automatically creates a box around whatever information is captured. Do not select 
it yet. Click Cancel.

6. Ensure that the browser window is not taking up the entire desktop area. You can use the Maximize/
Restore Down button located in the top-right corner to size the window. (Refer to Lab Figure 1.3 and 
Lab Table 1.1 in Lab 1.1 for information on the buttons that are in the top-right corner.)

7. In the Snipping Tool window, click the  beside the Mode menu option and select Full-screen 
Snip. The Snipping Tool application captures whatever is on the screen. If that is not what you want 
to capture and you only want to capture the search textbox, click New, and the Snipping Tool reverts 
to the small window.

8. Click on the  beside Mode again and select Window Snip. With a window snip, you must take the 
additional step of clicking on the window that you want. Click anywhere in the browser window.

 What information is shown inside the Snipping Tool window?

  _________________________________________________________________________________

 List one instance in which you think an IT person might use the window snip option.

  _________________________________________________________________________________

9. Pretend this still is not what you wanted because it is too big, and you want to just capture the search 
textbox. Click the Minimize button (the button to the left of the Maximize/Restore Down button you 
used before) within the browser window.

10. Re-access the browser window by clicking anywhere on it. In the address bar of the browser window, 
type www.pearson.com in the textbox at the top of the screen but do not press the ® key.

11. With the browser window open, re-access the Snipping Tool by clicking on the Snipping Tool icon 
located in the taskbar (the icon showing scissors within a red circle) at the bottom of the screen. If the 
taskbar is not there, hold down the å key and, while continuing to hold it down, press †. The cur-
rently running programs appear. Press the † key again until the Snipping Tool is selected. Let go of 
both keys, and the Snipping Tool application window appears on the screen. Ensure that the Snipping 
Tool application window is on a part of the desktop by itself (not on top of the browser window). In or-
der to move a window, you can click on the top part of the Snipping Tool window and, while continuing 
to hold down the mouse or touchpad, drag the window to a different part of the screen.

12. Click the Mode menu option and select Rectangular Snip. The screen appears grayed out. This is 
normal. A crosshairs symbol (which looks like a plus symbol) appears on the screen. Move the screen 
cursor (which, in turn, moves the crosshairs symbol) to the top part of the browser window, which 
contains the search textbox. Click and drag the crosshairs until it captures the part of the browser 
window that shows www.pearson.com.

 List one instance in which you think an IT person might use the rectangular snip option.

  _________________________________________________________________________________
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13. After taking a screen capture, the Snipping Tool window has more menu options available. Click the 
File menu option.

 Which four File menu options are available?

  _________________________________________________________________________________

14. Click the Edit menu option. This option can be used to select Copy so you can simply paste into an 
email or word processing document. Select the Tools menu item. Point to the Pen option and select 
Blue Pen from the menu. Use the pen to circle the words pearson.com.

Instructor initials: _____________

15. Access the Tools menu item again and select the Highlighter option. Highlight www.

Instructor initials: _____________

16. Close the Snipping Tool window by clicking on the Close button, which is located to the immediate 
right of the Maximize/Restore Down button. The Close button is in the top right of the Snipping Tool 
application window and has an X on the icon.

17. When asked if you want to save the snipped document, click No.

 Note: Only do Steps 18–22 if using a Windows 10/11 computer.

18. Using the Windows Search textbox, locate and open the Snip & Sketch tool. Notice the message on 
the screen about how you can use +Í+S as hotkeys to capture the screen.

19. Click the down arrow beside the word New in the upper-left corner and select Snip Now. Crosshairs 
that look like a plus sign appear on the screen. Click on the crosshairs and keep the mouse button 
held down to drag the crosshairs to make a rectangle that captures part of the screen. Let the mouse 
button go. This is known as a rectangular snip.

20. The part of the screen you drew appears in the Snip & Sketch window. If it does not appear, repeat 
step 19.

Instructor initials: _____________

21. Notice at the top of the screen that tools appear. Click on the highlighter icon that is shaded yellow. 
When you click on it, notice that a blue underline appears, showing that it is selected. Move the 
pointer somewhere in the window where the captured image appears. Click and hold the mouse or 
pointer and drag it to highlight a part of the screen. Use either the pencil or ballpoint pen tool to fur-
ther modify your capture.

Instructor initials: _____________

22.  Close the window. You do not have to save the document.

Lab 1.4 Creating a Text File

Objective:  To use various applications to create a text file

Parts: Windows computer

Procedure: Complete the following procedure and answer the accompanying questions. If you are not 
familiar with launching an application, complete Lab 1.1 before doing this lab.

Note: If you do not have Microsoft Office or Microsoft 365, you can download Apache OpenOf-
fice (openoffice.org) and install it on a Windows, Linux, or Mac computer. You can then 
use OpenOffice to open Word, Excel, and PowerPoint documents as well as create your 
own files. You can also use Google Docs (docs.google.com).

1. Power on the computer. Log in or unlock the screen.

2. Locate and launch the Notepad application. The Notepad application starts, as shown in Lab 
Figure 1.5.
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LAB FIGURE 1.5 Notepad application

 Which five menu options are available?

  _________________________________________________________________________________

 Which menu option do you think would be used to automatically insert the date and time?

  _________________________________________________________________________________

 Explore the menu options to determine which option would be used to turn on change the font.

  _________________________________________________________________________________

 Explore the menu options to determine which option would be used to turn on word wrap.

  _________________________________________________________________________________

 Explore the menu options to determine which option would be used to print a document.

  _________________________________________________________________________________

3. Notepad can be used to document problems on a computer that does not have a word processing app 
loaded, that does not have a working word processing app, or that has other issues. It can also be used 
for scripting, which is covered in Chapter 15, “Introduction to Scripting.” Both Microsoft Notepad 
and WordPad ship with the Windows operating system. Notepad does not have as many capabilities 
as WordPad. One of the things you can do with Notepad is insert the date and time into the document. 
Click the Edit menu item to see the full Edit menu, as shown in Lab Figure 1.6.

LAB FIGURE 1.6 Notepad Edit menu

4. Notice the words on the left and the corresponding keystrokes to the right. This means, for example, 
that you can either use the mouse to access the Edit menu and then select Time/Date, or you can 
simply press the ∞ key to do the same thing. Click away from the Edit menu so you can try the key-
board shortcut. Click inside the blank Notepad window. Now press the ∞ key.

5. Click the View > Status bar menu option.

 What did this option do?

  _________________________________________________________________________________



 LAB 1: Introduction to the World of IT Labs 9

LA
B 1

6. Click the View > Status bar menu option again and notice that there is now a check mark by the Sta-
tus bar option, indicating that this option is enabled.

7. Notepad allows a few font modifications. To make the date and time boldface, start by clicking the 
Format > Font menu option to see the options, as shown in Lab Figure 1.7.

LAB FIGURE 1.7 Notepad Font dialog box

 What is the default font (the font that is selected and highlighted by default)?

  _________________________________________________________________________________

 What are the names of the first and last font types? Use your mouse and the scrollbar to see the fonts.

  _________________________________________________________________________________

8. Click the Bold option in the Font style section. Click the OK button to return to the Notepad window. 
Your date and time should have turned bold. Repeat steps 7 and 8 if the words are not boldfaced.

 On your own, add the following message to the Notepad document. Ensure that you use the Verdana 
Regular 12 font type and size:

 Replaced display and tested. User confirms that the problem is solved.

Instructor initials: _____________

9. Click the Help > View Help menu option.

 Which help topic would be of most interest to you?

  _________________________________________________________________________________

10. Close the Help window by clicking on the X in the upper-right corner.

11. A header is a part of a document that might not appear on the screen, but when the document is 
printed, the information inside the header prints at the top of the page. A footer is at the bottom of the 
document. To insert a header and a footer in Notepad, click on the File > Page Setup option. Note that 
when you change the information in the header and footer, that information stays there for the current 
Notepad document and future documents as well.

 Use Help to determine what &f, the default setting for the header, and Page &p, the default setting 
for the footer, mean. Document your findings.

  _________________________________________________________________________________

  _________________________________________________________________________________
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12. Close the Help window.

Instructor initials: _____________

  _________________________________________________________________________________

  _________________________________________________________________________________

13. To save the document, click File > Save As. A window with several options appears, as shown in Lab 
Figure 1.8.

LAB FIGURE 1.8 Notepad Save As menu

14. When saving a file, you want to give it an appropriate name by entering it in the File name textbox. 
Start typing documentation in this textbox and notice how it automatically replaces the high-
lighted *.txt name. Do not press ® yet.

15. The current location is shown at the top of the screen. To change this location and save it onto a flash 
drive, for example, you must first select your flash drive from the left window. Note that drive letters 
change depending on the system. In Lab Figure 1.8, the flash drive is G:. Click the Documents option 
in the left window. If any folders are on the drive, they appear. Click the Cancel button.

16. In the Notepad window, click the Close button (the button with a red X in the top-right corner).

 What message appears?

  _________________________________________________________________________________

17. Click the Don’t Save button.



Connectivity Labs2

Lab 2.1 Identifying Ports

Objective: To identify various computer ports correctly

Parts: Computer ports, either built into a specific computer or as separate adapters

Procedure:

1. Contact your instructor for a computer on which to work or to obtain adapters.

2. Identify the computer port(s) given to you by the instructor. In Lab Table 2.1, fill in the connector type, number of pins, and port 
type. Note that you may have to refer to information in the book or on the internet.

LAB TABLE 2.1 Connector identification

Connector type (DVI, HDMI, RJ45, etc.) Number of pins Port purpose (video, USB, NIC, etc.)

1. ______________________ ______________________ ______________________

2. ______________________ ______________________ ______________________

3. ______________________ ______________________ ______________________

4. ______________________ ______________________ ______________________

5. ______________________ ______________________ ______________________

  _________________________________________________________________________________
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Lab 2.2 Identifying Devices/Ports

Objective:  To identify various computer ports correctly based on the type of connected device

Parts: Computer that has devices connected

Procedure:

1. Contact your instructor for a computer on which to work.

2. Ensure that the computer is powered off.

3. Each device connected to the computer will go through the same three-step process: (1) Identify one 
item attached to the computer. Trace its cable to a port. In Lab Table 2.2, write the name of the device 
in the first line. (2) On the same line in the second column, identify all ports that the device could 
possibly use to attach to the computer. (3) Disconnect the device from the port. On the same line in 
the third column, identify the port to which the device actually attaches. Do the same for all devices 
connected to the computer.

 Note: You may have to refer to information in the book or on the internet.

  _________________________________________________________________________________

LAB TABLE 2.2 Port Identification

Device attached Ports that possibly could 
have this device attached

Remove device and identify the port 
the device actually connects to. 
Reattach device when finished.



On the Motherboard Labs3

Lab 3.1 Using Windows to Discover Processor Information

Objective: To identify various computer features, such as the type of processor being used, processor socket, and additional 
expansion ports

Parts: Computer with Windows 7, 8, 10, or 11

Procedure: Complete the following procedure and answer the accompanying questions.

Note: If you do not remember how to locate an application, please refer to Lab 1.3.

1. Boot the computer and log in.

 In Windows 7, access Windows Explorer through All Programs > Search programs and files.

 In Windows 8/10/11, access File Explorer by using the Search function or a desktop tile.

2. Right-click on the computer in the far left panel. This is commonly shown as Computer or This PC. Select Properties. Use the in-
formation displayed to answer the following questions.

 Which processor is used?

  _________________________________________________________________________________

 How much RAM is installed?

  _________________________________________________________________________________

 When was Windows installed?

  _________________________________________________________________________________

 What version of Windows is installed?

  _________________________________________________________________________________

3. Close the window. Use the Search function to locate and launch Device Manager. From the top menu, select View > Devices by 
type.
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4. Expand the Computer category by clicking on the icon to the left. Right-click on the computer listed 
under the word Computer and select Properties. Close the window once the question is answered.

 Is the computer a 32- or 64-bit computer?

  _________________________________________________________________________________

5. Expand the Processors category.

 How many CPUs are listed?

  _________________________________________________________________________________

Instructor initials: _____________

6. Expand the System devices category.

 List any expansion slot types shown.

  _________________________________________________________________________________

7. Close all windows.

8. Right-click on the taskbar or use the Search function to locate and open Task Manger.

9. Select the Performance tab and click on the CPU option from the components listed in the left 
column. Task Manager shows key processor information, including the number of cores and sockets 
found on the motherboard.

 What is the current CPU utilization rate?

  _________________________________________________________________________________

 What is the current CPU speed?

  _________________________________________________________________________________

 Does the CPU speed stay the same? [Yes | No ]

 How many CPU sockets does the motherboard have?

  _________________________________________________________________________________

 How many CPU cores are present?

  _________________________________________________________________________________

 How many logical processors are present? Note that if you are viewing the usage of individual pro-
cessing cores, you can right-click on the graph and select Change graph to > Overall utilization.

  _________________________________________________________________________________

 Why would a computer show a different number of CPU cores than the number of logical processors? 
Note that this information is not shown in Task Manager.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Is virtualization enabled? [ Yes | No | Does not show ]

  _________________________________________________________________________________

 List the L1, L2, and L3 cache values.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Where is the L1 cache physically located? Note that this information is not shown in Task Manager.

  _________________________________________________________________________________

 How long has the system been up?

  _________________________________________________________________________________

 Look in the right corner. Who is the CPU manufacturer? [ Intel | AMD | Other ]

  _________________________________________________________________________________
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 What is the CPU model number?

  _________________________________________________________________________________

Instructor initials: _____________

10. Close all windows.

Lab 3.2 Identifying Processor Speed, Processor Socket, and Ports

Objective: To identify various computer features, such as the type of processor, processor socket, and 
additional expansion ports

Parts: Computer with internet access

Procedure: Complete the following procedure and answer the accompanying questions.

1. Boot the computer.

2. Use File Explorer and the Computer or This PC properties to determine the processor type and speed.

 Write down the processor type and speed.

  _________________________________________________________________________________

3. Power off the computer and unplug the power cable. Open or remove the cover. Locate the processor.

 Which type of processor socket is on the motherboard? If you are unsure, use the internet as a re-
source. Use some of the search skills described in Chapter 1, “Introduction to the World of IT.” Write 
down the processor socket type.

  _________________________________________________________________________________

 Which model of processors can go into this type of socket?

  _________________________________________________________________________________

 List the type of cooling that is used for the processor.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

4. Look at the back of the computer, where the ports are located. List every port located on the com-
puter and one device that could connect to the port. Document your findings using Lab Table 3.1. 
Add more lines as needed.

  _________________________________________________________________________________

LAB TABLE 3.1 Activity for computer ports

Port No. of ports Device that commonly connects to the port

5. Locate a picture on the internet of a motherboard that contains a 2.5 Gb/s Ethernet LAN port. List the 
motherboard model and document the URL for the site where you find this image.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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6. Using the internet, locate a mini-ITX motherboard for less than $200. Provide the name/model of the 
motherboard and the URL where you found this information.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________



Introduction to Configuration 
Labs4

Lab 4.1 Determining the Configuration Method

Objective:  To determine which configuration method a computer uses

Parts: A computer and internet access

Procedure: Complete the following procedure and answer the accompanying questions.

1. Open the computer and look at the motherboard. Note that you may have to use the computer model number and the internet to do 
research for parts of this lab or to answer some of the questions. Verify any information found on the internet with what you see in the 
computer.

 Document (write down) the location, name, and purpose of every motherboard jumper.

  _________________________________________________________________________________

  _________________________________________________________________________________

2. Locate the motherboard battery and document the battery type.

 What type of battery is installed?

  _________________________________________________________________________________

 What is an advantage of having a battery that keeps CMOS information?

  _________________________________________________________________________________

  _________________________________________________________________________________

 How can you tell the purpose of a jumper(s)?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is one of the first indications that a motherboard battery is failing?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the keystroke(s) required to access the Setup program?

  _________________________________________________________________________________
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Lab 4.2 Examining BIOS/UEFI Options

Objective:  To examine BIOS/UEFI features

Parts: A computer

Note:  Internet access may be required.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and watch the screen closely for directions for how to access the BIOS/UEFI. 
Press the appropriate key before the operating system boots. Note that you may have to restart the 
computer or power it down and then power it back on in order to access the BIOS/UEFI. This may 
take several tries. You may also be required to research the computer brand and model on the internet 
to determine which keystroke is required.

 Which keystroke is required to access BIOS/UEFI?

  _________________________________________________________________________________

2. Examine the main menu.

 List at least three main menu options.

  _________________________________________________________________________________

 Which keystroke(s) allow(s) you to save settings and exit BIOS/UEFI?

  _________________________________________________________________________________

3.  Explore various menus in order to answer the following questions.

 List the boot devices in the order in which they are currently configured through BIOS/UEFI.

 First boot device: __________________

 Second boot device: __________________

 Third boot device: __________________

  _________________________________________________________________________________

 On which menu screen can you set a power-on password?

  _________________________________________________________________________________

 List the options you can set for any integrated motherboard port.

  _________________________________________________________________________________

 The BIOS/UEFI enables which type of monitoring? Select all that apply and add any that are not 
listed.

 [ power | fan | CPU | HDD (hard disk drive) | temperature ]

  _________________________________________________________________________________

 What diagnostics, if any, are available through BIOS/UEFI?

  _________________________________________________________________________________

 Which power saving options, if any, are available through BIOS/UEFI?

  _________________________________________________________________________________

 Through which menu option is virtualization support enabled or disabled?

  _________________________________________________________________________________

 Which tool would a technician use for troubleshooting?

  _________________________________________________________________________________

 Which setting(s) would you choose to make the computer boot faster?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________



 LAB 4: Introduction to Configuration Labs 19

LA
B 4

 What is the BIOS/UEFI version?

  _________________________________________________________________________________

 Which keystroke(s) allow(s) you to exit BIOS/UEFI without saving any changes?

  _________________________________________________________________________________

4. Using whatever keystroke(s) you documented in the last question of step 3, exit BIOS/UEFI without 
saving any changes.

Lab 4.3 Accessing BIOS/UEFI Through Windows 8 or 10

Objective:  To access BIOS/UEFI through the operating system

Parts: A working Windows 8, 10, or 11 computer

Note:  Refer to Lab 1.2 or Lab 1.3 for directions on basic Windows 8 or 10 usage.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log in as required.

2. With newer devices that have fast-booting hard drives, accessing BIOS/UEFI setup is challenging. 
Windows 8 and higher support accessing BIOS/UEFI through Windows, but not all vendors add this 
support:

 Windows 8: Point to the upper-right corner of the screen or access Settings > Change PC Settings 
link > Update and Recovery > Recovery > Restart Now button > Troubleshoot > Advanced Options > 
UEFI Firmware Settings > Restart button.

 Windows 10: Access Settings > Update and Security > Recovery > Restart Now button > Trouble-
shoot > Advanced Options > UEFI Firmware Settings or Startup Settings > Restart button.

 Windows 11: Access Settings > System > Recovery > in the Advanced startup section, select the 
Restart Now option twice > Troubleshoot > Advanced Options > UEFI Firmware Settings or Startup 
Settings > Restart button.

 Describe a situation in which you think a technician would use this technique.

  _________________________________________________________________________________

 What BIOS/UEFI options are available on the main screen?

  _________________________________________________________________________________

 What option or keystroke(s) allow(s) you to exit BIOS/UEFI?

  _________________________________________________________________________________

 What option or keystroke(s), if any, allow(s) you to set the settings to the default?

  _________________________________________________________________________________

3. Using whatever keystroke(s) you documented in the last question of step 2, exit BIOS/UEFI without 
changing any settings.

Lab 4.4 Configuring System Resources Through the Setup Program

Objective:  To access the system resources through the Setup program

Parts: A computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer.

2. Press the appropriate key(s) to enter the Setup program.

3. Go through the various menus or icons until you find an interrupt (IRQ) setting for a particular device 
or port.
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 Write the device or port and the associated IRQ in the space below.

IRQ Device or port 

 Why do different devices generally not have the same interrupt?

  _________________________________________________________________________________

4. Go through the various menus or icons until you find an I/O address setting for a particular device or port.

 Write the device or port in the space provided, along with the associated I/O address.

I/O address Device or port

 Why must each device and port have a separate and unique I/O address?

  _________________________________________________________________________________

 How do I/O addresses, interrupts, and memory addresses get assigned to an installed adapter?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the best tool to use for viewing interrupts, I/O addresses, and memory addresses that have 
been assigned?

  _________________________________________________________________________________

5. Exit the Setup program.

6. Go to Device Manager and determine whether the information collected in steps 3 and 4 is the same.

Instructor initials: _____________

Lab 4.5 Examining System Resources by Using Windows

Objective:  To be able to view and access system resources by using Windows

Parts: A computer with Windows loaded

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and verify that Windows loads. Log on to the computer, using the user ID and 
password provided by the instructor or lab assistant.

2. Locate and access Device Manager. If necessary, refer to Chapter 1 labs for basic Windows usage.

3. Click the View menu option and select Resources by Type.

 Which types of system resources are shown?

  _________________________________________________________________________________

4. Click the plus sign (or arrow) or Interrupt Request (IRQ) to expand the section.

 Scroll through the list to determine whether there are any interrupts in use by multiple devices (the 
same number used by two things). If so, list one.

  _________________________________________________________________________________

 What device, if any, is using IRQ8?

  _________________________________________________________________________________

 Is this the standard IRQ for this device?

  _________________________________________________________________________________

 What device, if any, is using IRQ0? [ keyboard | mouse | system timer | numeric data processor ]

Instructor initials: _____________
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5. Collapse the Interrupt Request (IRQ) section. Expand the Input/Output (IO) section.

 What is the first I/O address range listed for the first occurrence of the Direct memory access 
controller?

  _________________________________________________________________________________

 What is the first I/O address range listed for the first occurrence of Motherboard resources?

  _________________________________________________________________________________

 What is the first I/O address range listed for the first occurrence of System timer?

  _________________________________________________________________________________

6. Collapse the Input/Output (IO) section. Expand the Direct Memory Access (DMA) section.

 Are any DMA channels being used? If so, list them.

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Collapse the Direct Memory Access (DMA) section. Expand the Interrupt Request (IRQ) section 
again. Click to select any device listed in the Interrupt Request (IRQ) section. Note that you may 
need to scroll down to the bottom to see devices you recognize. Once a device is selected, move 
your mouse slowly over the icons at the top until you locate the Update device driver icon. When the 
mouse is moved slowly enough, a description of the icon appears.

 In what position is the Update device driver icon located?

 [ first | last | second | third from the right | answer not listed ]

  _________________________________________________________________________________

8. Move your mouse slowly over the icons at the top until you locate (but do not click!) the Uninstall 
device icon. Now locate the Disable device icon. Both options can be used to troubleshoot problem 
devices.

 In what situation do you think a technician would use either option?

  _________________________________________________________________________________

9. From the main menu, select View > Devices by Type. Expand any section and select a particular 
device. Note that the questions cannot be answered unless you expand a section and select a device 
under the section heading. Select the Action menu item and select Properties. The Properties window 
opens. The General tab shows you the status of the device and whether it is working properly.

 What device was chosen?

  _________________________________________________________________________________

 What is the status of the device?

  _________________________________________________________________________________

10. Click the Driver tab, which shows information about the device driver.

 What device driver version is being used by the device chosen?

  _________________________________________________________________________________

 What other important button is found on this tab that you think might be used if a device is not per-
forming exactly as expected?

  _________________________________________________________________________________

11. Click the Resources tab, which shows what system resources a particular device is using. Note that if 
a device does not show the Resources tab, select another device that does have the Resources tab so 
the questions can be answered.

 What resources are being used?

  _________________________________________________________________________________
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 What message displays in the conflicting device list section?

  _________________________________________________________________________________

 Is the Use automatic settings checkbox enabled?

  _________________________________________________________________________________

Instructor initials: _____________

12. Click the Cancel button to return to Device Manager. Close the Device Manager window.

Lab 4.6 Becoming Familiar with Device Drivers

Objective:  To become familiar with finding a driver, driver information, and the current driver version

Parts: A computer with access to the internet

Procedure: Use the internet and a computer to answer the following questions.

1. A customer is looking to upgrade to Windows 11. She has a Creative Labs Sound Blaster Z PCIe 
sound card installed.

 This question requires two answers. Is there a device driver for this card that the customer can use if 
she decides to upgrade? Provide the URL where you find the answer. Note that if you are in a virtual 
environment where the computers do not have internet access, you will have to use your own com-
puter (and not the virtual environment) to do the search.

  _________________________________________________________________________________

  _________________________________________________________________________________

2. A user has a Windows 10 64-bit computer with a Gigabyte video card model GV-R523D3-1GL in-
stalled. Note that if you are in a virtual environment where the computers do not have internet access, 
you will have to use your own computer (and not the virtual environment) to do the search. 

 This question requires two answers. What is the latest device driver version for the video card? Pro-
vide the URL where you find this information.

  _________________________________________________________________________________

  _________________________________________________________________________________

3. This step can be done using a specific tool on the computer in order to find the answer. 

 What are the device driver version and date for any USB root hub on the computer?

  _________________________________________________________________________________

4. Locate any particular device (not a device category) in Device Manager. Use the Driver tab to deter-
mine the driver version currently used. List the device and the driver version.

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

5. Use the internet to research the answers to the questions. 

 What is the latest Windows 10 driver revision for a StarTech PCIe HDMI 4K video capture card 
part number PEXHDCAP4K? List the driver version number and the URL where you found this 
information.

  _________________________________________________________________________________

  _________________________________________________________________________________

 A chemistry teacher uses a Wacom One tablet attached to a macOS computer. List the latest driver 
available and the URL where you found this information. 

  _________________________________________________________________________________

  _________________________________________________________________________________
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Lab 5.1 Performing Maintenance on an Antistatic Wrist Strap

Objective: To understand how to care for and properly use an antistatic wrist strap

Parts: Antistatic wrist strap

 Computer chassis

 Multimeter

Note: Electrostatic discharge (ESD) has great potential to harm the electronic components inside a computer. Given this fact, 
it is vitally important that you practice proper ESD precautions when working inside a computer case. One tool you can 
use to prevent ESD is an antistatic wrist strap. This tool channels any static electricity from your body to the computer’s 
chassis, where it is dissipated safely.

Procedure: Complete the following procedure and answer the questions.

1. Examine the wrist strap for any obvious defects, such as worn or broken straps, loose grounding lead attachments, or dirt or grease 
buildup.

2. If necessary, remove any dirt or grease buildup from the wrist strap, paying close attention to the electrical contact points, such 
as the wrist contact point, the ground lead attachment point, and the computer chassis attachment clip. Use denatured alcohol to 
clean these contact points.

3. If possible, use a multimeter to check continuity between the wrist contact point and the computer chassis attachment clip. A read-
ing of 0 ohms of resistance indicates a good electrical pathway.

 How many volts of static electricity does it take to harm a computer’s electrical components?

  _________________________________________________________________________________

4. Adjust the wrist strap so it fits snugly yet comfortably around your wrist. Ensure that the wrist contact is in direct contact with 
your skin, with no clothing, hair, and so on in the way.

5. Attach the ground lead to the wrist strap and ensure that it snaps securely into place.

6. Attach the computer chassis attachment clip to a clean metal attachment point on the computer chassis.
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7. Any static electricity generated or attracted by your body will now be channeled through the antistatic 
wrist strap to the computer chassis, where it will be safely dissipated.

 How many volts will an ESD be before you will feel anything?

  _________________________________________________________________________________

 Should you use an antistatic wrist strap when working inside a CRT monitor or laser printer high-
voltage power supply? Why or why not?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

Lab 5.2 Disassembling and Reassembling a Computer

Objective: To disassemble and reassemble a computer correctly

Parts: A computer to disassemble

 A toolkit

 An antistatic wrist strap (if possible)

Note: Observe proper ESD handling procedures when disassembling and reassembling a 
computer.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Gather the tools needed to disassemble the computer.

2. Clear as much workspace as possible around the computer.

3. Power on the computer.

 Why is it important to power on the computer before you begin?

  _________________________________________________________________________________

External Cables

4. Turn off the computer and all peripherals. Remove the power cable from the wall outlet and then re-
move the power cord from the computer.

5. Note where the monitor cable plugs into the back of the computer. Disconnect the monitor, including 
the power cord, and move it to a safe place. Take appropriate notes.

6. Remove all external cables from the back of the computer. Take notes about the location of each 
cable. Move the peripheral devices to a safe place.

 Did the mouse cable connect to a PS/2 or USB port?

  _________________________________________________________________________________

Computer Case Side Access or Removal

7. If possible, remove one or both sides of the case. This is usually the most difficult step in disassem-
bly, especially if the computer is one that has not been seen before. Diagram the screw locations. 
Keep the cover screws separated from other screws. An egg carton or a container with small compart-
ments makes an excellent screw holder. Label each compartment and reuse the container. Otherwise, 
open the case as directed by the manufacturer.

Adapter and Internal Cable Placement

8. Make notes or draw the placement of each adapter in the expansion slots.
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9. On your notes, draw the internal cable connections before removing any adapters or cables from the 
computer. Make notes regarding how and where the cable connects to the adapter. Do not forget to 
include cables that connect to the motherboard or to the computer case.

 List some ways to determine the correct orientation for an adapter or a cable.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Internal Cable Removal

10. Remove all internal cables. Some cables have connectors with locking tabs. Release any locking tabs 
before disconnecting the cable. Make appropriate notes regarding the cable connections. Some stu-
dents find that labeling cables and the associated connectors makes reassembly easier, but good notes 
usually suffice.

 Warning: Do not pull on a cable; use the pull tab, if available, or use the cable connector to pull out 
the cable.

Adapter Removal

11. Start with the left side of the computer (as you look at the front of the computer) and locate the left-
most adapter.

12. If applicable, remove the screw or retaining bracket that holds the adapter to the case. Place the screw 
in a separate, secure location away from the other screws that were already removed. Make notes 
about where the screw goes or any other notes that will help you when reassembling the computer.

13. Remove the adapter from the computer.

 Why must you be careful not to touch the gold contacts at the bottom of each adapter?

  _________________________________________________________________________________

  _________________________________________________________________________________

14. Remove the remaining adapters in the system by repeating steps 11–13. Take notes regarding screw 
locations, jumpers, switches, and so forth for each adapter.

Drives

15. Remove all power connections to drives, such as hard drives, optical drives, and so on. Note the 
placement of each drive and each cable, as well as any reminders needed for reassembly.

16. Remove any screws holding the drives in place. Make notes about where the screws go. Keep these 
screws separate from any previously removed screws.

17. Remove all drives.

 Why must you be careful when handling a mechanical hard drive?

  _________________________________________________________________________________

 What would you do differently when handling an SSD than when handling a SATA hard drive?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Power Supply

18. Before performing this step, ensure that the power cord is removed from the wall outlet and the com-
puter. Remove the connectors that connect the power supply to the motherboard.

19. Take very good notes here so you will be able to insert the connectors correctly when reassembling.

20. Remove the power supply.

 What is the purpose of the power supply?

  _________________________________________________________________________________
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Motherboard

21. Make note of any motherboard switches or jumpers and indicate whether the switch position is on or 
off.

 What is the importance of documenting switches and jumpers on the motherboard?

  _________________________________________________________________________________

22. Remove any remaining connectors. Take appropriate notes.

23. Remove any screws that hold the motherboard to the case. Place these screws in a different loca-
tion from the other screws removed from the system. Write any notes pertaining to the motherboard 
screws. Look for retaining clips or tabs that hold the motherboard into the case.

24. Remove the motherboard. Make notes pertaining to the motherboard removal. The computer case 
should be empty after you complete this step.

Instructor initials: _____________

Reassembly

25. Reassemble the computer by reversing the steps for disassembly. Pay particular attention to cable ori-
entation when reinstalling cables. Before reconnecting a cable, ensure that the cable and the connec-
tors are correctly oriented and aligned before pushing the cable firmly in place. Refer to your notes 
and install the motherboard in the computer case and reconnect all motherboard connections and 
screws.

26. Install the power supply by attaching all screws that hold the power supply in the case. Reattach the 
power connectors to the motherboard. Refer to your notes.

27. Install all drives by attaching screws, cables, and power connectors. Refer to your notes. Attach any 
cables that connect the drive to the motherboard.

28. Install all adapters. Attach all cables from the adapter to the connecting device. Replace any retaining 
clips or screws that hold adapters in place. Refer to your notes and diagrams.

29. Connect any external connectors to the computer. Refer to your notes, when necessary.

30. Replace the computer cover. Ensure that slot covers are replaced and that the drives and the front 
cover are aligned properly. Ensure that all covers are installed properly.

31. Reinstall the computer power cable.

32. Once the computer is reassembled, power on all external peripherals and the computer. A chassis in-
trusion error message might appear. This just indicates that the cover was removed. Did the computer 
power on with POST error codes? If so, recheck all diagrams, switches, and cabling. Also, check 
a similar computer model that still works to see whether you made a diagramming error. The most 
likely problem is with a cable connection or with a part that is not seated properly in its socket.

Instructor initials: ______________

Lab 5.3 Determining Amps and Wattage

Objective: To determine the correct capacity and wattage of a power supply

Parts: Power supply

 Internet access (as needed)

Procedure: Complete the following procedure and answer the accompanying questions.

1. Locate the documentation stenciled on the power supply, if possible.

2. Use the internet to find documentation about the power supply on the manufacturer’s website. Use the 
information you find on the power supply or the website to answer the following questions.

 How many amps is the power supply rated for at 5 volts?

  _________________________________________________________________________________
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 How many amps is the power supply rated for at 12 volts?

  _________________________________________________________________________________

 How many +12V rails does the power supply have?

  _________________________________________________________________________________

 What is the maximum rated output power of the power supply, in watts?

  _________________________________________________________________________________

Instructor initials: _____________

Lab 5.4 Performing a Continuity Check

Objective: To perform a continuity check on a cable and find any broken wires

Parts: Multimeter

 Cable and pin-out diagram

Procedure: Complete the following procedure and answer the accompanying questions.

1. Obtain a meter, a cable, and a pin-out diagram from your instructor.

2. Set the meter to ohms.

3. Power on the meter.

4. Lay the cable horizontally in front of you. The connector on the left is referred to as Connector A. 
The connector on the right is referred to as Connector B.

5. Determine the number of pins on the cable connector. On a sheet of paper, write numbers vertically 
down the left side of the paper, ensuring that there is a number for each connector pin. At the top 
of the numbers, write Connector A as the heading. Create a corresponding set of identical numbers 
vertically on the right side of the paper. (See step 5 of Lab 5.5 for an example of how to set up this 
table.)

6. Check the continuity of each wire. Document your findings by placing a check mark beside each pin 
number that has a good continuity check.

 Which meter setting did you use to check continuity, and which meter symbol is used for this setting?

  _________________________________________________________________________________

7. Power off the meter and return all supplies to the instructor.

Instructor initials: _____________

Lab 5.5 Drawing a Pin-Out Diagram

Objective: To draw a pin-out diagram using a working cable

Parts: Multimeter

 Good cable

Procedure: Complete the following procedure and perform the accompanying activities.

1. Obtain a meter and a good cable from your instructor.

2. Set the meter to ohms.

Instructor initials: _____________

3. Power on the meter.

4. Lay the cable horizontally in front of you. The connector on the left is referred to as Connector A. 
The connector on the right is referred to as Connector B.
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5. Touch one meter lead to Connector A’s pin 1. Touch the other meter lead to every Connector B pin. 
Notice when the meter shows zero resistance, indicating a connection.

 Using the table that follows, draw a line from Connector A’s pin 1 to any Connector B pins that show 
zero resistance. Add more pin numbers as needed to the table or use a separate piece of paper. Re-
member that all pins do not have to be used in the connector. There are no review questions; however, 
there is a connector table that contains connection lines.

Connector A Connector B

❐ 1 ❐ 1

❐ 2 ❐ 2

❐ 3 ❐ 3

❐ 4 ❐ 4

❐ 5 ❐ 5

❐ 6 ❐ 6

❐ 7 ❐ 7

❐ 8 ❐ 8

❐ 9 ❐ 9

❐ 10 ❐ 10

❐ 11 ❐ 11

❐ 12 ❐ 12

❐ 13 ❐ 13

❐ 14 ❐ 14

❐ 15 ❐ 15

6. Power off the meter.

Instructor initials: _____________

7. Return all supplies to the instructor.

Lab 5.6 Checking a Fuse

Objective: To determine whether a fuse is good

Parts: Multimeter

 Fuse

Procedure: Complete the following procedure and answer the accompanying questions.

1. Obtain a meter and a fuse from your instructor.

2. Look at the fuse and determine its amp rating.

 What is the amperage rating of the fuse?

  _________________________________________________________________________________

3. Set the meter to ohms.

Instructor initials: _____________

4. Power on the meter.

5. Connect one meter lead to one end of the fuse. Connect the other meter lead to the opposite end.
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6. Look at the resistance reading on the meter.

 What is the resistance reading?

  _________________________________________________________________________________

 Is the fuse good?

  _________________________________________________________________________________

7. Power off the meter.

Instructor initials: _____________

8. Return all materials to the instructor.

Lab 5.7 Using a Multimeter

Objective: To check voltage and resistance levels using a multimeter

Parts: Multimeter

 AA, AAA, C, D, or 9-volt battery

 Extended paperclip or wire

Caution: Keep both hands behind the protective rings on the meter handles. See Figure 5.23.

Procedure: Complete the following procedure and perform the accompanying activities.

1. All voltage inside a computer is DC voltage (except for some parts inside the power supply). Learn-
ing how to measure DC voltage is important for a technician. The best place to start is with a battery. 
Obtain a battery. Look carefully at the battery and determine where the positive end or connector is 
located (it usually has a + [plus] symbol nearby) and where the negative end or connector is located.

 Why is it important to locate positive and negative on a battery?

  _________________________________________________________________________________

2. Look carefully at the battery and determine the voltage rating.

 Document your findings.

  _________________________________________________________________________________

  _________________________________________________________________________________

3. Place the battery on a flat surface. If the battery is an AA, AAA, C, or D battery, place the battery so 
that the positive side (the side with a nodule) points toward your right side. If the battery is a 9-volt 
battery, place the battery so that the connectors are facing you and the positive connector (the smaller 
connector) is on your right side.

4. If the meter has leads that attach, attach the black meter lead to the appropriate port (colored black or 
labeled COM). Attach the red meter lead to the positive port, marked with a plus sign ( + ).

5. Turn on the meter. Set the meter so that it is measuring VDC (DC voltage). This might involve manu-
ally rotating a dial and/or pushing a button. Note that some meters can autodetect the setting, but 
most require this configuration.

 Document what you did to configure the meter for VDC.

  _________________________________________________________________________________

 What indication, if any, did the meter show in the meter window that VDC is being measured?

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Hold the meter leads so that the black lead is in your left hand and the red lead is in your right hand. 
Ensure that your hands are behind the protective ring on the meter handle. Refer to Figures 5.22 and 
5.23 if you are unsure.
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7. Place the black meter lead to the negative side (left side or left connector). Also touch the red meter 
lead to the positive side (right side or right connector) of the battery.

 Make a note of the meter reading.

  _________________________________________________________________________________

 Based on your findings, is the battery good (usable in an electronic device)?

  _________________________________________________________________________________

8. Now reverse the meter leads, placing the black lead to the positive side and the red lead to the nega-
tive side.

 Record your findings.

  _________________________________________________________________________________

 What was different from the original meter reading?

  _________________________________________________________________________________

Instructor initials: ______________

9. Perform this voltage check on any other batteries given to you by the instructor or lab assistant.

10. Straighten a paperclip or obtain a wire. Place the paperclip or wire on a flat surface.

11. Change the meter so that it reads ohms. This is normally shown by the omega symbol (Ω).

 While having the meter leads up in the air (not touching each other), what does the meter display?

  _________________________________________________________________________________

12. Touch the meter leads together to make a complete circuit or path.

 What does the meter display now?

  _________________________________________________________________________________

13. Touch one meter lead to one end of the paperclip or wire and touch the other meter lead to the oppo-
site paperclip or wire end. Sometimes it is easier to just lay the meter lead on top of the wire, close to 
the end.

 What is the meter reading?

  _________________________________________________________________________________

14. Some meters have the ability to make a sound when a wire is good. This is frequently shown on the 
meter as a sound wave. If your meter has this ability, configure the meter and redo the test. You can 
see how much easier this would be than trying to hold your meter leads straight and watch the meter.

Instructor initials: ______________

15. Power off the meter. Disconnect the leads as necessary. Return all parts to the appropriate locations.

Lab 5.8 Checking Wall Outlet and Power Cord AC Voltage

Objective: To check the voltage from a wall outlet and through a power cord

Parts: Multimeter

 Computer power cord

Caution: Exercise extreme caution when working with AC voltages!

Procedure: Complete the following procedure and perform the accompanying activities.

1. Set the multimeter to AC VOLTAGE. (Refer to the meter’s manual if you are unsure about this 
setting.)

 Warning: Using a current or resistance setting could destroy the meter.

2. Power on the multimeter. Locate an AC power outlet. Refer to Lab Figure 5.1 for the power 
connections.



 LAB 5: Disassembly and Power Labs 31

LA
B 5

HotNeutral

Ground

LAB FIGURE 5.1 AC outlet

3. Insert the meter’s black lead into the round (ground) AC outlet plug.

4. Insert the meter’s red lead into the smaller flat (hot) AC outlet plug. The meter reading should be 
around 120 volts. Use Lab Table 5.1 to record the reading.

5. Move the meter’s red lead into the larger flat (neutral) AC outlet plug. The meter reading should be 0 
volts. Use Lab Table 5.1 to record the reading.

LAB TABLE 5.1 Wall outlet AC checks

Connection Expected voltage Actual voltage 

GND to hot 120VAC

GND to neutral 0VAC

Hot to neutral 120VAC

6. Remove both leads from the wall outlet.

7. Insert the meter’s black lead into the smaller flat (hot) AC outlet plug.

8. Insert the meter’s red lead into the larger flat (neutral) AC outlet plug. The meter reading should be 
around 120 volts. Use Lab Table 5.1 to record the reading.

9. Plug the computer power cord into the AC wall outlet that was checked using steps 3 through 8.

10. Verify that the other end of the power cord is not plugged into the computer.

11. Perform the same checks you performed in steps 3 through 8, except this time check the power cord 
end that plugs into the computer. Use Lab Table 5.2 to record the reading.

LAB TABLE 5.2 Power cord AC checks

Connection Expected voltage Actual voltage 

GND to hot 120VAC

GND to neutral 0VAC

Hot to neutral 120VAC

12. If the voltage through the power cord is correct, power off the meter. Notify the instructor of any in-
correct voltages.

Instructor initials: _____________
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Lab 5.9 Checking Device DC Voltage

Objective: To check the power supply voltages sent to various devices

Parts: Multimeter

 Computer

Procedure: Complete the following procedure and perform the accompanying activities.

1. Set the multimeter to DC VOLTAGE. (Refer to the meter’s manual if unsure about the setting.)

2. Power on the multimeter.

3. Power off the computer.

4. Remove the computer case.

5. Locate a Molex or Berg power connector. If one is not available, disconnect a power connector from 
a device.

6. Power on the computer.

7. Check the +5 volt DC output from the power supply by placing the meter’s black lead in (if the con-
nector is a Molex) or on (if the connector is a Berg) one of the grounds* (a black wire). Place the me-
ter’s red lead on the +5 volt wire (normally a red wire) in or on the connector. Consult Lab Figure 5.2 
for the layout of the Molex and Berg power supply connections. Lab Figure 5.2 also contains a table 
with the acceptable voltage levels.

+5 Volts
+12 Volts

+4.75
+11.4

Minimum Maximum
+5.25
+12.6

Voltages

Berg connector

Molex connector

Yellow: +12V
Black: ground
Black: ground
Red: +5V

Red: +5V

Black: ground

Black: ground

Yellow: +12V

LAB FIGURE 5.2 Molex and Berg power connectors

 Write the voltage level found for the +5 volt wire in Lab Table 5.3.

LAB TABLE 5.3 +5 volt check

Voltage being checked Voltage found 

+5 volts

8. Check the +12 volt DC output by placing the meter’s black lead in (if the connector is a Molex) or on 
(if the connector is a Berg) one of the grounds. Place the meter’s red lead on the +12 volt wire in or 
on the connector. See Lab Figure 5.2 for the layout of the Molex and Berg power supply connections. 
The figure also contains a table with acceptable voltage levels. Write the voltage level found or the 
+12 volt wire in Lab Table 5.4.

*  Use and check both ground connections (black wires going into the connector); do not check all the 
voltages using only one ground connection.
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LAB TABLE 5.4 +12 volt check

Voltage being checked Voltage found 

+12 volts

9. Notify the instructor of any voltages that are out of the acceptable range.

10. Power off the meter.

Instructor initials: _____________

11. Power off the computer.

Lab 5.10 Using a Power Supply Tester

Objective: To check voltage levels using a power supply tester

Parts: Power supply tester

 Working computer

Caution: Be sure you have the connector firmly attached to the power supply tester before applying 
power to the computer.

Procedure: Complete the following procedure and perform the accompanying activities.

1. Power on the computer and ensure that it works and boots to the operating system.

2. Power off the computer.

3. Access the interior of the computer. Remove the 24-pin motherboard power connector (the largest 
connector that goes from the power supply to the motherboard).

4. Attach the 24-pin motherboard power connector to the power supply tester.

 Note: All voltage inside the computer is DC voltage (except for some parts inside the power supply, 
of course).

5. Power on the computer. The LCD output should show each voltage level and/or give you an indica-
tion of whether the power output is okay. This varies between power supply testers.

 Does it appear that the power provided to the motherboard is accurate according to the power supply 
tester’s output? [ Yes | No ]

 What indication do you have on the power supply tester about the power going to the motherboard 
connector?

  _________________________________________________________________________________

6. Power off the computer. Remove the 24-pin motherboard power connector from the power supply tes-
ter and reattach it firmly into the motherboard.

7. Attach a SATA power connector to the power supply tester. Note that you may not have an available 
one and may have to remove it from the optical drive or hard drive.

8. Power on the computer. The SATA connector provides +12V, +5V, and +3.3V to an internal SATA 
device. The power supply tester should provide some indication of whether these voltage levels are 
within acceptable ranges.

 Does it appear that the power provided to an internal SATA device is accurate according to the power 
supply tester’s output? [ Yes | No ]

 What indication do you have on the power supply tester about the power going to the SATA power 
connector?

  _________________________________________________________________________________
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9. Power off the computer.

10. Detach the SATA power connector from the power supply tester and reattach it, if necessary.

11.  Power on the computer and ensure that all devices are accessible and that the computer still boots.

Instructor initials: _____________

12.  Either using the instructions printed on the power supply tester or documentation found on the inter-
net, determine how the power supply tester indicates an abnormal voltage level.

 What indication do you have on the power supply tester that a particular power supply voltage is not 
within an acceptable voltage range?

  _________________________________________________________________________________

Lab 5.11 Understanding the Windows 10/11 Power Options

Objective: To be able to control power options via BIOS/UEFI and Windows 10/11

Parts: Computer with Windows 10 or 11 loaded

Procedure:  Complete the following procedure and answer the accompanying questions.

1. Power on the computer and ensure that it boots properly before taking any further steps.

2. Reboot the computer and access BIOS Setup.

 List the BIOS/UEFI options related to power management.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Can ACPI be disabled via BIOS/UEFI?

  _________________________________________________________________________________

3. Exit the BIOS/UEFI Setup program without saving any settings. Boot to Windows.

4. Access the current power settings by using the Power Options Control Panel or the System > Power 
& sleep Settings link.

 What is the current power plan?

  _________________________________________________________________________________

5. Select the Create a Power Plan link on the left or Additional power settings if using Windows Set-
tings. Type a unique name in the Plan Name textbox. Click Next.

6. Use the various options to select specific power plans. Not all platforms have all options, but docu-
ment your settings in Lab Table 5.5.

LAB TABLE 5.5 Power plan options

Option Minutes selected

Display 

Display brightness (mobile devices)

Computer sleep
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7. When you are finished configuring, click the Create button. Notice that your new plan appears in the 
list of preferred plans. Also notice that the Show additional plans/Hide additional plans reveal arrow 
is available.

 What global ACPI state do you think this plan would assign? Look back through the chapter to 
review.

  _________________________________________________________________________________

8. Click the Change plan settings link under or beside the plan you just created. Select the Change ad-
vanced power settings link.

 List at least three devices for which you can have power controlled through this section of the Control 
Panel.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: __________

9. If available and possible, expand the USB section and the USB selective suspend setting.

 What is the current USB selective suspend setting?

  _________________________________________________________________________________

10. Expand the Processor power management setting, if possible.

 What is the minimum processor state?

  _________________________________________________________________________________

11. Expand the Desktop background settings > Slide show setting, if possible.

 What setting or settings are configured with this option?

  _________________________________________________________________________________

12. Click the Cancel button to return to the Change Settings window. Click the Cancel button again.

13. To delete a power plan you created (the default ones cannot be deleted), select the radio button for the 
original power plan. Refer to step 4, if necessary. Under the plan you created, select the Change plan 
settings link. Select the Delete this plan link and click OK. The plan should be removed from the 
power options list.





Memory Labs6

Lab 6.1 Examining Memory Resources Using Device Manager in Windows 10/11

Objective:  To be able to view memory resources currently being used by Windows 10 or 11

Parts: A computer with Windows 10 or 11 installed and rights to use Device Manager

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and verify that Windows loads. Log on to Windows using the known user ID and password or one pro-
vided by the instructor or lab assistant.

2. Use the Search textbox, type device and select Device Manager from the resulting list.

3. Select the View menu option > select Resources by Type > expand Memory by clicking the arrow beside the option.

 List at least one range of memory addresses that are used by the system board? Note that you may have to scroll to the bottom to 
find System board and not motherboard.

  _________________________________________________________________________________

4. Right-click the first system board memory address range shown and select Properties.

 What tabs are shown in the window?

  _________________________________________________________________________________

5. Select the Resources tab. All memory resources used by the function selected are shown.

 Can you select one of the memory resources using the Change Setting button? [ Yes | No ]

6. Close the Properties window and the Device Manager window.
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Lab 6.2 Using the System Information Tool in Windows 10/11 to View 
Memory

Objective:  To be able to view memory resources currently being used by Windows 10 or 11

Parts: A computer with Windows 10 or 11 installed and rights to use the System Information 
Tool

Procedure: Complete the following procedure and answer the accompanying questions.

1. Use the Search textbox to locate and select the System Information app. The questions can be an-
swered by scrolling through the information found on the System Summary main page.

 How much physical RAM is installed?

  _________________________________________________________________________________

 How much physical RAM is available?

  _________________________________________________________________________________

 How much total virtual memory does the machine have?

  _________________________________________________________________________________

 How much available virtual memory does the machine have?

  _________________________________________________________________________________

 What are the location and size of the page file?

  _________________________________________________________________________________

2. Close the System Information window.

Lab 6.3 Using Windows 10/11 Task Manager to View Memory

Objective:  To be able to use the Task Manager tool to view memory resources currently being used by 
Windows 10 or 11

Parts: A computer with Windows 10 and 11 installed and rights to use Task Manager

Procedure: Complete the following procedure and answer the accompanying questions.

1. After logging on to a Windows 10/11 computer, search for and select the Task Manager tool.

2. Access the Performance tab. Note that you might have to select the More details link to see the Per-
formance tab. To answer the questions, you will have to select different options on the left.

 What percentage of the CPU is being used?

  _________________________________________________________________________________

 How much RAM (memory) is available?

  _________________________________________________________________________________

 How many RAM slots are used?

  _________________________________________________________________________________

 What speed of memory modules is used?

  _________________________________________________________________________________

3. Click the Open Resource Monitor link and select the Overview tab.

 What is the percentage of used physical memory?

  _________________________________________________________________________________

4. Expand the Memory section.

 List three executable (.exe) files running in memory.

  _________________________________________________________________________________
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5. Open an application such as the Calculator app. Then locate the application in the Open Resource 
Monitor window in the Memory section.

 Which app did you choose?

  _________________________________________________________________________________

 How many kilobytes are shown for the application in the Commit column?

  _________________________________________________________________________________

 How many kilobytes are shown for the application in the Working Set column?

  _________________________________________________________________________________

 How many kilobytes are shown for the application in the Shareable column?

  _________________________________________________________________________________

 How many kilobytes are shown for the application in the Private column?

  _________________________________________________________________________________

6. Select the Memory tab. Ensure the Physical Memory section is expanded.

 How much memory is reserved for hardware, if any?

  _________________________________________________________________________________

7. Hold the mouse pointer over the colored bar portion of physical memory that represents the amount 
of memory In Use. A description of this portion of the bar appears.

 What is the exact purpose of the In Use section?

  _________________________________________________________________________________

8. Close the Resource Monitor window.

9. In the Task Manager window, select the Details tab.

 List three executable (.exe) files running in memory.

  _________________________________________________________________________________

10. From the Details tab, locate the app you opened in step 5.

 What is the status of the app? [ Running | Suspended | Idle ]

11. Select the Processes tab.

 Which app is using the most memory?

  _________________________________________________________________________________

 How many background processes are running in memory?

  _________________________________________________________________________________

 Are any Windows processes running but taking 0 MB of memory? If yes, list one of them.

  _________________________________________________________________________________

  _________________________________________________________________________________

12. Select the Performance tab and select Memory. Locate the memory composition graph. Hold the 
mouse pointer over the colored bar that shows how the Standby portion of physical memory is being 
used.

 What is the exact purpose of the Standby section?

  _________________________________________________________________________________

 Determine the exact purpose of the Free section. Document your findings.

  _________________________________________________________________________________

  _________________________________________________________________________________

13. Close the Task Manager window.
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Lab 6.4 Installing RAM

Objective:  To be able to install RAM

Parts: A computer or motherboard

 RAM that matches the computer or motherboard

Procedure: Complete the following procedure and answer the accompanying questions.

1. If using a computer, open the side to see how many expansion slots are available.

2. Ask your instructor or lab assistant if dual- or triple-channeling is required.

 Do you need to plan for dual- or triple-channeling?

  _________________________________________________________________________________

3. Determine the capacity of the chips that go in each bank. Document what chip(s) and what memory 
slot you plan to use in the space provided. Use motherboard documentation or information provided 
by the instructor or lab assistant. Draw a diagram, if needed.

 Document your memory installation plan.

  _________________________________________________________________________________

4. Ensure that the memory slot(s) where you are going to install the DIMM(s) has/have the retaining 
tabs pushed outward away from the memory slot. Using the DIMM(s) provided, use antistatic proce-
dures and insert the DIMM into the expansion slot, aligning the notch on the DIMM with the notch 
on the memory slot. Press downward, using even pressure, until the DIMM is firmly into the memory 
slot and the retaining tabs are firmly clasped into the DIMM. Note: Do not force the DIMM into the 
slot. Check the notch alignment again.

5. Power on the computer. Note that you may receive a BIOS/UEFI error. This is normal when you 
have just changed the configuration. You may be required to go into BIOS and confirm the amount of 
memory installed.

 Did you get a BIOS/UEFI error or beep? [ Yes | No ]

6. Ensure that the machine boots properly and the operating system loads if a computer is being used.

 Is the memory installed correctly? [ Yes | No ]

Instructor initials: _____________

7. Power off the computer. Remove the memory. Power on the computer and ensure that it boots without 
any errors.

 Is the computer working again? (Just write “not applicable” if you were just using a motherboard.)

  _________________________________________________________________________________
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Lab 7.1 Installing a Second PATA Hard Drive and Creating Two Volumes

Objective: To be able to install, configure, and manage a second hard drive using the Windows Disk Management console

Parts: Windows computer with an available PATA connection on the motherboard or an available PATA cable connection on 
an existing PATA connection to the motherboard

 Power connector

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: Use proper antistatic and gentle handling procedures when dealing with hard drives.

 You must be a user who has administrator rights to configure hard drives.

 If an optical drive is installed, it can be replaced with the new hard drive to perform this lab.

1. Power on the computer and log in.

2. There are several ways to get to the window used to manage hard drives. Practice using all of them:

 (a) Click the Start button, type compmgmt.msc in the Search box, and press ®.

 (b) In Windows Explorer/File Explorer, right-click Computer (Windows 7) or This PC (Windows 8/10/11) and select Manage.

 (c) Access the Administrative Tools Control Panel > Computer Management.

3. In the console tree shown in the left pane, select the Disk Management option. Note that the Disk Management tool can also be 
directly accessed by using the diskmgmt.msc command. The disks and volumes already installed in the computer display in a 
graphical manner on the right.

4. Right-click the drive partition labeled C: and select Properties.

 Which type of file system is being used? [ FAT16 | FAT32 | exFAT | NTFS ]

  _________________________________________________________________________________

 What is the drive number shown in the right panel? [ 0 | 1 | 2 | 3 ]

  _________________________________________________________________________________
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 What is the amount of free space?

  _________________________________________________________________________________

5. Shut down the computer and remove the power cord.

6. Access the interior of the computer. Locate an available PATA port on the motherboard or an avail-
able PATA cable connector. Determine which port this is by looking at the motherboard’s labeling or 
by using documentation.

 Are you using a PATA port that has nothing attached or an available PATA cable connector that has 
another device attached?

  _________________________________________________________________________________

7. If another device is installed on the same cable, remove the drive and determine whether it uses cable 
select or master/slave jumpers. Handle the drive carefully. If you removed a PATA device to check the 
drive settings, reinstall it into the machine and reconnect the power and data cables.

 If this is the only device that will connect to a motherboard PATA port, connect the PATA cable to the 
motherboard.

 If another device is present, does the device use the cable select, master, or slave jumper? If you are 
not using a cable that has another device present, choose not applicable as the answer.  
[ cable select | master | slave | ______________ (different setting) | not applicable ]

 If a PATA port that has nothing attached is being used, which motherboard PATA port is being used? 
If you are installing the drive as a second device on the same cable, choose not applicable as the 
answer. [ primary | secondary | tertiary | quaternary | not applicable ]

8. On the hard drive given to you by the instructor, configure the drive to the appropriate setting: cable 
select, master, or slave. Mount the drive, attach the data cable, and attach a power cable.

 Which drive setting did you choose?  
[ cable select | master | slave | ______________ (different setting) | not applicable ]

9. Reinstall the computer power cord and power on the computer.

10. Using previously described procedures, open the Disk Management tool. Locate the drive in the 
bottom section of the window. If you are unsure about which drive is to be partitioned, contact the 
instructor or lab assistant.

 Note that the drive you were given may have been partitioned already and assigned a drive letter. If 
the drive was already partitioned and a drive letter has been assigned, locate the drive in the bottom 
window and right-click the partition. Select Delete Volume and click Yes. Also note that you may have 
to delete multiple partitions.

 If the drive shows the status as Invalid in the bottom section (left side), right-click the drive in that 
left section and select the Convert to Basic Disk option.

 At this point, the drive should show all space as unallocated.

 Was the drive already partitioned? [ Yes | No ]

 Was the drive already assigned a drive letter? [ Yes | No ]

11. Right-click the new drive you just installed and select New Simple Volume. The New Simple Volume 
Wizard appears. Click Next.

 What is the difference between a simple volume and a spanned volume?

  _________________________________________________________________________________

  _________________________________________________________________________________
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 What is the minimum number of drives required to create a striped volume?

  _________________________________________________________________________________

12. Enter a partition size that is less than 32 GB and still leaves room on the hard drive. Notice that the 
partition size is shown in megabytes. Click Next.

 Which partition size did you choose?

  _________________________________________________________________________________

13. Select a drive letter (normally, this is the next drive letter available; take note of all the options) and 
then click Next.

 How many drive letters are available as options?

  _________________________________________________________________________________

 Which file systems are supported when you use this tool?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Are any file systems supported by Windows that are not shown? If so, what are they?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

14. Select the NTFS option. Assign a volume label that is constructed from a couple letters from each lab 
partner’s last name. Note that there is a 32-character maximum for NTFS partitions. Select (enable) 
the Perform a Quick Format checkbox and click Next. Click the Finish button.

 How can you tell from the information in the Disk Management window whether a partition is NTFS 
or another file system?

  _________________________________________________________________________________

15. In the Disk Management window, right-click the free space for the drive you installed. Using the 
same process, create an NTFS simple volume, add a unique volume label, and perform a quick 
format.

Instructor initials: _____________

Lab 7.2 Installing a Second SATA Hard Drive and Creating Two Volumes

Objective: To be able to install, configure, and manage a second hard drive using the Windows Disk 
Management console

Parts: Windows computer with an available SATA connection on the motherboard

 Power connector

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: Use proper antistatic and gentle handling procedures when dealing with hard drives.

 You must be a user who has administrator rights to configure hard drives.

1. Power on the computer and log in.

2. There are several ways to get to the window used to manage hard drives. Practice using all of them:

 (a) Click the Start button, type compmgmt.msc in the Search box, and press ®.

 ( b)  In Windows Explorer/File Explorer, right-click Computer (Windows 7)/This PC (Windows 
8/10/11) and select Manage.

 (c) Access the Administrative Tools section of the Control Panel > Computer Management.
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3. In the console tree shown in the left pane, select the Disk Management option. Note that the Disk 
Management tool can also be directly accessed by using the diskmgmt.msc command. The disks 
and volumes already installed in the computer display in a graphical manner on the right.

4. Right-click the drive partition labeled C: and select Properties.

 Which type of file system is being used? [ FAT16 | FAT32 | exFAT | NTFS ]

 What is the drive number shown in the right panel? [ 0 | 1 | 2 | 3 ]

 What is the amount of free space?

  _________________________________________________________________________________

5.  Shut down the computer and remove the power cord.

6.  Access the interior of the computer. Locate an available SATA port on the motherboard. Determine 
which port this is by looking at motherboard labeling or by using documentation.

 Which SATA port should you use to install the second hard drive?

  _________________________________________________________________________________

7. Power off the computer and access System BIOS/UEFI. If you do not know what keystroke is used to 
access BIOS/UEFI, watch the boot screen. If you still cannot tell, research the computer model on the 
internet.

 Which keystroke did you use to access BIOS/UEFI?

  _________________________________________________________________________________

8. Access the section of BIOS that controls the SATA port. The section you must enter varies from com-
puter to computer. Make notes about where you went to get there in the question below. Ensure that 
the SATA port you located and identified in step 6 is enabled.

 Was the port enabled in BIOS already, or did you have to enable it?

 [ already enabled | I had to enable it ]

 Document the BIOS steps you took to ensure that the SATA port was enabled.

  _________________________________________________________________________________

9. Save the BIOS/UEFI settings if changes were made.

10. Note that if you power on the computer with nothing attached to the SATA port, you may get an error 
message. That is okay because the drive has not been installed yet. Power down the computer, remove 
the power cord, and access the interior of the computer.

11. Mount the SATA hard drive in an available drive bay, attach the SATA data cable, and attach the hard 
drive power connector to the drive.

12. Reinstall the computer power cord and power on the computer.

13. Using previously described procedures, open the Disk Management tool. Locate the drive in the bot-
tom section of the window. If you are unsure which drive is to be partitioned, contact the instructor or 
lab assistant.

 Note that the drive you were given may have been partitioned already and assigned a drive letter. If 
the drive was already partitioned and a drive letter has been assigned, locate the drive in the bottom 
window and right-click the volume. Select Delete Volume and click Yes. Also note that you may have 
to delete multiple volumes.
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 If the drive shows the status as Invalid in the bottom section (left side), right-click the drive in that 
left section and select the Convert to Basic Disk option.

 At this point, the drive should show all space as unallocated.

 Was the drive already partitioned? [ Yes | No ]

  _________________________________________________________________________________

 Was the drive already assigned a drive letter? [ Yes | No ]

  _________________________________________________________________________________

14. Right-click the new drive you just installed and select New Simple Volume. The New Simple Volume 
Wizard appears. Click Next.

 What is the difference between a simple volume and a spanned volume?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the minimum number of drives required to create a striped volume?

  _________________________________________________________________________________

15. Enter a partition size that is less than 32 GB and still leaves room on the hard drive. Notice that the 
partition size is shown in megabytes. Click Next.

 Which partition size did you choose?

  _________________________________________________________________________________

16. Select a drive letter (normally, this is the next drive letter available; take note of all the options) and 
then click Next.

 How many drive letters are available as options?

  _________________________________________________________________________________

 Which file systems are supported when you use this tool?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Are there any file systems supported by Windows that are not shown? If so, what are they?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

17. Select the NTFS option. Assign a volume label that is constructed from a couple letters from each lab 
partner’s last name. Note that there is a 32-character maximum for NTFS partitions. Select (enable) 
the Perform a Quick Format checkbox and click Next. Click the Finish button.

 How can you tell from the information in the Disk Management window whether a partition is NTFS 
or another file system?

  _________________________________________________________________________________

18. In the Disk Management window, right-click the free space for the drive you installed. Using the 
same process, create an NTFS simple volume, add a unique volume label, and perform a quick 
format.

Instructor initials: _____________
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Lab 7.3 Installing an External Hard Drive and Creating Two Volumes

Objective: To be able to install, configure, and manage a second hard drive using the Windows Disk 
Management console

Parts: Windows computer with an available external connection

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: Use proper antistatic and gentle handling procedures when dealing with hard drives.

 You must be a user who has administrator rights to configure hard drives.

1. Power on the computer and log in.

2. There are several ways to get to the window used to manage hard drives. Practice using all of them:

 (a) Click the Start button, type compmgmt.msc in the Search box, and press ®.

 (b)  In Windows Explorer/File Explorer, right-click Computer (Windows 7)/This PC (Windows 
8/10/11) and select Manage.

 (c) Access the Administrative Tools section of the Control Panel > Computer Management.

3. In the console tree shown in the left pane, select the Disk Management option. Note that the Disk 
Management tool can also be directly accessed using the diskmgmt.msc command. The disks and 
volumes already installed in the computer display in a graphical manner on the right.

4. Right-click the drive partition labeled C: and select Properties.

 What type of file system is being used?

 [ FAT16 | FAT32 | exFAT | NTFS ]

 Which is the drive number shown in the right panel? [ 0 | 1 | 2 | 3 ]

 What is the amount of free space?

  _________________________________________________________________________________

5. Locate an available external port that can be used for the hard drive provided.

 Which type of external port did you identify?

 [ USB | eSATA | IEEE 1394 | Other (please identify: _________) ]

6.  Attach the external drive to the identified external port. Attach an external power brick/cord if neces-
sary. Turn on power to the drive if necessary. The system should install the proper drivers and allow 
the drive to be recognized by the operating system.

7. Using previously described procedures, open the Disk Management tool. Locate the drive in the bot-
tom section of the window. If you are unsure which drive is to be partitioned, contact the instructor or 
lab assistant.

8. Note that the drive you were given may have been partitioned already and assigned a drive letter. If 
the drive was already partitioned and a drive letter assigned, locate the drive in the bottom window 
and right-click the volume. Select Delete Volume and click Yes. Also note that you may have to delete 
multiple volumes.

9. If the drive shows the status as Invalid in the bottom section (left side), right-click the drive in that 
left section and select the Convert to Basic Disk option.

 At this point, the drive should show all space as unallocated.

 Was the drive already partitioned? [ Yes | No ]

 Was the drive already assigned a drive letter? [ Yes | No ]
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10. Right-click the new drive you just installed and select New Simple Volume. The New Simple Volume 
Wizard appears. Click Next.

 What is the difference between a simple volume and a spanned volume?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the minimum number of drives required to create a striped volume?

  _________________________________________________________________________________

11. Enter a partition size that is less than 32 GB and still leaves room on the hard drive. Notice that the 
partition size is shown in megabytes. Click Next.

 What partition size did you choose?

  _________________________________________________________________________________

12. Select a drive letter (normally, this is the next drive letter available; take note of all the options) and 
then click Next.

 How many drive letters are available as options?

  _________________________________________________________________________________

 Which file systems are supported when you use this tool?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Are there any file systems supported by Windows that are not shown? If so, what are they?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

13. Select the NTFS option. Assign a volume label that is constructed from a couple letters from each lab 
partner’s last name. Note that there is a 32-character maximum for NTFS partitions. Select (enable) 
the Perform a Quick Format checkbox and click Next. Click the Finish button.

 How can you tell from the information in the Disk Management window whether a partition is NTFS 
or another file system?

  _________________________________________________________________________________

14. In the Disk Management window, right-click the free space for the drive you installed. Using the 
same process, create an NTFS simple volume, add a unique volume label, and perform a quick 
format.

Instructor initials: _____________

Lab 7.4 Installing a PATA/SATA Hard Drive with the Windows 7/8/10/11 
Disk Management Tool, diskpart, and convert

Objective: To be able to configure and manage a hard drive using the Windows Disk Management 
console

Parts: Windows computer with an available PATA connection on the motherboard, an available 
PATA cable connection, motherboard SATA port, USB port, or eSATA port

 Internal or external PATA or SATA hard drive

 Available power connector for an internal hard drive

Procedure: Complete the following procedure and answer the accompanying questions.
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Notes: Use proper antistatic and gentle handling procedures when dealing with hard drives.

 You must be a user who has administrator rights to configure hard drives.

 If an optical drive is installed, it can be replaced by the new hard drive to perform this lab.

1. Power on the computer and log in.

2. There are several ways to get to the window used to manage hard drives. Practice using all of them:

 (a) Click the Start button, type compmgmt.msc in the Search box, and press ®.

 (b)  In Windows Explorer/File Explorer, right-click Computer (Windows 7)/This PC (Windows 
8/10/11) and select Manage.

 (c) Access the Administrative Tools Control Panel > Computer Management.

3. In the console tree shown in the left pane, select the Disk Management option. Note that the Disk 
Management tool can also be directly accessed by using the diskmgmt.msc command. The disks 
and volumes already installed in the computer display in a graphical manner on the right.

4. Right-click the drive partition labeled C: and select Properties.

 What type of file system is being used? [ FAT16 | FAT32 | exFAT | NTFS ]

 What is the total capacity of the drive?

  _________________________________________________________________________________

 What is the amount of free space?

  _________________________________________________________________________________

5. Shut down the computer and remove the power cord.

 Note: Three sections follow. Use the appropriate section, depending on whether you are installing an 
internal PATA, internal SATA, or external drive. Proceed to step 9 when you are finished with your 
respective section.

PATA Installation (Use This Section Only if a PATA Drive Is Being Installed)

6. Access the interior of the computer. Locate an available IDE PATA port on the motherboard or an 
available PATA cable connector. Determine which port this is by looking at motherboard labeling or 
by using documentation.

7. Determine whether the other device on the same cable (if installed) uses cable select or master/slave 
jumpers by removing the drive and examining it. Handle the drive carefully. If you removed a PATA 
device to check the drive settings, reinstall it into the machine and reconnect the power and data 
cables.

 If a PATA drive is being installed, is there a second device on the same cable? [Yes | No ]

 If so, does the device use the cable select, master, or slave jumper?

  _________________________________________________________________________________

8. On the hard drive given to you by the instructor, configure the drive to the appropriate setting: cable 
select, master, or slave. Mount the drive, attach the data cable, and attach a power cable. Reinstall the 
computer power cord and power on the computer.

SATA Installation (Use This Section Only if a SATA Drive Is Being Installed)

6. Access the interior of the computer. Locate an available motherboard SATA port. Determine which 
port this is by looking at motherboard labeling or by using documentation.

 If a SATA drive is being installed, which SATA port will be used for the new drive?

  _________________________________________________________________________________

  _________________________________________________________________________________
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7. Mount the hard drive (provided by the instructor or lab assistant). Attach the data cable and attach a 
power cable.

8. Reinstall the computer power cord and power on the computer. Enter BIOS/UEFI Setup and ensure 
that the SATA port is enabled and the drive is recognized.

External Drive Installation (Use This Section Only if an External Hard Drive Is Being Installed)

6. Locate an available port to be used.

7. Attach the power cord to the drive, if necessary. Attach the drive to the appropriate port. Optionally, 
power on the drive. If the drive does not have a power switch, it is powered by the port.

 Which type of port is being used for the new drive?

  _________________________________________________________________________________

8. Power on the computer. Install device drivers if required.

For All Drive Types

9. Using previously described procedures, open the Disk Management tool. Locate the drive in the 
bottom section of the window. If you are unsure about which drive is to be partitioned, contact the 
instructor or lab assistant.

 Note that the drive you were given may have been partitioned already and assigned a drive letter. If 
the drive was already partitioned and a drive letter assigned, locate the drive in the bottom window 
and right-click the partition. Select Delete Volume and click Yes. Also note that you may have to de-
lete multiple partitions.

 If the drive shows the status as Invalid in the bottom section (left side), right-click the drive in that 
left section and select the Convert to Basic Disk option. At this point, the drive should show all space 
as unallocated.

 Was the drive already partitioned? [Yes | No ]

 Was the drive already assigned a drive letter? [Yes | No ]

10. Right-click the new drive you just installed and select New Simple Volume. The New Simple Volume 
Wizard appears. Click Next.

 What is the difference between a simple volume and a spanned volume?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the minimum number of drives required to create a striped volume?

  _________________________________________________________________________________

11. Enter a partition size that is less than 32 GB and still leaves room on the hard drive. Notice that the 
partition size is shown in megabytes. Click Next.

 What partition size did you choose?

  _________________________________________________________________________________

12. Select a drive letter (normally, this is the next drive letter available; take note of all the options) and 
then click Next.

 How many drive letters are available as options?

  _________________________________________________________________________________

 What file systems are supported when you use this tool?

  _________________________________________________________________________________

  _________________________________________________________________________________
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 Are there any file systems supported by Windows that are not shown? If so, what are they?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

13. Select the FAT32 option. Assign a volume label that is constructed from a couple letters from each lab 
partner’s last name. Note that there is an 11-character maximum for FAT32 partitions and a 32-char-
acter maximum for NTFS partitions. Select (enable) the Perform a Quick Format checkbox and click 
Next. Click the Finish button.

 How can you tell from the information in the Disk Management window whether a partition is FAT32 
or NTFS?

  _________________________________________________________________________________

14. In the Disk Management window, right-click in the unallocated drive space on the drive you just 
installed and select New Simple Volume. The New Simple Volume Wizard appears. Click Next.

15. Select a partition size less than 32 GB but that still leaves some space on the drive. Click Next.

 What amount of space did you choose for the logical drive size?

  _________________________________________________________________________________

16. Accept the default drive letter assignment and click Next.

17. Change the file system type to FAT32.

18. Make the volume label a unique name.

 Write the volume label chosen.

  _________________________________________________________________________________

19. Select (enable) the Perform a Quick Format checkbox. Click Next, review the settings, and click 
Finish.

20. In the Disk Management window, right-click the free space for the drive you installed. Using the 
same process, create an NTFS simple volume (but leave some space on the drive), add a unique 
volume label, and perform a quick format.

Instructor initials: _____________

21. You can change a FAT16 or FAT32 partition to the NTFS file system by using the convert com-
mand at a command prompt. After a partition is changed, you cannot go back to a previous file 
system type. Also, data is preserved (but should be backed up before the conversion, just in case 
problems occur). Look to the left of the colored sections to see the disk number assigned (Disk 0, 
Disk 1, and so on).

 In the Disk Management console, which disk number is used for the newly installed drive?

 [ 0 | 1 | 2 | 3 ]

 Write the drive letter of the first FAT32 primary partition on the newly installed drive. Note that this 
drive letter will be used in the coming steps.

  _________________________________________________________________________________

 Write the volume label used for the first FAT32 partition. This label is case sensitive, so write it 
carefully.

  _________________________________________________________________________________
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22. Windows 7: Click the Start button. Locate the Command Prompt menu option. Normally, it is located 
in Accessories. Right-click the Command Prompt menu option and select Run as Administrator. Click 
Yes.

 Windows 8/10/11: Type command in the Search textbox > right-click on Command Prompt > select 
Run as Administrator.

23. Type convert /? to see a list of options. These options tell you what to type as an option after the 
convert command.

 Which option is used to run convert in verbose mode?

  _________________________________________________________________________________

 Which option is used to convert a volume to the NTFS file system?

  _________________________________________________________________________________

24. Type convert x: /fs:ntfs (where x: is the drive letter you wrote in step 21). For example, if 
the drive letter written in step 21 is d:, type convert d: /fs:ntfs. Notice the space between 
the drive letter and /fs:ntfs. /fs:ntfs is used to convert the existing file system (exFAT, 
FAT16, or FAT32) to NTFS. You are prompted for the volume label for the drive. Enter the volume 
label you documented in step 21 and press ®. Do not forget that the volume label is case sensi-
tive. The partition is converted and can never be returned to a previous type of file system, such as 
FAT32, unless the drive is reformatted.

Instructor initials: _____________

25. Use the same process to convert the second FAT32 partition to NTFS. Look up the volume label and 
the drive letter before starting. Close the command prompt window. Have the Disk Management 
Window open to verify the file system.

26. Close the command prompt window. In the Disk Management window, right-click the last partition 
on the newly installed hard drive.

27. Select the Shrink Volume option. Reduce the amount of hard drive space and click Shrink.

 What was the result in the Disk Management console?

  _________________________________________________________________________________

28. Right-click the second partition on the newly installed drive. Select Extend Volume. A wizard appears. 
Click Next. Use the maximum space available on the same drive and click Next and then Finish.

 What message appears?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 According to the information in the dialog box, do you think changing this volume to a dynamic disk 
will matter?

  _________________________________________________________________________________

  _________________________________________________________________________________

29. Click No and return to the Disk Management console. Review the disks and determine the disk num-
ber and drive letter of the boot volume.

 Write the disk number of the boot volume. [ 0 | 1 | 2 | 3 ]

 Write the drive letter of the partition that holds the boot volume.

  _________________________________________________________________________________

30. Right-click the second partition of the newly installed drive and select Delete Volume. Click Yes.
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31. Partitions can be created from the Disk Management console, and they can also be created by using 
the diskpart command utility. Open another command prompt window.

32. At the command prompt, type diskpart and press ®. You may have to click Yes to allow 
access to the tool.

 How does the prompt change?

  _________________________________________________________________________________

33. Type help and press ®. Use the help command to determine which commands are available.

 Which command is used to make a new volume?

  _________________________________________________________________________________

 Which command can be used to assign a drive letter to a drive partition?

  _________________________________________________________________________________

34. Type create ? and press ®.

 Which two options can be used with create?

  _________________________________________________________________________________

  _________________________________________________________________________________

35. Type create partition ? and press ®.

 What types of partitions can be created?

  _________________________________________________________________________________

36. Press the  key once. The same command appears. Use the ∫ key and replace the ques-
tion mark with the word primary so the command reads create partition primary. Press 
®.

 What does the feedback say?

  _________________________________________________________________________________

 Based on what you see in Help, what command do you think would be used to select a drive?

  _________________________________________________________________________________

37. Type select disk x (where x is the disk number documented in step 21) and press ®. A 
prompt says the disk is selected.

38. Retype the create partition primary command or press the  key until that command 
appears. Press ®.

39. Look back to the Disk Management console and notice that the part of the drive previously marked as 
free space is now a partition.

40. At the command prompt, type detail disk and press ® to see the partition you just created.

 Based on the command output, what drive letters are currently used?

  _________________________________________________________________________________

41. At the command prompt, type assign and press ®.

 Look in the Disk Management console window to determine what drive letter was assigned. Write the 
drive letter.

  _________________________________________________________________________________

 What volume label, if any, was assigned?

  _________________________________________________________________________________

42. (Skip this step if on a Windows 7 computer.) On a Windows 8/10/11 machine, when you are 
prompted to apply high-level formatting to the drive, click Cancel and then OK.

43. On all versions of Windows computers, at the command prompt type exit and press ® to leave 
the diskpart utility.
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44. Type help at the command prompt and press ® to look for a command to help with the high-
level formatting of the drive. The commands scroll quickly, so type help | more and press ®. 
(The | keystroke is made by holding down the Í key and pressing the key above the ® 
key.) One page at a time is shown. Press the ∆ once to see the next page of commands.

45. The next step requires you to fill in the following parameters. Let’s review them here and then you 
must replace the italicized part of the command with values when you get to the section of this step 
that tells you to “Type the command…”:

 x:—The drive letter documented in step 41.

 /v:name—Where name is a unique volume name with up to 32 characters.

 /fs:ntfs—To tell the system to use the NTFS file system. (Other options could be /fs:fat, /
fs:fat32, or /fs:exfat, but this lab uses NTFS.)

 /q—To do a quick format.

 Type the command format x: /fs:ntfs /v:name /q and press ®. An example of this 
command is format x: /fs:ntfs /v:Goofy /q. Remember that x is the drive letter docu-
mented in step 41.

 Note: If you get a message saying that the arguments are not valid, you did not exit the diskpart 
utility and did not do steps 42, 43, and 45. Go back and do them. When asked to proceed, press y 
and then press ®.

46. View the results in the Disk Management console. The last partition should be a partition that has a 
drive letter, that has a volume name assigned, and that uses the NTFS file system.

47. Using whatever method you like, copy one file to each of the three partitions you have created. Call 
the instructor over and show the instructor the three files and the Disk Management console. Do not 
proceed unless you have completed these parameters.

Instructor initials: _____________

48. Close the command prompt window.

49. Starting with the partition on the far right in the Disk Management console for the newly installed 
drive, right-click each partition and delete each volume. Call the instructor over when the drive shows 
as one block (black bar across the top) of unpartitioned hard drive space.

Instructor initials: _____________

50. Shut down the computer. Remove the computer power cord. Remove the data cable from the newly 
installed hard drive. Remove the power cord from the newly installed hard drive (optional on the 
external drive). Remove the hard drive. If necessary, reinstall the optical drive, data cable, and power 
cord. Reinstall the computer cover and power cord.

51. Boot the computer. Open Windows Explorer (Windows 7)/File Explorer (Windows 8/10/11) and se-
lect Computer (Windows 7)/This PC (Windows 8/10/11). Ensure that the optical drive is recognized. 
If it is not, redo step 50.

52. Show the instructor the optical drive in the Windows Explorer/File Explorer window and give the 
hard drive and any cable back to the instructor/lab assistant.

Instructor initials: _____________
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Lab 7.5 Striping and Spanning Using Windows

Objective: To be able to configure and manage a striped volume or a spanned volume on a hard drive 
using the Windows Disk Management console

Parts: Windows computer

 Motherboard or adapter that supports RAID 0

 Two IDE PATA or SATA hard drives

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: Use proper antistatic and gentle handling procedures when dealing with hard drives.

 You must be a user who has administrator rights to configure hard drives.

 This lab assumes that you can install and configure two or more SATA or PATA hard drives 
so that they are recognized in the Disk Management console.

1. Power on the computer and log in. In File Explorer right-click My PC > Manage > select the Disk 
Management option. The two newly installed hard drives should be visible in the Disk Management 
console. Initialize the drives, if necessary, by right-clicking each one of them and selecting Initialize 
Disk.

 What disk numbers are assigned to the newly installed hard drives?

  _________________________________________________________________________________

2. Within the Disk Management console, right-click in the unallocated space of the newly installed drive 
with the lowest-numbered disk. Select New Spanned Volume. A wizard appears. Click Next.

3. In the Available pane, select the second drive number written as the answer in step 1 and click Add to 
move the drive to the Selected pane. At least two drives should be listed in the Selected pane. Click 
Next.

4. Select a drive letter to assign to the spanned volume. Click Next.

5. Select NTFS from the drop-down menu and add a volume label. Select (enable) the Perform a quick 
format checkbox. Click Next. Click Finish.

6. When a message appears to convert a basic disk to a dynamic disk, click Yes. Verify that the spanned 
volume appears.

 When using the Disk Management tool, how can you tell which two drives are a spanned volume?

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Show the instructor the spanned volume.

Instructor initials: _____________

8. Use Windows Explorer/File Explorer to view the drive letters assigned and the total capacity of each 
of the two drives.

 What drive letter was assigned to the spanned volume?

  _________________________________________________________________________________

 What is the total capacity of the spanned volume?

  _________________________________________________________________________________

 Which RAID level is spanning, if any?

  _________________________________________________________________________________
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9. In the Disk Management console, right-click in the newly created spanned volume space and select 
Shrink Volume. Select a smaller amount of space in the Enter the amount of space to shrink in MB 
textbox.

 How does the Disk Management tool change?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Show the instructor the shrunken volume.

Instructor initials: _____________

11. In the Disk Management console, right-click in the spanned volume and select Delete Volume. When 
asked if you are sure, click Yes.

12. To create a striped volume from within the Disk Management console, right-click the lowest-num-
bered disk of the two newly installed drives and select New Striped Volume > Next.

13. In the Available pane, select the second newly installed disk and click the Add button to move the 
drive to the Selected pane. Click Next.

14. Select a drive letter or leave the default. Click Next.

15. Leave the default system as NTFS and select (enable) the Perform a quick format checkbox. Click 
Next. Click Finish. Click Yes.

 How do the disks appear differently than the spanned volumes in the Disk Management console?

  _________________________________________________________________________________

16. Open Windows Explorer or File Explorer.

 How many drive letters are assigned to a RAID 0 configuration?

  _________________________________________________________________________________

17. Copy a file to the RAID 0 drive. Show the instructor the file and the Disk Management console.

Instructor initials: _____________

18. Right-click in the healthy volume space of either RAID 0 drive.

 Can a RAID 0 volume be shrunk? [Yes | No ]

19. Select the Delete Volume option. Click Yes. Show the instructor the unallocated space.

Instructor initials: _____________

20. Power down the computer, remove the power cord, and remove the two newly installed drives.

21. Power on the computer and, if necessary, return the BIOS/UEFI settings to the original configuration. 
Ensure that the computer boots normally. Show the instructor that the computer boots normally.

Instructor initials: _____________

Lab 7.6 Windows 8/10/11 Hard Disk Tools

Objective: To be able to use the tools provided with Windows 8 or 10 to manage the hard disk drive

Parts: Windows 8 or 10 computer and administrator rights

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: The defragmentation and error checking (Check Now) process can take more than 60 min-
utes on large hard drives.

1. Power on the computer and log on using a user ID and password that has administrator rights.

2. Open Windows File Explorer. Locate the C: drive in the left pane. You may have to expand This PC. 
Right-click on the C: drive and select Properties.

 On the General tab, what is the name of the volume?

  _________________________________________________________________________________
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 What is the drive capacity?

  _________________________________________________________________________________

 What does the option Allow files on this drive to have contents indexed in addition to file properties 
do?

  _________________________________________________________________________________

  _________________________________________________________________________________

3. Click Disk Cleanup. The Disk Cleanup window appears. Ensure that only the following checkboxes 
are checked (enabled) for purposes of this lab:

 Temporary Internet Files

 Recycle Bin

 Temporary Files

 Game Statistics Files (if available)

 Click the OK button. When prompted if you are sure, click the Delete Files button.

 What message, if any, is given to you at the end of the process?

  _________________________________________________________________________________

4. Access the Disk Cleanup window again. Select the Clean up system files option. The Disk Cleanup 
window appears, and the related file sections are automatically checked. Click any one of the options 
that has an enabled (checked) checkbox. Click on the option itself (not the checkbox). Click View 
Files.

 If no files appear, then you might be viewing an option that takes up no hard drive space. If you 
think this is the case, return to the View Files window, select another checked option, and click View 
Files again; or enable the viewing of files by clicking on the View menu option > Options down ar-
row > Change folder and search options > View tab > enable (click on) Show hidden files, folders, 
and drives > disable (ensure the option is unchecked) Hide protected operating system files (Recom-
mended) > Yes (to the warning prompt) > OK. The files that are to be deleted appear.

5. Close the window. Return to the Disk Cleanup window. Click OK to delete unused system files. Click 
Delete Files. When finished, access the Disk Cleanup window again by clicking on Disk Cleanup.

6. Select the More Options tab. You may have to click on the Clean up system files option again to 
access this tab.

 What are the two sections shown in the window that allow for more disk cleanup?

  _________________________________________________________________________________

 What do you think would be a disadvantage to using the Clean Up button for Programs and Features?

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Click Cancel. Click the Tools tab. Note that the Tools tab contains two tools: Error-checking and 
Optimize and Defragment Drive.

8. Click Check. Click Scan Drive.

 What message appears?

  _________________________________________________________________________________

  _________________________________________________________________________________

9. Click Close. Click on Optimize.

 What percentage of the C: drive is fragmented? ____%

  _________________________________________________________________________________

 Is scheduled optimization turned on or off so that drives are automatically optimized? [ On | Off ]
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10. Click on Analyze.

 Did the percentage of fragmented drive space change? [ Yes | No ]

11. Click on Optimize. Click on Close when the process is done.

 In the corporate environment, do you think that any of these processes are done on a regular basis? 
Explain your answer.

  _________________________________________________________________________________

  _________________________________________________________________________________

Lab 7.7 Windows 8/10/11 Storage Spaces

Objective: To be able to use the tools provided with Windows 8, 10, or 11 to manage the hard disk 
drive

Parts: Windows 8, 10, or 11 computer and administrator rights

 One or more of the following already installed and accessible through Windows Disk Man-
agement tool: internal hard drive, external hard drive, SSD, or SSHD

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on using a user ID and password that has administrator rights.

2. Access the Storage Spaces Control Panel.

3. Select the Create a new pool and storage space link > click Yes if asked permission to continue.

4. Enable (click in the checkbox to select) the drive(s) to be used > Create pool button.

5. In the resulting window, name the storage space, optionally select a drive letter and file system, and 
select the resiliency type.

 What resiliency types are available? (Choose all that apply.)

 [ simple | complex | extended | parity | no parity | two-way mirror | three-way mirror ]

 What resiliency type is the default?

 [ simple | complex | extended | parity | no parity | two-way mirror | three-way mirror ]

 What file systems are available?

  _________________________________________________________________________________

6. Select the pool size.

7. Select Create storage space. The storage space appears in File Explorer.

 Which drive letter did you choose?

  _________________________________________________________________________________

Instructor initials: _____________

8. To remove a storage space, access the Storage Spaces Control Panel again.

9. Locate Storage Spaces > Change settings > Delete pool link located on the right side > Delete stor-
age space button.





Video and Multimedia 
Devices Labs8

Lab 8.1 Managing Sound and Optical Drives in Windows

Objective:  To be able to use the tools provided with Windows to manage sound devices and optical media drives

Parts:  A computer with Windows 7 or higher loaded, with an optical drive installed, and that has internet access

Procedure: Complete the following procedure and answer the accompanying questions.

Note: Parts of this lab may be completed differently, depending on the hardware installed and the version of Windows 
installed.

1. Power on the computer and log in to Windows.

2. Access the Sound Control Panel.

 Which tabs are shown in the window?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Which device is the default playback device?

  _________________________________________________________________________________

3. With the default playback device selected, click the Configure button.

 Which audio channels are available?

  _________________________________________________________________________________

4. Click the Test button.

 What was the result?

  _________________________________________________________________________________

  _________________________________________________________________________________
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5. Click the Cancel button and ensure that the Playback tab is selected. Click Properties. The Speakers 
Properties window opens.

 What jack information is displayed?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Click Properties.

 What is the device status?

  _________________________________________________________________________________

7. Select the Driver tab.

 What is the driver version?

  _________________________________________________________________________________

 What is the purpose of the Roll Back Driver button?

  _________________________________________________________________________________

 Can the audio be disabled from this window?

  _________________________________________________________________________________

8. Click Cancel. On the Speakers Properties window, click the Advanced tab.

 How many bits are used for sampling?

  _________________________________________________________________________________

 What is the frequency response?

  _________________________________________________________________________________

9. Click Cancel. Select the Recording tab.

 What is the default recording device?

  _________________________________________________________________________________

10. Select the Sounds tab. In the Program (Windows 7)/Program Events (Windows 8/10/11) window, se-
lect any task that has a speaker icon to the left of it. Listening to these sounds is an easy way to check 
for issues without having to download a sound file. Click Test.

 Did sound emit? [ Yes | No ]

11. Select the Sound Scheme drop-down menu.

 What options are available?

  _________________________________________________________________________________

 What is the checkbox used for in this section?

  _________________________________________________________________________________

12. Click Cancel. Close the Control Panel window.

13. Open Windows Explorer (Windows 7)/File Explorer (Windows 8/10/11) and select Computer (Win-
dows 7)/This PC (Windows 8/10/11) from the left panel. In the right panel, right-click the optical 
drive. Notice the Eject option, which can be used to eject a stuck disc.

14. Point to the Share With option and select Advanced Sharing. The optical drive Properties window 
opens. The Sharing tab allows you to share a disc with others.
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15. If you closed the optical drive Properties window, go back into it and select the Hardware tab. In the 
All Disk Drives: window, select the optical drive. Click Properties.

 What is the device status?

  _________________________________________________________________________________

16. In the Properties window, select the DVD Region tab if a DVD drive is installed.

 What is the DVD region code? Write Not applicable as your answer if a CD drive is installed.

  _________________________________________________________________________________

  _________________________________________________________________________________

17.  Select the Driver tab.

 Which version of the driver is installed?

  _________________________________________________________________________________

 What is the date of the driver?

  _________________________________________________________________________________

18. Use the internet to determine whether a newer device driver is available. Show this driver to the in-
structor or lab assistant.

Instructor initials: _____________

19. In the device’s Properties window, click Cancel.

20. In the original optical drive Properties window, select the Customize tab.

 What types of things can be customized from this tab?

  _________________________________________________________________________________

  _________________________________________________________________________________

21. Click the Cancel button. Close the Windows Explorer (Windows 7)/File Explorer (Windows 8/10/11) 
window.

Lab 8.2 Installing an Optical Drive

Objective:  To install, configure, and test an optical drive

Parts:  A computer with Windows loaded

 An antistatic wrist strap or glove

 An optical drive with accompanying cable and mounting equipment, if necessary

Procedure: Complete the following procedure and answer the accompanying questions.

1. Obtain an optical drive designated by the instructor or student assistant.

 Which type of drive is this?  
[ CD-ROM | CD-R | CD-RW | DVD-R | DVD+R | DVD±RW | DVD-R DL | DVD+R DL | BD-R | 
BD-RE ]

 List the drive manufacturer and model number.

  _________________________________________________________________________________

 If possible, determine whether a driver is available and list the website on which you located this 
information.

  _________________________________________________________________________________

 Which type of interface does the optical drive use? [ PATA IDE | SATA | SCSI | Parallel | USB ]

2. Power off the computer, remove the power cord, open the computer, and determine whether a cable 
and interface are available to install the drive. If not, obtain them from the lab supplies area, instruc-
tor, or lab assistant.
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3. Configure the drive as necessary for the type of interface being used.

 Which drive settings did you select, if any?

  _________________________________________________________________________________

4. If appropriate, install the drive into the computer and attach power.

5. If an external device is being installed, a device driver may need to be installed at this point. Always 
refer to the device installation instructions. Whether the drive is internal or external, attach the correct 
interface cable to the drive.

6. Power on the computer, load a device driver (if necessary), and ensure that the operating system rec-
ognizes the drive. Troubleshoot as necessary until the drive works.

 Which tests did you perform to ensure that the drive works?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Tell the instructor when the drive is successfully installed.

Instructor initials: _____________

8. Remove the drive and reinstall the computer cover. Power on the computer and ensure that BIOS/
UEFI errors do not appear.

Instructor initials: _____________

Lab 8.3 Using DirectX for Diagnostics in Windows

Objective:  To be able to use the DirectX tool provided with Windows 7 or higher

Parts:  A computer with Windows 7, 8, or 10 loaded and with administrator rights and internet 
access

Procedure: Complete the following procedure and answer the accompanying questions.

Note: This lab may be completed differently depending on the equipment installed and the Win-
dows version and service pack.

1. Power on the computer and log in to Windows.

2. Click the Start button and in the Search Programs and Files textbox, type dxdiag, and press ® 
or select the dxdiag link. The DirectX tool may ask you if you want to check that the drivers are 
digitally signed and/or to allow an internet connection for an update. Click Yes.

 After the tool is shown and the System tab is displayed, which DirectX version is running?

  _________________________________________________________________________________

 How much RAM is installed in the computer?

  _________________________________________________________________________________

 What is the size of the page file?

  _________________________________________________________________________________

 How much of the page file is currently used?

  _________________________________________________________________________________

3. Click the Next Page button. The next tab displays.

 What notes, if any, appear on the tab?

  _________________________________________________________________________________

4. Ensure that you are on the Display tab.

 How much RAM is on the video adapter?

  _________________________________________________________________________________



 LAB 8: Video and Multimedia Devices Labs 63

LA
B 8

 Are any DirectX features enabled? If so, which ones?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Research the words RAM, video adapter, and DirectX on the internet to help with this answer and 
give a brief description of the features.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

5. Ensure that the Sound tab is selected.

 What is the device type used?

  _________________________________________________________________________________

 What is WDM, and what does it stand for? If you do not know, research it on the internet.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Which driver file is used?

  _________________________________________________________________________________

 What does the WHQL logo mean? If you do not know, research this term on the internet.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Click the Input tab.

 List any direct input devices displayed.

  _________________________________________________________________________________

7. Expand any USB devices in the Input Related Devices section.

 List any USB devices that are considered to be input devices.

  _________________________________________________________________________________

8. Close the DirectX Diagnostics window.

Lab 8.4 Installing a Sound Card and Speakers in Windows

Objective:  To install and configure a sound card

Parts: A computer with Windows 7 or higher loaded and an available expansion slot

 Sound card with drivers or internet access

 Optional audio disc

Procedure: Complete the following procedure and answer the accompanying questions.

1. Before powering on the computer, determine the current audio capabilities.

 How many sound ports are integrated into the motherboard?

  _________________________________________________________________________________

 Draw each port and state its purpose. If you do not know, use the internet to research the computer model.

  _________________________________________________________________________________

2. Connect power to the speakers and attach the speakers to the computer, if necessary.
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3. Power on the computer and log in to Windows. Access the Hardware and Sound section of the Con-
trol Panel. Select the Sound link.

 On the Playback tab, how many playback devices are listed?

  _________________________________________________________________________________

4. Right-click the icon that represents the enabled speaker(s) and select Properties.

 Which name is currently assigned to the output device?

  _________________________________________________________________________________

5. Click in the General Tab textbox and change the name to something more meaningful.

 List the name assigned.

  _________________________________________________________________________________

 Which output jacks are available for this output device?

  _________________________________________________________________________________

 What controller is controlling the speakers?

  _________________________________________________________________________________

6. Click the speaker controller Properties button.

 Which driver version is installed?

  _________________________________________________________________________________

7. Close the Properties window. Back in the Speakers Properties window, select the Levels tab.

 Which settings can you control on this tab?

  _________________________________________________________________________________

 The tabs that are available vary depending on the speakers installed. Which tabs are available for the 
speakers on your computer?

  _________________________________________________________________________________

8. Select the Advanced tab. Test the quality of the sound output by clicking the Test button. Troubleshoot 
the system if the speakers do not emit a sound.

 How many bits are used in converting analog sounds into digital audio?

  _________________________________________________________________________________

9. Select the Default Format drop-down menu. Note that this is the window where you allow applica-
tions to control or change the speaker settings.

 List two other available formats, if possible.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Click Cancel twice to close the Speaker Properties windows. Power off the computer.

11. Power on the computer and enter the BIOS/UEFI Setup program.

 Which key or process did you use to enter Setup?

  _________________________________________________________________________________

12. Locate and disable the integrated sound ports. Save the settings and exit BIOS/UEFI Setup.

13. Log in to Windows.

14. Using any method you would like, ensure that the speakers do not emit sound.

 Which method did you use?

  _________________________________________________________________________________

15. Shut down the computer and remove the power cord.
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16. Access the computer expansion slots and, if necessary, remove any slot covers or retention bars.

17. Install the sound adapter into an empty expansion slot and ensure it fits snugly into the slot. Reinstall 
any retention bar as necessary.

18. Attach the power cord and power on the computer. The computer should detect that a new device 
has been installed. You may be prompted for a device driver and to restart the computer in order to 
use the new adapter. If you don’t have a device driver, go to a computer that has internet access and 
download the appropriate driver for the sound card you installed. Note that you may have to power 
down the computer and look at the sound card (and possibly remove it) in order to get the appropriate 
model required to download the correct driver.

19. Attach the speakers to the appropriate ports on the newly installed sound card.

20. Using any method, including previously demonstrated methods or by playing an audio disc, test the 
new sound card.

21. Access Device Manager and expand the Sound, Video and Game Controllers section.

22. Right-click the newly installed sound card and select Properties.

 Which I/O address does the adapter use?

  _________________________________________________________________________________

 What is the device status?

  _________________________________________________________________________________

Instructor initials: _____________

23. Power down the computer and remove the power cord.

24. Unplug the speakers from the sound card. Remove the sound card and attach any slot covers.

25. Power on the computer and access BIOS/UEFI Setup.

26. Enable the integrated sound ports and save the settings.

27. Attach the speakers to the motherboard speaker port.

28. Attach the power cord. Boot the computer and log in to Windows again. Test the speakers.

29. Return all parts to the proper location.

Lab 8.5 Installing a USB Scanner

Objective: To be able to install a USB scanner and driver on a Windows-based computer

Parts: USB scanner, USB cable, scanner driver, scanner software/utilities, computer with Win-
dows loaded

Procedure: The procedures outlined below are guidelines. Refer to the scanner’s installation instruc-
tions for exact procedures.

Installing the Scanner Driver

1. Insert the scanner driver media into the drive. Sometimes you must also select which type of inter-
face connection is going to be used. If this is the case, select USB. The software installer sometimes 
includes additional software programs that can be used to control the scanner and to manipulate 
scanned images. Many drivers require the computer to be restarted when the installation process is 
complete.

Connecting the Scanner

2. A scanner may ship with a carriage safety lock. If this is the case, remove the safety lock.

3. With the computer powered on, connect one end of the USB cable to the scanner’s USB port and at-
tach the other end to a USB computer port or a USB hub port.

4. If necessary, attach the power cable to the scanner. Attach the other power cable end to an electrical 
outlet.

5. Power on the scanner.
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6. Optionally, if the scanner has a calibrate routine, execute it.

Using the Scanner

7. If the scanner software program(s) did not install during driver installation, install the scanner soft-
ware program(s) now.

8. Insert a document to be scanned.

9. Access the scanner software program by clicking the Start button and scan the document.

Instructor initials: _____________

Lab 8.6 Changing the Drive Letter of an Optical Drive by Using Disk Man-
agement and the diskpart Utility

Objective:  To reassign the optical drive letter

Parts:  Windows computer with administrator rights

Procedure: Complete the following procedure and answer the accompanying questions.

1. Using Windows/File Explorer, determine the current optical drive letter.

 What drive letter is being used by the optical drive?

  _________________________________________________________________________________

2. In Windows 7, from the Start button menu in the Search Program and Files textbox, type Disk 
Management and press ®. In Windows 8/10/11, open the Disk Management tool.

3. Locate the optical drive in the bottom half of the Disk Management window. Note that you may have 
to scroll to the bottom of the drives in the lower half of the screen.

4. Right-click or tap and briefly hold the drive icon in the left side of the panel where the drive letter is 
located and select Change Drive Letter and Paths.

5. Select Change and use the Assign the following drive letter: drop-down menu to select a different 
drive letter.

 What drive letter did you choose?

  _________________________________________________________________________________

6. Click OK and click Yes to the notification that some programs might not work properly.

7. At a command prompt, type diskpart and press ®. Type list volume and press ®. 
Look down the Type column for an optical drive and locate the drive to be changed. Ensure that the 
drive letter in the Ltr column is the same drive letter written down in step 5.

 Write the volume number that is listed in the same row as the optical drive.

  _________________________________________________________________________________

8. At a command prompt, type select volume x (where x is the number you wrote in step 7). A message 
appears, stating that the volume is selected. If the message does not appear, recheck your steps, start-
ing from the beginning of the lab.

9. Type assign letter=x (where x is the newly assigned drive letter). A message appears, stating 
that the drive letter assignment was successful. If this message does not appear, redo the exercise.

10. Use Windows Explorer (Windows 7)/File Explorer (Windows 8, 10, or 11) to verify the reassignment, 
refreshing the screen if necessary. Show the instructor or lab assistant your reassigned drive letter.

Instructor initials: _____________

11. In the diskpart utility or the Disk Management window, return the drive to the original drive let-
ter. Refer to the answer to the question in step 1 if you do not remember the original drive letter. Use 
Windows Explorer/File Explorer to show the instructor or lab assistant that the drive letter has been 
reassigned.

Instructor initials: _____________
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Lab 9.1 Installing a Generic/Text-Only Print Driver on a Windows 7, 10, or 11 Computer

Objective: To install a generic print driver on a Windows computer and examine printer properties

Parts: Computer with Windows 7, 10, or 11 installed

Procedure:  Complete the following procedure and answer the accompanying questions.

Notes: A printer is not required to be attached to the computer for this lab to be executed.

 In order to install a printer, you must have the specific permission to install a printer and install a device driver.

1. Power on the computer and log on using the user ID and password provided by the instructor or lab assistant.

 Is a printer attached to the PC? If so, does it attach wirelessly or using the USB port?

  _________________________________________________________________________________

2. In Windows 7: Click the Start button > Control Panel > Hardware and Sound > Devices and Printers > Add a Printer link > Add 
a Local Printer > ensure that the Use an Existing Port radio button is selected and the LPT1: (Printer Port) option is selected 
(even if a printer attaches to the PC already; you will not be printing from this print driver) > Next > in the Manufacturer column, 
select Generic > in the Printers column, select Generic/Text Only > Next > in the Printer name textbox, type Class Printer > 
Next > ensure that the Do Not Share This Printer radio button is enabled > Next > ensure that the Set as the Default Printer check-
box is unchecked > Finish.

 In Windows 10/11: Search for printers and select Printers and scanners from the resulting list > Add a printer or scanner link 
> when the system starts searching for printers, The printer that I want isn’t listed link > enable (select) the radio button for Add 
a local printer or network printer with manual settings > Next > if on a higher version of Windows, you should select the Do not 
share this printer radio button > ensure that the Use an existing port radio button is selected and the LPT1: (Printer Port) option is 
selected (even if a printer attaches to the PC already; you will not be printing from this print driver) > Next > in the Manufacturer 
column, select Generic > in the Printers column, select Generic/Text Only > Next > in the Printer Name textbox, type Class 
Printer > Next > ensure the Set as the Default Printer checkbox is unchecked > Finish.
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3. From the Devices and Printers section of the Control Panel > right-click the Class Printer icon > 
Properties.

 Which tabs are available with the generic print driver?

  _________________________________________________________________________________

4. Click OK > right-click the Class Printer icon > Printer properties.

 Which tabs are available through this option?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Use Lab Table 9.1 to list what is important about each tab or why a technician might use the tab.

LAB TABLE 9.1 Generic printer Properties window tabs

Tab Notes

General

Sharing

Ports

Advanced

Color 
Management

Security

Device Settings

Printer 
Commands

Font Selection

 On the Ports tab, what do you think printer pooling is?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Which button on the General tab do you think would be useful to a technician when troubleshooting a 
printing problem?

  _________________________________________________________________________________

Instructor initials: _____________

5. Close the window. Right-click on Class Printer and select Printing Preferences. In the Orientation 
section, select the Landscape option.

 How does this change printing?

  _________________________________________________________________________________

6. Select the Paper/Quality tab. Click the Paper Source drop-down menu.

 Which options are available, even with a generic print driver?

  _________________________________________________________________________________

Instructor initials: _____________
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7. Select the Advanced button.

 List three paper size options.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

8. Click Cancel; click Cancel again. Then access the Printer Properties window.

9. Click the Ports tab. Notice that LPT1 is checked. If you made a mistake during installation and se-
lected the wrong port, you can change it here. Notice that File: and XPS are options.

10. Access the Advanced tab. Select the Printing Defaults button. Through this option, you can select the 
default quality and orientation the printer uses to print. Users must change the settings if they want 
something other than this. Click Cancel. Click the Separator Page button.

 What is the purpose of a separator page?

  _________________________________________________________________________________

  _________________________________________________________________________________

11. Click Cancel. Click OK.

12. To rename the Class Printer driver, right-click on Class Printer in the Control Panel > Printer Proper-
ties. On the General tab, change the name of the printer in the first textbox to IT Printer > OK.

13. To delete the IT Printer, right-click on IT Printer > Remove Device > Yes.

Lab 9.2 Installing a Local Printer on a Windows 7, 8, 10, or 11 Computer

Objective: To install a local printer on a Windows 7, 8, or 10 computer

Parts: A computer with Windows 7, 8, or 10 installed and a printer physically attached to an LPT, 
COM, or USB port

 An appropriate printer driver for the operating system (with internet connectivity or a 
printer driver provided)

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: Refer to the printer installation guide when installing a new printer. A printer may have its 
own CD and installation wizard that installs the driver and software.

 In order to install a printer, you must log on as an administrator (or use a user ID that 
belongs to the Administrators group).

1. Power on the computer and log on using the user ID and password provided by the instructor or lab 
assistant.

2. Use the internet to research and download the printer driver appropriate for the printer and operating 
system version installed. Otherwise, use the driver provided by the instructor or lab assistant.

 Which version of the printer driver did you download or do you have?

  _________________________________________________________________________________

3. Attach the printer cable to the correct computer port. Attach the power cord to the printer, if neces-
sary, and insert the other end into a wall outlet. Power on the printer.

4. Windows normally detects a plug-and-play printer and may complete all the installation steps 
automatically.

 Does Windows automatically detect and install the printer?

  _________________________________________________________________________________

5. If Windows cannot find the driver, browse for a printer driver when you are prompted to do so.
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6. When the driver is installed, print a test page to ensure communication between the computer and the 
printer.

 Did the printer print correctly? If not, delete the printer and complete the installation again.

  _________________________________________________________________________________

Instructor initials: _____________

Lab 9.3 Exploring a Windows 7, 8, or 10 Printer

Objective: To explore printer options available through Windows 7, 8, or 10

Parts: A computer with Windows 7, 8, or 10 installed and an installed printer

 Optionally, access to the internet for researching the latest printer driver

Procedure: Complete the following procedure and answer the accompanying questions.

Note: This process depends on the printer manufacturer. You may need to modify the initial steps 
to find the details for the specific printer.

1. Power on the computer and log in to Windows.

2. Access the Devices and Printers section of the Control Panel or the Printers & scanners Settings op-
tion. Right-click on the installed printer and select Printing Preferences.

 What is the default print quality mode for this printer?

  _________________________________________________________________________________

 Is this the most cost-efficient mode available? If not, what is?

  _________________________________________________________________________________

3. Using various options or links, answer the following questions.

 a.  List one instance in which a technician might use the Pause Printing option. If you do not know 
for sure, research the answer on the internet.

  _________________________________________________________________________________

  _________________________________________________________________________________

 b. List the steps necessary to share this printer with other computers.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 c. Which printer option would you use to see how many documents have been sent to the printer?

  _________________________________________________________________________________

 d. List information that might be important for business documentation purposes.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 e. What information is provided for troubleshooting printing problems?

  _________________________________________________________________________________

 f.  To what port does the printer attach?

  _________________________________________________________________________________

 g. Which print spooler option is used?

  _________________________________________________________________________________
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 h. Which security options are currently used?

  _________________________________________________________________________________

 i.  If the printer is shared, does the printer have the option to render print jobs on client computers?

  _________________________________________________________________________________

Instructor initials: _____________

4. Close any open windows.

Lab 9.4 Exploring a Windows 11 Printer

Objective: To explore printer options available through Windows 11

Parts: A computer with Windows 11 installed and an installed printer

 Optionally, access to the internet for researching the latest printer driver

Procedure: Complete the following procedure and answer the accompanying questions.

Note: This process depends on the printer manufacturer. You may need to modify the initial steps 
to find the details for the specific printer.

1. Power on the computer and log in to Windows.

2. Access Settings > Bluetooth & devices > Printers & scanners > select a printer. The printer settings 
options display.

3. Open the print queue. Even though there are no documents, the printer can be controlled as in previ-
ous versions of Windows.

4. Access the Printer menu ribbon option. Notice that you can set a printer to the default printer using 
this menu item.

 List three other options that are available.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Based on the information you learned in the chapter, what is the purpose of the Sharing… option?

  _________________________________________________________________________________

  _________________________________________________________________________________

5. Explore the Printing Preferences and Properties options, if available.

 Describe the difference between the settings that can be changed through the Printing Preferences 
option and the Properties option. If one of them is not available, state which one and just describe the 
option that is available.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 When the print queue window is open, which menu item would you use to pause printing?  
[ Printer | Document | View ]

 When the print queue window is open, which menu item would you use to select and continue print-
ing a document after a paper jam is cleared?  
[ Printer | Document | View ]

 When the print queue window is open, which menu item would you use if a new print job comes into 
the queue? [ Printer | Document | View ]

 When the print queue window is open, which menu item would you use to cancel all print jobs?  
[ Printer | Document | View ]
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 When the print queue window is open, which menu item would you use to select and cancel a par-
ticular document that has a lot of pages that the user sent by mistake? [ Printer | Document | View ]

6. Use the Print test page option to test the printer.

 Did a document print? If so, describe the information found on the test page. If it didn’t print, de-
scribe why you think the test page did not output.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Select the Run the troubleshooter option. Select the View detailed information link.

 List at least three potential issues that were checked.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

8. Access the Printer properties > General tab.

 Which button do you think a technician would use if there were a paper jam on the final page of a 
multipage print job and there were no more pages to come through?

  _________________________________________________________________________________

Instructor initials: _____________

9. Select the Hardware properties option > General tab for the particular printer being used.

 What is the device status?

  _________________________________________________________________________________

Instructor initials: _____________

10. Close all Printer settings/Settings windows.
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Lab 10.1 Backing Up an iOS Device to a PC or Mac by Using iTunes

Objective:  To be able to use the iTunes application to back up the operating system and settings on an iOS device

Parts: An iOS-based device

 A PC or Mac computer

 A USB cable to connect the iOS device to the PC or Mac

 An Apple ID and password

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the PC or Mac and the iOS device. Log in as required.

2. Ensure that the PC or Mac has iTunes installed. If the application is not installed, download and install it. Open iTunes.

3. Attach the USB cable from the iOS device to the computer.

4. On the Mac or PC, the iOS device should display, or you can choose it from the top left, where the music notes icon is located. 
Note that you may have to click Continue > Get Started if this device has never been connected before.

 What iOS version does iTunes show is on the iOS device?

  _________________________________________________________________________________

 What is the iOS serial number shown in iTunes?

  _________________________________________________________________________________

5.  In the Backups section, select the This Computer radio button.

 Looking at the screen, does this Mac or PC have the ability to encrypt the backup file where the backup is to be stored?  
[ Yes | No ]

 How do you know?

  _________________________________________________________________________________



74 Complete A+ Guide to IT Hardware and Software

6. Click the Back Up Now button.

 What information displays under the Latest Backup section?

  _________________________________________________________________________________

 What option on the screen would you use if you needed to reinstall the iOS operating system?

  _________________________________________________________________________________

Lab 10.2 Determining Memory Resources in an iOS-Based Device

Objective:  To be able to use the Apple iOS operating system to determine the amount of memory

Parts: An Apple iPhone or iPad

Procedure: Complete the following procedure and answer the accompanying questions.

1. Ensure that the Apple device is powered on.

2. Access the Home screen (by pressing the Home screen button or swiping up from the bottom). Tap 
the Settings option. Note that you may have to swipe your finger to access the Settings option if mul-
tiple pages of icons are present.

3. Tap the General option. Tap the About option. Locate the Capacity option, which shows the total 
amount of memory installed.

 How much memory is available on the device?

  _________________________________________________________________________________

4. Locate the Available option, which shows the amount of memory that is not being used.

 How much memory is free?

  _________________________________________________________________________________

5. Return to the Home screen.

Lab 10.3 Determining Memory Resources in an Android-Based Device

Objective:  To be able to use the Android operating system to determine the amount of memory

Parts: An Android-based device

Procedure: Complete the following procedure and answer the accompanying questions.

Note: The Android operating system is an open source operating system. Options vary from 
device to device, but most configuration options are similar.

1. Ensure that the Android device is powered on.

2. Access the Home screen by tapping the Home icon. Tap the Settings option. Note that you may have 
to swipe your finger to access the Settings option if multiple pages of icons are present.

3. Tap the Storage option. Locate the total amount of storage.

 How much memory is available on the device?

  _________________________________________________________________________________

4. Locate how much memory is available (that is, not being used).

 How much memory is free?

  _________________________________________________________________________________

 How much memory is being used by applications?

  _________________________________________________________________________________

 Does this device have external storage? If so, how can you tell?

  _________________________________________________________________________________

5. Return to the Home screen.
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Lab 10.4 Managing Files on a Mobile Device

Objective:  To be able to copy files or send files using an Android or Apple iOS-based device

Parts:  Android device or Apple iOS device

Procedure: Complete the following procedure and answer the accompanying questions.

Android

1. If working on an Apple device, please go to step 16. Power on the Android device.

2. Access the Camera app by touching the Camera icon on the Home screen.

3. Normally in the Camera app, there is an icon of a camera or a circle that you touch to take the pic-
ture. Take a picture. You may hear a camera shutter sound effect.

4. Return to the Home screen by touching the Home icon. If the Home icon is not showing, touch the 
screen where it normally appears (bottom left, center icon).

5. Locate and tap the File Manager app.

6. Unless the settings have been changed, most photos are stored by default on internal storage. Tap the 
Internal Storage option. The internal storage folders are listed to the right.

7. Locate and tap the DCIM folder.

8. Locate and open the Camera folder.

9. To open a picture, touch the filename. Frequently there are options such as rotating or cropping the 
photo found by touching just outside the photograph.

  What photo options are available?

  _________________________________________________________________________________

10. Return to the file listing by using the Return button (the button on the screen that is a return ar-
row that looks like this: ). If the Return button is not shown, you can touch the bottom left of the 
screen, and the Return arrow should appear.

11. Enable the checkbox next to the name of the photograph by touching the checkbox.

12. Options either appear or you can touch an icon normally located in the upper-right or upper-left cor-
ner to allow options to appear. Locate the options that include the copy function.

13. Go to another folder located in your internal storage. Select the Paste option.

Instructor initials: _____________

14. Delete the original and copied photographs.

Instructor initials: _____________

15. Power off the device.

Apple

16. If working on an Android device, please go to step 1. Power on the Apple device.

17. Access the Camera app by tapping the Camera icon on the Home screen.

18. Tap the icon of the camera to take the picture. Take a picture. You may hear a camera shutter sound 
effect.

19. Notice that a small image of the photograph is available in the lower-left corner. Tap the graphic of 
the photo. Note that you can also access the photograph by using the Photos home screen icon.

20. Options are available in the top-right corner. If these options have disappeared, just tap the photo.

  Describe three options available at the top of a photograph.

  _________________________________________________________________________________

  _________________________________________________________________________________
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21. Select the option that has a box with an arrow in it. Select Email Photo.

22. In the To: textbox, type a valid email address such as your own by tapping inside the blank space to 
the right of To:. See the instructor if you don’t know of an email address to use.

 What email address did you use?

  _________________________________________________________________________________

23. In the Subject textbox, type Class Photo. Notice that the photo is already attached to the email.

24. Tap the Send button in the top-right corner of the email.

25. Take another photograph.

26. Either using the Camera app or the Photos app, locate the original photograph.

27. Tap the photo to bring up the options in the right corner if they are not showing. Select the Slideshow 
icon.

28. Select a type of transition by tapping the Transitions option.

 What transition did you choose?

  _________________________________________________________________________________

29. Select Start Slideshow. Stop the slideshow by tapping on the screen.

Instructor initials: _____________

30. Delete the two photographs.

Instructor initials: _____________

31. Power off the device.

Lab 10.5 Connecting a Mobile Device to a Wi-Fi Network

Objective:  To be able to connect an Android or Apple iOS-based device to an IEEE 802.11 Wi-Fi 
network

Parts:  Android device or Apple iOS device

Procedure: Complete the following procedure and answer the accompanying questions.

Note: Android is an open source operating system. The operating system may be modified by the 
vendor. Android simulators are available for free and can be used for the Android portion 
of this lab.

Android

1. If working on an Apple device, please go to step 7. Power on the Android device.

2. Access the Home screen by pressing the Home button. Locate the Settings option by swiping, if 
necessary.

3. Tap the Settings option > optionally Wireless and Network > Wi-Fi/Wi-Fi Settings.

4. Tap the Wi-Fi network you want to join. Enter the security credentials if needed > Connect. Note that 
if the Wi-Fi network is not shown because the wireless access point is not broadcasting the SSID (see 
Chapter 14, “Introduction to Operating Systems,” for more information), you can tap the Add Wi-Fi 
Network option at the bottom of the page and enter the relevant SSID and security credentials.

5. Verify that the wireless symbol appears at the top of the mobile device.

6. To disconnect from the network, tap the connected network > Forget.

Apple

7. If working on an Android device, please go to step 1. Power on the Apple device.

8. Access the Home screen by pressing the Home button or swiping up from the bottom. Locate the Set-
tings option by swiping, if necessary.
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9. Tap the Settings option > Wi-Fi. Ensure that Wi-Fi is enabled by tapping the button to the far right of 
the option to the enabled (right) side.

10. Tap the Wi-Fi network you want to join. Enter the security credentials if needed > Join. Note that if 
the Wi-Fi network is not shown because the wireless access point is not broadcasting the SSID (see 
Chapter 13, “Networking” for more information), you can tap the Other option at the bottom of the 
page and enter the relevant SSID and security credentials.

11. Verify the wireless symbol appears at the top of the mobile device.

12. To disconnect from the network, tap the connected network > Forget This Network.





Computer Design and 
Troubleshooting Review Labs11

Lab 11.1 Approaching Troubleshooting Logically

Objective:  To use logic to solve a computer problem

Parts:  Computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. In teams of two, one person leaves the room, while the other person inserts a problem in the machine and powers it down.

2. The person who left the room powers on the computer with the problem and performs troubleshooting. Use the flowchart shown 
in Lab Figure 11.1 and answer the questions that follow. When the problem is solved, swap roles.
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LAB FIGURE 11.1 Lab troubleshooting flowchart

 Do you hear any audio clues? If yes, list the symptoms.

  _________________________________________________________________________________

 Do any POST errors appear? If so, list them.

  _________________________________________________________________________________

 Are there any startup errors? If so, list them.

  _________________________________________________________________________________

 Are there any application-specific problems? If so, list them.

  _________________________________________________________________________________

 List any possible techniques to test. Test them one at a time. Document the solution.

  _________________________________________________________________________________
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Lab 11.2 Designing a Computer Subsystem

Objective:  To design an upgrade for a particular subsystem

Parts:  Computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Look at a particular computer within the classroom or that you have seen in your own home or a 
friend’s home. Think of the computer in terms of one of the following subsystems. Note that the in-
structor may assign a particular subsystem.

 > Motherboard and case

 > Power supply and case

 > Storage

 > Audio

 > Display

 Can the subsystem be upgraded? Why or why not? [ Yes | No ]

  _________________________________________________________________________________

 Is the system a proprietary one? In other words, are you limited in your upgrade options because the 
system is sold by a particular manufacturer? [ Yes | No ] Describe the limitations, if any.

  _________________________________________________________________________________

2. Before you design an upgrade for that particular subsystem, remove the parts for the subsystem in 
order to see the particulars about the parts. Document your findings.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

3. Design an upgrade for the subsystem. Write a proposal for a prospective customer on what the parts 
would cost and what you would charge them to upgrade the chosen or assigned subsystem.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

4. In three or more complete sentences, describe the challenges associated with designing for a particu-
lar subsystem rather than designing an entire computer system that serves a specific purpose.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________





Internet Connectivity, 
Virtualization, and Cloud 
Technologies Labs12

Lab 12.1 Installing and Configuring the Mozilla Firefox Browser

Objective: To be able to download, install, and configure Firefox

Parts: A computer with Windows installed

 Administrative privileges to install and configure software

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on using the user ID and password provided by the instructor or lab assistant.

2. Open a web browser and go to mozilla.org.

3. From the Firefox Browsers menu ribbon option, select the appropriate environment you are using. Ask the instructor or lab assis-
tant if unsure.

4. Click the Download Firefox button. For the purpose of this lab, select the option to just download the browser.

5. Click the Save File button and note the location where the file is saved. If you are using the Chrome browser, if the file appears at 
the bottom, you can click on the arrow and select Show in folder. If you are using Microsoft Edge, you can click on the three dots 
in the right corner and select Downloads and click on the folder to see where the Firefox installer.exe file was downloaded.

 To what folder/location was the executable file for the Firefox browser downloaded?

  _________________________________________________________________________________

6. Click on the Firefox browser .exe downloaded file. If you see a prompt that you are trying to install an app that is not Microsoft 
verified, click Install anyway. You may have to provide credentials for a user ID that has administrator rights or select the ID you 
used to log in if you have the proper rights. Click OK. If asked if you want to make changes to this device, select Yes.

7. Enter comptia.org into the address textbox at the top of the browser and press Enter. Scroll up and down the page until you get 
a pop-up. Then close the tab by clicking on the x in the tab for CompTIA (not the entire browser). 

8. Click the Open Application Menu (three horizontal lines) icon in the upper-right corner > Settings.

 In the Browser Privacy section, what is the current setting for privacy?  
[ Standard | Strict | Custom ]
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9. Locate the Cookies and Site Data section.

 List one instance where you think the Delete cookies and site data when Firefox is closed option 
would be a good option for a technician to select for a user?

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Click the Clear Data button.

 What type of data will be cleared by default? (Choose all that apply.)  
[ cached web content | cookies and site data | downloaded data | recorded data | spam ]

 What is the total amount of hard drive space saved by deleting this data?

  _________________________________________________________________________________

11. Click Clear.

 Based on the feedback given, what is a drawback to clearing all the data?

  _________________________________________________________________________________

12. Click Clear Now.

 Look at the various settings to determine if, by default, Firefox automatically autofills credit card in-
formation. Does Firefox autofill credit card information by default? [ Yes | No ]

13. Go to the Settings > History section and click the Clear History button.

 List three types of browser history.

  _________________________________________________________________________________

  _________________________________________________________________________________

 What type of data history could be removed?

  _________________________________________________________________________________

 Which time ranges are available from the drop-down menu? (Choose all that apply.)

 a. Last 30 minutes

 b.  Last hour

 c. Last two hours

 d. Last four hours

 e. Last eight hours

 f.  Last twelve hours

 g.  Today

 h. Today and yesterday

 i.  Everything

14. Select one of the time ranges and click OK.

15. In the Settings > Permissions area, locate the Block pop-up windows checkbox.

 Is the option enabled or disabled by default? [ Enabled | Disabled ]

16. Click the Exceptions button to the right.

17. In the address of website textbox, enter the URL of your school. If you don’t know your school’s web 
address, enter fscj.edu. Click the Allow button, and the website appears in the window below. 
This is how you configure a website to legitimately allow pop-up information and windows to appear. 
Click the Save changes button.

Instructor initials: _____________
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18. Notice in the Permissions section there is an option to warn the user if a website tries to install an 
add-on. This is a good security option to enable. Scroll down to the Security section.

 What two options related to deceptive and dangerous content are enabled by default? (Choose two.)

 a. Provide information when dangerous content is shown

 b.  Block dangerous downloads

 c. Block all advertisers

 d. Block known phishers

 e. Warn you about unwanted and uncommon software

19. In the Certificates section, click the View Certificate button. Because you have not gone to many 
websites yet, you might not have any listed.

20. Select the Authorities menu ribbon option. You can scroll through the certificate authorities that are 
prepopulated.

Instructor initials: _____________

21. Close the certificate manager window.

22. Select the General settings option on the left menu. Scroll to the Files and Applications section. As a 
technician, you might be asked by the user to always put the files in the Downloads folder or another 
folder of the user’s choosing. The other option they might want is to be asked where the downloaded 
file goes.

 What is the default option for file downloads?  
[ Save files to Downloads | Always ask you where to save files ]

23. Scroll down to the Applications section.

 What is the default action taken for PDF files?  
[ Open in Acrobat Reader | Open in Firefox | Open in Edge | Open in Word]

24. Select either Use other and select Adobe Acrobat or if Use other is not available, leave the default 
value.

25. Close the Settings tab by clicking on the x in the upper-right corner of the tab (not the x that closes 
the browser). Open a new tab by clicking the plus sign (+) at the top of the browser window.

26. Enter azureforeducation.microsoft.com into the browser address textbox. This is a web-
site for free Microsoft operating system and application downloads for students. Notice the https 
at the beginning of the address once the page loads; this indicates that the site is using more security 
than a normal website.

27. Select on the lock to the left of the address > Connection secure > More information. Ensure that the 
Security menu ribbon option is selected.

 What is the total amount of hard drive space on the computer that is being used by this website?

  _________________________________________________________________________________

 Based on the information shown in the window, was the page encrypted?  
[ Yes | No ]

 Based on the information shown in the window, when does this certificate expire?

  _________________________________________________________________________________

  _________________________________________________________________________________

28. Click the View Certificate button. Scroll through the information to see the type of information that is 
included in order to validate that this information is from a legitimate source.

Instructor initials: _____________

29. Close the certificate window.
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30. Select the Open Application Menu (three horizontal lines icon in the upper-right corner) icon > New 
private window.

 What visual indication(s) do you have that you are using private browsing?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Based on information from the chapter or from information that Firefox provides, what is a benefit of 
using a private window?

  _________________________________________________________________________________

Instructor initials: _____________

31. Select the Open Application Menu (three horizontal lines) icon in the upper-right corner > Settings > 
Extensions & Themes > Extensions.

 Based on your chapter reading, what is the purpose of a browser extension?

  _________________________________________________________________________________

  _________________________________________________________________________________

 List up to three extensions that are currently installed.

  _________________________________________________________________________________

 List up to three extensions that are recommended for you.

  _________________________________________________________________________________

  _________________________________________________________________________________

32. Select the Plugins option.

  List any plug-in that is installed. Enter none if there are no plug-ins.

  _________________________________________________________________________________

33. Close all browser tabs.

34. Check with the instructor about whether the Firefox browser is to be uninstalled and uninstall it if 
needed.

Lab 12.2 Getting to Know the Internet Options Control Panel

Objective: To become familiar with basic Internet Options Control Panel

Parts: Windows computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and ensure that it boots properly.

2. Open the Internet Options Control Panel.

 What tabs are available with this Control Panel? (Choose all that apply.)

 [ General | Home | Security | Policy | Privacy | Certificates | Content | Connections | Internet | 
Programs | Advanced ]

 While looking at the General tab, which URL is listed as the home page?

  _________________________________________________________________________________

 Is the Delete browsing history on exit option enabled or disabled?

 [ Enabled | Disabled ]

  _________________________________________________________________________________

 Which startup radio button is enabled? [ Start with tabs from the last session | Start with home page ]
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 List one corporate scenario for which you think the business security policy would require the Delete 
browsing history on exit option be enabled.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

3. Click the Settings button in the Browsing history section.

 How often does the browser check to see if there is a newer version of a web page?

  _________________________________________________________________________________

 Which drive currently holds temporary internet files?

  _________________________________________________________________________________

 If the drive that currently holds temporary internet files is an SSD, would it be better to change this to 
a different folder? Why or why not?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

4. Access the History tab from within the Website Data Settings window.

 What is the number of days the web browsing history is kept?

  _________________________________________________________________________________

5. Access the Caches and databases tab from within the Website Data Settings window.

 How much drive space can be used before the user is notified that a website cache or database ex-
ceeds that amount?

  _________________________________________________________________________________

6. Click the Cancel button to close the Website Data Settings window. Click the Tabs button in the Tabs 
section.

 [ T | F ] To enable tabbed browsing when it has been disabled, you must close all Internet Explorer 
windows and then reopen Internet Explorer to activate the change.

 Based on the configured options, what currently happens when a new tab is opened?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Based on the information in the Tabbed Browsing Settings window, what do you think would be the 
most secure pop-up setting for a corporate environment, and why do you think this?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 From the choices provided, what is your favorite way of handling program links provided in a 
website?

  _________________________________________________________________________________

  _________________________________________________________________________________
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7. Click Cancel. Click the Colors button located in the Appearance section.

 Is the Use Windows colors option enabled or disabled? [ Enabled | Disabled ]

8. Disable the Use Windows Colors option. Select the Use Hover Color option.

 Based on what you see as the default settings, which option might you change for a person who is 
red/green colorblind?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What color is the default hover color?

  _________________________________________________________________________________

  _________________________________________________________________________________

9. Click Cancel. Click the Languages button.

 What two prefix and suffix options are available? (Choose two.)

 [ Do not add ‘www’ to the beginning of typed web addresses | Use English as the default language |

 Do not default to the home page | Specify the suffix that should be added to typed web addresses 
when you press Ctrl + Shift + Enter ]

10. Click Cancel. Click the Fonts button.

 What is the current font setting for web pages?

  _________________________________________________________________________________

  _________________________________________________________________________________

11. Click Cancel. Click the Accessibility button.

 List one example of when you might use the formatting options presented in a home computer 
environment.

  _________________________________________________________________________________

  _________________________________________________________________________________

12. Click Cancel twice and close the Internet Properties window.

Lab 12.3 Getting to Know Microsoft Edge Browser Configuration

Objective: To become familiar with basic Microsoft Edge configuration options

Parts: Windows computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and ensure that it boots properly.

2. Open the Microsoft Edge browser. From the Settings and more (three dots) icon in the upper right 
corner, point to Help and feedback > About Microsoft Edge to determine the Edge version.

 Which version of Edge is being used?

  _________________________________________________________________________________

3. Click the Settings options list to the left. Select Default browser to make Microsoft Edge the default 
browser that opens when a URL link is presented and selected.

4.  Select Start, home, and new tabs.

 In the When Edge starts section, which option is currently enabled?

 [ Open the new tab page | Open tabs from the previous session | Open these pages: ]

  _________________________________________________________________________________

 In the Home button section, which URL is listed as the home page, if any?

  _________________________________________________________________________________
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5. Select Privacy, search, and services option from the Settings list on the left.  

 In the Tracking prevention section, which option is selected, if any?

 [ Basic | Balance | Strict | this option is not turned on ]

 Is the Always use “Strict” tracking prevention when browsing InPrivate enabled or disabled? 
[ Enabled | Disabled ]

Instructor initials: _____________

6. In the Clear browsing data section, click the Choose what to clear button in the Clear browsing data 
now row.

 Which time ranges are available from the drop-down menu? (Choose all that apply.)

 a. Last 30 minutes

 b.  Last hour

 c. Last eight hours

 d. Last 24 hours

 e. Last 48 hours

 f.  Last 7 days

 g.  Last 4 weeks

 h. All time

 i.  Everything

 Which browsing data options are enabled by default?

 [ Browsing history | Download history | Cookies and other site data | Cached images and files | 
Passwords | Autofill form data (includes forms and cards) | Site permissions |  
All data from the previous version of Microsoft Edge | Media Foundation data ]

7. Click Clear now. Notice that you also have an option to specify what is cleared automatically every 
time you close the browser.

 List one corporate scenario for which you think the business security policy would require everything 
to be deleted every time the browser is closed.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

8. Locate the Privacy section.

 Is the Send Do Not Track requests option enabled or disabled? [ Enabled | Disabled ]

 Is the Allow sites to check if you have payment methods saved option enabled or disabled? 
[ Enabled | Disabled ]

Instructor initials: _____________

***PE: For the ques-
tion directly below 
this note, do not add 
a student line.
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9. Locate the Security section and access Manage certificates.

 Are any certificates listed under the Personal tab? [ Yes | No ]

  _________________________________________________________________________________

10. Look in the Intermediate Certificate Authorities tab and Trusted Root Certification Authorities to 
view where common certificates are issued. Use the Untrusted Publishers tab to view any that might 
appear there. You can also use the Intended purpose drop-down menu to see only the certificates is-
sued for client authentication or as secure emails.

11. The Security section also contains the Microsoft Defender SmartScreen option, which, when enabled, 
will warn you if a website is a potential phishing site or is a known untrusted source for software. 
Downloaded files and apps are also checked and warnings provided if any are suspected malware or 
suspicious.

 Is the Microsoft Defender SmartScreen option enabled or disabled? 
[ Enabled | Disabled ]

 Do you think the Microsoft Defender SmartScreen option should be enabled or disabled in the corpo-
rate environment?  
[ Enabled | Disabled ]

 Explain why you selected either enabled or disabled for the recommendation for the Microsoft De-
fender SmartScreen option.

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

12. Locate the Block potentially unwanted apps option within the Security section.

 Is the Block potentially unwanted apps option enabled or disabled? 
[ Enabled | Disabled ]

 What do you think is the difference between the Block potentially unwanted apps option and the Mi-
crosoft Defender SmartScreen option?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

13. The last option in the Security section is the one related to secure DNS. Domain Name System 
(DNS) translates an internet address like www.pearson.com to an IP address so the correct web server 
can be found. If you ever can’t get to www.pearson.com, but you can get to the web server address 
23.222.24.141 from a browser, then the DNS server you use isn’t working. DNS servers are frequent 
targets for attack, and this is the section where you can choose to use secure DNS and even specify 
the IP address of a server you want to use.

 What is the current setting for the Use secure DNS to specify how to lookup the network address for 
websites option? [ Enabled | Disabled ]

 What do you think the Use current service provider option does?

  _________________________________________________________________________________

  _________________________________________________________________________________
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14. Use the plus sign (+) on the top line of the browser to open a new tab. Close the Settings tab by click-
ing the x on the tab, taking care not to close the entire browser. From the Settings and more (three 
dots) icon in the upper-right corner, point to New InPrivate window.

 How does this browser page look different from the browser page/tab you just had open?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

15. From the Settings and more (three dots) icon in the upper-right corner, point to Extension.

 Based on your chapter reading or the information found on the screen, what is the purpose of a 
browser extension?

  _________________________________________________________________________________

  _________________________________________________________________________________

 List up to three extensions that are currently installed.

  _________________________________________________________________________________

16. Close all tabs and the Microsoft Edge browser window.

Lab 12.4 Getting to Know Google Chrome Browser Configuration

Objective: To become familiar with basic Chrome browser configuration options

Parts: Windows computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and ensure that it boots properly.

2. Open the Google Chrome browser. From the Customize and control Google Chrome (three dots) icon 
in the upper-right corner, select Settings > On startup option.

 List the three choices that can be selected to occur when Chrome is launched.

  _________________________________________________________________________________

3. Select the Default browser option from the left menu. This is where you can configure the browser to 
be the one that opens when any URL link is selected or used.

4.  Select the Search engine option from the left menu. This is where you can configure what app is used 
to search the internet.

 Using the drop-down menu, list three options that could be used to search within the Chrome 
browser.

  _________________________________________________________________________________

5. Select the Appearance option from the left menu.

 Is the Show home button option enabled or disabled? [ Enabled | Disabled ]

 Is the Show bookmarks bar option enabled or disabled? [ Enabled | Disabled ]

 What font size is currently chosen?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the current page zoom percentage?

  _________________________________________________________________________________

Instructor initials: _____________
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6. Select the Privacy and security option from the left menu.

 What is the purpose of the Safety check section?

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Locate the Privacy and security section and access Clear browsing data.

 Which time ranges are available from the drop-down menu? (Choose all that apply.)

 a. Last 30 minutes

 b.  Last hour

 c. Last 8 hours

 d. Last 24 hours

 e. Last 48 hours

 f.  Last 7 days

 g.  Last 4 weeks

 h. All time

 i.  Everything

 Which browsing data options are enabled by default?

 [ Browsing history | Download history | Cookies and other site data | Cached images and files | 
Passwords and other sign-in data | Autofill form data | Site Settings |  
Hosted app data ]

 List one corporate scenario for which you think the business security policy would require everything 
to be deleted every time the browser is closed.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

8. Click the Clear data button.

9. Select the Cookies and other site data option from within the Privacy and security section.

 Is the Allow all cookies option enabled or disabled? [ Enabled | Disabled ]

 List one example of when you think the Allow all cookies option should be enabled.

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Expand the Block third-party cookies in Incognito section by selecting the arrow to the right so more 
information is shown.

 Based on the information shown, what is one disadvantage to enabling this option?

  _________________________________________________________________________________

 Is the Clear cookies and site data when you close all windows option enabled or disabled?  
[ Enabled | Disabled ]
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 List one example of when you think the Clear cookies and site data when you close all windows op-
tion should be enabled.

  _________________________________________________________________________________

 Is the Send a “Do Not Track” request with your browsing traffic option enabled or disabled?  
[ Enabled | Disabled ]

11. Select the See all cookies and site data option. Once you have seen all of the information, use the 
arrow to return to the previous section. Use the arrow again to return to the Privacy and security set-
tings sections.

12. Within the Privacy and security section, locate and select the Security option.

 Which Safe Browsing option is selected?  
[ Enhanced protection | Standard protection | No protection ]

 Domain Name System (DNS) translates an internet address like www.pearson.com to an IP address so 
the correct web server can be found. If you ever can’t get to pearson.com, but you can get to the web 
server address 23.32.251.173 from a browser, then the DNS server you use isn’t working. DNS servers 
are frequent targets for attack, and this is the section where you can choose to use secure DNS and even 
specify the IP address of a server you want to use. Is the Use secure DNS option enabled or disabled?  
[ Enabled | Disabled ]

13. Select the Manage certificates option.

 Are any certificates listed under the Personal tab? [ Yes | No ]

14. Look in the Intermediate Certificate Authorities tab and at Trusted Root Certification Authorities to 
view where common certificates are issued. Use the Untrusted Publishers tab to view any certificates 
that might appear there. You can also use the Intended purpose drop-down menu to see only the cer-
tificates issued for client authentication or as secure emails. 

Instructor initials: _____________

15. Scroll back to the top and use the left arrow to return to the previous screen. Select the Site Settings 
option within the Privacy and security section. In the permissions section, select the Location option.

 What is the default behavior for websites being able to ascertain your current location?

 [ Sites can ask for your location | Don’t allow sites to see your location ]

 List one reason you think someone would want a website to be able to ask for your location.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

16. Scroll to the top and use the left arrow to return to the previous screen. In the Permissions section, 
select Camera.

  What is the default behavior for websites being able to access the camera?

 [ Sites can ask to use your camera | Don’t allow sites to use your camera ]

 List one reason why you think someone would want a website to be able to ask to use the camera.

  _________________________________________________________________________________

  _________________________________________________________________________________
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17. Scroll to the top and use the left arrow to return to the previous screen. In the Permissions section, 
select Background sync.

  What is the default behavior for websites being able to continue to send or receive data after you are 
no longer accessing the website?

 [ Recently closed sites can finish sending and receiving data |  
Don’t allow closed sites to finish sending or receiving data ]

18. Scroll to the top and use the left arrow to return to the previous screen. Locate the Content section 
and select JavaScript.

  What is the default behavior for allowing JavaScript?  
[ Sites can use JavaScript | Don’t allow sites to use JavaScript ]

19. Scroll to the top and use the left arrow to return to the previous screen. In the Content section, select 
Pop-ups and redirects.

  What is the default behavior for pop-ups?  
[ Sites can send pop-ups and use redirects | Don’t allow sites to send pop-ups or use redirects ]

20. In the left Settings menu, select Extensions.

  Based on your chapter reading or the information found on the screen, what is the purpose of a 
browser extension?

  _________________________________________________________________________________

  _________________________________________________________________________________

 List up to three extensions that are currently installed. If none are installed, write none.

  _________________________________________________________________________________

  _________________________________________________________________________________

21. From the Customize and Control Google Chrome (three dots) icon in the upper-right corner, select 
New Incognito window.

 How does this browser page look different from the browser page/tab you just had open?

  _________________________________________________________________________________

  _________________________________________________________________________________

 When in Incognito mode, what happens if you bookmark a site?

  _________________________________________________________________________________

 When in Incognito mode, what happens if you download a file?

  _________________________________________________________________________________

 Would your activity still be visible to your employer if you are using a corporate machine and using 
Incognito mode?

  _________________________________________________________________________________

Instructor initials: _____________

22. Close all tabs and the Google Chrome browser window.
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Lab 12.5 Verifying Computer Support for Microsoft Hyper-V Virtualization

Objective: To determine if a Windows computer can use the Microsoft Hyper-V virtualization tool

Parts: Windows computer

 Internet access if BIOS/UEFI research is needed

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and ensure that it boots properly.

2. Access the BIOS/UEFI. Locate and enable the virtualization extensions. These are commonly found 
in either the Chipset, Processor, or Security menu option. Look for Intel Virtualization Technology, 
Intel VT, AMD Virtualization, AMD-V, or Virtualization extensions. Research the computer on the 
internet for BIOS/UEFI options.

 Which option did you enable?

  _________________________________________________________________________________

3. Also enable hardware-enforced data execution prevention (DEP). On an Intel-based system, this is the 
execute disable (XD) bit. On an AMD-based system, this is called the no execute (NX) bit.

 Where did you find the DEP option to enable within the BIOS/UEFI?

  _________________________________________________________________________________

4. Save and exit the BIOS/UEFI.

5. Once Windows starts, launch the System Information Windows tool.

6. Look for the Hyper-V requirements, as detailed in Lab Table 12.1 and as shown in Lab Figure 12.1. Note 
that there should be a Yes next to each requirement, or Hyper-V cannot be used on the computer.

 Do all four options show as Yes? Only if they all show as Yes can Hyper-V be used on the computer.

  _________________________________________________________________________________

LAB TABLE 12.1 Hyper-V Requirements Explanation 

Requirement Description

Processor 64-bit

Processor nested paging Also known as second-level address translation (SLAT) 
extensions. Intel provides this through the extended page table 
(EPT) in Core i9, i7, i5, and i3 processors. AMD calls this nested 
page tables (NPT) or rapid virtualization indexing (RVI).

Processor support for virtualization 
(VM Monitor Mode extension)

Intel lists this as Virtualization Technology (VT); VT-x, such as 
VT-c or VT-d. AMD lists it as AMD-V.

RAM 4 GB or higher

BIOS/UEFI support Enable virtualization and hardware-enforced data execution 
prevention.

LAB FIGURE 12.1 Windows System Information Hyper-V requirements
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Lab 12.6 Installing Another Operating System Within Microsoft Hyper-V

Objective: To create a virtual machine using Microsoft Hyper-V

Parts: Windows 10 computer

 Any other operating system ISO file

 Internet access if an ISO file needs to be downloaded

Note: Additional steps may be needed for installation of the operating system.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and ensure that it boots properly.

2. Download or otherwise obtain an ISO operating system image.

3. Ensure that the computer has BIOS/UEFI virtualization options enabled. See Lab 12.5 or the Tech 
Tip in the “Virtualization Basics” section of Chapter 12, “Internet Connectivity, Virtualization, and 
Cloud Technologies.”

4. Access the Turn Windows Features On or Off Control Panel. Ensure that the following two Hyper-V 
options are enabled: Hyper-V Management Tools and Hyper-V Platform > OK. Reboot the computer 
by selecting Restart Now.

5. Access the Hyper-V Manager app. Use the Action menu option to select New > Virtual Machine. 
Note that if this option is not available, you may need to select the item immediately under the 
Hyper-V Manager in the left window. Click Next.

6. Name the virtual machine.

 What name did you select?

  _________________________________________________________________________________

7. Select the default location to store the virtual machine > Next > leave the default of Generation 1 > 
Next > select the proper amount of RAM for the operating system you are going to install.

 How much RAM did you select?

  _________________________________________________________________________________

 Are you sure this is at least the minimum RAM required for the operating system that will be in-
stalled? If not, research on the internet the minimum required before proceeding. [ Yes | No ]

8. Click Next only after you are sure you have at least the minimum amount of RAM required for the 
operating system to be installed.

9. For the networking portion, select Not Connected > Next. For the virtual hard disk, in the Size option, 
ensure that you select the minimum hard drive space required for the operating system.

 How much hard drive space did you select?

  _________________________________________________________________________________

 Are you sure this is at least the minimum hard drive space required for the operating system that will 
be installed? If not, research on the internet the minimum required before proceeding. [ Yes | No ]

10. Leave all the other defaults and click Next in the virtual hard disk window. In the Installation Options 
section, select the Install an Operating System from a Bootable CD/DVD-ROM option > select the 
Image File (.iso) radio button > select the path where the ISO file is located by using the Browse but-
ton > Next > Finish.

11. From within the Hyper-V Manager window under Virtual Machines > right-click the newly created 
device > Connect > Start (Power) button.

12. Install the operating system. Steps will vary based on the operating system chosen.

Instructor initials: _____________
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Lab 12.7 Getting to Know Amazon AWS Cloud

Objective: To become familiar with cloud technologies using AWS

Parts: Windows computer

Notes: A credit card is required but is not charged unless you exceed the AWS Free Tier limits.

 Vendors frequently change their online products, so although the examples shown in this 
lab were relevant at the time of press, they may not be relevant when you work through this 
lab.

 The AWS Educate website, at awseducate.com, is available for use with reduced 
functionality.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and ensure that it boots properly. Open a web browser and use the following 
URL to access Amazon Web Services (AWS): https://aws.amazon.com.

2. Create an account, if necessary, and log in. Note that if you do not have a credit card and are so di-
rected by your instructor, skip to the note in step 9.

3. From the Products menu, select Amazon EC2. The AWS Free Tier includes 750 hours of Linux and 
Windows usage. Select the Try Amazon EC2 for Free button if this is your first time using it.

4. Select the Launch a Virtual Machine option from within the Build a Solution section.

 Which version of Amazon Linux AMI is shown?

  _________________________________________________________________________________

 Which root device type is the Microsoft Windows Server 2016 Base with Containers?

  _________________________________________________________________________________

 Which virtualization type is used with the Deep Learning AMI (Microsoft Windows Server 2016)? 
Note that if the server version is not available, the answer should be the answer for another version.

  _________________________________________________________________________________

 Does the Windows Server 2008 SP2 base allow you to choose whether you use a 32-bit or a 64-bit 
version?

  _________________________________________________________________________________

 How many machine images are available?

  _________________________________________________________________________________

5. Enable the Free Tier Only checkbox.

 How many machine images are available within the free tier?

  _________________________________________________________________________________

6. Click the Cancel and Exit link at the top right. Click on the letters aws in the top-left corner to return 
to the home page.

7. Select the Backup and Recovery option from within the Learn to Build section.

8. Locate the Explore with Tutorials and Labs section and click the Introduction to Amazon Simple Stor-
age Service (S3) self-paced lab. Note that you will just be watching the introductory 3-minute video 
and not doing the full 45-minute lab. In the Overview section, select the link Here Is a 3-Minute In-
troductory Video.

9. If you did not create an account within AWS, then use the internet to access www.youtube.com. 
Search for the Introduction to Amazon Simple Storage Service (S3) - Cloud Storage on AWS video. 
This is the same video you would watch if you had an account.

 According to the video, what are two drawbacks of building your own storage repository? (Choose 
two.)

 [ Time-consuming | Technically difficult | Space invasive | Expensive | Unsecure ]
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  According to the video, what must you also have if you have your own storage repository?

 a. PATA hard drives

 b. Lots and lots of space

 c. Different manufacturers (and often incompatible) products

 d. Racks and racks of hardware and software

 According to the video, guessing how much capacity you need in your own storage repository is 
_____.

 [ pretty easy | usually easy | sometimes tedious | difficult ]

 According to the video, is S3 secure? [ If you pay for it | Yes | No ]

 If you used Amazon S3 Cloud Storage, what are the two steps required to store data? (Choose two.)

 a. Select a type of drive.

 b. Choose the region.

 c. Create a bucket.

 d. Select a drive.

 e. Select the capacity needed.

 How does S3 ensure that your data is not lost?

  _________________________________________________________________________________

 Which Amazon plan would be used for data that is kept for archival purposes?

 [ S3 Prime | S3 Standard | Amazon Glacier | S3 Standard Infrequent Access ]

Lab 12.8 Installing VMware Workstation

Objective:  To install VMware Workstation 15 Pro in preparation for future VMware Workstation labs

Parts: Windows computer with administrator rights to install software

 Internet access to download a 30-day trial of VMware Workstation Pro

Procedure: Complete the following procedure and answer the accompanying questions.

1. If VMware Workstation Pro is not already downloaded on the computer, go to http://www.vmware.
com and download the software.

 Is VMware Workstation already installed on the computer?

  _________________________________________________________________________________

 Is the same version of VMware Workstation downloaded for 32-bit Windows as 64-bit Windows? If 
you do not know, research this on the internet.

  _________________________________________________________________________________

2. Start the VMware installer. Accept the end-user agreement. When the Customer Setup window ap-
pears, keep the default location selection unless directed otherwise.

3. Leave the Check for Product Updates on startup option enabled and click Next.

4. Either enable or disable the Join the VMware Customer Experience Program checkbox.

  _________________________________________________________________________________

  _________________________________________________________________________________

5. Leave the shortcut checkboxes enabled and click Next. Click Install.

6. Either enter a license key provided by the instructor or lab assistant or click the Finish button. Note 
that no key is needed for the 30-day trial.

7. When the installation is complete, the VMware Workstation icon appears on the desktop. Note that 
you may be prompted to restart the computer before using the software.

Instructor initials: _____________
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Lab 12.9 Installing Windows and Ubuntu as a VMware Workstation 
Virtual Machine

Objective:  To install a version of Windows 7 and Ubuntu as a VMware Workstation virtual machine

Parts: Windows computer with administrator rights that has VMware Workstation installed

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: This lab does not require .iso discs but uses the integrated guest operating systems sim-
ply to expose the student to the environment.

1. Double-click the VMware Workstation icon on the desktop or access the software from the Start but-
ton menu. VMware Workstation opens. If this is the first time starting VMware Workstation, you will 
be prompted to enter a license key or you can select the I want to try VMware Workstation 15 for 30 
days radio button. Make your selection and click Continue > Yes > Finish. Lab Figure 12.2 shows the 
VMware Workstation area.

LAB FIGURE 12.2 VMware Workstation

2. On the Home tab, select the Create a New Virtual Machine option.

3. Select the Typical (Recommended) radio button and click Next.

4. Select the I will install the operating system later radio button and click Next.

5. Select the Microsoft Windows radio button. Set the version to Windows 7 and click Next. Answer the 
questions based on what you see on the screen.

 Were a username and password selected as part of this installation process?

 [ Yes | No ] If so, document the username and password.

  _________________________________________________________________________________

6. Enter a name for the machine (or leave the default) and select a hard drive location to store the virtual 
machine file. Click Next after you have answered the questions.

 What name did you use for the virtual machine?

  _________________________________________________________________________________

 Document the path to the folder that contains the virtual machine file.

  _________________________________________________________________________________

7. Keep the default disk size and accept the default Split virtual disk into multiple files radio button. 
Click Next.

8. Look over the virtual machine settings to answer the questions.

 What is the default amount of RAM?

  _________________________________________________________________________________

 What type of network adapter is installed?

  _________________________________________________________________________________
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 What other devices are automatically installed?

  _________________________________________________________________________________

9. Click Finish. Notice that the virtual machine is within its own tab. Right-click the tab that contains 
your new virtual machine.

 Document at least four menu options that are available when you right-click the virtual machine tab.

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Locate the VM in the Library panel on the left. The virtual machine name is under My Computer and 
is a name that you assigned. Right-click the virtual machine you just created.

 Are the options the same as the ones you saw when you right-clicked the virtual machine tab?

 [ Yes | No ]

11. Ensure that the VM is still selected in the left panel. In the right panel, select the Edit virtual machine 
settings link. Ensure that Memory is selected in the Device column.

  Based on what is shown, what is the maximum recommended memory?

  _________________________________________________________________________________

 What is the recommended memory amount?

  _________________________________________________________________________________

 What is the guest OS recommended minimum?

  _________________________________________________________________________________

12. Select Processors in the left window.

 What is the default number of processors for the VM?

  _________________________________________________________________________________

 What is the default number of cores per processors for the VM?

  _________________________________________________________________________________

 What is the maximum number of processors that can be selected for the VM?

  _________________________________________________________________________________

 How many processor cores are available on each processor?

  _________________________________________________________________________________

13. Select the Hard Disk option.

 Which drive interface is used by default? [ PATA | SAS | SATA | SCSI ]

 Which disk utilities are available for this drive? (Choose all that apply.)

 [ Mark as active | Convert to GPT | Map | Defragment | Compact | Compress |

 Expand | Disconnect | Partition ]

14. Click the Advanced button. Look in the mode section. If the Independent option was selected, you are 
allowed to select either the persistent or nonpersistent mode. With persistent mode, any changes you 
make take effect immediately. Nonpersistent mode means that you can make changes to the VM, but 
when you power the VM off, the changes are not kept. Click Cancel.

15. Select Network Adapter from the device list on the left. An important part of virtualization is how you 
configure the NIC.

 What are the types of network connections? (Choose five.)

 [ Bridged | Custom | Disconnected | Host-only | LAN segment | NAT | PAT ]

 Which network connection type is the default?

 [ Bridged | Custom | Disconnected | Host-only | LAN segment | NAT | PAT ]

 Looking at the other devices, is a printer detected by default? [ Yes | No ]
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16. Click Cancel to return to the main VM Workstation window.

17. Using the process you just learned, return to the Home tab and create a new VM using the guest OS 
of Ubuntu.

 What is the default amount of memory allocated to this VM?

  _________________________________________________________________________________

 Is the hard drive interface the same that was used for the Windows 7 VM?

 [ Yes | No ]

 Which network connection is the default for the Ubuntu VM?

 [ Bridged | Custom | Disconnected | Host-only | LAN segment | NAT | PAT ]

Instructor initials: _____________

18. Ensure that one of your VMs is selected in the left window. Select the VM menu option. Notice the 
Snapshot option. A snapshot is used to create an image or a backup of the VM in its current state. 
This is good when making changes or trying something new so that you can revert back to the VM at 
a particular point in time if something happens or you do not like the results of a particular change.

19. Right-click on the Windows 7 VM. Select Remove > click the Remove button.

20. Right-click on the Ubuntu VM. Select Remove > click the Remove button.

21. Close the VMWare Workstation window.

Lab 12.10 Installing VirtualBox

Objective:  To download and install VirtualBox on a Windows 10 computer

Parts: Windows computer with administrator rights

 Access to the internet or a disc/drive with the VirtualBox installer file

Procedure: Complete the following procedure and answer the accompanying questions.

1. VirtualBox is software that allows you to create virtual machines. Inside a virtual machine, you can 
run multiple guest operating systems. If you need to download the VirtualBox installer, access the 
www.virtualbox.org > Downloads page. Download the binary version for Windows hosts.

2. From the location where you downloaded the VirtualBox installer or disc that has the file, launch the 
executable file by double-clicking it.

3. Click Next. Most people accept the default features and location where VirtualBox is to be installed, 
but your instructor may have specific requirements. If the instructor has not provided any specifics, 
click Next > select the options to be installed or accept the default > Next. Note that the installation 
process disables the network connection temporarily. Click Yes > Install. Click Yes to install. Make 
sure you click Install in any security window that pops up, depending on which options are to be 
installed.

4. Click New to create a new virtual machine (VM).

 List three types of VMs supported by VirtualBox.

  _________________________________________________________________________________

 If you selected the macOS X operating system, what versions are available?

  _________________________________________________________________________________

5. In the Name textbox, type a name for the VM, select the Linux operating system from the Type drop-
down menu, and select Ubuntu (32-bit) from the Version drop-down menu > Next.

 What is the maximum memory that can be used for the VM?

  _________________________________________________________________________________

  _________________________________________________________________________________
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6. For Memory Size, leave the default and click Next. Leave the default Create a Virtual Hard Disk Now 
> Create. Leave the default hard disk file type set to VDI > Next. Leave the default storage type as 
Dynamically Allocated > Next. For File Location and Size, leave the default > Create. Lab Figure 
12.3 shows the Oracle VM VirtualBox Manager window with the new VM installed.

LAB FIGURE 12.3 Oracle VM VirtualBox Manager

 Is the VM powered on or off by default? [ On | Off ]

Instructor initials: _____________

7. With the name of the VM highlighted in the left window, select the Settings icon. Use the menu op-
tions on the left to answer the following questions.

 How many CPUs are allocated to the VM by default? [ 1 | 2 | 4 | 8 | 16 ]

 How much video memory is allocated to the VM by default?

 [ None | 4 MB | 8 MB | 16 MB | 64 MB | 128 MB ]

 Is video capture available? [ Yes | No ]

 On which type of hard drive is the VM built by default?

 [ IDE | PATA | SATA | USB ]

 Is the network adapter enabled by default? [ Yes | No ]

 Which USB controllers are supported? Select all that apply.

  [ 1.1 | 2.0 | 2.2 | 3.0 | 3.1 ]

8. Click OK. With the VM name still highlighted in the left window, select the Start menu icon. The VM 
powers on. Notice that the VM requires a startup disk or an operating system. Either browse to an 
ISO or click Cancel to close the VM.
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Lab 13.1 Creating a Straight-Through Cat 5, 5e, or 6 Network Patch Cable

Objective: To create a functional Cat 5, 5e, or 6 UTP network cable

Parts: UTP cable

 RJ45 connectors

 Stripper/crimper tool

 UTP cable tester

Note: Standard Ethernet networks are cabled with UTP cable. In this exercise, you create a standard cable for use with Ether-
net networks connected through a central hub or switch.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Category 5 and higher UTP cable consists of four twisted pairs of wires, color coded for easy identification. The color-coded 
wires are colored as follows:

  Pair 1: White/orange and orange

  Pair 2: White/blue and blue

  Pair 3: White/green and green

  Pair 4: White/brown and brown

2. Using the stripper/crimper tool, strip approximately 1/2 inch (1 centimeter) of the protective outer sheath to expose the four 
twisted pairs of wires. Most wire strippers have a strip gauge to help you strip the proper length. See Lab Figure 13.1.

  Note: To make it easier to sort the wire pairs, the sheathing can be stripped farther than 1/2 inch (1 centimeter), and the wires can 
be sorted properly and then trimmed to the proper length.
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LAB FIGURE 13.1 Strip the cable sheathing

3. Untwist the exposed wire pairs. Be careful not to remove more twist than necessary. Sort the wires as 
follows:

  Wire 1: White/orange

  Wire 2: Orange

  Wire 3: White/green

  Wire 4: Blue

  Wire 5: White/blue

  Wire 6: Green

  Wire 7: White/brown

  Wire 8: Brown

  Ethernet cable utilizes wires 1, 2, 3, and 6. Using the preceding wiring scheme means that the cable 
will use the white/orange-orange and white/green-green wire pairs.

 Will both ends of the cable need to follow the same wiring schematic?

 [ Yes | No ]

4. Insert the sorted and trimmed cable into an RJ45 connector. The RJ45 connector tang should face 
downward with the open end toward you while you insert the wires. Verify that all eight wires fully 
insert into the RJ45 connector and that they are inserted in the proper order. See Lab Figure 13.2.

LAB FIGURE 13.2 Push wires firmly into the RJ45 connector in the correct color order
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5. Insert the cable-connector assembly into the stripper/crimper tool and crimp the connector firmly. See 
Lab Figure 13.3.

LAB FIGURE 13.3 Crimp the RJ45 connector firmly

6. Remove the cable/connector assembly from the stripper/crimper tool and verify that the wires fully 
insert into the connector and that they are in the proper order.

7. Repeat steps 2 through 6 for the other end of the CAT 5 or higher UTP cable.

 Can the cable be used at this point? [ Yes | No ]

8. Before using the cable, you should test it with a cable tester to verify that you have end-to-end conti-
nuity on individual wires and proper continuity between wire pairs. Insert the RJ45 connector into the 
proper cable tester receptacle and verify that the cable is functional. See Lab Figure 13.4.

LAB FIGURE 13.4 Network cable tester

Instructor initials: _____________
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Lab 13.2 Creating a Cat 5, 5e, 6, or 6a Crossover Network Cable

Objective: To create a functional UTP crossover cable

Parts: UTP cable

 RJ45 connectors

 Stripper/crimper tool

 UTP cable tester

Note: In normal situations, straight-through UTP cable is used to connect to a central hub or 
switch. In this exercise, you create a crossover cable for use when directly connecting two 
network devices (computers without using a central hub or switch).

Procedure: Complete the following procedure and answer the accompanying questions.

1. Category 5, 5e, 6, 6a, and 7 UTP cable consists of four twisted pairs of wires that are color coded for 
easy identification. The color-coded wires are as follows:

  Pair 1: White/orange and orange

  Pair 2: White/blue and blue

  Pair 3: White/green and green

  Pair 4: White/brown and brown

2. Using the stripper/crimper tool, strip approximately 1/2 inch (1 centimeter) of the protective outer 
sheath to expose the four twisted pairs of wires. Most tools have a strip gauge to help you strip the 
proper length.

  Note: To make it easier to sort the wire pairs, the sheathing can be stripped farther than 1/2 inch (1 
centimeter). The wires can then be sorted properly and then trimmed to the proper length.

3. Untwist the exposed wire pairs. Be careful not to remove more twist than necessary. Sort the wires as 
follows:

  Wire 1: White/orange

  Wire 2: Orange

  Wire 3: White/green

  Wire 4: Blue

  Wire 5: White/blue

  Wire 6: Green

  Wire 7: White/brown

  Wire 8: Brown

  Ethernet networks utilize wires 1, 2, 3, and 6. Using the above wiring scheme means the cable will 
use the white/orange-orange and white/green-green wire pairs.

 When making a crossover cable, will both ends of the cable need to follow the same wiring sche-
matic? [ Yes | No ]

4. Insert the sorted and trimmed cable into an RJ45 connector. The RJ45 connector tang should face 
downward with the open end toward you while you insert the wires. Verify that all eight wires fully 
insert into the RJ45 connector and that they are inserted in the proper order.

5. Insert the cable-connector assembly into the stripper/crimper tool and crimp the connector firmly.

6. Remove the cable/connector assembly from the stripper/crimper tool and verify that the wires are 
fully inserted into the connector and that they are in the proper order.
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7. To create the crossover cable, the wire pairs must be put in a different order. To accomplish this, 
repeat steps 2–6 on the opposite end of the cable, but when sorting the wire pairs, use the following 
color codes:

  Wire 1: White/green Wire 5: White/blue

  Wire 2: Green Wire 6: Orange

  Wire 3: White/orange Wire 7: White/brown

  Wire 4: Blue Wire 8: Brown

8. Verify both ends of the cables, ensuring that the tang is downward and the colored wires are in the 
correct order. You can also check the ends of the connectors to see if you see the tip of the copper 
wire pushed against the end. See Lab Figure 13.5.

 Can the crossover cable be used at this point? [ Yes | No ]

LAB FIGURE 13.5 Verify the color codes on both connectors

9. Before using the crossover cable, you should test it with a cable tester to verify that you have end-to-
end continuity on individual wires and proper continuity between wire pairs. Insert the RJ45 connec-
tor into the proper cable tester receptacle and verify that the cable is functional.

  Note: Your cable tester must have the capability to test crossover cables.

Instructor initials: _____________

Lab 13.3 Exploring NIC Properties with the Windows 7, 8, 10, or 11 
Control Panel

Objective: To examine and modify NIC properties, including manually setting IP address information

Parts: Computer with Windows 7, 8, 10, or 11 installed

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on to Windows, if necessary.

2. Access the Network and Sharing Center section of the Control Panel.

3. Select the Change adapter settings link.

4. Double-click the wired or wireless connection that is currently used to connect the computer to the 
network.

5. Select the Details button. Use Lab Table 13.1 to document key pieces of information assigned to this 
NIC. For any property that is not shown, simply write not applicable for that setting.
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LAB TABLE 13.1 NIC lab documentation

Property Setting

Physical (MAC) Address

DHCP Enabled [ Yes | No ]

IPv4 Address

IPv4 Subnet Mask

Leased Obtained

Lease Expires

IPv4 Default Gateway

IPv4 DHCP Server

IPv4 DNS Server

IPv6 Address

IPv6 Default Gateway

6. Close the Network Connection Details window. In the Status window, notice that you can disable the 
NIC. You can also do this by right-clicking on the NIC icon. Click the Disable button.

  What indication do you have that the NIC is actually disabled?

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Right-click on the NIC icon and select Enable. Double-click the NIC icon again.

  How many bytes have been sent?

  _________________________________________________________________________________

  How many bytes have been received?

  _________________________________________________________________________________

8. Select the Properties button. The Properties window opens. Select the Configure button. The proper-
ties for the specific NIC card appear. The tabs at the top of the window are manufacturer specific, but 
most manufacturers tend to have the same basic tabs.

  Which company manufactured the NIC?

  _________________________________________________________________________________

  Which data bus does the card use? [ PCI | PCIe | _______________ ]

  What key information in the Device Status window would be important to the tech?

  _________________________________________________________________________________

  Using the various tabs, determine the following information:

  Which driver version is installed?

  _________________________________________________________________________________

  Are any power management options enabled? If so, which ones?

  _________________________________________________________________________________

  _________________________________________________________________________________

  Which tab can be used to disable the device?

  _________________________________________________________________________________
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9. Access the Advanced tab. Locate and select the option that allows you to manually set the NIC speed 
(and optionally the duplex).

  What default value is shown?

  _________________________________________________________________________________

10. Click the down arrow in the Value option.

  List the available options.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  If you were to manually configure this NIC for speed and/or duplex, which option would be best?

  _________________________________________________________________________________

  _________________________________________________________________________________

  In your opinion, why do you think that a 1.0 Gbps option shows only full duplex?

  _________________________________________________________________________________

  _________________________________________________________________________________

11. Leave the speed at the original setting and return to looking at the specific properties.

  Look through the advanced property options and list which ones relate to Wake on LAN. Note that 
you may have to access the option and look at the values to answer this completely.

  _________________________________________________________________________________

  _________________________________________________________________________________

12. Select Cancel > Close.

Lab 13.4 Exploring and Configuring NIC Properties with Windows 10/11 
Settings

Objective: To examine and modify NIC properties, including manually setting IP address information

Parts: One computer with Windows 10 or 11 installed

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on to Windows, if necessary.

2. Access Windows Settings > Network & internet link.

3. Within the Network status section, or the section that has the active network connection shown, select 
the Properties button for the network card being shown.

 Within the Network profile section, is the device configured as being on a public network or a private 
network? [ Public | Private ]

 Within the Metered connection section, is the device configured as having a metered connection op-
tion turned on or off? [ On | Off ]
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4. Locate the IP settings section.

 Does the device have the IP address information manually configured, or is the device receiving IP 
addressing information from a DHCP server?  
[ Manually configured | DHCP server ]

5. Locate the NIC Properties section. Use Lab Table 13.2 to document key pieces of information as-
signed to this NIC. For any property that is not shown, simply write not applicable for that setting.

  _________________________________________________________________________________

LAB TABLE 13.2 NIC lab documentation

Property Setting

Physical (MAC) Address

IPv4 address

IPv4 Subnet Mask

Link Speed

Lease Expires

IPv4 Default Gateway

IPv4 DHCP Server

IPv4 DNS Server

IPv6 Address

IPv6 link-local address

IPv6 DNS servers

NIC manufacturer

NIC driver version

6. In the IP settings section (Windows 10) or IP assignment section (Windows 11), click the Edit but-
ton. Ensure that the drop-down menu option is set to Manual. Within the IPv4 section, ensure that the 
option is turned to On by clicking in the space to the right. The option turns to On, and option boxes 
appear.

  What are the option boxes available when manually configuring a Windows 10/11 computer for IP 
addressing information? (Choose all that apply.)

 [ MAC address | IP address | Default gateway | Gateway | Preferred DNS | DNS server |  
Alternate DNS ]

 Why would a technician configure an Ethernet network device for two DNS addresses?

  _________________________________________________________________________________

7. Click the Cancel button and ensure that the IP settings section is back the way it was originally. Refer 
to the answer provided in step 4 if you are unsure. Close the Settings window.

Lab 13.5 Networking with Windows 7, 8, or 10

Objective: To put two Windows 7, 8, or 10 computers into a network workgroup

Parts: Two computers with Windows 7, 8, or 10 installed

 One crossover cable or two straight-through cables and a hub or switch

Procedure: Complete the following procedure and answer the accompanying questions.
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1. Power on the first computer and log on to Windows, if necessary. Do one of the following: (1) Con-
nect a crossover between the two computers’ NICs or (2) connect a straight-through cable from each 
computer to the hub or switch and power on the hub or switch. (Note that the computer may already 
be on a wired network.) Then either you or a fellow classmate should log in to the second computer.

2. Ensure that each computer has a user created that is the same user and password on both computers. 
See Chapter 16, “Advanced Windows,” for directions on how to create a user account. Log in with 
that username on both computers.

 Document the username that is the same on both computers and used to log in before doing any 
remaining steps: ____________________________________

3. Use any and all of the following to discover the computer name/device name as well as the domain or 
workgroup name.

 > System Control Panel

 > PC Settings link

 > System Settings link > About

 > Advanced system settings link (System Properties window)

  Document the current settings. Write None if the information is not shown:

  Original Computer 1 name: ____________________________________

 Original Computer 2 name: ____________________________________

  Original Full computer 1 name: ____________________________________

  Original Full computer 2 name: ____________________________________

  Is Computer 1 on a workgroup or domain? [ Workgroup | Domain ]

 Is Computer 2 on a workgroup or domain? [ Workgroup | Domain ]

  Original workgroup/domain name for Computer 1: ____________________

  Original workgroup/domain name for Computer 2: ____________________

4. Use the System Control Panel to select the Advanced system settings link (located in the left menu). 
Use the Computer name tab > Change button and locate the Member of section in order to select the 
Workgroup radio button. Name the workgroup something unique and remember that both computers 
must be within the same workgroup. Select OK and/or Close until prompted to Restart Now. Do the 
same steps on the second computer.

  Document the new workgroup name:

 New workgroup name for both Computer 1 and 2: ____________________

 What message appears once you selected OK?

  _________________________________________________________________________________

5. When both computers have rebooted, the current IP addresses need to be documented. Open the 
command prompt and type ipconfig /all.

  On Computer 1, what is the IPv4 address on the Ethernet adapter?

  _________________________________________________________________________________

  On Computer 1, what is the IPv6 link-local address on the Ethernet adapter?

  _________________________________________________________________________________
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  On Computer 1, what is the IPv4 subnet mask?

  _________________________________________________________________________________

  On Computer 1, what is the default gateway?

  _________________________________________________________________________________

  On Computer 1, what is the MAC address?

  _________________________________________________________________________________

  On Computer 2, what is the IPv4 address on the Ethernet adapter?

  _________________________________________________________________________________

  On Computer 2, what is the IPv6 link-local address on the Ethernet adapter?

  _________________________________________________________________________________

  On Computer 2, what is the IPv4 subnet mask?

  _________________________________________________________________________________

  On Computer 2, what is the default gateway?

  _________________________________________________________________________________

  On Computer 2, what is the MAC address?

  _________________________________________________________________________________

  Who is the network adapter manufacturer for Computer 2?

  _________________________________________________________________________________

  How many hexadecimal characters are shown in the Computer 1 IPv6 address?

  _________________________________________________________________________________

  How many bits does this represent?

  _________________________________________________________________________________

6. On both computers, close the Command Prompt window. Access the Network and Sharing Center 
Control Panel > access the Change advanced sharing settings link in the left pane. Expand the profile 
that shows as the “(current profile)” so you can see the sharing options. Also explore the All Networks 
section and expand it as well to answer the questions that follow.

 Document the current Sharing and Discovery settings for both computers. Note that all options may 
not be available in Windows Home versions, but the lab still works. You may also have to expand 
some sections to find them in the particular type of network currently being used.

Computer 1 Computer 2

Network discovery __________ __________

File sharing __________ __________

Printer sharing __________ __________

Password protected sharing __________ __________

Media sharing/streaming __________ __________

Public folder sharing __________ __________
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7. On both computers, click Cancel. From the Network and Sharing Center Control Panel, select 
Change adapter settings link in the left panel. Right-click Local Area Connection or the Ethernet 
adapter option > Properties. In the center window, locate and select Internet Protocol Version 4 (TCP/
IPv4) > Properties button.

  Document the settings for Computer 1 and Computer 2: _________________

 Is Computer 1 configured with an IP address, mask, and default gateway OR is Computer 1 
configured to obtain an IP address automatically?

  _________________________________________________________________________________

 Is Computer 1 configured with preferred and alternate DNS server(s) IP addresses OR does Computer 
1 obtain DNS server address information automatically?

  _________________________________________________________________________________

 Is Computer 2 configured with an IP address, mask, and default gateway OR is Computer 2 
configured to obtain an IP address automatically?

  _________________________________________________________________________________

 Is Computer 2 configured with preferred and alternate DNS server(s) IP addresses OR does Computer 
2 obtain DNS server address information automatically?

  _________________________________________________________________________________

8. On Computer 1, select the Use the following IP address radio button and type in the following 
information:

  IP address: 192.168.1.1

  Subnet mask: 255.255.255.0

  Default gateway: 192.168.1.254

 Click the OK button. Click the OK/Close button at the bottom of the Local Area Connection 
Properties screen.

9. On Computer 2, select the Use the following IP address radio button and type in the following 
information:

  IP address: 192.168.1.2

  Subnet mask: 255.255.255.0

  Default gateway: 192.168.1.254

 Click the OK button. Click the OK/Close button at the bottom of the Local Area Connection 
Properties or Ethernet Properties window.

 From the information that has been entered on Computer 1 and Computer 2, what IP address is en-
tered on the device such as a router that is connected to the same network as these two computers? 
Note that this information is derived from the chapter reading.

  _________________________________________________________________________________

 What is the purpose of the default gateway address? Note that this information is derived from the 
chapter reading.

  _________________________________________________________________________________

  _________________________________________________________________________________

10. On both computers, using previously described procedures, open a command prompt and use the 
ipconfig command to verify that the IPv4 address has been applied. Note that you may have to 
scroll up to see the IPv4 address assigned to the Ethernet adapter.
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11.  At a Computer 1 command prompt, type ping 192.168.1.2.

 What was the response? Note that the default Windows Firewall behavior is to deny pings. When File 
and Print Sharing is enabled, the firewall automatically allows ICMP messages that include pings.

  _________________________________________________________________________________

Sharing and Accessing a Shared Folder

Note: This section can take a little patience, depending on the type of network the computer uses. Also note 
that in some settings, the network status cannot be changed to a private network in Step 12. If you do not 
have these, options, just make a note that it shows as a public network and make sure you use that network 
type to configure the settings in Step 13.

12. To set the computer as a private network, use the Network & Internet Settings option. Ensure that the 
status shows as a private network. To change it, click the Properties button and in the Network profile 
section, ensure that the Private radio button is selected. If the link cannot be selected, just make a 
note of the type of network as that is the profile area you need to be in for the next step.

13. On both computers, access the Network and Sharing Center Control Panel > Change advanced 
sharing settings link. Configure the following settings in the appropriate profile area:

 Network discovery: Turn on Network Discovery

 File and print sharing: Turn on File and Print Sharing

 Click the Save Changes button. Do the same on the second computer.

14.  At a Computer 1 command prompt, type ping 192.168.1.2.

 What was the response? Note that the ping should be successful, and you should get the message 
“Reply from 192.168.1.2” with a specific number of bytes and a time value. If you do not receive a 
successful ping, redo the lab starting at Step 8.

Instructor initials: _____________

15. On Computer 1, using Windows Explorer (Windows 7) or File Explorer (Windows 8/10), create a 
subfolder of the Documents folder called ABC, create a text file called Surprise.txt within the 
ABC folder, and place this message in the text file:

 Technology makes it possible for people to gain control over 

everything, except over technology. -John Tudor

16. On Computer 1, right-click or tap to select the ABC folder > Properties > Sharing tab > Share button 
> access the down arrow and choose Everyone > Add button so the Everyone user appears as a name 
> Share button.

 Notice that the full path is shown in the window. An example is \\DESKTOP-26NITHP\Users\student\
Documents\ABC. This full path can be emailed or given to someone so they can access the documents 
contained within the ABC folder.

 What is the full path for your shared folder? Click the Done button > Close button when finished.

  _________________________________________________________________________________

17. On Computer 2, there are several ways to view the share, depending on the type of network the com-
puter is on. Note that not all options will be available; the options available depend on the type of 
network configured. If necessary, ask the instructor or student assistant what type of network is used 
and then select the option that best suits your network environment:

>  Use File Explorer > Network option from the left panel > double-click the name of Computer 1

 > If using OneDrive, access it through Windows Explorer/File Explorer or a web browser.

 > If using the older method of folder sharing, use Windows Explorer/File Explorer to select the Net-
work option from the left pane. In the right pane, double-click the Computer 1 Name.
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 Note: If Computer 1 does not appear in the right pane (it can take quite a few minutes to do so), do 
what many IT personnel do and access the computer by using its UNC. In a command prompt or 
Search textbox, type the following: \\computer_name\share_name (where computer_name 
is the name of Computer 1, and share_name is ABC, the name of the share). An example would be 
\\Cheryl-PC\ABC. You can also type the full path documented in step 16.

 Note: If no passwords are assigned to the existing user account, a password will have to be applied to 
the account on both machines.

18.  Access the ABC folder. Open the Surprise.txt document. Try modifying the text inside and 
saving it on Computer 1.

 Were you successful? [ Yes | No ]

Instructor initials: _____________

19. Close the Surprise.txt document on both computers.

Instructor initials: _____________

20. Place both computers back in the original workgroup/domain. Refer to step 3 for the original settings.

21. Configure both computers to the original Sharing and Discovery settings. Refer to step 6 for the origi-
nal settings.

22. Return both computers to the original IPv4 IP address, mask, default gateway, and DNS settings. 
Refer to steps 5 and 7 for the original settings.

23. Remove the cable and return the computers back to the original cabling configuration. Ensure that 
each computer works and has the same access as it had before you began this lab.

Instructor initials: _____________

Lab 13.6 Connecting to a Windows 10 Shared or Networked Printer

Objective: To properly share a printer and use a shared or networked printer using Windows 10

Parts: Two networked computers with a printer attached to one and Windows 10 installed

Procedure: Complete the following procedure and answer the accompanying questions.

Sharing a Printer on the Network

1. Power on the computer that has the printer attached. If necessary, log on to Windows, using the ap-
propriate user ID and password/PIN.

2. Access the Network and Sharing Center Control Panel. Ensure that File and printer sharing is 
enabled through the Change advanced sharing settings link.

3. Using the Devices and Printers Control Panel, locate the Printers section. Locate the printer to be 
shared. Right-click the printer icon > Properties.

4. Click the Sharing tab. (If the Sharing tab is not available, return to the Devices and Printers Control 
Panel, right-click the printer icon > select Printer Properties.)

5.  Select the Share this printer radio button/checkbox. (If the option is grayed out, go back to the Net-
work and Sharing Center Control Panel and ensure that sharing options are enabled. Make changes as 
necessary. Then continue with the rest of this step.) Ensure that the Render print jobs on client com-
puters checkbox is enabled.
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6. In the Share Name textbox, type in a unique printer name, limited to eight characters, if possible. It is 
important that this name be unique.

  What name was assigned to the printer? __________________________

7. Click the OK button.

Printing to a Shared or Networked Printer in Windows 10

8. On the Windows 10 computer that does not have the printer attached, use Settings > Devices > Print-
ers & Scanners.

9. Select the Add a printer or scanner option.

10.  The printer should be listed in the window. Click Next if the printer is there and then click the Install 
Driver button.

  If the printer is missing, click The printer that I want isn’t listed. Four methods can be used to find a 
shared or networked printer:

 > Method 1: Select the My printer is a little older. Help me find it link > Next.

 > Method 2: Select the Share printer by name radio button. Either type the name of the printer using the 
format \\computer_name\printer_share_name or browse the network for the printer name, 
click the Next button, select the printer, and click Next. Note that this is sometimes the quickest method 
for a shared printer as it directly accesses the printer across the network. To locate the computer name, 
use the System Control Panel. The printer share name was issued and documented in step 6.

 > Method 3: Select the Add a printer using a TCP/IP address or hostname radio button and click 
Next. Type the hostname or IP address. Click Next.

 > Method 4: Select the Add a Bluetooth, wireless or network discoverable printer radio button.

11. Select one of these options and locate the shared printer. Print a test page to the shared printer.

  Does the test page print properly? If not, perform appropriate printer troubleshooting. [ Yes | No ]

Lab 13.7 Installing a Wireless NIC

Objective: To install a wireless NIC into a computer and have it attach to an access point

Parts: A computer with access to the internet and permission to download files

 A wireless NIC

 An access point that has already been configured by the instructor or lab assistant

Note: To verify that a wireless NIC works after it is installed, it must have another wireless device 
such as another computer with a wireless NIC installed or an access point. This lab as-
sumes that an access point is available and allows attachment of wireless devices. Students 
will need any security information such as WEP key or WPA2/WPA3 password before they 
begin. Each student will download the installation instructions and driver for the wireless 
NIC. Frequently, these files may be in zipped or PDF format. The computer they use may 
need to have Adobe’s Acrobat Reader and/or a decompression software package loaded.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Determine which type of wireless NIC is being installed.

  What type of wireless NIC is being installed?

 [ USB | PCI | integrated | PCIe ]
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  Who is the manufacturer of the wireless NIC?

  _________________________________________________________________________________

  What operating system is used on the computer in which the wireless NIC will be installed?

  _________________________________________________________________________________

2. Using the internet, determine the latest version of wireless NIC driver for the operating system being 
used and download the driver.

  What is the latest driver version?

  _________________________________________________________________________________

3. Using the internet, download the installation instructions for the wireless NIC being used.

  What is the name of the installation document?

  _________________________________________________________________________________

4. Open the document that details how to install the wireless NIC.

5. Follow the directions and install the wireless NIC.

  Does the wireless NIC automatically detect a wireless network?

  _________________________________________________________________________________

  _________________________________________________________________________________

  List any specifications given to you by the instructor/lab assistant.

  _________________________________________________________________________________

Lab 13.8 Configuring a Wireless Network

Objective: To configure a wireless AP (access point) or router and attach a wireless client

Parts: One wireless access point or router

 A computer with an integrated wireless NIC or a wireless NIC installed as well as an 
Ethernet NIC

 One straight-through cable

Procedure: Complete the following procedure and answer the accompanying questions.

1. Obtain the documentation for the wireless AP or router from the instructor or the internet.

2. Reset the wireless AP or router as directed by the wireless device manufacturer.

  Document the current Ethernet NIC IPv4 settings. [ DHCP | Static IP address ]

  If a static IP address is assigned, document the IP address, subnet mask, default gateway, and DNS 
configuration settings.

  _________________________________________________________________________________

  _________________________________________________________________________________

3. Attach a straight-through cable from the computer Ethernet NIC to the wireless AP or router.

4. Power on the computer and log on, if necessary.

5. Configure the computer NIC with a static IP address or DHCP, as directed by the wireless device 
manufacturer.

6. Document the current settings first. Then open a web browser and configure the wireless AP or router 
with the following parameters:

 > Change the default SSID.

 > Leave SSID broadcasting enabled for this lab.
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 > Do not configure wireless security at this time.

 > Change the default password used to access the wireless AP/router.

  Document the current settings:

  SSID: ___________

  Password for wireless device access: ___________

7. Save the wireless AP or router configuration.

8. Disconnect the Ethernet cable.

9. Enable the wireless NIC and configure it for the appropriate SSID.

10. Configure the wireless NIC for a static IP address or DHCP, as directed by the wireless AP or router 
manufacturer.

11. Open a web browser and access the wireless AP or router. If access cannot be obtained, troubleshoot 
as necessary or reset the wireless AP or router to default configurations and restart the lab.

  What frequency (channel) is used by the wireless AP or router and the wireless NIC for connectivity?

  _________________________________________________________________________________

12. Show the instructor the connectivity.

Instructor initials: _____________

13. Reset the wireless AP or router to the default configuration settings.

14. Reset the computer(s) to the original configuration settings.

Lab 13.9 Using an FTP Server and Client

Objective: To transfer files from one network device to another, using an FTP server and client 
software

Parts: An application or freeware application that provides the FTP server service

 An application or freeware application that provides the FTP client service

Procedure: Complete the following procedure and answer the accompanying questions.

FTP Server

1. Download, install, and open an FTP server freeware application such as Home FTP Server or 
FileZilla. This lab has directions specifically for Home FTP Server, but the steps for other applica-
tions are similar.

2. Start the FTP server. You may need to start the FTP server or the FTP server service. In the Home 
FTP Server application, click the FTP Server tab > Start Server.

3. Some FTP server applications allow anonymous users or anyone who connects to the server to down-
load files. Also, some applications allow you to specify what the anonymous user can do, such as 
download, upload, and delete files and directories. To enable anonymous logins within Home FTP 
Server, click the FTP Server tab > enable Allow Anonymous Users (Allow All Active) checkbox. This 
same tab can be used to enable specific permissions for creation and deletion of files and directories.

 Write down where the default anonymous directory is located.

  _________________________________________________________________________________

  _________________________________________________________________________________
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4. FTP server applications frequently allow web connectivity. To enable the web interface within Home 
FTP Server, select the Web Interface tab > enable the Web Interface Enabled checkbox.

  What is the default port number used for the FTP server?

  _________________________________________________________________________________

  What is the IP address of the FTP server?

  _________________________________________________________________________________

5. Copy some files into the default anonymous directory on the FTP server.

FTP Client

6. Download, install, and open an FTP client freeware application. This lab has directions specifically 
for the SmartFTP client, but the steps for other applications are similar.

7. Usually, a client requires the following configuration:

>  Address of the FTP server

>  User login ID and password or anonymous login selected

  In the SmartFTP client, type in the FTP server IP address in the Address textbox > click the Anony-
mous button (option) > click the green arrow to connect. The FTP client displays the files that were 
copied into the anonymous directory.

Instructor initials: _____________

Tightening Security

8. Create a user on the FTP server. In Home FTP Server, click the New Member button > General tab > 
type a name in the User Name textbox > type class999 in the Password textbox.

  Make a note of the home directory and permissions for this user.

  _________________________________________________________________________________

9. Click Apply. Test the user account from the FTP client application by creating a new entry with the 
appropriate user ID and password. In SmartFTP, click the File menu option > select Disconnect to 
disconnect the previous login session. Click the File menu option > New Remote Browser > in the 
Host textbox, type the FTP server IP address > in the User Name textbox, type the exact username 
that was typed in the FTP server application > in the Password textbox, type class999 > in the 
Name textbox, type FTP with login > OK. The client connects to the FTP server.

Instructor initials: _____________

10. Within the client application, close the FTP session. For the SmartFTP client, use the Close button in 
the upper-right corner of the FTP with Login tab. Close all tabs and sessions.

11. Delete FTP client entries. From within SmartFTP client, click the Favorites menu option > Edit Fa-
vorites Quick Connect option in the left pane > click once on the FTP server IP address in the right 
pane > Edit menu option > Delete > Yes. Delete the FTP with login option using the same technique.

Instructor initials: ____________
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Lab 14.1 Windows Basic Usage: Working with the Traditional Desktop and Control Panel 
Utilities

Objective: To work effectively with the Windows 10 traditional desktop and the Windows 11 desktop, including accessing Control 
Panel utilities; managing the display through the Control Panel; performing file, folder, and computer searches; and ac-
cessing programs

Parts: Two computers with Windows 10/11 and a user account with administrator rights

Note: This lab could actually be done with one computer; in that case, only steps 17 and 18 cannot be completed.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on to Windows, if necessary. The desktop appears. The traditional Windows 10 desktop has a Start 
button in the lower-left corner, a taskbar along the bottom, and a notification area in the lower-right corner. In the default Windows 
11 desktop, the Start button is at the left of a group of buttons centered on the taskbar.

Searching for Files, Folders, Applications, and Computers

 Note: Windows Search can find files, folders, applications, contacts, emails, and other items on a computer. It can also return re-
sults from the internet. In Windows 10, it normally appears as a Type here to search textbox or as a Search icon to the right of the 
Start button. Windows 11 only has the Search icon. In both Windows 10 and Windows 11, the Type here to search textbox appears 
after you click the Search icon. Throughout the rest of this lab, we refer to the Type here to search textbox as the Search box or 
the Search function.

2. If you don’t see the Search textbox or icon in Windows 10, right-click on an empty space within the taskbar > select Search > 
Show search icon or Show search box. In Windows 11, right-click on an empty space within the taskbar and toggle the Search 
switch to On.

3. Type msconfig in the Search box and select System Configuration from the resulting list. (Note that the msconfig command 
is an important one for technicians because it launches the System Configuration utility.)

4. Click Cancel to close the System Configuration window.
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5. Search for the WordPad application and launch it. Type the following message:

 The function of education... is to teach one to think intensely and 
to think critically. But education which stops with efficiency may 
prove the greatest menace to society. The most dangerous criminal 
may be the man gifted with reason, but with no morals. - Dr. Martin 
Luther King, Jr.

6. Select the Save icon in the top-left corner (which looks like a floppy disk, ).

7. Ensure that the address bar shows that the file is being saved into Documents. If it is not, scroll in 
the left window to locate and select Documents. In the File name textbox, type Lab4test and click 
Save.

8. Use the Close button in the top-right corner to close WordPad.

9. Type lab in the Search box.

 Did your Lab4test file appear in the resulting search list? [ Yes | No ]

 If not, redo steps 5 through 9.

10. Open Windows File Explorer by clicking the yellow folder on the taskbar or right-click Start > select 
File Explorer. (Note that the search tool in File Explorer returns folders, files, and applications on the 
local computer. It can also find computers on the network.)

11. Select This PC. Type msconfig in the Search This PC textbox located in the upper-right corner and 
then press the ® key. Wait while the system searches for results.

12. In the resulting list, locate and double-click the msconfig utility (normally located in the C:\
Windows\System32 folder).

 List the five tabs in the System Configuration window.

  _________________________________________________________________________________

13. Click Cancel to close the System Configuration window. Close File Explorer.

14. Use the Control Panel > System and Security > System link to find your computer name. Notice that 
this opens Settings > System > About.

 Computer name: _____________________________

 Note: To use a Windows 10/11 computer to locate other computers on a network, you need to enable 
Network Discovery. Enabling Network Discovery is also required for a Windows 10/11 computer to 
be seen on a network.

15. Enable Network Discovery by accessing the Network and Internet Control Panel > Network and 
Sharing Center > Change advanced sharing settings > expand the section that shows your current 
profile by selecting the down chevron > enable Turn on network discovery > Save changes.

16. On your own computer, access File Explorer > select Network from the left column. If computers and 
devices are configured to be seen on the network, then they appear in the screen to the right.

17. Confirm that a classmate has completed steps 14 and 15. Document your classmate’s computer name.

 Second computer name: _____________________________

18. If the second computer from step 17 does not appear immediately, type second computer name 
in the File Explorer Search box and press the ® key. Ask your classmate if your computer ap-
pears in their File Explorer.

 Does the remote device appear? [ Yes | No ]

 Does your device appear in File Explorer on the remote device?

 [ Yes | No ]

Instructor initials: _____________
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TECH TIP

Obtaining Help

19. In the Search box on the taskbar, type help. Click the Get Help app. You can use the Search box in 
the center to search for specific help topics, or you can access the links for common searches.

20. Type monitor quality in the Search box and press ®.

 List two solutions suggested to improve display quality.

  _________________________________________________________________________________

  _________________________________________________________________________________

21. To see a list of troubleshooting topics, type troubleshooting in the Search box.

22. Close the Get Help app.

Working with the Taskbar

23. Right-click on an empty space within the taskbar. (Recall that the taskbar is the bar that runs across 
the bottom of the display.)

 List the options available in the context menu.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 In Windows 10, how can you tell if the taskbar is locked or unlocked without moving it? (Note that 
the Windows 11 taskbar cannot be unlocked.)

  _________________________________________________________________________________

  _________________________________________________________________________________

24. Review the items available in the notification area. Note that you may have to select an up arrow to 
see additional items.

 List three system icons that can be customized within the notification area.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Working with Control Panels

25. Access the Control Panel by typing control in the Search box > select Control Panel.

Different ways to access Control Panel utilities in Windows 10

> Type control in Type here to search textbox > select Control Panel.

> After searching for Control Panel, right-click the icon > select Pin to Start so you have a Control Panel 
tile on the Start menu or select Pin to taskbar so it will be available on the traditional desktop taskbar.

> With the Control Panel window open, locate the words Control Panel in the address bar > select and 
drag the words Control Panel to the desktop so that a shortcut icon will be created.

 Note: The Control Panel option gives you access to Control Panel icons or links used to configure the 
computer. There are two basic ways to view Control Panels: the classic view (small and large icons for 
each Control Panel) and category view (where eight major categories are shown with a few links under 
each category but more links are available after you select the link). The default view is by category.
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26. To ensure that you are in the default view, locate and select the View by down arrow on the top right > 
ensure that Category is selected.

 List two Control Panel categories shown on the screen.

  _________________________________________________________________________________

  _________________________________________________________________________________

27. Select Large Icons or Small Icons in the View by drop-down menu. This view is the older method for 
accessing any particular Control Panel utility. Return to the category Control Panel view.

28. Using Lab Table 14.1 as a reference, complete Lab Table 14.2. Explore the Windows Control Panel 
and document in Lab Table 14.2 which Control Panel category and subcategory you would use to 
perform particular tasks. Note that some systems have special Control Panel utilities because of the 
type of computer being used. Also, some of the options are found in multiple categories.

LAB TABLE 14.1 Common Windows 10/11 Control Panel categories*

Control Panel 
category

Subcategory Function

System and Security Security and 
Maintenance

Review computer’s status and resolve issues; scan for 
viruses. 

Windows 
Defender 
Firewall

Prevent access to the computer through the internet or 
a network.

System View basic computer properties, such as RAM, 
processor type, and computer name.

Power Options Configure power-saving modes.

File History Automatically save backup copies of files.

Backup 
and Restore 
(Windows 7)

Save or restore files and folders to or from a different 
location.

BitLocker Drive 
Encryption

Change or use encryption options.

Storage Spaces Save files to two or more drives to help protect against 
a single drive failure.

Work Folders Make files available on all devices, even when offline.

Administrative 
Tools

Free up hard disk space, manage hard drive partitions, 
schedule tasks, and view event logs.

Network and 
Internet

Network and 
Sharing Center

Check the status and modify network-related settings 
as well as share files, folders, and devices on the 
network.

Internet Options Customize settings for internet browsers.

Hardware and 
Sound

Devices and 
Printers

Add/remove/configure devices, scanners, cameras, 
printers, and mice and access Device Manager.

AutoPlay Change how media is automatically handled when a 
disc, flash drive, or type of file is added or inserted.

Sound Manage audio devices and change sound schemes.

Power Options Configure power-saving modes.

Pen and Touch Configure pen options for tablet devices.
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Control Panel 
category

Subcategory Function

Tablet PC 
Settings

Configure tablet and screen settings on a tablet PC.

Display Adjust resolution, configure an external display, or 
make text larger/smaller.

Programs Programs and 
Features

Uninstall or change programs as well as turn 
Windows features such as containers, Hyper-V, and 
TFTP client on or off.

Default 
Programs

Remove a startup program, associate a file extension 
with a particular application, or select the program 
used with a particular type of file.

Appearance and 
Personalization

Taskbar and 
Navigation

Select items that appear on the taskbar and control 
the behavior of the taskbar.

Ease of Access 
Center

Make the computer easier to use, especially for those 
with physical or visual limitations.

File Explorer 
Options

Control the appearance and behavior of folders, files, 
shortcuts, and links. Also configure search options. 

Fonts Preview, install, delete, and configure fonts.

User Accounts User Accounts Add, remove, or modify accounts on the computer.

Credential 
Manager

Manage saved logon information for websites, 
connected applications, and networks.

Mail Configure email accounts and email storage 
directories.

Clock and Region Date and Time Configure time, date, time zone, and clocks for 
different time zones.

Region Configure the format for date, time, currency, and 
other region-specific options and customize keyboard 
settings.

Ease of Access Ease of Access 
Center

Make the computer easier to use, especially for those 
with physical or visual limitations.

Speech 
Recognition

Configure built-in speech recognition system.

* Note that you can find particular options by typing in the subcategory in the Search Control Panel textbox.

Fill in Lab Table 14.2 with the correct Control Panel category and subcategory.

LAB TABLE 14.2 Determine the correct Control Panel categories and subcategories

Task Control Panel category Control Panel subcategory

Configure the mouse 
buttons for a left-handed 
person.

Mute the computer speaker 
sound.

Configure the date to be in 
the format April 15, 202X.
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Task Control Panel category Control Panel subcategory

Define how quickly a 
character repeats when a 
specific key is held down.

Define what page (home 
page) appears every time 
Edge starts.

Configure an IP address on 
a wired or wireless network 
adapter.

Set a printer as the default 
printer.

Verify if Windows 
recognizes a particular 
piece of hardware.

Working with the Display

29. Some items that were in Control Panel in previous versions of Windows have been moved to Settings 
in Windows 10 and Windows 11. For example, Display has been moved from the Hardware and 
Sound Control Panel to Settings > System > Display.

 Access the display settings by right-clicking Start > Settings > System > Display. Another option is 
to right-click on a blank area of the Desktop > select Display settings. Answer the questions below. 
Note that you may be required to search throughout this area and select various options. Also, you 
may have to use another application to control your display settings, depending on the manufacturer 
of your computer and the manufacturer of your display adapter.

 What is the current resolution?

  _________________________________________________________________________________

 What is the orientation?

  _________________________________________________________________________________

30. Continue working within the Display window. Locate and select the Advanced display settings 
(Advanced display in Windows 11) link.

 What adapter is used?

  _________________________________________________________________________________

 What is the bit depth?

  _________________________________________________________________________________

 Click Display adapter properties for Display X (where X is system dependent).

 How much video memory (that is, dedicated video memory) does the adapter have?

  _________________________________________________________________________________

 How much total graphics memory is available?

  _________________________________________________________________________________

31. Select the Monitor tab.

 What refresh rate is used?

  _________________________________________________________________________________
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32. Click Cancel on this window and go to the desktop. Right-click on a blank area of the desktop > 
select Personalization/Personalize > Lock screen.

 What lock screen, if any, is currently set?

  _________________________________________________________________________________

33. In Windows 10, select Pictures for Background if it isn’t already selected. In Windows 11, select 
Pictures for Personalize your lock screen. Several pictures are displayed below Choose your picture. 
Click each picture to see a preview of the lock screen. Return the lock screen to the original setting 
(see the answer to Question 32).

Dealing with Power Settings

34. Return to the Control Panel. Select Hardware and Sound > Power Options. The Power Options 
window appears. Lab Table 14.3 shows the various power options available in Windows 10/11.

 What power option would a teacher use when using a laptop to teach a four-hour class?

  _________________________________________________________________________________

LAB TABLE 14.3 Windows 10/11 default power schemes*

Power scheme Purpose

Balanced Default mode; processor adapts to activity being performed; performance 
provided when the computer is in use; power savings when the computer 
is inactive. Display powers down after 10 minutes, hard drive powers down 
after 20 minutes, and system goes to sleep after 30 minutes.

Power saver Provides maximum battery life for mobile devices. Display and hard drive 
power down after 5 minutes, and the system goes to sleep after 15 minutes.

High 
performance 

Maximum system performance and responsiveness. Display powers down 
after 5 minutes, and hard drive powers down after 20 minutes, but the 
system never sleeps.

Customized A scheme created by the user that has different settings than the three 
default schemes.

* Note that a computer manufacturer may provide additional power schemes. Also, additional settings may be available for 
laptops.

35. Close all windows.

Changing UAC (User Account Control) settings

Windows has a UAC dialog box that appears, asking for permission to do something. The UAC feature 
is intended to give you a moment to think before you make significant changes to a system. To change 
UAC settings, use the User Accounts Control Panel > select User Accounts > Change User Account 
Control settings > move the UAC control slider to have more notifications, fewer notifications, or no 
notifications > OK.

The UAC settings can also be accessed through the System Configuration (msconfig command) > 
Tools tab > Change UAC Settings > Launch button > select the appropriate level > OK.

Recycle Bin

36. Open File Explorer > locate the Lab4test document created earlier in the lab. Ensure that the file 
is visible in the right window.
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TECH TIP

37. Right-click on the Lab4test filename. Notice that there is a Delete option (a trashcan icon in 
Windows 11). Do not click this option. This is just one way you could delete the file, but here you 
are going to use a different way. With the Lab4test filename still highlighted (but no context menu 
showing), press the ∂ key. The file is sent to the Recycle Bin.

 The Recycle Bin is just a folder on the hard drive that holds deleted files and folders. When a file 
or folder is deleted, it is not immediately discarded; instead, it goes into the Recycle Bin folder. A 
deleted file or folder can be removed from the Recycle Bin. This is similar to retrieving a piece of 
trash from an office trash can. A technician must remember that the files and folders in the Recycle 
Bin take up hard drive space and that users frequently forget to empty these deleted files and folders.

Files deleted from the Recycle Bin cannot be retrieved

After the Recycle Bin has been emptied, the deleted files cannot be recovered without the use of 
special software.

38. Locate the Recycle Bin icon on the desktop and double-click it. If the Recycle Bin is not on the 
desktop, search for the Recycle Bin folder.

 Does the Lab4test WordPad document appear in the Recycle Bin window?

 [ Yes | No ] If no, redo the steps in this lab to create and delete the file.

39. Select Empty Recycle Bin from the Recycle Bin Tools menu ribbon option. A confirmation window 
appears, asking if you are sure you want to permanently delete the items in the recycle bin. Select 
Yes. The Lab4test document disappears from the Recycle Bin window (as do any other files that 
were located in the Recycle Bin). Close the Recycle Bin window.

Lab 14.2 Windows 10 Basic Usage: Introduction to the Start Menu

Objective: To work effectively with the Windows 10 Start menu

Parts: Desktop computer with Windows 10 and a user account with administrator privileges

Procedure: Complete the following procedure and answer the accompanying questions.

Working with the Windows 10 Start Menu

1. Power on the computer and log on to Windows 10.

 On Windows 10 desktop computers, the screen that displays after a user logs in is configurable. It 
can be the traditional desktop or it can be tablet mode. The traditional desktop has small icons that 
represent files, folders, applications, or other items. Tablet mode has large tiles similar to the Start 
screen, which was introduced in Windows 8/8.1. Tablet computers can only use tablet mode.

 Which type of screen do you see?

 a.  The traditional Windows desktop with labeled shortcuts (links to applications, websites, 
accessories and folders), a Start button in the lower-left corner, and a taskbar across the bottom

 b.  The Windows tablet mode with Pinned tiles and All apps buttons in the upper left corner, square 
tile shortcuts (links to applications, websites, accessories and folders), and a taskbar across the 
bottom

  In this lab you will examine the Start menu, which is a component of the traditional desktop.



 LAB 14: Introduction to Operating Systems Labs 129

LA
B 1

4

2. Right-click the Start button > select Settings > type tablet in the Search box > select Tablet 
settings.

 Document your current setting for When I sign in so that you can reinstate it later in the lab.

 When I sign in [ Always use tablet mode | Never use tablet mode | Use the appropriate mode for my 
hardware ]

 If it’s not already selected, choose Never use tablet mode for the When I sign in option.

3. Click the Start button. The Start menu opens. To see what options are available on the Start menu, 
begin by opening Settings using one of the following methods:

 > Right-click the Start button in the bottom-left corner > select Settings.

 > Hold down the  key and press the i key.

 > Click the Start button > select the icon that has three horizontal lines (located in the top-left cor-
ner) > select Settings from the resulting menu.

 > Click the Start button > click the icon that looks like a bulleted list (located in the top-left corner) 
> scroll down and select Settings.

  Note: You might not have all these methods available, depending on the type of device or 
configuration settings.

4. Select Personalization > select Start.

 Document your current settings so that you can reinstate them later in the lab. Be sure to document 
any additional settings that are not listed below.

  > Show more tiles on Start [ On | Off ]

  > Show app list in Start menu [ On | Off ]

  > Show recently added apps [ On | Off ]

  > Show most used apps [ On | Off ]

  > Show suggestions occasionally in Start [ On | Off ]

  > Use Start full screen [ On | Off ]

  >  Show recently opened items in Jump Lists on Start or the taskbar and in File Explorer Quick 
Access [ On | Off ]

5. Set all options to the Off position. Select the Choose which folders appear on Start link at the bottom 
of the pane.

 Document your current settings so that you can reinstate them later in the lab.

  > File Explorer [ On | Off ]

  > Settings [ On | Off ]

  > Documents [ On | Off ]

  > Downloads [ On | Off ]

  > Music [ On | Off ]

  > Pictures [ On | Off ]

  > Videos [ On | Off ]

  > Network [ On | Off ]

  > Personal folder [ On | Off ]

6. Set all the options to Off. Close the Settings window.
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7. Click the Start button.

 What menu options appear directly above the Start button?

  _________________________________________________________________________________

  _________________________________________________________________________________

8. Select the All apps option > scroll down and select Settings > Personalization > select the Start 
option.

9. Turn on the Show more tiles on Start option. Click the Start button.

 How did the Start menu change (if at all)?

  _________________________________________________________________________________

 Enable the Show suggestions occasionally in Start option. How did the Start menu change, if at all?

  _________________________________________________________________________________

10. Lab Table 14.4 shows the purpose of each of the Windows 10 Start menu/screen options. Lab Figure 
14.1 shows where some of these options would be located on the Start menu. Explore these options to 
see their effects.

LAB TABLE 14.4 Windows 10 Start menu/screen settings

Setting Purpose

Show more tiles on Start Shows one more column of tiles. Note that you can drag 
the edge of a tile to make it any size you want.

Show app list in Start menu Shows the app list without requiring the user to click the 
All apps icon.

Show recently added apps Lists the apps that have been installed recently.

Show most used apps Dynamically populates with the most commonly used apps.

Show suggestions occasionally in 
Start

Displays ads for suggested apps.

Use Start full screen Uses a Start screen that is more like the Windows 8 full 
screen tiles view, where you use the All apps icon in the 
left-top corner to access apps.

Show recently opened items in 
Jump Lists on Start or the taskbar 
and in File Explorer Quick Access

Shows jump lists, which include recently used documents, 
websites, and so on related to a particular app. Right-
clicking an app icon in the Start menu allows you to see 
the associated jump list.

Choose which folders appear on 
Start

Determines which folders appear at the bottom of the Start 
menu for easy access.

11. Within the Start settings, ensure that the Use Start full screen option is Off. Access the Choose which 
folders appear on Start link at the bottom of the right pane. Review the list of available folders. Se-
lect up to three folders. Click the arrow in the upper-left corner to return to the Start settings main 
page.

12. Change several of the settings and re-access the Start screen. Confirm your configurations from this 
step and the previous step.

 List which options you think would be most beneficial for people in a work environment.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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Power
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to appear on Start

LAB FIGURE 14.1 Windows 10 Start menu areas

Manipulating the Start Screen

13. Within the Personalization > Start settings, ensure that the Use Start full screen option is On. When 
this option is on, the Start menu is called the Start screen.

14. Re-access the Start screen by selecting the Start icon from the desktop.

15. Examine the tiles shown on the Start screen.

 Which tile is currently located in the far-left position?

  _________________________________________________________________________________

16. Select and drag the tile located in the far-left position to the last position in the first block of tiles. 
Then return the tile to the original position.

17. To add a tile that represents an app to the Start screen, access the All apps icon that looks like a 
bulleted list. Select the Windows Accessories menu item and locate but do not select the Notepad 
application. Right-click the Notepad option. A context menu appears. Move the pointer to the More 
option to see the other options that are available.

 Which additional options are available?

  _________________________________________________________________________________

18. Press the escape key to return to the main context menu. Select the Pin to Start option. While still on 
the Start screen, select the Pinned tiles icon (which looks like two squares and two rectangles) in the 
upper-left corner. A Notepad tile is now in the Start screen. Right-click the Notepad tile.

 List the options available in the context menu.

  _________________________________________________________________________________

19. Tap or select the Notepad tile. The Notepad application window opens. Close the window using the 
Close button in the upper-right corner.

20. Re-access the Start screen using whatever method you prefer. Locate the Notepad tile and right-click 
it to access the context menu.

21. Hover the pointer over the Resize option.

 What choices do you have?

  _________________________________________________________________________________
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22. Select a different tile size than the one currently used. Re-access the Notepad tile context menu > select 
More option > select Open file location. Windows File Explorer opens, showing the folder that contains 
this file (and other files in the same folder). Notice that the Notepad option is a shortcut. You can tell 
because the icon on the left has a bent arrow on it. Also, in the Type column, you can see the word 
Shortcut.

23. To see where the original file is located, right-click the Notepad icon from within File Explorer > 
select Properties. Ensure that the Shortcut tab is selected. The Target textbox shows where the actual 
file is located. %windir% is a variable used to describe the folder where Windows was installed. 
Commonly it is C:\Windows, but because this might be on another drive letter or installed to a 
different folder, Microsoft simply describes it as %windir%. The full path for the Notepad application 
is commonly C:\Windows\Systems32\notepad.exe.

24. Click Cancel to return to File Explorer. Close File Explorer and return to the Start screen (the one 
with the tiles).

25. Re-access the Notepad context menu > select Unpin from Start.

Conducting Searches
 Note: Searches in Windows 10 can be conducted through the taskbar, using the Search here to search 

textbox. Note that if you have the Cortana feature turned on, you can speak or type questions or con-
duct searches through that interface. To ensure that everyone is on the same page, you need to docu-
ment some original configuration settings and, if necessary, change them.

26. On the Start screen, start typing search (note that you do not have to click anywhere in the Start 
screen) and select Windows Search settings from the resulting list.

 Document the device’s current settings related to searching. Note that you may have to explore the 
links to find answers. Document any additional settings.

 >  Find My Files [ Classic | Enhance ]

 Under Permissions & History:

 >  SafeSearch [ Strict | Moderate | Off ]

 >  Microsoft Account [ On | Off ]

 >  Work or School account [ On | Off ]

 >  History [ On | Off ]

27. Ensure that History is turned On.

28. Select the Search icon from the taskbar. Type comm in the textbox. A list including Best match, Apps, 
Store, Search school and web, People, Settings, and/or other possible categories appears. Select the 
Command Prompt option. The Command Prompt window appears. Close the Command Prompt 
window by using the Close button in the top-right corner.

29. Re-access the Search function and type word. In the resulting list, right-click on the WordPad app. 
Notice from the search results that you still have access to the context menu that allows you to pin a 
particular app to the Start menu or taskbar. You also have the option to run an app as an administrator. 
This is sometimes required with Windows utilities used by technicians, although it is not needed with 
WordPad. Click away from the search list.

30. In the textbox at the bottom of the list, remove word and type trinkets instead. Notice that 
because there is nothing in the Windows 10 environment related to trinkets, web links are provided if 
this computer is connected to the internet. Select somewhere away from the search list.

Power Button Options

31. Click the Power button icon in the Start menu. It is a circle with a vertical line that extends through the 
top part of the circle ( ). Lab Table 14.5 explains the various power button options that you might see.
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LAB TABLE 14.5 Windows 10 power button shutdown options

Option Purpose

Restart Used when new software or hardware has been installed or when the computer locks.

Sleep Reduces power consumption. Stores the current state of open files and settings in 
RAM.

Hibernate Reduces power consumption even more than does the sleep mode. Saves the 
current state of open files and settings to the hard disk. Takes longer to resume 
operations than sleep mode but not as long as with a cold boot.

Shut down Powers off the computer. 

Update and 
restart

Applies pending updates and then restarts the system.

Update and 
shut down

Applies pending updates and then shuts down the system.

 What options are available?

  _________________________________________________________________________________

  _________________________________________________________________________________

User Account Options

32. Click the User account options icon in the Start menu. It is a circle with a figure of a person inside the 
circle and the current user’s name beside it. Lab Table 14.6 explains the various user account options 
that might be seen.

LAB TABLE 14.6 Windows 10 user account options

Option Purpose

Change account 
settings

Opens Settings > Accounts > Your info to allow configuration of a Microsoft 
account, a picture, and other settings.

Lock Returns the system to the login screen. The current user can log in again to 
resume the current session, or another user can log in to their account. If 
the system shuts down or restarts while an account is locked, the current 
state of the user’s open documents or files might be lost.

Sign out Reduces power consumption even more than does the sleep mode. Saves 
the current state of applications and settings to the hard disk. Takes longer 
to resume operations than sleep mode but not as long as with a cold boot.

 What options are available?

  _________________________________________________________________________________

Controlling the Desktop

 Note: The desktop is the main screen area that you see when you log in to Windows 10. You can 
customize what is shown on the desktop and the default options, just as you can with the Start menu.

33. Right-click on an empty space on the desktop > point to the View option.

 What options are available in the context menu?

  _________________________________________________________________________________

 What options are currently enabled?

  _________________________________________________________________________________
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34. If necessary, select the Show desktop icons option to disable it (that is, remove the check mark beside 
the option).

 What changed?

  _________________________________________________________________________________

35. Re-access the View context menu and ensure that the Show desktop icons option is set to the original 
configuration.

Task View

 Note: On the taskbar is the Task View option, which allows you to view thumbnails of open apps and 
easily switch between them. In this section, you will see how the Task View option works.

36. Open the Notepad, Snipping Tool, and Command Prompt apps.

37. Find and select the Task View option, which is located to the right of the Search box on the taskbar. 
It has a rectangle in the center and a vertical line on the side. If you hold your cursor over the icon, it 
changes to two rectangles.

 What happened when you selected the Task View option?

  _________________________________________________________________________________

38. Locate and select the Notepad app. Note that you may have to select a down arrow below the 
thumbnails to see more thumbnails if you have more apps open than can fit on the screen. Leave 
these apps open.

 Note: Task View can also be used to create more than one desktop. It enables you to have one or 
more apps open within one desktop and different apps open within another desktop. Then you can use 
Task View to easily swap between them.

39. Re-access Task View from the taskbar.

40. Select the New desktop option from the top of the Task View desktop.

41. Access the new desktop by clicking that numbered desktop (usually Desktop 2).

42. On the new desktop, open the WordPad app.

43. Select the Task View taskbar option again. The multiple desktops appear. Hover the mouse pointer 
over the first desktop (Desktop 1), and all open apps appear in the window above. Move the pointer to 
the desktop you just created, and the WordPad app thumbnail appears.

 Note: Virtual desktops are not totally separated from one another. For example, if you enable the Use 
Start full screen option, it will be enabled across all desktops.

44. Ensure that the pointer is pointing toward the last desktop that was just created (usually Desktop 2). 
Click the X in the upper-right corner to delete that virtual desktop. If you have clicked within that 
virtual desktop and see the opened WordPad app, you are in the wrong place. Click the Task View 
icon on the taskbar and then hover the pointer over the miniature icon representing the last desktop 
created. Then click the X in the upper-right corner to delete that particular virtual desktop.

45. In the original desktop, close any apps you have open (for example, Notepad, Snipping Tool, and 
Command Prompt).

Getting the Machine Back in Order

46. Referring to steps 2, 4, 5, 26, and 33, return all settings to their original configuration.

47. Have a classmate verify that the settings are configured properly.

 Are the computer settings back to the original configuration, as listed in steps 2, 4, 5, 26, and 33?  
[ Yes | No ]

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________
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Lab 14.3 Windows 11 Basic Usage: Introduction to the Start Menu

Objective: To work effectively with the Windows 11 Start menu

Parts: Desktop computer with Windows 11 and a user account with administrator privileges

Procedure: Complete the following procedure and answer the accompanying questions.

Working with the Windows 11 Start Menu

1. Power on the computer and log on to Windows 11.

  Note: In this lab you will examine the Start menu, which is a component of the Windows 11 desktop. 
By default, the Windows 11 Start button is at the left of a group of icons in the center of the taskbar.

2. To move these icons to the left of the taskbar (as in the traditional Windows desktop), right-click the 
taskbar > click Taskbar settings > Taskbar behaviors > select Center for Taskbar alignment.

3. Click the Start button. The Start menu opens. To see what options are available on the Start menu, 
open Settings using one of the following methods:

 > Right-click the Start button in the bottom-left corner > select Settings.

 > Click the Start button > Settings.

 > Hold down the  key and press the i key.

  Note: You might not have all these methods available, depending on the type of device or 
configuration settings.

4. Select Personalization > select Start.

 Document your current settings so that you can reinstate them later in the lab. These settings control 
the options available when you click the Start button. Be sure to document any additional settings that 
are not listed below.

  > Show recently added apps [ On | Off ]

  > Show most used apps [ On | Off ]

  > Show recently opened items in Start, Jump Lists, and File Explorer [ On | Off ]

5. Set all options to the Off position. Click the These folders appear on Start next to the Power button 
arrow.

 Document your current settings so that you can reinstate them later in the lab.

  > Settings [ On | Off ]

  > File Explorer [ On | Off ]

  > Documents [ On | Off ]

  > Downloads [ On | Off ]

  > Music [ On | Off ]

  > Pictures [ On | Off ]

  > Videos [ On | Off ]

  > Network [ On | Off ]

  > Personal folder [ On | Off ]

6. Set all the options to Off. Close the Settings window. Click the Start button to open the Start menu.

 What options appear at the bottom of the Start menu?

  _________________________________________________________________________________

  _________________________________________________________________________________
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7. Select the All apps option > scroll down and select Settings > Personalization > select the Start 
option.

 Lab Table 14.7 shows the purpose of each of these options. Lab Figure 14.2 shows where these 
options would be located on the Start menu. Explore these options to see their effects.

LAB TABLE 14.7 Windows 11 Start button settings

Setting Purpose

Show recently added apps Lists the apps that have recently been installed.

Show most used apps Dynamically populates with the most commonly used apps.

Show recently opened items 
in Start, Jump Lists, and File 
Explorer

Shows jump lists, which include recently used documents, 
websites, and so on related to a particular app. Right-clicking 
an app icon in the Start menu allows you to see the associated 
jump list.

These folders appear on Start 
next to the Power button

Determines which folders appear at the bottom of the Start 
menu for easy access.

Pinned apps

Recently
added app

All pinned
apps

All recently
opened files

Power

Folders selected
to appear on Start

Recently
opened files

Logged on
user

LAB FIGURE 14.2 Windows 11 Start menu areas

8. Within the Start settings, ensure that the Use Start full screen option is Off. Access the These folders 
appear on Start next to the Power button link at the bottom of the right pane. Review the list of 
available folders. Select up to three folders. Click the arrow in the upper-left corner to return to the 
Start settings main page.

9. Change several of the settings and re-access the Start screen. Confirm your configurations from this 
step and step 8.

 List which options you think would be most beneficial for people in a work environment.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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Conducting Searches

 Note: Searches in Windows 11 can be conducted through the taskbar, using the Search function. Note 
that if you have the Cortana feature turned on, you can speak or type questions or conduct searches 
through that interface. To ensure that everyone is on the same page, let’s document some original 
configuration settings and, if necessary, change them.

10. Open the Start menu and type search (note that you do not have to click anywhere in the Start 
menu) and select Windows Search settings from the resulting list.

 Document the device’s current settings related to searching. Note that you may have to explore the 
links to find answers. Document any additional settings.

  > Respect power settings when indexing [ On | Off ]

 >  Find my files [ Classic | Enhance ]

 >  Exclude folders from enhanced search (List the excluded folders: _______________)

 >  Advanced indexing options > Index these locations (List the locations: _______________)

11. Select the Search icon from the taskbar. Type comm in the textbox. A list including Best match, Apps, 
Store, Search school and web, People, Settings, and/or other possible categories appears. Select the 
Command Prompt option. The Command Prompt window appears. Close the Command Prompt 
window by using the Close button in the top-right corner.

12. Re-access the Search function and type word. In the resulting list, right-click on the WordPad 
app. Notice from the search results that you have access to a context menu that allows you to pin a 
particular app to the Start menu or taskbar. You also have the option to run an app as an administrator. 
This is sometimes required with Windows utilities used by technicians, although it is not needed with 
WordPad. Click away from the search list.

13. In the textbox at the top of the list, remove word and type trinkets instead. Notice that because 
there is nothing in the Windows 11 environment related to trinkets, web links are provided if this 
computer is connected to the internet. Select somewhere away from the search list.

Power Button Options

14. Click the Power button icon in the Start menu. It is a circle with a vertical line that extends through 
the top part of the circle ( ). Lab Table 14.8 explains the various power button options that might be 
seen.

LAB TABLE 14.8 Windows 11 power button options

Option Purpose

Restart Used when new software or hardware has been installed or when the computer 
locks.

Sleep Reduces power consumption. Stores the current state of open files and settings 
in RAM.

Hibernate Reduces power consumption even more than does the sleep mode. Saves the 
current state of open files and settings to the hard disk. Takes longer to resume 
operations than sleep mode but not as long as with a cold boot.

Shut down Powers off the computer. 

Update and 
restart

Applies pending updates and then restarts the system.

Update and 
shut down

Applies pending updates and then shuts down the system.
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 What options are available?

  _________________________________________________________________________________

  _________________________________________________________________________________

User Account Options

15. Click the User account options icon in the Start menu. It is a circle with a figure of a person inside 
the circle and the current user’s name beside it. Lab Table 14.9 explains the various user account 
options that might be seen.

LAB TABLE 14.9 Windows 11 user account options

Option Purpose

Change account 
settings

Opens Settings > Accounts > Your info to allow configuration of a Microsoft 
account, a picture, and other settings.

Lock Returns the system to the login screen. The current user can log in again to 
resume the current session, or another user can log in to their account. If the 
system shuts down or restarts while an account is locked, the current state of 
the user’s open documents or files might be lost.

Sign out Reduces power consumption even more than does the sleep mode. Saves 
the current state of applications and settings to hard disk. Takes longer to 
resume operations than sleep mode but not as long as with a cold boot.

 What options are available?

  _________________________________________________________________________________

  _________________________________________________________________________________

Controlling the Desktop

 Note: The desktop is the main screen area that you see when you log in to Windows 11. You can 
customize what is shown on the desktop and the default options, just as you can with the Start menu.

16. Right-click on an empty space on the desktop > point to the View option.

 What options are available in the context menu?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What options are currently enabled?

  _________________________________________________________________________________

17. If necessary, select the Show desktop icons option to disable it (that is, remove the check mark beside 
the option).

 What changed?

  _________________________________________________________________________________

18. Re-access the View context menu and ensure that the Show desktop icons option is set to the original 
configuration.

Task View

 Note: On the taskbar to the right of the Search box is the Task View option, which allows you to view 
thumbnails of open apps and easily switch between them. In this section, you will see how the Task 
View option works.

19. Open the Notepad, Snipping Tool, and Command Prompt apps.
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20. Locate and select the Task View option on the taskbar. It has a black rectangle overlapping a white 
rectangle.

 What happened when you selected the Task View option?

  _________________________________________________________________________________

21. Locate and select the Notepad app. Note that you may have to scroll within a screen to see more 
thumbnails if you have more apps open than can fit on the screen. Leave these apps open.

 Note: Task View can also be used to create more than one desktop. That way you can have one or 
more apps open within one desktop and different apps open within another desktop. Then you can use 
Task View to easily swap between the desktops.

22. Re-access Task View from the taskbar.

23. Select the New desktop option from the bottom of the Task View desktop.

24. Access the new desktop by clicking that numbered desktop (usually Desktop 2).

25. On this desktop, open the WordPad app.

26. Select the Task View taskbar option again. The multiple desktops show. Hover the mouse pointer over 
the first desktop (Desktop 1), and all open apps appear in the window above. Move the pointer to the 
desktop you just created, and the WordPad app thumbnail appears.

 Note: Virtual desktops are not totally separated from one another. For example, if you disable the 
Show desktop icons option, it will be disabled across all desktops.

27. Ensure that the pointer is pointing toward the last desktop that was just created (usually Desktop 2). 
Click the X in the upper-right corner to delete that virtual desktop. If you have clicked within that 
virtual desktop and see the opened WordPad app, you are in the wrong place. Click the Task View 
icon on the taskbar and then hover the pointer over the miniature icon representing the last desktop 
created. Then click the X in the upper-right corner to delete that particular virtual desktop.

28. In the original desktop, close any apps you have open (for example, Notepad, Snipping Tool, and 
Command Prompt).

Getting the Machine Back in Order

29. Referring to steps 4, 5, 10, and 16, return all settings to their original configuration.

30. Have a classmate verify that the settings are configured properly.

 Are the computer settings back to the original configuration, as listed in steps 4, 5, 10, and 16?  
[ Yes | No ]

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

Lab 14.4 Windows 10/11 Basic Usage: Introduction to Settings

Objective: To be familiar with the Windows 10/11 Settings

Parts: Computer with Windows 10/11 installed

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

Working with Windows 10/11 System Settings

1. Power on the computer and log on to Windows.

2. Right-click the Start button to access Settings.

 Note: Settings provides more configurable options in Windows 10/11 than does Control Panel. Some 
configuration items have been moved from Control Panel to Settings. Some options in Settings open 
Control Panels.
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3. Select the System option from the Settings screen and look over the list.

 Which option(s) are you curious about?

  _________________________________________________________________________________

4. Select the Display setting. This setting is commonly used to set the size of text and the orientation of 
the display, and it shows the number of displays detected.

 What is the current orientation? [ Landscape | Portrait | Landscape (flipped) | Portrait (flipped) ]

5. Change the orientation to something else, such as Landscape (flipped). Select Keep changes. If you 
cannot select an option, the display automatically changes back to the original setting, allowing you 
to try again.

 What happened?

  _________________________________________________________________________________

  _________________________________________________________________________________

 If necessary, change the orientation back to the original orientation.

 What is the current resolution?

  _________________________________________________________________________________

6. Select the Display resolution drop-down menu. Normally, you will see (Recommended) beside the 
resolution that is best for the screen being used.

 What is the recommend resolution?

  _________________________________________________________________________________

7. Select the Multitasking option in the left pane in Windows 10 or in the right pane in Windows 11. The 
Multitasking option has items related to snapping and resizing windows, as well as virtual desktop 
settings that relate to Task View (covered in Labs 14.2 and 14.3).

 What is the current setting for On the taskbar, show windows that are open (Windows 10) or On the 
taskbar, show all the open windows (Windows 11)?

 [ Only the desktop I’m using | All desktops ]

8. Select the System > Power & sleep (Windows 10) or Power (Windows 11) option. This is where 
you can configure power settings for the system. The options available depend on the hardware 
specifications for your computer.

 After what period of inactivity will the screen turn off?

  _________________________________________________________________________________

 After what period of inactivity will the PC go to sleep?

  _________________________________________________________________________________

 Could you configure a Windows 10 or Windows 11 computer so that it never goes to sleep?

 [ Yes | No ]

9. Select the Additional power settings link. Notice that you are taken to the Power Options Control 
Panel utility, discussed in Lab 14.1. You can navigate here via Control Panel > Hardware and Sound 
> Power Options.

10. Attach a flash drive to the PC.

11. Open the System > Storage settings. Click View storage usage on other drives (Advanced storage 
settings > Storage used on other drives in Windows 11). Select the flash drive that has just been 
attached. Windows categorizes the type of documents found on the drive (system files, apps and 
features, documents, pictures, music, videos, maps, temporary files, and others) and shows you how 
much of each type are on the chosen file media.



 LAB 14: Introduction to Operating Systems Labs 141

LA
B 1

4

 Return to the Storage settings screen and click the Change where new content is saved link 
(Advanced storage settings > Where new content is saved in Windows 11).

 Use Lab Table 14.10 to document current save locations.

LAB TABLE 14.10 Windows 10/11 save locations

Option Current setting

New apps will save to

New documents will save to

New music will save to

New photos and videos will 
save to

New movies and TV shows 
will save to

Change where you store your 
offline maps

 Describe a situation in which you think someone might want to change one or more of these settings.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

12. Return to the System settings. On the left menu in Windows 10 or the right pane in Windows 11, 
select and access the About setting. This screen is full of information that is important to an IT 
person.

 List five items that you think might be useful to a technical person that are not usually useful to end 
users.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Can you rename the computer from this window? [ Yes | No ]

 From the Related settings area, select the Device Manager link. Does the Device Manager tool open 
in another window or display within the settings window?

 [ Another window | Same window ]

13. Close any Control Panel or Device Manager window that is open. Return to the main Settings 
window.

Devices

14. Select the Devices setting in Windows 10 or Bluetooth and devices in Windows 11. This setting is 
used to quickly see and configure attached devices. Rather than go through each option, answer some 
questions in each section to make sure you are looking at important options. Explore the different 
options to answer the questions.

 Does the Printers & scanners option have any settings related to devices other than printers and scan-
ners? [ Yes | No ] If yes, explain what is there.

  _________________________________________________________________________________
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 Can you configure Bluetooth devices through the Bluetooth & other devices link in Windows 10 or 
Devices in Windows 11?

 [ Yes | No ]

 Does the attached flash drive appear as a connected device? [ Yes | No ]

 List two connected devices under Bluetooth & other devices in Windows 10 or Devices in Windows 11.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Describe which steps can be taken so the PC can be found by other Bluetooth devices. Note that not 
all devices have Bluetooth installed. Write “not applicable” as an answer if this is the case.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Which button is the primary mouse button? [ Left | Center | Right ]

 If the mouse has a scroll wheel, how many lines scroll each time the mouse wheel is rolled?

  _________________________________________________________________________________

 Can the computer scroll inactive windows when the user hovers the mouse pointer over them? 
[ Yes | No ]

 Can the Windows operating system be configured to automatically correct misspelled words? (Note 
that in Windows 11, you need to look in another Settings option.)

 [ Yes | No ]

 Can the Windows operating system be configured to suggest alternative words? (Note that in Win-
dows 11, you need to look in another Settings option.)

 [ Yes | No ]

 Can you disable AutoPlay through the AutoPlay settings? [ Yes | No ]

 What is the default web browser for the machine? How did you find this through Settings?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Network & Internet

15. Return to the main Settings window.

16. Select Network & Internet. Explore the different options to answer the questions.

 What types of networks are supported?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Does your computer allow you to turn on airplane mode? [ Yes | No ]

 If you work in a corporate environment in which a proxy server is used and you are required to 
configure an executive’s laptop, what configuration settings do you need to obtain from the network 
support staff to manually configure the settings?

  _________________________________________________________________________________

 Which option would you use to see the MAC address of the Ethernet network card?

  _________________________________________________________________________________

 Which option would you use to attach the device to the wireless network?

 [ Wi-Fi | Airplane Mode | Proxy | Ethernet | Dial-up ]
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Personalization

17. Return to the Settings screen.

18. Select Personalization from the Settings window.

19. The lock screen function is a screen that appears when you have not interacted with the device after 
a specified amount of time. Select the Lock screen option. This particular setting allows you to 
control how the display reacts, and possibly the camera as well (if one is installed), after a period 
of inactivity. The lock screen commonly shows information such as time, date, battery status, and 
network status.

 What is the current setting for the Show lock screen background picture on the sign-in screen option? 
[ On | Off ]

20. Choose the opposite selection for the Show lock screen background picture on the sign-in screen by 
clicking the colored oval so that the dot goes to the opposite side. If the answer to Question 19 was 
On, you should turn the option Off. If the answer to Question 19 was Off, you should turn the option 
to On.

 What visual clue did you have that the option changed?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

21. Return the setting to the original On or Off position.

22. Access the Screen saver settings link (Screen saver in Windows 11) at the bottom of the window. 
Screen timeout and screen saver settings are important options in the business environment for 
security reasons.

Accounts

23. Return to Settings. Click the Accounts option. Rather than go through each option, answer some 
questions in each section to make sure you are looking at important options. Explore the different 
Accounts options to answer the questions.

 What are three sign-in options that can be used with Windows 10/11?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the minimum length of a PIN in Windows 10/11?

  _________________________________________________________________________________

 How would you add an additional account to this machine? Give exact steps.

  _________________________________________________________________________________

  _________________________________________________________________________________

 What does Sync your settings (Remember my preferences in Windows 11) mean?

  _________________________________________________________________________________

  _________________________________________________________________________________
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Time & Language

24. Return to the Settings screen.

25. Select Time & Language from the Settings screen. Explore the different options to answer the questions.

 Can the time be manually configured?

 [ Yes | No ]

 Write the date Wednesday, June 8, 2022, in the same format as each of the Long date options.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Does Windows 10/11 support multiple languages being installed at the same time? [ Yes | No ]

 Is any option available that might help with speech recognition for a person from the deep South? If 
so, what?

  _________________________________________________________________________________

 What is the default voice for text-to-speech apps?

  _________________________________________________________________________________

Ease of Access

26. Return to the Settings screen.

27. Select Ease of Access (Accessibility in Windows 11). Explore the different options to answer the 
questions.

 Can the Narrator be turned on and the Start Narrator after sign-in for me option (Start Narrator after 
sign-in for Windows 11) be turned off at the same time? [ Yes | No ]

 What is the purpose of the magnifier?

  _________________________________________________________________________________

 Does Use color filters have to be on to invert colors? [ Yes | No ]

 In what other way could you adjust color settings for a person who is color blind?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Why do you think someone would want to have the onscreen keyboard enabled?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the purpose of the third Change pointer color (Mouse pointer style in Windows 11) option?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What option would be used to increase the thickness of the cursor?

  _________________________________________________________________________________

 Does Windows 10/11 support closed captioning? [ Yes | Not that I can tell ]

Privacy

28. Return to the Settings screen.

29. Select Privacy (Privacy and security in Windows 11). Explore the different options to answer the 
questions.

 Does Windows 10/11 allow you to disable and enable the capability to let apps access the account 
information (name, picture, and so on) on the computer?

 [ Yes | No ]
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 What apps, if any, can use the computer’s location?

  _________________________________________________________________________________

 Does the computer have a webcam? [ Yes | No ]

 If so, are any devices allowed to use it? Where did you find this information?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Which apps are allowed to use the computer’s microphone?

  _________________________________________________________________________________

 Which apps are allowed to access your phone call history?

  _________________________________________________________________________________

Update & Security

 Note: Be very careful to follow the directions in this section exactly. You can lose all data if you’re 
not careful.

30. Return to the Settings screen.

31. Select Update & Security (Windows Update in Windows 11). Explore the different options to answer 
the questions.

 When was the last update installed on this computer? How did you find this information? Document 
your process.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Does Windows 10/11 allow you to choose how updates get installed? [ Yes | No ]

 What steps would you take to uninstall an update?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the purpose of the File History option? Note that in Windows 11, you need to look in Control 
Panel.

  _________________________________________________________________________________

  _________________________________________________________________________________

 What recovery options are available? Note that in Windows 11, you need to look in Settings > 
System.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Which recovery option would allow you to access Windows Recovery Environment?

 [ Reset this PC | Advanced startup ]

32. From the Update & Security > Recovery option (System > Recovery in Windows 11), click the 
Restart now button. The Windows Recovery Environment opens.

 What options are available?

  _________________________________________________________________________________

  _________________________________________________________________________________

33. From the screen shown, select Troubleshoot.

 What options are available to you?

  _________________________________________________________________________________
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34. Select Advanced options.

 What options are available to you?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

35. Select Startup Repair.

36. If necessary, select an account and enter the appropriate password > select Continue.

37. The system attempts to repair the PC and presents a results page. Select Advanced options. You are 
returned to the Windows Recovery Environment. Select the Continue option.

Lab 14.5 Windows 10/11 Taskbar Options

Objective: To interact with and customize the Windows taskbar

Parts: Computer with Windows 10/11 installed

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log on, if necessary.

Taskbar Options

2. Locate the taskbar on the bottom of the screen. If it is not showing, move the mouse to the bottom of 
the screen, and the taskbar pops up.

3. To modify or view the taskbar settings, right-click a blank area of the taskbar. A menu appears. Select 
the Taskbar settings option. The Settings > Personalization > Taskbar window appears. (Note that the 
Taskbar and Navigation link in Control Panel > Appearance and Personalization opens this window 
also.)

4. The options available on this screen relate to how things are shown on the taskbar. The On items are 
active. Simply click an item’s switch to toggle between On (enabled) and Off (disabled). Lab Table 
14.11 shows the functions of the options in Windows 10. Lab Table 14.12 shows the functions for 
Windows 11.

 Document the current settings for Windows 10:

 >  Lock the taskbar [ On | Off ]

 >  Automatically hide the taskbar in desktop mode [ On | Off ]

 >  Automatically hide the taskbar in tablet mode [ On | Off ]

 >  Use small taskbar buttons [ On | Off ]

 >   Use Peek to preview the desktop when you move your mouse to the Show desktop button at the 
end of the taskbar [ On | Off ]

 >   Replace Command Prompt with Windows PowerShell in the menu when I right-click the start 
button or press Windows key+X [ On | Off ]

 >  Show badges on taskbar buttons [ On | Off ]

 >  Taskbar location on screen [ Left | Top | Bottom | Right ]

 >  Combine taskbar buttons [ Always, hide labels | When taskbar is full | Never ]

 >  Show taskbar on all displays [ On | Off ]

 >   Show taskbar buttons on [ All taskbars | Main taskbar and taskbar where window is open | Taskbar 
where window is open ]

 >  Combine buttons on other taskbars [ Always, hide labels | When taskbar is full | Never ]

 >  Show contacts on the taskbar [ On | Off ]

 >  Choose how many people to show [ 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 ]
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  > Show My People notifications [ On | Off ]

 >  Play a sound when a My People notification arrives [ On | Off ]

 >  Show My People suggestions [ On | Off ]

5. The notification area is on the far right side of the taskbar. It displays important information about 
specific system tools and applications. Some icons remain on the taskbar permanently. You have to 
click the Show hidden icons symbol (^) to see the other icons. In the Windows 10 only, open Settings 
> Personalization > Taskbar window > click the Select which icons appear on the taskbar link.

 Document the current settings:

 >  Always show all icons in the notification area [ On | Off ]

 >  Network [ On | Off ]

 >  Volume [ On | Off ]

 >  Windows Explorer [ On | Off ]

 >  Microsoft OneDrive [ On | Off ]

 >  Document any other settings: 

  _________________________________________________________________________________

6. In Windows 10 only, select the Turn system icons on or off link.

 Document the current settings:

 >  Clock [ On | Off ]

 >  Volume [ On | Off ]

 >  Network [ On | Off ]

 >  Power [ On | Off ]

 >  Input Indicator [ On | Off ]

 >  Location [ On | Off ]

 >  Action Center [ On | Off ]

 >  Document any other settings: 

  _________________________________________________________________________________

LAB TABLE 14.11 Windows 10 taskbar options and functions

Option Function

Lock the taskbar Prevents the taskbar from being moved.

Automatically hide the taskbar in desktop 
mode

Hides the taskbar until the pointer is moved to 
the taskbar area when the computer uses the 
traditional desktop.

Automatically hide the taskbar in tablet mode Hides the taskbar until the pointer is moved to 
the taskbar area when the computer uses tablet 
mode.

Use small taskbar buttons Makes icons on the taskbar smaller.

Use Peek to preview the desktop when you 
move your mouse to the Show desktop button 
at the end of the taskbar

Hides all open windows when the pointer is 
moved to the last spot past the date and time at 
the end of the taskbar.

Replace Command Prompt with Windows 
PowerShell in the menu when I right-click the 
start button or press Windows key+X

Allows you to easily access Windows 
PowerShell as a command-line interface.
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Option Function

Show badges on taskbar buttons Displays status information related to an app, 
such as the number of unread emails.

Taskbar location on screen Sets whether the taskbar appears at the bottom 
(default) or to the left, right, or top.

Combine taskbar buttons Optionally combines similar labels. 

Show taskbar on all displays Puts a taskbar on each display when multiple 
displays are connected to the computer.

Show taskbar buttons on Determines what buttons are shown on each of 
multiple displays.

Combine buttons on other taskbars When multiple displays are connected to the 
computer, controls combining of buttons on the 
other displays.

Show contacts on the taskbar Places an icon for the My People app 
(address book and communication tool) in the 
notification area.

Choose how many people to show Determines the number of pinned contacts 
that display on the taskbar (with the remaining 
pinned contacts appearing in My People app).

Show My People notifications Displays notifications from pinned contacts.

Play a sound when a My People notification 
arrives

Plays a sound when notifications are received 
from pinned contacts.

Show My People suggestions Allows the My People app to suggest 
communication apps.

 Similar taskbar settings are available in Windows 11.

 Document the current settings for Settings > Personalization > Taskbar in Windows 11:

 >  Search [ On | Off ]

 >  Task view [ On | Off ]

 >  Widgets [ On | Off ]

 >  Chat [ On | Off ]

 >  Pen Menu [ On | Off ]

 >  Touch Menu [ On | Off ]

 >  Virtual Keyboard [ On | Off ]

 >  Taskbar corner overflow items:

   _____________ [ On | Off ]

   _____________ [ On | Off ]

   _____________ [ On | Off ]

   _____________ [ On | Off ]

   _____________ [ On | Off ]

   _____________ [ On | Off ]

 >  Taskbar alignment [ Left | Center ]

 >  Show badges (unread messages counter) on taskbar apps [ Enabled | Disabled ]
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 >  Show my taskbar on all displays [ Left | Center ]

 >  Share any window from my taskbar [ Left | Center ]

 >  Select the far corner of the taskbar to show the desktop [ Left | Center ]

  _________________________________________________________________________________

LAB TABLE 14.12 Windows 11 taskbar options and functions 

Option Function 

Search Displays the Search icon on the taskbar.

Task view Displays the Task view icon on the taskbar.

Widgets Displays the Widgets icon on the taskbar.

Chat Displays the Chat icon on the taskbar.

Pen menu Permanently displays the Pen menu icon in the notification 
area.

Touch menu Permanently displays the Touch menu icon in the 
notification area.

Virtual keyboard Permanently displays the Virtual keyboard icon in the 
notification area.

Taskbar corner overflow items Prevents the respective icon from moving to the overflow 
menu on the taskbar.

Taskbar alignment Determines the position of the Start button and general 
application icons. 

Show badges (unread messages 
counter) on taskbar apps

Allows messaging applications to display the number of 
unread messages.

Show my taskbar on all displays Determines whether the taskbar is duplicated on all 
screens when multiple displays are connected to the 
computer.

Share any window from my taskbar Allows application windows to be shared directly from the 
taskbar to Microsoft Teams.

Select the far corner of the taskbar 
to show the desktop

Enables the Show Desktop area.

7. In Windows 10, open the Settings > System > Notifications & actions window.

 Document the current settings:

 >  Get notifications from apps and other senders [ On | Off ]

 >  Show notifications on the lock screen [ Enabled | Disabled ]

 >  Show reminders and incoming VoIP calls on the lock screen [ Enabled | Disabled ]

 >  Allow notifications to play sounds [ Enabled | Disabled ]

 >   Show me the Windows welcome experience after updates and occasionally when I sign in to 
highlight what’s new and suggested [ Enabled | Disabled ]

 >  Suggest ways I can finish setting up my device to get the most out of Windows [ Enabled | Disabled ]

 >  Get tips, tricks, and suggestions as you use Windows [ Enabled | Disabled ]
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 In Windows 11, open System > Notifications and then expand Notifications.

 Document the current settings:

 >  Show notifications on the lock screen [ Enabled | Disabled ]

 >  Show reminders and incoming VoIP calls on the lock screen [ Enabled | Disabled ]

 >  Allow notifications to play sounds [ Enabled | Disabled ]

8. Return to the Taskbar window. It might be easier to close all windows and right-click on an empty 
taskbar space > select Taskbar settings.

9. In the Taskbar settings window, ensure that the Automatically hide the taskbar in desktop mode 
option (Taskbar behaviors > Automatically hide the taskbar in Windows 11) is enabled and all other 
taskbar options are disabled. The taskbar disappears from view. If it does not, redo this step.

10. Point to the area of the screen (the main display, if you have more than one display) where the task-
bar is normally located. The taskbar appears. Open the Notepad app using any method previously 
described or one of your own methods. Maximize the screen by clicking the Maximize button, which 
is the center button at the top-right side of the window.

 What happened to the taskbar?

  _________________________________________________________________________________

11. Move the pointer to the screen area where the taskbar is normally located.

 Did the taskbar appear? [ Yes | No ]

12. Close the Notepad window.

13. Move the pointer to the taskbar area so that the taskbar appears. Three common options are Clock, 
Volume, and Network. The Clock option displays the time in the notification area. The Volume option 
is used to change the sound output level. The Network option is used to show local network and 
internet access status.

14. Make the taskbar reappear. On the taskbar, select the Show hidden icons symbol (^) to show and view 
hidden icons.

 Did the computer display any hidden icons? [ Yes | No ]

15. In Windows 10 only, right-click an empty taskbar space and select Taskbar settings > select Turn 
system icons on or off. Windows 11 users can skip to step 20.

16. Locate an icon that is currently enabled (turned on). Turn off that option.

17. Verify the setting modification by making the taskbar reappear and looking in the notification area.

18. Return to the Taskbar settings window.

19. Windows gives you the option to use Windows PowerShell in addition to the command prompt. 
Windows PowerShell allows more powerful commands and scripts to be executed, so it may be more 
useful than the command prompt environment. To have easy access to PowerShell, you can enable the 
Replace Command Prompt with Windows PowerShell in the menu when I right-click the start button 
or press Windows key+X option.

20. In Windows 11, PowerShell opens by default when you right-click the Start button and select 
Windows Terminal. You can set the command prompt as the default command line interface via this 
procedure: open Windows Terminal > click the down arrow at the top of the terminal window > select 
Settings > select Command Prompt in the Default profile section.

21. Bring the taskbar settings back up and reset them to their original configuration. Refer to the answer 
to questions in steps 4, 5, 6, and 7 for option settings.
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Lab 14.6 Windows 10/11 File and Folder Management

Objective: To create folders, move files, and copy files to new locations

Parts: Computer with Windows 10/11 installed

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

Note: There are multiple ways to complete some of the steps in this exercise. For some steps, an 
alternative method for doing the same procedure is listed. For such a step, you may use 
either method.

1. Power on the computer, log in, and attach a flash drive. Ensure that it is recognizable through File 
Explorer and is assigned a drive letter.

 What drive letter is assigned to the flash drive?

  _________________________________________________________________________________

2. Access the Notepad Windows accessory or app using whatever method you like, including using the 
Search function. Then type the following in Notepad:

 Develop a passion for learning. If you do, you will never cease to 
grow.-Anthony J. D’Angelo

3. Select the File menu > Save.

4. Select the flash drive letter in the left pane. Note that you may have to scroll down to view it in the 
left pane (see Lab Figure 14.3). Notice that the flash drive letter appears in the address bar. Whenever 
you are at the start of any drive, this is known as the root directory of that drive.

5. In the File Name textbox, click once, and the entire filename, including *.txt, is highlighted. 
Notice that the default Save as type option is Text Documents (*.txt). You do not have to add a file 
extension when you type a filename for a document of that file type.

 Type Quote1 for the name of the file. Click or tap the Save button. If you accidentally selected 
somewhere else and Text Documents (*.txt) is not highlighted, simply erase all that and type 
Quote1. (Note that the file will have the extension .txt because of the default setting, so the full 
filename will be Quote1.txt.)

LAB FIGURE 14.3 Windows 10 Notepad flash drive selection

6. In Notepad, select File > New. Then type the following:

 The man who graduates today and stops learning tomorrow is 
uneducated the day after.-Newton D. Baker
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7. Using the skills you just learned or know already, save the file as Quote2.

8. Select File > New. Then type the following:

 Don’t just learn the tricks of the trade. Learn the trade.-James 
Bennis

9. Save the file as Quote3.

10. Select File > New. Then type the following:

 Nine-tenths of education is encouragement.-Anatole France

11. Save the file as Quote4.

12. Select File > New. Then type the following:

 Technology is dominated by two types of people: those who 
understand what they do not manage and those who manage what they 
do not understand.-Source Unknown

13. Save the file as Quote5.

14. Close the Notepad application by selecting the Close button (the X) in the upper-right corner.

15. Open File Explorer. In the left window, use the vertical scrollbar to locate and select the drive media 
you are using. Remember that you might have to expand the This PC area in order to be able to see 
the drive.

16. In the right window, locate the five files you just created (Quote1, Quote2, Quote3, Quote4, 
and Quote5). If the files are not there, redo the lab from the beginning.

Instructor initials: _____________

Create a Folder

 Note: The label Alternative denotes an alternative way to perform the same step. For such a step, you 
may use either method, and you might consider using one method in one step and then trying it a 
different way on another step.

17. Ensure that the flash drive is selected in the left File Explorer pane. Right-click an empty space 
in the right pane. Point to the New option > select the Folder option. A folder appears in the right 
window with the words New folder highlighted. Type LearningQuotes and press ®. The 
LearningQuotes folder now appears in the right pane.

 Alternative: Select the Home tab at the top of the screen. Select the New item > New folder option 
from the ribbon. A folder appears in the right window with the words New folder highlighted. Type 
LearningQuotes and press ®.

On Your Own

18. Create another new folder in the root directory of the flash drive called GeneralQuotes, using either 
procedure outlined in step 17.

Instructor initials: _____________

Copy a File

19.  In the right File Explorer pane, right-click the file named Quote1. A context menu appears. In 
Windows 10, one of the text options is Copy. There is not a text Copy option in the context menu in 
Windows 11, but there is a Copy icon. The icon consists of two rectangles overlapping each other. 
The word Copy appears when you hover the mouse over the icon. Press the ´ key. 
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 Similarly, the Home menu ribbon in the Windows 10 File Explorer contains a Copy button that con-
sists of two overlapping sheets of paper and the word Copy. The Copy button at the top of the Win-
dows 11 File Explorer simply consists of two overlapping rectangles.

20.  In the right File Explorer pane, right-click the file named Quote1. A context menu appears. Select 
the Copy option. The file is placed in a Windows utility called the Clipboard, which works in the 
background.

 Alternative: In the right File Explorer pane, select the file named Quote1 > select the Home menu 
option (Windows 10 only) > Copy. The file is copied to the Windows utility called the Clipboard, 
which works in the background.

 Note: Complete steps 21 and 22 (opening the destination folder) OR complete step 23 (right-clicking 
on the destination folder).

21. In Windows 11, the Paste icon looks like a clipboard with a small piece of paper. The word Paste 
appears when you hover the mouse over the icon.

 In the right pane, double-click the LearningQuotes folder to open it. Notice that the address bar 
changes to This PC > X > LearningQuotes (where X is the name and drive letter of the flash drive).

 The right pane is empty because the folder does not have any files or subfolders in it yet.

22. Right-click in the right window and a context menu appears. Select Paste, and the Quote1 file 
appears in the right pane.

 Alternative: In the Windows 10 File Explorer window, select the Home menu option > Paste. In 
Windows 11, simply click the Paste icon at the top of File Explorer. The Quote1 file appears in the 
right pane.

 Note: If you completed steps 21 and 22, DO NOT complete the next step because it is an alternative 
method that accomplishes the same paste task.

23. Right-click on the LearningQuotes folder > select Paste. To confirm the paste, double-click the 
LearningQuotes folder. The Quote1 file is in the folder.

On Your Own

24. Copy the files named Quote2 and Quote3 from the root directory of the flash drive into the 
LearningQuotes folder, using the methods outlined in previous steps.

Copy Multiple Files

25. In the left File Explorer pane, select the drive option for the media you are using.

 Alternative: In the address bar, select the left arrow to return to the root directory of the flash drive.

26. Locate the files called Quote4 and Quote5 in the right File Explorer pane. In the right File 
Explorer pane, click once on the Quote4 filename. The name is highlighted.

27. Hold down Í and select the Quote5 filename. Both the Quote4 and Quote5 filenames are 
highlighted.

 Note: The Í key is used to select files that are consecutive in a list (one right after the other). If 
you wanted to select files that are not consecutive, hold down the Ç key while selecting the files.

28. Right-click the Quote4 file or the Quote5 file > select the Copy option.

  Alternative: Select the Home menu option > Copy in Windows 10 or the Copy menu item in Windows 11.

29. Double-click the GeneralQuotes folder.

 The path across the top changes to This PC > X > GeneralQuotes (where X is the name and drive 
letter of the flash drive). The right pane is empty because the folder does not have any files or 
subfolders in it yet.
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30. In the right File Explorer pane, right-click an empty space > select Paste. The Quote4 and Quote5 
files appear in the right pane.

  Alternative: Select the Home menu option > Paste in Windows 10 or the Paste menu item in Win-
dows 11. The Quote4 and Quote5 files appear in the right pane.

 How many folders are located in the flash drive root directory?

  _________________________________________________________________________________

 How many files are in the root directory?

  _________________________________________________________________________________

 How many files are in the LearningQuotes folder?

  _________________________________________________________________________________

 How many files are in the GeneralQuotes folder?

  _________________________________________________________________________________

Instructor initials: _____________

Copying a File from One Folder to Another

31. In the left File Explorer pane, select the flash drive you are using. The files and folders in the flash 
drive root directory appear in the right File Explorer pane.

 Alternative: Select the name of the flash drive in the address bar. The flash drive root directory files 
and folders appear in the right File Explorer pane.

32. Open the LearningQuotes folder. The files Quote1, Quote2, and Quote3 appear in the right File 
Explorer pane.

33. In the right File Explorer pane, right-click the Quote3 file > select Copy.

34. Open the GeneralQuotes folder located under the flash drive option you are using. The Quote4 and 
Quote5 files appear in the right File Explorer pane, and the address bar shows GeneralQuotes.

35. In the right File Explorer pane, right-click an empty space > select Paste. The Quote3 file appears.

On Your Own

36. Using the same procedures previously described, copy the Quote1 and Quote2 files from the 
LearningQuotes folder into the GeneralQuotes folder. At the end of this step, you should have three 
files (Quote1, Quote2, and Quote3) in the LearningQuotes folder and five files (Quote1, 
Quote2, Quote3, Quote4, and Quote5) in the GeneralQuotes folder.

Moving a File

37. Create a folder in the root of the flash drive and name it MyStuff. Refer to the steps earlier in the lab 
if you need assistance.

The purpose of Cut and Paste

The Cut and Paste options move a file from one folder to another. When a file is cut, it no longer 
exists in the original folder.
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38. Open the folder called GeneralQuotes. In the right pane, all five files appear.

39. In the right File Explorer window, select the Quote1 file to highlight it. Hold down the Ç key and 
select the Quote3 file. Both the Quote1 and Quote3 filenames are highlighted.

 Note: The Ç key is used to select nonconsecutive files, whereas the Í key is used to select files 
that are listed consecutively.

40. In Windows 11, the Cut icon is a pair of scissors. The word Cut appears when you hover the mouse 
over it.

 Right-click either the Quote1 or Quote3 filename (both filenames are still highlighted). A context 
menu appears. Select the Cut option. The Cut option is used to move a file from one folder to another.

  Alternative: Select the Home menu option > Cut in Windows 10. Select the Cut menu option in 
Windows 11.

41. Open the MyStuff folder. The right File Explorer pane is empty because no files have been copied 
or moved into the MyStuff folder yet. Right-click in the right File Explorer pane > select Paste. The 
Quote1 and Quote3 files appear in the right File Explorer pane.

 Alternative: In Windows 10, select the Home menu option > Paste. In Windows 11, select the Paste 
menu option. The Quote1 and Quote3 files appear in the right File Explorer pane.

On Your Own

42. Using the procedures just learned, move the Quote1 file from the LearningQuotes folder into the 
GeneralQuotes folder.

 How many files are in the GeneralQuotes folder?

  _________________________________________________________________________________

 How many files are in the LearningQuotes folder?

  _________________________________________________________________________________

 How many files are in the MyStuff folder?

  _________________________________________________________________________________

Instructor initials: _____________

Deleted files on external media are not put in the Recycle Bin

When deleting files from an optical disc, a flash drive, or other external media, the files are not 
placed in the Recycle Bin; they are deleted. When deleting files from a hard drive, the files are 
placed in the Recycle Bin.

Deleting Files and Folders

43. Open the MyStuff folder. The Quote1 and Quote3 files appear in the right pane.

44. In the right File Explorer pane, select the Quote1 and the Quote3 files. Both the Quote1 and 
Quote3 filenames are highlighted.

45. In Windows 11, the Delete icon is a trash can. The word Delete appears when you hover the mouse 
over the icon.

 Press the ∂ key on the keyboard. A message appears on the screen, asking Are you sure you want to 
delete these 2 items? if you are on a flash drive. Select Yes.
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 Alternative: In Windows 10, select the Home menu option > Delete. In Windows 11, select the Delete 
icon in the menu. A message appears on the screen, asking Are you sure you want to delete these 2 
items? if you are on a flash drive. Select Yes.

46. From the flash drive root directory, select the MyStuff folder. The MyStuff folder is highlighted. Press 
the ∂ key on the keyboard. If working from a flash drive, a message appears on the screen, asking 
Are you sure you want to permanently delete this folder? Click the Yes button.

Instructor initials: _____________

Skipping the Recycle Bin for deleted hard drive files

If you want to permanently delete a file from a hard drive so that the file will not first be placed 
in the Recycle Bin, hold down the Í key while pressing the ∂ key.

On Your Own

47. Using the previously demonstrated procedures, delete the LearningQuotes folder, the GeneralQuotes 
folder, all files contained within each folder, and the original Quote1, Quote2, Quote3, Quote4, 
and Quote5 files.

48. Close the File Explorer window.

Retrieving a deleted file

To restore a file that has been accidentally placed in the Recycle Bin, open the Recycle Bin > 
right-click the file > click the Restore option.

Challenge

49. Using Notepad, create three text files and save them to the external media in a folder called MyFiles.

50. On the flash drive, create a folder called ComputerText.

51. Copy two of the three text files from the MyFiles folder into the folder called ComputerText.

52. Move the third text file from the MyFiles folder into the folder called ComputerText.

Instructor initials: _____________

 How many files are in the MyFiles folder?

  _________________________________________________________________________________

 How many files are in the ComputerText folder?

  _________________________________________________________________________________

53. Permanently delete the folder called ComputerText and all files within it.

54. Delete the folder called MyFiles and all files within it.
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Lab 14.7 Windows 10/11 File Extensions

Objective: To associate a file extension with a file type

Parts: Computer with Windows 10/11 installed

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer, log in, and attach a flash drive to the computer.

2. Access and launch the Notepad application. Type the following:

 I hear and I forget. I see and I remember. I do and I 
understand.-Confucius

3. Select the File menu > Save. Select the appropriate drive option for the media you are using. In the 
File name textbox, type Junk. Click the Save button.

4. Close the Notepad application.

5. Right-click the Start button > select File Explorer.

6. In Windows 10, select the View ribbon menu option > enable the File name extensions option.

 In Windows 11, select the View dropdown menu > Show > enable File name extensions.

7. In the left File Explorer pane, use the vertical scrollbar to locate and select the disk media you used 
to save the file. Locate the Junk.txt file in the right pane and double-click the icon.

 What happened?

  _________________________________________________________________________________

8. Close the Notepad application.

9. In Windows 11, the Rename icon is a rectangle with a cursor shape on top of it. The word Rename 
appears when you hover the mouse over the icon.

 In the right File Explorer pane, right-click the file called Junk.txt. Click the Rename option. 
Ensure that the entire filename, Junk.txt, is highlighted. Type junk.abc and press ®. A 
rename warning box appears, stating If you change a file name extension, the file may become unus-
able. It also asks Are you sure you want to change it? Click Yes. Junk.txt is renamed junk.abc.

 What does the junk.abc file icon look like now?

  _________________________________________________________________________________

10. Double-click the junk.abc file icon.

 What happened when you double-clicked on the junk.abc file icon?

  _________________________________________________________________________________

11. Click the More apps link. Locate and click the Notepad icon. Click OK.

 What happened when you selected Notepad?

  _________________________________________________________________________________

  _________________________________________________________________________________

12. In the Notepad application, select the File menu > New.

13. Type the following:

 The only real mistake is the one from which we learn nothing.-John 
Powell

14. Select the File menu option > click Save As. Ensure that the disk media option that you are using is 
the destination. In the File name textbox, type Junk2 and click Save.

15. Close the Notepad application.
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16. Using File Explorer, rename the Junk2.txt file to Junk2.abc. A rename warning box appears, 
stating If you change a file name extension, the file may become unusable. It also asks Are you sure 
you want to change it? Click Yes. Notice the file icon after the change.

 How is the icon different from before?

  _________________________________________________________________________________

17. Double-click the Junk2.abc icon.

 What happened when you double-clicked the Junk2.abc icon?

  _________________________________________________________________________________

Instructor initials: _____________

18. Close Notepad. Delete both files.

Lab 14.8 Windows 10/11 Attributes, Compression, and Encryption

Objective: To identify and set file and folder attributes, including compression and encryption

Parts: Computer with Windows 10/11 installed on an NTFS partition

Note: The compression and encryption portions of this exercise require an NTFS partition.

Procedure: Complete the following procedure and answer the accompanying questions.

Managing File Attributes

1. Access and open the Notepad application. Type the following:

 Aim for success, not perfection.-Dr. David M. Burns

2. Select the File menu > Save. In the File Explorer left pane, select a location such as Documents or 
Desktop. In the File name textbox, type Attribute File and click Save.

 Document which folder holds the file.

  _________________________________________________________________________________

3. Close the Notepad application.

4. Open File Explorer.

5. In the left pane, select the option where you stored the file. The Attribute File file should be 
listed in the right pane. If it is not, redo the previous steps to create the file.

6. Select (but do not open) the Attribute File file in the right pane.

7. In Windows 10, select the Home menu option > Properties. In Windows 11, select the three dots 
to the right of the View menu > Properties. The same results can be obtained by right-clicking the 
filename and selecting Properties.

 The file attributes are listed at the bottom. Additional attributes can be viewed for a file stored on an 
NTFS partition by clicking the Advanced button. Note that the Advanced button is not available on a 
flash drive that uses a file system other than NTFS.

 What file attributes are listed for the Attribute File file?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 What file attributes are enabled by default?

  _________________________________________________________________________________

  _________________________________________________________________________________
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8. Backup applications use the File is ready for archiving attribute when backing up data. When this 
attribute is enabled, the file is selected for backup by default.

 On the General tab of the Attribute File.txt Properties window, select (enable) the Read-only attribute 
checkbox and click OK.

9. Open the Attribute File file. The application opens with the typed text shown. Add the 
following to the quote:

 Never give up your right to be wrong, because then you will lose 
the ability to learn new things and move forward with your life.-
David M. Burns

10. Select the File menu option > select Save. A Save As window will open. With the same name listed 
(do not change it), click the Save button.

 What happens when the Save option is chosen?

  _________________________________________________________________________________

11. Click Yes to save the file. Another message box appears, stating that the file is read-only. Select OK > 
Cancel to return to the changed Notepad document.

12. Click the Close button in the Notepad window. When asked if you want to save the changes, select 
Don’t Save. The read-only attribute prevented the file from being changed.

13. In the File Explorer window, right-click the Attribute File filename > select Properties. Select 
the Hidden file attribute checkbox > select OK.

 What happens to the Attribute File filename in File Explorer ?

  _________________________________________________________________________________

  _________________________________________________________________________________

14.  In a Windows 10 File Explorer window, select the View menu option > Options down arrow > 
Change folder and search options > View tab. In Windows 11, select the three dots to the right of the 
View menu > Options > View tab.

 Which one of the following options is enabled? [ Don’t show hidden files, folders, or drives | Show 
hidden files, folders, and drives ]

15. Select (enable) the Show hidden files, folders, and drives radio button or ensure that it is enabled. 
Click OK. This option is used to see files or folders that have the hidden attribute set or enabled.

 Note: If you want to make this change applicable to all folders, you can select the Apply to folders 
button, but you do not do this in this lab.

 Does the Attribute File file appear in the right pane of the File Explorer?

 [ Yes | No ]

 If the file does not reappear, press the ∞ key to refresh the window or click the Refresh icon (which 
is a curved arrow at the end of the address bar).

 How does the file icon differ from before? Note that you may need to create an unhidden text file to 
see the difference.

  _________________________________________________________________________________

16.  In File Explorer, select the View menu option > select Small icons.

 How do the icons now appear in the File Explorer right pane?

  _________________________________________________________________________________

  _________________________________________________________________________________
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17. Select the View menu option > select List.

 How does the Attribute File now appear in the right pane?

  _________________________________________________________________________________

  _________________________________________________________________________________

18. Select the View menu option > Details.

 Why do you think that a technician would prefer the Details option over any other view?

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

19. Delete the Attribute File file.

 Did either the hidden or read-only attribute stop the Attribute File file from being deleted?

 [ Yes | No ]

20. Put the folder option back to the original setting (see step 14).

Using Compression

 Note: The disk volume must have an NTFS file system on it in order for you to complete this section. 
To check the file system, in File Explorer, open This PC > right-click the hard drive volume that 
contains Windows > select Properties. The file system is listed in the Properties window near the top.

21. Create a WordPad file called CompressionFile and save it in the Documents folder on the hard 
drive. If necessary, refer to a previous exercise for steps. Enter the following text in the file:

 The most successful career must show a waste of strength that might 
have removed mountains, and the most unsuccessful is not that of 
the man who is taken unprepared, but of him who has prepared and 
is never taken. On a tragedy of that kind, our national morality is 
duly silent.-Edward M. Forster

22. Copy the text from step 21 repeatedly in the document until you have four pages of text. You could 
also copy a picture from the internet, use the Windows Snipping Tool accessory to make screen 
captures and windows captures and then paste them into the document, or use different kinds of fonts 
and text formatting to make the document of decent size so this step will work. (Note that if you do 
not make the file size large enough, compression will not occur.)

23. Save and close the WordPad application. Using File Explorer, locate the CompressionFile file. 
(Note that you might need to change the view or get the properties of the file to answer the question 
that follows.)

 What is the file size of the CompressionFile file?

  _________________________________________________________________________________

 The file needs to be at least 20 KB in size. If it is not, add more content to the file.

24. Right-click on the CompressionFile file > select Properties. Click the Advanced button. In the 
Advanced Attributes dialog box, locate the Compress or Encrypt attributes section.

25. Select (enable) the Compress contents to save disk space checkbox. This option is used to compress a 
file or folder. Click the OK button > click OK again.

26. Using File Explorer, locate the file called CompressionFile and open the file’s Properties 
window again.



 LAB 14: Introduction to Operating Systems Labs 161

LA
B 1

4

TECH TIP

27. On the General tab, notice the Size and Size on disk numbers. If these numbers are the same, you 
don’t have enough information in the file to compress it. Type more information into it, use graphics 
to increase the size, or recopy and paste the content you have to increase the size of the file and then 
attempt the compression again. Leave this window open to show the instructor the reduction.

 Document the Size and the Size on disk.

  _________________________________________________________________________________

 What visual clue do you have in File Explorer that a file is compressed?

  _________________________________________________________________________________

Instructor initials: _____________

28. Click OK to close the CompressionFile Properties window.

Enabling Encryption

 Note: The disk volume must have an NTFS file system on it for you to complete this section.

29. Use Notepad or WordPad to create a file called EncryptionFile and save it to Documents. If 
necessary, refer to a previous exercise for steps. Enter the following text in the file:

 I do not fear computers. I fear the lack of them.-Isaac Asimov

30. Close the Notepad/WordPad application window. Using File Explorer, locate the file named 
EncryptionFile.

 What is the current size of EncryptionFile?

  _________________________________________________________________________________

31. Right-click on the filename EncryptionFile > select Properties > Advanced button. In the 
Advanced Attributes dialog box, locate the Compress or Encrypt attributes section. Select (enable) 
the Encrypt contents to secure data checkbox, the option used to encrypt a file or folder. (Note that 
the checkbox may not be available on some Windows Home versions. See the following Tech Tip.) 
Click OK twice. A dialog box appears, asking if you want to encrypt the file and the parent folder or 
encrypt only the file. Select the Encrypt the file only radio button > OK.

Limited encryption support on Home versions

Windows Home versions do not fully support encrypting files. In these versions, the cipher 
command can be used at the command prompt to decrypt files, to modify an encrypted file, and 
to copy an encrypted file to the computer.

32. The first time you select to encrypt a file, a prompt appears, telling you that you should back up the 
recovery key. This is extremely important. If the encryption key used to encrypt your file ever has an 
issue, you will not be able to get into your file again. For now, ignore the message, and later you will 
see how to access it and back it up.

 What is the size of EncryptionFile after encryption?

  _________________________________________________________________________________

Instructor initials: _____________
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Backing Up the File Encryption Certificate and Key

33. Open Control Panel. In the Search Control Panel textbox, type encrypt and select the Manage 
file encryption certificates link > Next > ensure that the Use this certificate radio button is selected 
> Next > in the Back up the certificate and key window, ensure that the Back up the certificate and 
key radio button is selected (enabled) > use the Browse button to specify a backup location that is 
on some type of removable media and type in a filename so you will know it is your encryption 
certificate > select Save. In the Password and Confirm password textboxes, type a password that 
you won’t forget > Next > do not select anything within the Update your previously encrypted files 
window > Next > Close.

 In File Explorer, open the external media and verify that you saved the key.

Instructor initials: _____________

Recovering EFS-protected files

If your encryption key ever becomes corrupted or you move a drive that contains encrypted files 
to another computer, it is possible to recover it if you have that encryption certificate and key 
backed up. Use the following steps:

 Step 1. Enter the certmgr.msc command in the Search textbox or at a command prompt.

 Step 2. In the left window, select Personal.

 Step 3. From the Action menu, select All Tasks > Import > Next > Browse > in the drop-down 
menu to the right of the File name textbox, select Personal Information Exchange (*.pfx; 
*.p12), and browse to where the encryption certificate and key are located in the ex-
ternal media. Select the key file > Open button > Next > in the Password textbox, type 
the password (that you were never supposed to forget!) > select the checkbox Mark this 
key as exportable. This will allow you to back up or transport your keys at a later time > 
leave the Include all extended properties checkbox enabled > Next > on the certificate 
store window click Next > Finish. A message appears, indicating success.

34. Permanently delete the CompressionFile file.

35. Permanently delete the EncryptionFile file.

Lab 14.9 Using regedit.exe in Windows 10/11

Objective: To become familiar with the regedit.exe registry-editing utility

Parts: Computer with Windows 10/11 installed and a user account with administrator rights

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: regedit.exe is a utility used for editing the Windows registry. With regedit.exe, 
you can view existing registry settings, modify registry settings values, or create new 
registry entries to change or enhance the way Windows operates. In this lab, you will use 
regedit.exe to view the system BIOS and component information on your computer.

Caution: Editing the registry can cause your computer to run erratically or not run at all! When per-
forming any registry editing, follow all directions carefully, including spelling, syntax use, 
and so on. Failure to do so may cause your computer to fail!
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Viewing Registry Information

1.  In Windows 10/11, search for regedit using the Search function or any other search method > 
open Registry Editor.

2. In the left Registry Editor window, expand Hkey_Local_Machine, Hardware, and 
Description by selecting the arrow located to the left of each name. Select the System option 
located under Description. In the right window, the system BIOS and component information 
displays.

 What is the system BIOS version?

  _________________________________________________________________________________

 Who is the manufacturer of the system BIOS?

  _________________________________________________________________________________

 What values are listed in the Component Information option?

  _________________________________________________________________________________

Exporting and Importing a Registry Section

3. regedit.exe can be used to back up and restore part or all of the registry. To illustrate this 
point, a portion of the registry will be exported to disk and then imported into the registry. Ensure 
that Hkey_Local_Machine\Hardware\Description\System is still selected in the left 
Registry Editor window. (Ensure that the word System is selected under Description.)

4. Select the File menu option > choose Export. The Export Registry File window opens.

5. Attach a flash drive. Select the down arrow in the Save in textbox and select the appropriate drive 
option for the flash drive you are using. In the File name textbox, type Registry System 
Section and click Save. The specific registry key is saved to disk.

6. To restore the registry (or a portion of it, as in this exercise), select the File menu option > select 
Import. The screen should list the file located on the external disk media, but if it does not, select the 
appropriate drive letter option for the disk media you are using.

7. Select the Registry System Section filename and click the Open button. A message appears when the 
section is successfully inserted into the registry. Show this message to the instructor or lab assistant.

Instructor initials: _____________

8. Close the regedit.exe utility.

Lab 14.10 Windows 10 File History Utility

Objective: To explore backing up data using Windows File History via Settings

Parts: Computer with Windows 10 installed

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log in to Windows.

2. Attach the flash drive to the computer.

 Which drive letter is assigned to the flash drive?

  _________________________________________________________________________________

3. Search by typing in the words file history in the Search textbox. Select Backup settings from 
the resulting search list.

4. If more than one external drive is connected to the computer, select the + Add a drive option and 
choose the drive to use for File History backups. If there is only one external drive, the + Add a drive 
option does not appear.
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 Click Automatically back up my files and select the More options link to select what files/folders are 
backed up, how often to back up the files, and how long to keep the backups.

5. After all settings have been configured, click the Back up now button.

 How much space is the backup going to take?

  _________________________________________________________________________________

6. Open File Explorer and access the flash drive.

 What is the name of the folder that contains the backed-up data?

  _________________________________________________________________________________

7. Return to the Backup window and set the Automatically back up my files option to Off.

8. Return to File Explorer and access the flash drive. Right-click on the FileHistory folder > select 
Delete > Yes.

 Do you think most people will use this option? Why or why not?

  _________________________________________________________________________________

Lab 14.11 Windows 11 File History Utility

Objective: To explore backing up data using Windows File History via Control Panel

Parts: Computer with Windows 11 installed. (Note: This procedure also works in Windows 10.)

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

1. Boot the computer and log on.

2. Insert the flash drive.

3. Access Control Panel > System and Security > File History.

4. Click the Select drive option on the left > select the flash drive where the recovery files will be stored 
> click OK.

5. Select the Exclude folders option. For each library that you want to exclude, click Add > click the 
library > click Select Folder. Click Save changes when you’re done.

6. Click the Advanced settings option to select how often to back up the files and how long to keep the 
backups. Click Save changes when you’re done.

7. Click Turn on. The system does an initial backup to the flash drive.

8. Open File Explorer and access the flash drive.

 What is the name of the folder that contains the backup data?

  _________________________________________________________________________________

9. Return to the Control Panel > System and Security > File History window and click Turn off.

10. Return to File Explorer and access the flash drive. Right-click on the FileHistory folder > select 
Delete > Yes.

 Do you think most people will use this option? Why or why not?

  _________________________________________________________________________________
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Lab 14.12 Creating a Windows 10/11 Recovery Drive

Objective: To create a system recovery in the Windows 10/11 environment

Parts: Computer with Windows 10/11 installed

 16 GB+ flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

1. Boot the computer and log on.

2. Access the Search function and type Create a recovery. Select the Create a recovery drive 
option.

3. Leave the Back up system files to the recovery drive option enabled > click Next. The message Please 
wait appears for a long time.

4. Select the flash drive where the recovery files will be stored > click Next. The system gives a final 
warning that everything on the flash drive will be erased. Click Create. The message Creating the 
recovery drive appears for a long time. The message The recovery drive is ready appears after the 
process completes. Click Finish.

 How often do you think a home user should create a system recovery drive?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the difference between a system recovery drive and a system image disc?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

5. After the drive has been created, open File Explorer. The flash drive should have the label 
RECOVERY.

(Optional) Using the System Recovery Drive in Windows 10

6. Confirm that the flash drive is attached to the computer.

7. Boot the computer and access the BIOS/UEFI BIOS. Ensure that the computer is configured to boot 
from the USB drive.

8. Restart the computer. Choose your keyboard layout.

9. Click Troubleshoot.

10. From this screen, you can use any of the Windows recovery tools, such as restoring the system from a 
previously created system image.

 List three options from the menu shown in this step.

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

11. Select Startup Repair. The system should report that it could not repair your computer; that’s because 
the computer is not broken. Click Shutdown.

12. Boot the computer and return the BIOS/EUFI BIOS to the original configuration.
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Lab 14.13 Creating a Windows 10/11 System Image

Objective: To create a system image disc in the Windows 10/11 environment

Parts: Computer with Windows 10/11 and a user account with administrator rights

 At least two hard drives (operating system disk and a backup disk). The backup disk can be 
external. The free space on the hard disk must be at least as large as the utilized space on 
the operating system disk.

 (Optional) Windows 10/11 installation media or system recovery drive

Procedure: Complete the following procedure and answer the accompanying questions.

1. Boot the computer and log on.

2. Click the Start button > Control Panel > System and Security link > Backup and Restore (Window 7) 
link > Create a system image link.

 What three options are available for where to save the backup?

  _________________________________________________________________________________

3. Determine from the instructor or lab assistant the appropriate storage medium and select the 
appropriate radio button. Click Next.

4. Select at least the operating system volumes to back up. An operating system volume has (System) 
after its name.

 What is the amount of space required to do the system image?

  _________________________________________________________________________________

5. Click Next. Click Start Backup.

 While the image is being created, what option(s) do you have on the screen?

  _________________________________________________________________________________

 The message The backup completed successfully appears when the backup is done. You might get the 
message Do you want to create a system repair disc?. If so, click No.

Instructor initials: _____________

 Click Close.

6. Open File Explorer and navigate to the disk where the image was saved. It should include a file 
named WindowsImageBackup.

7. Create a new folder on the desktop and name it Disappear.

(Optional) Using the System Image Disk

8. Confirm that the disk with the system image is installed in or attached to the computer.

9. Insert the Windows 10/11 installation media or system recovery drive.

10. Start the computer and enter BIOS/EUFI BIOS. Confirm that the computer is configured to boot from 
the inserted device.

11. Boot the computer. Choose your keyboard layout.

12. Click Troubleshoot.

13. Select System Image Recovery.

14. If necessary, log in as a user with administrator rights. Change the keyboard layout if necessary. Click 
Continue.

15. Select to the appropriate system image. Click Next. Click Next again. Confirm the settings and click 
Finish. Click Yes. The message Restoring disk (X:)… appears for a long time while the image is 
applied.

Instructor initials: _____________
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16. When the process is done, restart the computer when prompted to do so. If you don’t respond, the 
computer restarts automatically.

17. After the computer restarts, log on, if necessary. The Disappear folder should not be present on 
the desktop because it was created after the system image was created.

Lab 14.14 Using the Backup and Restore (Windows 7) Tool

Objective: To be able to use the Backup tool provided with Windows 10/11

Parts: Windows 10/11 computer and a user account with administrator rights

 Flash drive with 1 GB of free space. The flash drive must be empty. That is, it must not 
contain any files or folders.

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: This lab does not back up the hard drive but simply illustrates the concept of using the 
Backup tool.

1. Power on the computer and log on using the user ID and password for an account that has 
administrator rights.

2. Microsoft introduced the Backup and Restore tool in Windows 7. Although using the File History tool 
is the recommend backup method, the Backup and Restore tool is still available in Windows 10/11 as 
Backup and Restore (Windows 7). You might need to use this tool to restore backups that were made 
in previous versions of Windows.

 Use the internet to answer the following questions to learn more about backups in Windows.

 Is Shadow Copies of Shared Folders a feature available in Windows 10/11? [ Yes | No ]

 What is the purpose of the Shadow Copies of Shared Folders feature?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What command is used from the command prompt to create and manage system image backups for 
Windows 10/11 computers?

  _________________________________________________________________________________

 What are five Windows-based backup tools?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 List one recommended location for storing a backup.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 If a flash drive is to be used for this lab, what is the minimum amount of free space that must be 
available on that drive?

  _________________________________________________________________________________

3. Insert a flash drive. Ensure that the drive is visible in File Explorer.

4. Using File Explorer, create a folder called Backup in the Documents folder. Inside Backup, create a 
Notepad file called Data.

5. Locate the System and Security Control Panel and then select the Backup and Restore (Windows 7) 
link.

6. If a backup has not been performed before, select the Set up backup link. If a backup has been 
performed before, select the Change settings link.
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 Note: You may need to use the Refresh button to be able to see the flash drive. If the flash drive does 
not appear, ensure that it is viewable through File Explore and that it has more than 1 GB of free 
space available. Select the appropriate drive letter. Click Next.

 Select the Let me choose radio button. Click Next. If the system is not set up to do backups on 
demand, you may have to click the Change schedule link to modify the schedule so the backup can 
be done.

7. Locate the Backup folder in Documents by expanding Computer > X: > Users > Username, where 
X: is the drive where the operating system is installed (usually C:) and Username is the account that 
you’re using. Check the box beside Backup. Uncheck the Include a system image of drives box. Click 
Next.

8. If this is the initial setup, select the Save settings and run backup button. If you are updating settings, 
select Save settings and exit > Back up now.

9. While the backup is occurring, click the View Details button.

 Why do you think a technician would use this option?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Were you surprised at the time it took to perform the backup?

  _________________________________________________________________________________

Instructor initials: _____________

10. When the backup is complete, click Close. Use File Explorer to open the flash drive. You should see 
a folder with the same name as the computer. The folder’s icon shows a curved green arrow and an 
optical disc.

(Optional) Restoring the Backup

11. In File Explorer, delete the Backup folder in the Documents folder.

12. Return to Control Panel > System and Security > Backup and Restore (Windows 7).

13. Click Restore my files > Browse for files. Locate the backup file (the file with the same name as your 
computer) that you just created. The title will be Backup of X: where X: is usually the drive let-
ter of your operating system disk (usually C:). Follow the path to your Data file, which is usually 
Backup of X: > Users > Username > Documents > Disappear. Double-click the Data file.

14. Click Next > Restore > Finish.

15. Open Documents in File Explorer. The Backup folder has been restored. Open the Backup folder. The 
Data file has been restored as well.

16. Delete the Data file and the Backup folder.
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Lab 15.1 Using Basic Commands from a Windows Command Prompt

Objective: To execute basic commands at a command prompt

Parts: A Windows-based computer with command prompt access

 The ability to save a file to the hard drive

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

Note: For each step requiring a typed command, the ® key must be pressed to execute the command. This instruction is 
not given with each step.

1. Power on the computer and log on, if necessary.

2. Create a file in Notepad called LadyVOLS.txt and save the file to the flash drive. Add this text to your file:

 This is a fine mess you've gotten me into, Ollie.

 Go get that Earth creature and bring back the Uranium Pew36 Space Modulator.

 Can you sing "Rocky Top"?

 What drive letter does the flash drive use?

  _________________________________________________________________________________

3. Close Notepad. The LadyVOLS.txt file will be used later in the lab.

4. Use the Search function on the taskbar to search for command, and select the Command Prompt option from the resulting list.

 Does a prompt display? [ Yes | No ]

 If you do not see a prompt but you followed every step correctly, contact your instructor.

 What prompt displays on the screen? This is the folder (directory) from which you are starting.

  _________________________________________________________________________________
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5. At the prompt, type the following command:

 cd\

 The prompt changes to C:\>. If a message appears, stating that this is an invalid command or an in-
valid directory, you made a typing error. If you suspect an error, verify that the backslash is after cd 
and that there are no extra spaces. The backslash starts from the left side and goes down to the right 
(\). Other commands use a forward slash (/).

 cd is the command to change the directory, and it can tell the operating system to go to a different di-
rectory in the tree structure. The \ after the cd command tells the operating system to go to the root 
directory. An alternative way of typing this command is cd \, with a space between the cd com-
mand and the backslash. There are usually different ways to use every command from a prompt. The 
cd\ or cd \ command allows you to return to the root directory at any time.

6. At the command prompt, type the following:

 dir

 A list of files and directories appears. In this list, next to each filename, you see a period and an 
extension to the right of the filename, the file size, and the date and time when the file was last modi-
fied. The file extension gives a clue about which application created the file. Each directory has a 
<DIR> entry to the right of the timestamp.

 List two filenames, including their extensions, and one directory shown on the screen. Using your 
own knowledge or the internet, try to determine what application was used to create each file and 
write the name of that application (if found) beside the filename. Document your findings in Lab 
Table 15.1.

LAB TABLE 15.1 File and directory information

Information displayed Name Application

File

File

Directory N/A

7. When the number of files shown exceeds what can display on the screen, the files quickly scroll off 
the screen until all files finish displaying. The DIR command has a switch that controls this scroll-
ing. A command switch, which begins with a forward slash, enhances or changes the way a command 
functions. 

 At the command prompt, type dir /p. The /p switch, when used with the dir command, tells the 
operating system to display the files one page at a time.

 After looking at the data on the screen, you can press ® again to see the next page and then con-
tinue pressing ® until the prompt reappears. 

8. At the prompt, type the following:

 dir /w

 What is the function of the /w switch?

  _________________________________________________________________________________

9. Multiple switches can be used with a command. At the prompt, type the following command:

 dir /w/l

 Using the dir command with the /w and /l switches causes files to display in a wide format, with 
the information displayed in lowercase.
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10. The online help available within Windows varies across the different versions of Windows. To find 
out the operating system version loaded on the computer, type ver.

 What is the version number of the Windows operating system used on the computer?

  _________________________________________________________________________________

11. At the prompt, type dir /? | more. To create the vertical bar used in the command, hold down 
the Í key and, while keeping it held down, press the key directly above the ® key, which is 
the same key as the backslash (\). A short explanation of the dir command appears, followed by 
the command syntax (that is, the instructions or rules for how the command is to be used). A techni-
cian needs to understand command syntax to determine what commands to type when unfamiliar 
with a command. The | symbol is called the pipe symbol. The | more command tells the operating 
system to display the output one page at a time. Perform the following activity and then press any key 
to continue until you return to a prompt.

 Based on the output, list two switches that can be used with the dir command.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Write one switch that can be used with the dir command and briefly explain its purpose.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

12. Type cd\Windows at the prompt. The prompt changes to C:\Windows>.

13. Type the following command:

 dir a*.*

 The a*.* is not a switch. This command is directing the operating system to list all files or subdi-
rectories that start with the letter A (upper- or lowercase because filenames and directory names in 
Windows are not case-sensitive). The directory you chose may not have any files or subdirectories 
that start with the letter A. If this occurs, the operating system displays the message File Not Found.

 The * is known as a wildcard. The * wildcard substitutes for any combination of characters, includ-
ing no character. Since the combination a* comes before the period, it means you’re looking for any 
files that begin with A. Since the second asterisk comes after the period, the files can include any ex-
tension, including no extension.

 Does the operating system list any files or subdirectories that start with the letter A? If so, write one 
of them in the following space. If not, did the operating system let you know this? If so, write the 
message displayed.

  _________________________________________________________________________________

  _________________________________________________________________________________
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14. Type the following command:

 cd..

 The .. tells the operating system to move back (or up, if you think about the structure in File Ex-
plorer) one directory in the directory structure. Typing cd\Windows in step 12 took you one level 
down from the root. This cd.. command returns you to the root directory.

 To display a list of all files or directories in the root directory that start with the letter C, what com-
mand do you type? Try the command you think is right on the computer to see if it works.

  _________________________________________________________________________________

 Do any files or directories start with the letter C? If so, write down at least one of them.

  _________________________________________________________________________________

On Your Own

15a. Change to the directory that contains the Windows operating system. (The System32 directory and 
other important files and directories are located there.) The directory name is normally Windows. If 
you cannot determine what directory contains Windows, use the dir command again. Try repeating 
the lab until it is easier to do this step.

 Write the command you used to do this.

  _________________________________________________________________________________

 List two Windows files or directories that begin with the letter D.

  _________________________________________________________________________________

  _________________________________________________________________________________

15b. Return to the root directory.

 Write the command you used.

  _________________________________________________________________________________

16. You need to access the flash drive. To do this, you type the drive letter assigned to the flash drive 
(see the answer to the question in step 2), followed by a colon, and then press the ® key. For 
example, if a flash drive is assigned the letter G, you type G: and press ®. In this lab, whenever 
directions are given where the drive letter is not known, X: (italicized X and then a colon) is used, 
and you need to substitute your drive letter for X. Type the following command, based on your own 
drive letter:

 X:

 Notice that the prompt changes to the drive letter of the flash drive. If it does not, you might have 
forgotten to press ® or may not have replaced the X with your own drive letter, documented in 
step 2.

17. The type command allows you to view the text file you created in the root directory. Enter the 
following command:

 type ladyvols.txt

 What is the result of using the type command?

  _________________________________________________________________________________

 Can you edit and change the file by using this command? [ Yes | No ]

 Have your instructor verify that your file displays.

Instructor initials: _____________
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18. The del command is used to delete files. From the root directory, delete the file you created in the 
root directory by using the following command:

 del ladyvols.txt

 Why do you think you did not have to type del x:\ladyvols.txt (the full path) in this step?

  _________________________________________________________________________________

  _________________________________________________________________________________

Lab 15.2 Using the copy, md, del, and rd Commands

Objective: To correctly use the copy, md, del, and rd commands

Parts: Windows computer with command prompt access

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

Notes: For each step requiring a typed command, the ® key must be pressed to execute the 
command. This instruction is not given with each step.

 The directions given in Lab 15.1 are not repeated here. If you have trouble with this lab, it 
is recommended that you do Lab 15.1 until you are proficient with the concepts and then 
do this lab again.

 It is critical that you follow the directions in this lab. For example, if the lab directs you to 
make a directory called SubFolder1 using the command md subfolder1, make sure 
you type the command exactly as shown, without any extra spaces or other characters. A 
common mistake is to type the following: md subfolder 1. Notice the difference? A 
space has been added after subfolder, and that means that the system created the direc-
tory subfolder and the directory 1, not the directory subfolder1. When the student 
has to create subfolder2 and the command md subfolder 2 is typed by accident, 
a message indicates that the directory already exists. Why? The md subfolder 2 com-
mand was giving the computer the direction to create directories called subfolder and 
2, but the directory subfolder already exists..

1. Power on the computer and log on, if necessary.

2. Using Notepad, create four text files and put any professional data that you want into the files. Name 
the files with your first initial and last name plus a number, a dash, and another number (that is, 
flast#-#.txt). (For example, for a user named Chris Lee, the files could be named clee1-1, 
clee1-2, clee2-1, and clee2-2.) Save the files to the root directory of your flash drive.

 What drive letter does the flash drive use?

  _________________________________________________________________________________

 What application did you use to verify what drive letter the flash drive uses?

  _________________________________________________________________________________

 Have an instructor verify that your four files are in the flash drive root directory. Then close File Ex-
plorer and Notepad.

Instructor initials: _____________

3. Access a command prompt. Multiple methods can be used. Use a previous lab or the textbook for 
instructions.

 At the command prompt, type the command to go to the flash drive and then press ®. The com-
mand is X: (where X is the letter of the drive where you are allowed to create files). For example, if 
your flash drive uses the drive letter G, you type G: and press ®. The prompt changes to the ap-
propriate drive letter, such as G:\>.
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4. At the command prompt, type the following command: 

 cd\

 What is the purpose of the cd command?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is the purpose of the cd\ command?

  _________________________________________________________________________________

5. Create a directory (folder) called Class by entering the following command:

 md Class

6. Use the dir command to verify that the directory is created. If it is not created, redo step 5.

7. When the directory is created, move into the Class directory by using the cd command:

 cd class

 If you use the dir command at this point, what entry or entries are automatically created in Class?

 Windows 10: _____________________________

 Windows 11: _____________________________

8. Within the Class directory, create a subdirectory (subfolder) called SubFolder1 by entering the fol-
lowing command:

 md Subfolder1

9. Move from the Class folder into the subfolder just created by using this command:

 cd subfolder1

 In this step, would the cd X:\Class\SubFolder1 (where X: represents the flash drive you are 
using) command have worked as well? Why or why not?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

10. From the SubFolder1 directory, move back one directory by entering this command:

 cd..

 What does the prompt look like at this point?

  _________________________________________________________________________________

11. Make another subdirectory called SubFolder2 that is located under the Class directory.

 Have another student verify that both subdirectories have been created by using the dir command. 
Have that classmate sign their name on your answer sheet if the Class directory has two subdirecto-
ries that have the correct names.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

12. Return to the root directory of the flash drive. Redo Lab 15.1 if you cannot remember how to do this 
step.
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On Your Own
13a. From the prompt, create two directories on the root directory of the flash drive. Name the directories 

Sara and Josh. Use the dir command to verify that the Sara and Josh directories exist in the root 
directory of the flash drive.

 Have another student verify that the two new directories are created in the root directory. Ensure that 
the two names are correct and are readable.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

13b. Return to the root directory of the X: drive (the flash drive root directory).

 Draw a picture of the directory structure that you have created on the flash drive.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 You are sitting at the root directory of the flash drive. What do you think would be the results of en-
tering the following command?

 COPY C:\WINDOWS\SYSTEM32\ATTRIB.EXE

  _________________________________________________________________________________

  _________________________________________________________________________________

14. Note: This step assumes that Windows has been loaded in a directory (folder) called Windows. If it 
is loaded in a different directory, substitute the name of that directory for Windows in the commands. 
You also have to substitute the X: in X:\Class with the flash drive letter you are using.

 You will now practice the copy command. When using this command, notice that the copy com-
mand is first, followed by the source (the complete path where the file is located: C:\windows\
system32\attrib.exe). Last is the destination—where the file is to be placed (in the Class di-
rectory found on the flash drive). From the root directory, type the following command:

 copy C:\windows\system32\attrib.exe X:\class

 If you did this step correctly, a message appears, saying that one file was copied. If you do not get 
such a message, try the command again. Remember that X: is your flash drive letter, and you are 
supposed to type that drive letter rather than X.

 To what location do you think the file was copied?

  _________________________________________________________________________________

15. From the root directory, verify that the file has been copied by typing the following command:

 dir \class

 What is the size of the attrib.exe file?

  _________________________________________________________________________________

  _________________________________________________________________________________

16. To copy the attrib.exe command from the Class folder into SubFolder2, from the root directory, 
use the following command:

 copy \class\attrib.exe \class\subfolder2

 Notice that the command comes first, and because everything is on the flash drive and the prompt is 
showing the flash drive, the flash drive letter can be omitted from both the source and the destination. 
The drive letter for the flash drive could precede the backslash (\) before the source and the destina-
tion part of the command, and it would work just as well (that is, copy X:\class\attrib.exe 
X:\class\subfolder2).
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17. Verify that the file copied correctly by using the following command:

 dir \class\subfolder2

 Notice that with the dir command, you are instructing the computer to show a directory listing start-
ing from the root drive (because the next part starts with the backslash [\]) and then instructing the 
computer to go into the Class directory and then go into the subfolder2 directory. You are giving the 
computer the exact path to take to get to the correct directory to show the listing.

 The attrib.exe file should be listed. If it is not, redo step 16.

 Are any other files or folders in the subfolder2 directory? [ Yes | No ]

18. Copy the flast1-1.txt text file into the Subfolder1 directory (which is located under the Class 
directory) by using the following command:

 copy \flast1-1.txt \class\subfolder1

 Remember that flast1-1.txt is your first initial and last name followed by a 1, a dash, and an-
other 1. You created this file in step 2 at the beginning of this lab.

 A message should appear that one file copied. If it does not, redo step 18. 

19. Verify that the file copied by using the following command:

 dir \class\subfolder1

 Write the exact command to copy the flast1-1 text file from Subfolder1 into the Subfolder2 direc-
tory. Remember that both Subfolder1 and Subfolder2 are subdirectories located under the Class direc-
tory. The Class directory is directly under the root directory.

  _________________________________________________________________________________

  _________________________________________________________________________________

20. Execute the command documented in step 19. If you do not see a message indicating that one file 
copied, redo the command or rewrite the command in step 19. Once the file is copied, verify the copy 
by using the dir command.

 What is the full command used to verify the copy in step 20?

  _________________________________________________________________________________

21. From the flash drive root directory, use the tree command to verify your structure:

 tree /f | more

 There should be four text files in the root directory with your first initial and last name and 1-1, 
1-2, 2-1, and 2-2 as part of the filename. There should be directories called Class, Sara, and Josh. 
Under the Class directory, there should be one file (attrib.exe) and two subfolders (Subfolder1 
and Subfolder2). Under the Subfolder2 directory are the files flast1-1.txt and attrib.exe. 
Under the Subfolder1 directory is the file flast1-1.txt. If any of these are not correct, use File 
Explorer to delete any files, directories, and subdirectories you have created and restart the lab.

On Your Own

22a. From the flash drive root directory prompt, copy the flast1-2.txt file from the flash drive root 
directory into the Sara directory. Use the space that follows to write your command before attempting 
to type it.

 Document the command to copy the flast1-2.txt file from the root directory of the flash drive 
into the Sara directory.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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22b. From the flash drive root directory prompt, copy the flast2-1.txt file into the Josh directory. 
Use the space that follows to write your command before attempting to type it.

 Document the command to copy the flast2-1.txt file from the root directory of the flash drive 
into the Josh directory.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

22c. From the flash drive root directory prompt, copy the flast2-2.txt file into the Class directory. 
Use the space that follows to write your command before attempting to type it.

 Document the command to copy the flast2-2.txt file from the root directory of the flash drive 
into the Class directory.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Have another student verify that a file is copied into each of the three subdirectories. Ensure that the 
names are correct and readable. File Explorer can be used to verify but not to correct. A better option 
would be to use the dir and cd commands.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

22d. Return to the root directory of the X: drive (the flash drive root directory). Close all other windows 
except the command prompt window.

23. A subdirectory can be created within a subdirectory from the root directory. To create a subdirectory 
called Fun within the SubFolder2 subdirectory (which is under the Class directory), use the following 
command from the root directory. Notice that you must insert the backslashes when you have mul-
tiple directories to go through to create the subdirectory.

 md \class\subfolder2\Fun

24. Verify the subdirectory creation by using the following command:

 dir \class\subfolder2

 A directory called Fun should be listed in the output.

 How much space do the files located within SubFolder2 occupy?

  _________________________________________________________________________________

25. Use the tree command to verify the Class folder structure:

 tree \class

 There should be two subdirectories (Subfolder1 and Subfolder2) and one subdirectory (Fun) under 
Subfolder2.

26. To copy all the files from SubFolder2 into the newly created Fun subdirectory, use the following 
command:

 copy \class\subfolder2 \class\subfolder2\fun

 A message should appear, indicating that two files copied. If you do not receive this message, do not 
go any further. Try redoing the command. Make sure there is a space between the copy command 
and the first backslash. Make sure there is a space between the first time you type subfolder2 and 
the next backslash (between the source and the destination parts).
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27. Use the dir command as follows to verify the copy:

 dir \class\subfolder2\fun

28. Wildcards can be used with the copy command. To copy all the files that start with the letter A from 
the Fun subdirectory into the Subfolder1 subdirectory, use the following command:

 copy \class\subfolder2\fun\a*.* \class\subfolder1

 A message should appear, stating that one file copied. If you do not receive this message, do not go 
any further. Try redoing the command. Make sure there is a space between the copy command and 
the first backslash (\). Make sure there is a space between the last asterisk (*) and the next backslash 
(between the source and the destination parts).

 How many files were copied?

  _________________________________________________________________________________

Instructor initials: _____________

29. The del command is used to delete files. Wildcards can also be used with this command. Delete all 
the files located in the Fun subdirectory by using the following command (where the *.* is the wild-
card representing all files with any extension):

 del \class\subfolder2\fun\*.*

 When prompted if you are sure, type Y and press ®. Verify that the files are deleted with the 
dir command:

 dir \class\subfolder2\fun

30. The rd command removes directories and subdirectories. Note that you cannot remove a directory or 
subdirectory with the rd command unless that directory or subdirectory is empty. Type the following 
command to remove the Fun subdirectory:

 rd \class\subfolder2\fun

31. Type the following command to remove the SubFolder2 subdirectory:

 rd \class\subfolder2

 What is the operating system response, and what do you think has to be done as a result?

  _________________________________________________________________________________

  _________________________________________________________________________________

32. Type the following command to delete the files in the Subfolder2 subdirectory:

 del \class\subfolder2\*.*

 When prompted if you are sure, type Y and press ®. Verify that the files are deleted with the 
dir command:

 dir \class\subfolder2

33a. Type the following command to remove the Subfolder2 subdirectory:

 rd \class\subfolder2

 Type the following command to verify the results:

 dir \class

On Your Own

33b. From the command prompt, use the del, rd, and dir commands to delete all files that you have 
created in the root directory and verify the deletions.

 Write each command you are going to use before attempting this part. An important part of learning 
how to use the commands and the prompt is to think about what and how you are going to type some-
thing before executing the command.
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  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Write each command used to delete the files in the Class, Subfolder1, Sara, and Josh directories and 
subdirectories.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Write each command used to delete the Class, Subfolder1, Sara, and Josh directories and 
subdirectories.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Have another student verify your work. Have that student sign and print their name to verify that all 
of the files created during this lab have been deleted.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

Lab 15.3 Using the attrib Command and Moving Around in the 
Directory Structure

Objective: To use the attrib command and to work correctly from a prompt when dealing with 
directories and subdirectories

Parts: A computer with a Windows operating system loaded

 A flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

Note: For each step requiring a typed command, the ® key must be pressed to execute the 
command. This instruction is not given with each step.

1. Power on the computer and log on, if necessary.

2. Using Notepad, create three files, named Special1.txt, Special2.txt, and Tickle.txt, 
and save them in the root directory of the flash drive.

 What drive letter is assigned to the flash drive?

  _________________________________________________________________________________

3. Access a command prompt. Ensure that the prompt represents the root directory of the flash drive. Do 
not use File Explorer to verify anything for the rest of the lab. If you are not sure how to use the com-
mand prompt for all of this, you should practice the previous labs some more.

 What does your command prompt look like? Note that it should be the drive letter of the flash drive, 
a colon, a backslash, and a greater-than sign. If it is not, review the previous labs before going to  
step 4.

  _________________________________________________________________________________
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4. From the root directory of the flash drive, type the following command to create a directory called 
Junk:

 md junk

5. Under the Junk directory, make subdirectories called Sub1, Sub2, and Sub3 by using the following 
commands:

 cd junk

 md sub1

 md sub2

 md sub3

6. Return to the root directory. Verify that you are in the correct directory by looking at the command 
prompt.

 What command makes the root directory the current directory?

  _________________________________________________________________________________

 Write the command prompt as it appears on your screen.

  _________________________________________________________________________________

7. Make a new directory called Trash from the root directory and within the Trash directory, make sub-
directories called Sub1, Sub2, and Sub3 by using the following commands:

 md trash

 cd trash

 md sub1

 md sub2

 md sub3

8. Return to the root directory of the flash drive.

On Your Own

9. Make a new directory called Garbage from the root directory. Within the Garbage directory, make 
subdirectories called Sub1, Sub2, and Sub3. Verify that the directory and subdirectories were created.

 Write the commands to create a directory called Garbage and the three subdirectories.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Copy the Special1.txt, Special2.txt, and Tickle.txt files to the Garbage\Sub1 
subdirectory.

11. Go to the root directory, if you’re not there already.

12. Still in the root directory, copy all files that begin with the letter S from the Garbage\Sub1 subdirec-
tory to the Trash\Sub3 subdirectory.

 Write the commands to copy these files from the Garbage\Sub1 subdirectory to the Trash\Sub3 
subdirectory.

  _________________________________________________________________________________

  _________________________________________________________________________________



 LAB 15: Introduction to Scripting Labs 181

LA
B 1

5

 How many files were copied?

  _________________________________________________________________________________

13. Copy any file that begins with T from the Garbage\Sub1 subdirectory and place it in the Sub2 subdi-
rectory of the Junk directory.

 Write the commands to copy files that begin with T from one subdirectory to another subdirectory.

  _________________________________________________________________________________

 How many files were copied?

  _________________________________________________________________________________

 Draw a diagram of the directory structure that you have created in this lab, including all directories, 
subdirectories, and files.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Setting/Removing Attributes

14. To make all files in the Sub3 subdirectory of the Trash directory read-only, use the attrib com-
mand with the +r switch. From the root directory, type the following command:

 attrib +r \trash\sub3\*.*

15. To verify that the read-only attribute is set, type the following command:

 attrib \trash\sub3\*.*

 The Sub3 subdirectory should list two files. Each of them should have an R beside it, indicating that 
the read-only attribute is set. If the two files do not have the read-only attribute set, perform steps 14 
and 15 again.

16. The best way to prove that the files are read-only is to try to delete them. Type the following command:

 del \trash\sub3\*.*
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17. When asked if you are sure you want to delete the files, type Y and press ®. A message should 
appear on the screen, stating Access is denied. Then the command prompt appears. If the access de-
nied message does not appear, the files were deleted, which means the read-only attribute was not set. 
If this is the case, repeat step 12 to restore the files, then try steps 14 through 17 again.

18. Hide the Junk\Sub2 subdirectory by using the following command:

 attrib +h \junk\sub2

 No message appears on the screen. The command prompt appears again.

19. To verify that the directory is hidden, type the following command:

 dir \junk

 The Sub2 subdirectory should not appear in the list.

20. Use the attrib command to verify that the directory is hidden by typing the following command:

 attrib \junk\sub2

 The directory listing should appear with an H beside the name.

21. Some operating system files are automatically marked as system files when the operating system is 
installed. Type the following command to see what files are already marked as system files:

 attrib c:\*.*

 List any files that have the system attribute.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

On Your Own

22. Hide the Special1.txt file located in the Sub1 subdirectory of the Garbage directory.

 Write the command you used for this step.

  _________________________________________________________________________________

23. Verify that the Special1.txt file is hidden by using the dir and attrib commands.

 Write the commands you used for this step.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Have another student verify your work. Have that student sign and print their name and write the 
commands they used to verify that you were in the correct directory.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

Instructor initials: _____________

24. Remove the hidden attribute from the Special1.txt file in the Sub1 subdirectory of the Garbage 
directory. If necessary, use Help to find the switch to remove an attribute.

 Write the command used in this step.

  _________________________________________________________________________________

25. Have a classmate verify that the Special1.txt file is no longer hidden.

 Have that student sign and print their name and write the commands they used to verify that the 
Special1.txt file is no longer hidden.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________
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  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

26. Ensure that you are in the root directory.

27. Moving around within subdirectories can be challenging when you are first learning commands. 
Move to the Sub3 subdirectory of the Trash directory.

 What command did you use to perform this step?

  _________________________________________________________________________________

28. To move to the Sub1 subdirectory from within the Sub3 subdirectory, type the following:

 cd..

 Then type the following to move into the correct subdirectory:

 cd sub1

 What does the command prompt look like now?

  _________________________________________________________________________________

29. A shortcut to move up one directory is to type cd.. from within the Sub1 subdirectory. The prompt 
immediately changes to one level up (the Trash directory). Type the following:

 cd..

 The prompt changes to X:\Trash>.

30. Using the cd.. command again takes you one level back in the directory structure, to the root direc-
tory. Type the following:

 cd..

 The prompt changes appropriately.

Cleanup

31. Still in the root directory, change to the Sub2 subdirectory of the Garbage directory.

 Write the command used in this step.

  _________________________________________________________________________________

 How can you verify that the current directory is Garbage\Sub2?

  _________________________________________________________________________________

32. Still in the Garbage\Sub2 subdirectory, change the current directory to the Sub3 subdirectory of the 
Trash directory.

 Write the command you used in this step.

  _________________________________________________________________________________

 Have a classmate verify your work. Have that student sign and print their name and describe how 
they verified that you were in the correct directory.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

  _________________________________________________________________________________

33. Using the cd.. command, move from Trash\Sub3 to Trash.

34. Using the cd.. command, move from Trash to the root directory.
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35. Using the attrib, del, and rd commands, delete the Trash and Garbage directories, including all 
subdirectories underneath them. Write all commands needed for this before you attempt this step at 
the command prompt.

 Write all commands used in this step.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

36. Using the attrib, del, and rd commands, delete the Junk directory and all its subdirectories. 
Write all commands needed for this before you attempt this step at the command prompt.

 Write all commands used in this step.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

Lab 15.4 Windows 10/11 Backup Software and the Archive Bit

Objective: To explore backup options and how they affect the archive attribute, using Windows  
10 or 11

Parts: A computer with Windows 10 or 11 installed

 Flash drive

Procedure: Complete the following procedure and answer the accompanying questions.

Note: This lab requires both command prompt and Windows skills.

1. Power on the computer and log in to Windows.

2. Attach the flash drive.

 What drive letter is assigned to the flash drive?

  _________________________________________________________________________________

3. Ensure that there are at least three files in the Documents folder on the hard drive. You may have to 
create three files. This will be the folder that contains the data to be backed up.

 What are the names of your three files?

  _________________________________________________________________________________

 What is the path to your Documents folder?

  _________________________________________________________________________________
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4. Search for command prompt. In the resulting list, right-click the words Command Prompt > select 
Run as Administrator > Yes.

5. Use the cd command to move into the directory (folder) chosen in step 3. Hint: You must change into 
the directory Users and the folder with the username used to log in to the computer before you can 
locate the Documents folder. For example, for the username Akil, the prompt is C:\Users\Akil\
Documents>.

 Document the command(s) used to accomplish this step.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Use the dir command to verify that at least three files are in the folder.

 Have another student verify that three files are in the folder.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

7. Use the attrib command to determine the attributes set by default on a file saved on a Windows 
computer. The attributes are listed to the far left, then there is a space, and then there is the full path 
to the filename. Leave the command prompt window open.

 Document the attributes found for the three files, keeping in mind that A is the archive attribute, R is 
the read-only attribute, and H is the hidden attribute.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

8. Go to Control Panel > Backup and Restore (Windows 7).

9. If a backup has been done before, select the Change settings link; otherwise, select the Set up backup 
link.

10. Select the appropriate backup destination (the flash drive letter, as specified in the answer to the ques-
tion in step 2) > Next.

11. Select the Let me choose button > Next.

12. Uncheck any other items that are already selected.

13. Expand folders as necessary by clicking on the arrows. Then locate and select the folder chosen in 
step 3 > Next. 

14. Click the Save settings and run backup button.

15. When the backup finishes, return to the command prompt window and reissue the attrib 
command.

 Did the archive attribute change for the three files? [ Yes | No ]

 Describe the backup file on the flash drive (that is, how Backup and Restore (Windows 7) saves the 
file).

  _________________________________________________________________________________

  _________________________________________________________________________________
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16. Using File Explorer, copy one of the files from the Documents folder to the desktop.

17. In the command prompt window, type cd\ to return to the root directory.

18. Use the cd command to access the Desktop directory. A sample command would be cd \users\
akil\desktop if the person who signed onto the computer used the Akil account.

 Document the exact command you used to access the Desktop directory.

  _________________________________________________________________________________

  _________________________________________________________________________________

19. Use the attrib command to determine whether the archive bit changes when a file is copied.

 Document your findings.

  _________________________________________________________________________________

Using the xcopy Command for Backups

20. You need to access the flash drive. To do this, you type the drive letter assigned to the flash drive 
(see the answer to the question in step 2), followed by a colon, and then press the ® key. For 
example, if a flash drive is assigned the letter G, you type G: and press ®. Type the following 
command, substituting your own drive letter for X:

 X:

21. Go to the root of the flash drive and create a directory called Documents by entering the following:

 cd\

 mkdir Documents

22. Return to the C: drive by entering the following:

 C:

23. Use the cd command to access the Documents directory. A sample command would be  
cd \users\akil\documents if the person who signed onto the computer used the Akil 
account.

24. Unlike Backup and Restore (in Windows 7), the xcopy \m command can alter the archive attri-
bute. The \m tells xcopy to copy only files with the archive attribute set and then clear the flag on 
the original files after the files are copied. Use the following to copy the files from your Documents 
folder to the documents folder on the flash drive: 

  xcopy /m *.* X:\Documents

Instructor initials: _____________

25. When the backup finishes, reissue the attrib command. The archive attribute should be cleared.

Instructor initials: _____________

26. Use the following to copy the files from the Documents folder to the flash drive: 

 xcopy /m *.* X:\Documents

 No files should be copied.

27. Use Notepad to make changes to one of the files in the Documents on the hard disk, such as  
C:\Users\Akil\Documents\File3.txt.

28. Use the following to copy the files from the Documents folder to the flash drive: 

 xcopy /m *.* X:\Documents

 Select Yes at the overwrite request. Only one file should be copied.

Cleanup

29. Permanently delete the file copied to the desktop and the three files created in the Documents folder.

30. Close all windows.
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Lab 15.5 Setting Windows Environment Variables
Objective: To access environment variables in Windows

Parts: Windows computer and an account with administrator rights

Procedure: Complete the following steps and answer the accompanying questions.

1. Power on the computer and log on using a user ID and password that has administrator rights.

2. Open Settings > About > Advanced system settings. Explore the System Properties window to answer 
the following questions.

 Which options do you select to find the Environment Variables window?

  _________________________________________________________________________________

 Which system variable name is used for the PowerShell environment variable?

  _________________________________________________________________________________

 What is the value of this variable?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Is the PowerShell environment variable a system variable or a user variable?

 [ System variable | User variable ]

 Should you edit this environment variable? [ Yes | No ] Why or why not? 

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 What variable is used for temporary files?

  _________________________________________________________________________________

 What is the value associated with this variable?

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

 Describe another way to access environment variables in Windows.

  _________________________________________________________________________________

 Which option would you use, and why?

  _________________________________________________________________________________

3. Use the internet to research how to find Python environment variables. 

 Document three findings and the URL where you found them.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

On Your Own

4. Change the environment variable for one user’s program so that it includes a new directory named 
TestDir. 

 Document how you did this.

  _________________________________________________________________________________

  _________________________________________________________________________________
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5. Do your own research to find out where user environment variables are stored in the registry. 

 Document your findings and be sure to list the specific registry key.

  _________________________________________________________________________________

6. Do your own research to find out where system environment variables are stored in the registry. 

 Document your findings and be sure to list the specific registry key.

  _________________________________________________________________________________

  _________________________________________________________________________________

7. For each of the following environment variables, locate the appropriate value on your computer and 
record it in the space provided:

 %COMPUTERNAME% _________________________________

 %APPDATA% ______________________________________

 %HOMEPATH% _____________________________________

 %LOCALAPPDATA% _________________________________

 %PATHEXT% ______________________________________

Instructor initials: _____________

Lab 15.6 Creating a Batch File
Objective: To create and run a script using the command line and batch files

Parts: Windows computer with Microsoft Office or OpenOffice or access to five user-created files 
and with an account that has administrator rights

 Flash drive

Procedure: Complete the following steps and answer the accompanying questions.

1. Power on the computer and log on.

2. In File Explorer, locate and select the flash drive. Create a folder (directory) on the flash drive named 
batchTest.

3. Next, put five files inside the batchTest folder. You can use any files that are already on the computer, 
or you can create five simple files yourself. The files can be from any application and can contain 
anything you want; the content is not important. It is recommended that you use at least three different 
applications to make the results more interesting, such as an Excel file, a Word file, a text file, and so 
on. OpenOffice is also acceptable. Suggested filenames and contents are provided in Lab Table 15.2.

LAB TABLE 15.2 Suggested batch file contents*

Sample filename Sample content

drones.docx, drones.odt A drone is an unmanned aircraft, like a flying robot.

addition.xlsx, addition.ods 2 + 2 = 4 (normally)

scripting.pptx, scripting.odp My First Scripting Presentation

firstScript.txt The echo command displays messages on the console. 

smile.png, smile.jpg, smil.bmp Draw a smiley face.

* These are only suggestions. You can create any five files you want.

4. Open Notepad and create a batch file with the text shown below:

 echo

 REM create a list of files in the batchTest folder

 dir "X:\batchTest" > X:\file_list.txt

 echo "Check out the list of files now!"
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  This batch file should create a new file with a list of all the files that are in the batchTest directory. 
Make sure you replace the X: with the drive letter assigned to the flash drive. For example, if your 
flash drive is F:, then everywhere you see X: above, use F: instead.

 Note: Batch file commands are not case-sensitive. You could substitute ECHO for echo and DIR for 
dir. The comment command (REM) is normally written in uppercase simply so it is set off from the 
comment text.

 Save the file on the flash drive with the filename batch1xxx.bat, replacing xxx with your ini-
tials. When you save the file, be sure to use the drop-down menu under Save as type and select the All 
Files option. Otherwise, Notepad will add the .txt extension to your file, and the script will not run.

 Close the file.

5. Search for command prompt to open the command prompt. Then enter the following commands 
to run your file:

 X: (where X: is the drive letter of your flash drive) 

 cd batchTest 

 start batch1xxx.bat (where xxx is your initials) 

 What is displayed on the console?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  In File Explorer, locate the file named file_list.txt and open it. What are its contents?

  _________________________________________________________________________________

Instructor initials: _____________

6. Modify your batch file as follows: Locate the batch1xxx.bat file, right-click it, and choose Edit 
to open it in Notepad. Add or modify the commands to do the following:

> Edit the batch file so it creates a new directory (folder) in the root directory of the flash drive called 
myFiles. Recall that the command to make a new directory is md or mkdir.

> Edit the batch file so it saves the file_list.txt file to the new myFiles folder.

  What changes did you make? List them.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Add comments to your batch file to explain what each line does.

8. Execute the batch file and then verify that the file_list.txt file is located in a folder called 
myFiles.

 Where is file_list.txt located now? Verify that it is in the location where you want it to be.

  _________________________________________________________________________________

Instructor initials: _____________
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9. Create a second batch file, named batch2xxx.bat, to add two numbers. Store the numbers in 
variables named number1 and number2. Store the sum in a third variable, named sum, and then 
store a message to display the results in another variable, named message1. Output only the results. 
The code is as follows:

 @echo off

 setlocal EnableDelayedExpansion

 REM doing math

 SET /A number1=5

 SET /A number2=3

 SET /A sum=!number1! + !number2!

 SET message1=The result of adding !number1! and !number2! is !sum!

 echo !message1!

10. Execute the batch file from a command prompt to verify your code.

 What message displays on the screen?

  _________________________________________________________________________________

Instructor initials: _____________

11. Modify your batch file as follows:

 > Add a third variable, named product, to store the results of multiplying the two numbers.

 > Add a variable named message2 to store a message that gives the result of the multiplication and 
output this message.

 Your final display should look like this:

 The result of adding 5 and 3 is 8.

 The result of multiplying 5 by 3 is 15.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

12. Create a third batch file, named batch3xxx.bat, to count by twos from 2 through 20, using a loop 
and an if clause. The output should be a vertical list of the following numbers:

 2 4 6 8 10 12 14 16 18 20

 Note: Batch files do not actually have a true while loop. However, there are several ways to mimic 
the while loop syntax that is available in Python, JavaScript, and shell scripting. A true while loop 
begins with a test condition that compares a variable or an expression to another value. This is fol-
lowed by a block of statements that are executed over and over until the test condition is no longer 
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true. In the block of statements, the variable or expression to be tested is changed (normally incre-
mented or decremented). All of this can be simulated in a batch file with a label, an if clause, and 
the goto command.

 A loop in a batch file begins with a colon (:) and a label. The label can be almost anything you 
choose. It is followed by an if clause that tests a condition. If the condition is true, the statements 
in the if clause execute. You must remember to change the test item somewhere in the if clause, or 
the loop will run forever. After these statements have executed, the goto command is used with the 
label name to tell the computer to start again, back at the first line. In general terms, the syntax is as 
follows:

  :label

  if test condition is true

      do stuff

      change the test variable

      goto :label

  However, if you use the word while as your label, your batch file loop looks a lot like a while 
loop. Type and save this code:

 @echo off

 setlocal EnableDelayedExpansion

 REM Using a loop and an if clause to count by two's from 2 through 
20

 SET /A number=2

 SET /A count=1

 SET /A limit=10

 :while

 if !count! LEQ !limit!  (

     SET /A result=!number!*!count!

     echo !result!

     SET /A count=count+1

     goto :while

 )

13. Execute the third batch file and ensure that it works properly. Troubleshoot as necessary.

Instructor initials: _____________

14. Create a fourth batch file, named batch4xxx.bat, and save it inside your batchTest folder. Use 
the forfiles command to have this batch file output to the console a list of all the files in the 
batchTest folder with the date and time last modified. Here’s the code:

 @echo off

 REM use a forfiles loop to create a list of files in the batchTest 
folder

 forfiles /C "cmd /c echo @file @fdate @ftime"

 What is displayed?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

On Your Own

15. Create a batch file to output the following, changing the name Funmilayo to your own name:

 Hello, Funmilayo. Your operating system is Windows 11.

 Do this by creating a variable named name that holds the value Funmilayo. Use a second variable, 
named systemOS, to hold the value Windows 11. 

 Write your code below.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

16. Modify your batch file from step 15 to detect the computer’s operating system version. Search the 
internet to find out how to do this. 

 Document your results.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

17. Create a batch file script to output only files created after a specific date. The command to do that is:

 forfiles ... [/D [+] {MM/DD/YYYY}]

 This command selects files with a last modified date greater than or equal to (+) the specified date us-
ing the MM/DD/YYYY format. 

 Document your results.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________
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Lab 15.7 Introduction to PowerShell

Objective: To create and run PowerShell scripts using cmdlets and scripting code

Parts: Windows computer with Microsoft Office or OpenOffice or access to five user-created files 
and with an account that has administrator rights

Procedure: Complete the following steps and answer the accompanying questions.

1. Power on the computer and log on.

2. Open File Explorer. Locate the Documents folder. In the Documents folder, create a folder (directory) 
named PowerShellTest.

3. Next, put five files inside the PowerShellTest folder. You can use any files from the user of the com-
puter or you can create five simple files yourself. The files can be from any application and can 
contain anything you want; the content is not important. It is recommended that you use at least three 
different applications to make the results more interesting, such as an Excel file, a Word file, a text 
file, and so on. OpenOffice is also acceptable. Suggested filenames and content are provided in Lab 
Table 15.3.

LAB TABLE 15.3 Suggested filenames and content for PowerShell*

Filename Content

drones.docx, drones.odt A drone is an unstaffed aircraft, like a flying robot.

addition.xlsx, addition.ods 2 + 2 = 4 (normally)

scripting.pptx, scripting.odp My First Scripting Presentation

firstScript.txt The echo command displays messages on the console. 

smile.png, smile.jpg, smil.bmp Draw a smiley face.

* These are only suggestions. You can create any five files you want.

4. Search for PowerShell ISE. (ISE stands for Integrated Scripting Environment.) Click Run as adminis-
trator > Yes. Your screen should look like the one in Lab Figure 15.1.

LAB FIGURE 15.1 The PowerShell ISE
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5. On the right side of the screen, select the Modules drop-down > CimCmdlets. 

 Use the internet to research what CIM stands for and record your answer and the URL where you 
found that information:

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Using File Explorer, go inside the PowerShellTest folder. Click in a blank space in the address bar to 
see the full path (for example, C:\Users\student\Documents\PowerShellTest). While 
the path is highlighted, use Ç+c to copy that path.

7. In the PowerShell ISE environment, use the Get-Childitem cmdlet to view the files in the 
PowerShellTest folder via either of these two methods:

 Option 1: On the left, type the following command after the prompt (all of the text below is one 
command):

 Get-ChildItem C:\users\username\Documents\PowerShellTest

  Option 2: Type Get-Childitem, add a space, and then press Ç+v to paste the path into the 
command line.

 You should see a list of the files you stored in the PowerShellTest folder. If you don’t, check to make 
sure you typed the command exactly as shown and try again, if needed. Do not proceed until you ac-
complish this task.

Instructor initials: _____________

8. To create a PowerShell script, open Notepad or any other simple text editor and enter the following:

 Write-Host "Hello! This is my first PowerShell script."

 Save the file inside your PowerShellTest folder with the filename powershell1xxx.ps1, where 
xxx is your initials. When you save the file, be sure to use the drop-down menu under Save as type 
and select the All Files option. Otherwise, Notepad will add the .txt extension to your file, and the 
script will not run.

9. Return to the PowerShell window and run the script with the command below, remembering to re-
place username with the username you used to log into the computer. Note that all the text below 
needs to be typed on one line:

 & "C:\Users\username\Documents\PowerShellTest\powershell1xxx.ps1"

 If you get an error, it may be because PowerShell has enforced an execution policy. Be sure you 
have opened PowerShell as an administrator. (Close PowerShell, rerun the search, right-click on the 
search results for Windows PowerShell ISE, and select Run as administrator.) Then run the following 
command:

 Set-ExecutionPolicy RemoteSigned

 Select Yes in the message that appears. Then try running your script again. You should see the 
following:

 Hello! This is my first PowerShell script.

Instructor initials: _____________

10. Now let’s alter the script to see a list of all the files in the PowerShellTest directory. Edit the pow-
ershell1xxx.ps1 file and add the command that you issued in step 7 to the end of the file. Run 
the script again. What is the result now? You should see the Hello! line of text, a line that displays the 
path to your PowerShellTest directory, and a list of all the files in that directory. If you do not see this, 
start the lab over.

 What properties are shown for the files in the directory (that is, what column headings are shown)?

  _________________________________________________________________________________
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11. On your own, create a second PowerShell script file, named powershell2xxx.ps1, to count by 
twos from 2 through 20, using the ForEach-Object command. The output should include a line 
of text and a vertical list of these numbers, as shown in Lab Figure 15.2:

 2 4 6 8 10 12 14 16 18 20

LAB FIGURE 15.2 Results of a PowerShell script file

 The command to process the numbers is as follows:

 1,2,3,4,5,6,7,8,9,10 | ForEach-Object -Process {$_*2}

 Here’s the code:

 Write-Host "Counting by twos"

 1,2,3,4,5,6,7,8,9,10 | ForEach-Object -Process {$_*2}

12. To execute the code, press ¯ and change the name of the file from powershell1xxx.ps1 to 
powershell2xxx.ps1 (where xxx is your initials). If you can’t get this to work, type the full 
command to execute the script.

 Did the script work? [ Yes | No ] 

 If the script did not work, redo the code and execute it again.

Instructor initials: _____________

13. In PowerShell ISE, use the Get-Date cmdlet to get the current date and time.

14. Create a third PowerShell script file named powershell3xxx.ps1.

15. Now you will use the Get-Date command to find all files that are more than a year old in your 
PowerShellTest directory. Be sure you have at least one file that was created over a year ago so you 
can check that your script works. Put the code that follows in your script, replacing username with 
the name you used when you logged into Windows: 

 $time = (Get-Date).AddDays(-365)

 $path = "C:\Users\username\Documents\PowerShellTest"

 Get-ChildItem $path |

 Where-Object {$_.LastWriteTime -lt $time}

 Note: There is no space between (Get-Date) and .AddDays.

Instructor initials: _____________

On Your Own

16. Add comments to your PowerShell scripts. In PowerShell, a single-line comment begins with the # 
symbol and ends at the end of that line. A multi-line comment begins with <# and ends with #>.

 List an example of one of your comments.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

17. Create a new script, powershell4xxx.ps1, to multiply each number in a list (2, 4, 6, 8) by 100 
and divide each number in the list by 4 so the output is as shown in Lab Figure 15.3.

LAB FIGURE 15.3 Output of a PowerShell script

 List your code.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

18. Create a new script, powershell5xxx.ps1, to find all files that are older than 60 days in your 
PowerShellTest directory. Before you run your script, copy some files that are older than 60 days to 
the PowerShellTest folder.

 List your code.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

19. Create a new script, powershell6xxx.ps1, to get all the files in your PowerShellTest directory 
that have a specific extension. To do this, you use the Select-String command.

 List your code.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

Lab 15.8 Introduction to Python Scripting

Objective: To create and run Python scripts using IDLE

Parts: Windows computer with access to the internet and rights to download and install free 
software

Procedure: Complete the following steps and answer the accompanying questions

1. Power on the computer and log on. Open a web browser.

2. In the browser, go to https://www.python.org. Click Downloads > Download  Python 3.10.4. Save the 
file python-3.10.4-amd64.exe to a place on the computer where you can find it. 
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 Note: At the time of this writing, Python 3.10.4 was the latest version. If that has changed, you can 
download a later version. However, to do this lab, you must have a version of Python 3 installed (not 
Python 2!).

 The executable file that you downloaded installs Python on your computer. This will allow you to 
create programs in the Python language, using the integrated development environment (IDE) named 
IDLE. (Note: IDE is a generic term for a program used by a language to write programs, and IDLE is 
the name of the IDE used here to write Python programs.)

3. Run the executable file and follow the prompts. Accept all the default options. If your installation is 
successful, you should see a verification similar to the one shown in Lab Figure 15.4.

LAB FIGURE 15.4 Successful installation of Python

4. From Windows Start, expand the Python 3.10 folder, if necessary, and click on IDLE (Python 3.10 
64-bit), as shown in Lab Figure 15.5.

LAB FIGURE 15.5  IDLE (Python 3.10 64-bit) in the Start menu
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5. You should see the IDLE Shell 3.10.4 window. This is also called the Python Shell. Make it active by 
clicking anywhere in its blank area. The cursor should be blinking to the right of the three chevrons: 
>>>. Press ® two times, and you should see two more rows of chevrons. This means that Py-
thon is working and waiting for you to do something.

6. In the Python Shell window, type the following:

 print("I got it to work!")

 Press ®, and you should see a screen like the one shown in Lab Figure 15.6.

LAB FIGURE 15.6 Working in the Python IDLE shell

7. To prepare for your work, create a folder called PythonTest. Make sure you know where this folder is 
located.

8. The Python Shell window is where you see a script run. To create a script, you need to work in the 
Python editor. From the menu within the Python Shell window, select File > New File to open the 
Python editor.

 Type the following into the editor:

 # display a greeting and generate a password

 # get input from the user

 first_name = input("First name: ")

 last_name = input("Last name: ")

 id_number = input("Enter your school ID number: ")

 # create strings

 name = first_name + " " + last_name

 temp_password = first_name + "*" + id_number

 # display the results

 print("Welcome " + name + "!")

 print("Your temporary password is: " + temp_password)

 Be sure to type this code exactly as shown. In Python, indents, spaces, and line spacing are very 
important:

 > In this program, any line that begins with a hash symbol (#) is a comment and will be ignored by 
the computer when the program runs.

 > The following are the variable names in this script: first_name, last_name, id_number, 
name, and temp_password. The value on the right side of the equals sign is the value stored in 
the variable on the left side.
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 > In the line first_name = input("First name: "), the variable is first_name. The 
word input is a Python function that tells the computer to put a prompt on the screen. The text of the 
prompt is whatever is enclosed in quotes inside the parentheses. In this case, the text First name: is 
displayed. When the user enters their name, that value is stored in the variable first_name.

 > The name variable joins the values of two variables and adds a space between those values because 
of the space within quotes (" ").

 > The print() command tells the computer to display something on the screen. It can be text, the 
value of a variable, or a combination of text and variables.

9. Save your program with the filename python1xxx.py (where xxx is your initials) inside your 
PythonTest folder by going to the File tab and selecting Save As.

10. Now you can run your program. Go to the Run tab at the top of the Python editor screen, as shown in 
Lab Figure 15.7, and click on Run Module. The program should open in the Python shell and prompt 
you for your first name.

LAB FIGURE 15.7 The Run tab in the Python IDLE editor

 If you get an error, go back to the editor and compare your code with the code given above. Fix any 
errors you find, save the changes, and try again.

11. Nothing happens until you enter something. Enter Jackie for the first name and enter Cho for the 
last name. Enter 123456 for the school ID number. You should see the results in the Python shell, as 
shown in Lab Figure 15.8.

LAB FIGURE 15.8 Results of the first Python script

 Did the script work? [ Yes | No ] 

 If the script did not work, troubleshoot and edit your code as necessary until it does.

Instructor initials: _____________
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12. Create a new Python program. Name this new file python2xxx.py (where xxx is your initials). 
This new program will use a decision structure to decide whether a user is eligible for a 20%, 10%, or 
0% discount on a purchase. In this program, the user will enter the cost of a purchase. If the purchase 
value is over $100.00, the discount is 20%. If the purchase value is $50.00 to $99.99, the discount is 
10%. Anything under $50.00 is not eligible for a discount. The code for this program is as follows:

 # prompt user for cost of purchase

 cost = float(input("How much is your purchase? $ "))

 # check for discount amount

 if cost >= 100:

     discount = cost * .20

     percent = "20%"

 elif cost >= 50:

     discount = cost * .10

     percent = "10%"

 else:

     discount = 0

     percent = "0%"

 # display the results

 cost = cost - discount

 print("You have received a " , percent, " discount")

 print("Your final cost is $ ", cost)

13. Run the program at least three times to check that all the discount options (0%, 10%, or 20%) work. 
You can enter any numbers you want, but here are some suggestions for input:

 105

 87

 50

 34

 If you enter 87 at the prompt, you should see the results shown in Lab Figure 15.9.

 You might notice that there are some things that could be improved in this program:

 > Try entering a negative number. The program will still run, but it makes no sense to have a negative 
value as an input. You can fix this later as an On Your Own exercise.

 > The output shows a dollar amount but has only one decimal place where you would expect two. 
There are ways to deal with this issue, but they require more advanced coding, so for now, this is 
fine.

 > Each time you want to enter a new value, you must run the program again. By using a loop, you can 
allow the user to enter as many values as desired. You will add this functionality in the next step.
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LAB FIGURE 15.9 Results of the second Python script

14. Save your python2xxx.py file with a new filename: python3xxx.py. For this script, you will 
add a while loop so a user can repeat the process of entering values as often as desired.

 Add the following lines to the top of the program:

 # loop to re-enter a new value

 choice = "y"

 while choice == "y":

 Next, indent each line of your previous code one time by pressing † at the start of each line.

 Add the following line at the end, also indented once:

 choice = input("Enter another value? (y/n) ")

 An abbreviated version of the code looks like this:

 # loop to re-enter a new value

 choice = "y"

 while choice == "y":

     # prompt user for cost of purchase

     cost = float(input("How much is your purchase? $ "))

     # check for discount amount

     if cost >= 100:

         discount = cost * .20

         percent = "20%"

     ...(remainder of code)

     print("Your final cost is $ ", cost)

     choice = input("Enter another value? (y/n) ")
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 Note that your entire program from the previous file must be between the new lines. The first new 
line of code is a comment. The next line declares a variable named choice and sets its value to 
y. The while loop tests to see if choice has the value y. If it does, the loop is entered, and the 
program proceeds. After running once, you are prompted to enter y or n. Then control returns to 
the while test. If you entered y, the condition is true, and the program runs again. If the entry is 
anything other than y, the condition is false, and the loop statements are skipped. In this case, the 
program ends.

15. Now save and run your program. If you enter 63 at the first prompt, y at the second prompt, 245 at 
the third prompt, and n at the last prompt, you should see the results shown in Lab Figure 15.10 in 
the Python Shell window.

LAB FIGURE 15.10 Results of the improved Python script

16. You may have noticed that the user can enter anything when prompted for a decision about whether 
to run the program again. If the user enters a lowercase y, the program loops around again. But any 
other entry from the keyboard will stop the program. However, the prompt specifies entering either y 
or n. This is done mainly for the user’s sake because it seems to make more sense to allow the user 
to say, in effect, yes or no in answer to the question. However, you can change this by changing this 
line:

 choice = input("Enter another value? (y/n) ")

 to the following (all on the same line):

 choice = input("Enter another value? Type y to

 continue or any other key to end. ")

 Note: Because of space constraints in this text, the code shown above appears on two lines. But you 
must type the whole thing on a single line.

 Add this change to your program and run it again. Be sure it works correctly before continuing.

Instructor initials: _____________
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17. You may also have noticed that a user can type an uppercase Y to continue, but if that happens, the 
program ends. This is because computers are case-sensitive. If you want to give the user the option to 
use uppercase or lowercase entries, you can use a logical operator.

 Change this line:

 while choice == "y":

 to the following:

 while choice == "y" or choice == "Y":

 Make this change and test your program with both upper- and lowercase entries.

Instructor initials: _____________

On Your Own

Note: Most programming problems can be solved in a variety of ways. Your solution may not be 
exactly like your classmates’ solutions, but as long as the problem is solved, one method is not 
necessarily better than another. As you become more proficient with writing scripts, you may find 
more efficient ways to write code. 

18. Your next task is to revise the code of your python3xxx.py file to determine whether the purchase 
price for a 0% discount is both less than 50.00 and greater than 0. One solution is to add an elif 
clause to check whether the cost entered is greater than 0 and revise the else clause so it will dis-
play a message that any other amount is invalid. Updates to the results section will also be needed. 
Modify the code and save it as python4xxx.py. Execute the program to test it.

 Write your code here.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

19. Add tax to the final cost in the python4xxx.py program and save the new program as 
python5xxx.py. Assume that the tax rate is 6.25%. The final output should include the discounted 
cost plus 6.25% tax. Run the program to verify your code. Hint: The code cost = cost + 
(.0625*cost) can help here.

 Write your code here.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Did the code run properly? [ Yes | No ]

Instructor initials: _____________
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20. Create a new Python program, python6xxx.py, to assign a letter grade to a student when a nu-
merical grade is input. The grades should be as follows:

   90–100: A

   80–89.99: B

   70–79.99: C

   60–69.99: D

   Under 60: F

 Write the code you used for this program.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Did the code run properly? [ Yes | No ]

21. Add a loop to your python6xxx.py program that will allow the user to enter information for as 
many students as desired. Save the new program as python7xxx.py. Test the program.

 Write the modified program here.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Did the code run properly? [ Yes | No ]

Instructor initials: _____________

22. Add a greeting to your python7xxx.py program to explain to the user what the program does. 
The greeting should appear only once. Consider the placement of this greeting within the program 
(before or inside the loop). Save the modified program as python8xxx.py.

 Write the modified program.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Did the code run properly? [ Yes | No ]

Instructor initials: _____________
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23. Create a new Python program, python9xxx.py, that accepts input from the user and generates an 
email address, as follows:

 First name: Sam

 Last name: Throckmorton

 Welcome Sam!

 Your new email address is Sam.Throckmorton@mycollege.edu

 The email address should consist of the user’s first name, a dot, and the user’s last name, followed by 
@mycollege.edu.

 Write the code you used to create the program.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Did the code run properly? [ Yes | No ]

Instructor initials: _____________

Lab 15.9 Introduction to JavaScript

Objective: To create and run JavaScript programs in a web browser

Parts: Windows computer with access to the internet and rights to download and install free 
software

Procedure: Complete the following steps and answer the accompanying questions.

Notes: JavaScript runs in a browser. A JavaScript program is called from a web page, which is 
written in HTML. Normally web pages are stored on a server and opened from the inter-
net. However, for this lab, you will create a simple HTML file, add some JavaScript, and 
open your file in the browser from your computer. An HTML file is a text file. There are 
many HTML editors available, and many of them are free. But here you will simply use 
Notepad.

1. Power on the computer and log on.

2. Using File Explorer, create a folder to save your work. Name the folder JavaScriptTest.

3. In this step you will be creating a simple web page. All items in web pages are defined by tags, which 
are keywords that help organize, format, and classify content. Most tags are in pairs, with an open-
ing tag (start tag) and a closing tag (end tag). Everything between the start and end tags will have the 
formatting associated with that tag. While this can be changed by a web designer, here you can ac-
cept the default formatting. All web pages start with an <html> start tag and end, at the very bottom 
of the page, with a </html> end tag. Notice that an end tag begins with a slash (/). All web pages 
have two important parts: a head section and a body section. The head section includes information 
needed by the browser that is not seen by the user. The body section is where the content within the 
browser is displayed.
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 Open Notepad or any other text editor. Type the following text into Notepad to create the web page:

 Note: It is very important that you type all punctuation correctly. Also, in the third line from the bot-
tom, <h1> and </h1> have the number 1 after the h, not a lowercase L.

 <html lang="en">

 <head>

     <meta charset="utf-8" />

     <title>First JavaScript Program</title>

 </head>

 <body>

     <h1>My First JavaScript Program</h1>

 

 </body>

 </html>

 The <html> tag in the first line contains the attribute lang="en". Attributes provide additional 
formatting and descriptive information associated with the tag. Not all tags contain attributes. The 
lang="en" attribute in this example sets the default language of the page to English, which is im-
portant for programs such as screen readers and search engines that may read the page. 

 The third line, <meta charset="utf-8" />, specifies the character set. In this case, utf-8 is 
capable of encoding all the characters in Unicode. ASCII is a subset of Unicode. Note that the meta 
tag is a type of tag called an empty tag because it has no end tag. Instead, there is a slash before the 
closing angle bracket (>).

 The next line uses the <title></title> tag pair to define a page title. The page title is the text 
that shows up in your browser on the very top whenever you go to a web page. This web page will 
have First JavaScript Program as its title.

 The head section must be closed with the </head> end tag before the body section begins with 
the <body> start tag. Anything between <body> and </body> will be visible when the page is 
opened in a browser.

 This web page has one line only. The text My First JavaScript Program will be displayed. 
Since it is enclosed in <h1></h1> tags, by default the text will be large and black. Other tag pairs 
can be used for different formats.

4. Note: Read this entire step before taking action. 

 Save your file inside the JavaScriptTest folder with the filename javascript1xxx.html, where 
xxx is your initials. In the Notepad Save As window, be sure to use the drop-down menu under Save 
as type to select the All Files option. Also, be sure to save your file with the .html extension by 
including the file extension (.html) as part of the filename. If you let Notepad use the default exten-
sion (.txt), your file will not be a web page.

5. Now open your web page in a browser by right-clicking on the javascript1xxx.html file 
in File Explorer and use the Open With option to select a web browser such as Microsoft Edge or 
Google Chrome. If you have done everything correctly, you should see in your browser a page like 
the one in Lab Figure 15.11.
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LAB FIGURE 15.11 HTML code in the Edge browser

 Notice the page title in the upper-left corner. Notice the path to the file in the browser’s address bar. 
In this case, the path is G:/Users/Akil/Documents/JavascriptTest/javascript-
1cal.html, but your path will be slightly different, depending on where you saved your file (and 
your own initials, of course). If your web page appeared properly, you are now ready to add some 
JavaScript. If it did not appear properly, correct the code using Notepad and rerun it until it does.

 Did the proper web page appear? [ Yes | No ]

Instructor initials: _____________

6. In this first JavaScript program, you will return to Notepad and create a button that the user will click 
to start the JavaScript program. The button and the area where the result of the JavaScript code will 
appear are enclosed in <p></p> tags. The button is nested inside the <p></p> tags and enclosed in 
<button></button> tags.

 In Notepad, enter the following code under the first line of the body (<h1>My First Java-
Script Program<h1>):

 <p>

    <button type = "button" onclick = "welcome()">Click me</button>

    <span id="greet">&nbsp;</span>

 </p>

 Note: While character spacing and line spacing are not essential in JavaScript or HTML, it is im-
portant to follow standard spacing and indentation conventions to make reading and debugging code 
easier: separate operators like + and = with a space and indent all JavaScript statements inside func-
tions as demonstrated in the next step.

 This code puts a Click me button on the web page. A space for the result is identified by 
id="greet", and the result will be placed in the area between the <span></span> tags. When 
the page initially loads, there is nothing in this space. The entity &nbsp; is simply a placeholder. It 
stands for “non-breaking space.”
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7. Run the updated program. If you see the Click me button, click it. If you do not see the Click me but-
ton, redo the code. Do not proceed until you see the Click me button.

 Does the Click me button appear? [ Yes | No ]

Instructor initials: _____________

8. Return to Notepad to edit the web page. In the head section, under the <title>First Java-
Script Program</title> line, add this JavaScript code:

 <script type = "text/javascript">

   function welcome()

   {

     var name = prompt("What's your name?);

     var greeting = ("Hello there, " + name + "!");

     document.getElementById('greet').innerHTML = greeting;

   }

 </script>

 JavaScript scripts (or programs) are enclosed in <script></script> tags. In this small script, 
the code defines a function named welcome(). When the button on the HTML page is clicked, con-
trol transfers to the welcome() function. All the code to be executed when the welcome() func-
tion is called is contained between an opening curly brace ({) and a closing curly brace (}).

 The first line of the function declares a variable named name. A variable is a named memory loca-
tion that stores data. In a script, variables are declared in order to tell the JavaScript interpreter to 
create the memory location that will store the value. A prompt will appear on the screen with the text 
What's Your Name?, and execution of the code will pause until the user types in a name. That 
value is stored in the variable name.

 The next line declares a second variable, named greeting. The value of greeting consists of 
text ("Hello there, ") joined with the value of name and then joined with an exclamation 
point. 

 Note: The text to be displayed includes a space after the comma. A space is considered a character. 
Without the space, the output would be something like this:

  Hello there,Chris!

 when what you want is this, in order to make the output more readable:

 Hello there, Chris!

 The last line of the function outputs the value greeting into the space on the web page identified 
by id="greet". This line has several parts:

 document.getElementById('greet').innerHTML = greeting;

 The word document refers to an object that represents the current web page. getElement-
ById() is a JavaScript function that tells the computer to look for an element with a tag on the page 
with the id attribute that matches what is inside the parentheses. In this case, it is the <span> tag 
with id="greet" attribute. The variable greeting, which is on the right side of this statement, is 
assigned to the innerHTML property of the element on the left side of the statement using the equal 
(=) sign. This is one way for JavaScript to tell the computer to replace whatever currently is in the 
<span> element with the value of the variable greeting.

9. Save your new file with the filename javascript2xxx.html inside your JavaScript Test folder. 
Now open the file in a browser as you did before.

10. Click the Click me button. Enter your name and see if it works. If your name is Chris, you should see 
the prompt and, after you enter Chris, the screen should display the correct greeting. Compare your 
results to Lab Figure 15.12 (which shows the page opened in Edge).
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LAB FIGURE 15.12 Enhanced JavaScript program with a button and a prompt

11. Now create a JavaScript program that allows the user to enter two numbers and either add or multiply 
them. You can start with your first program and make the following changes to the HTML body:

 > Change the page title to Second JavaScript Program.

 > Change the <h1></h1> contents to Second JavaScript Program.

 > In the <button> section, change the text on the button from Click me to Do the math!.
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 > In the next step, you’ll create a new JavaScript function named do_math().Therefore, in the on-
click= section of the HTML body, change welcome() to do_math().

 > Change the id attribute of the span element from greet to 'calc'.

12. Between the <script></script> tags in the head section, replace the welcome() function 
with the following do_math() function:

   function do_math()

   {

     var num1 = parseFloat(prompt("Enter the first number: "));

     var num2 = parseFloat(prompt("Enter the second number: "));

     var result = prompt("Enter A to add the numbers or M to 
multiply them: ");

     if (result == 'A')

       var answer = num1 + num2;

     else if (result == 'M')

       var answer = num1 * num2;

     else

       var answer = "Invalid entry";

     document.getElementById('calc').innerHTML = "The result is " + 
answer;

   }

 JavaScript does not have strict rules regarding spacing or indentation. In fact, a whole program could 
be typed on a single line, although this would never be a good idea since the resulting code would be 
difficult to read. The spacing and indentation you see in the code shown here follows standard coding 
conventions for readability, which is helpful for developers during debugging. You should make every 
effort to follow these conventions in your own code.

13. Save this new file inside your JavaScript Test folder with the filename javascript3xxx.html. 
There are a few new things worth discussing in this program:

 > It uses an if/else decision structure to determine whether to add the numbers or multiply them. It 
also validates the user input by displaying the error message Invalid entry if the user has not selected 
either A to add or M to multiply.

 > You will notice that the prompt() statements are enclosed in the JavaScript function 
parseFloat(). When a user types in anything in response to a prompt, it is automatically stored 
as a string (a sequence of text that is not interpreted as numbers). But, in order to do mathematical 
calculations, numerical digits must be stored as numbers. The parseFloat() function changes 
the text the user has entered into a floating-point number (a number with a decimal point).

14. Run your new program in a browser. Click on the Do the math! button. If the button is not there, redo 
the code until it appears. Do not proceed until the button appears.

 Does the Do the Math! button work properly? [ Yes | No ]

Instructor initials: _____________

15. Enter 3 and 5 for the two numbers and A to add (ensuring that it is a capital A). Lab Figure 15.13 
shows the results you should see, given the inputs listed. If you do not see this output, redo your code 
until you do.
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LAB FIGURE 15.13 JavaScript math program using addition

16. Click the Do the math! button again. Enter 4.6 and 6.9 for the two numbers and M to multiply (en-
suring that it is a capital M). Lab Figure 15.14 shows what you should see now.

LAB FIGURE 15.14 JavaScript math program using multiplication

17. Click on the Do the math! button again. Enter 35 and 63 for the two numbers and m to multiply. 
Note that the lowercase m is intentional so you can see the result shown in Lab Figure 15.15.
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LAB FIGURE 15.15 JavaScript math program, with an error due to case

18. To deal with the situation that arose in Lab Figure 15.15, where a lowercase letter is entered instead 
of the required uppercase letter, you can add a logical OR (||) operator to ensure that both lowercase 
and uppercase entries are valid. Change the if statement in your program as shown below:

    if (result == 'A' || result == 'a')

 and change the else if as shown here:

    else if (result == 'M' || result == 'm')

 There are a few things to be careful about when you make these changes:

 > You can enclose the text within the conditions with either double or single quotes (" " or ' '), but 
whichever you choose, it should be consistent.

 > The entire condition must be enclosed in parentheses.

 > The two sides of the OR symbol (||) must be complete conditions. 

 Consider these examples:

 if (result == "A" || result == "a') is not correct.

 if (result == 'A') || (result == "a") is not correct.

 if (result == 'A' || 'a') will not work.

 Save your file again with the new filename javascript4xxx.html, and run the program several 
times to make sure all of the entries (A, a, M, and m) are now valid. Troubleshoot your code until it 
works before proceeding.

 Does the Do the math! button work with lowercase letters now? [ Yes | No ]

Instructor initials: _____________

19. Click on the Do the math! button again. Enter two and six for the two numbers and A to add.

 In Lab Figure 15.16, the result is shown as NaN. This stands for “not a number,” and it is what you 
get when the JavaScript parseFloat() function attempts to convert text that has no numerical 
value to a number. To avoid the NaN error, a developer can validate the input by checking if the value 
stored in num1 or num2 was an actual number and, if necessary, prompt the user for a valid entry.
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LAB FIGURE 15.16 JavaScript math program, with invalid entries

20.  Now you will add a loop to this program to allow the user to run the program as often as desired 
without having to use the Back button or refresh the screen. To do this, you need to add a variable, 
rerun, and set its initial value to y. Then you open a while loop and enclose the entire block of 
statements in the loop within curly braces ({ }). You will also call the alert function to display an 
alert box containing the result, followed by a prompt asking the user if the program should run again.

  The new do_math code looks like this:

  function do_math()

  {

    var rerun = 'y';

    while (rerun == 'y' || rerun == 'Y')

    {

      var num1= parseInt(prompt("Enter the first number: "));

      var num2 = parseInt(prompt("Enter the second number: "));

      var result = prompt("Enter A to add the numbers or M to mul-
tiply them: ");

      if (result == 'A' || result == 'a')

        var answer = num1 + num2;

      else if (result == 'M' || result == 'm')

        var answer = num1 * num2;

      else

        var answer = "Invalid entry";

      alert("The result is " + answer);

      rerun = prompt("Enter y or Y to continue or enter any other 
value to end: ");

    }

  }
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  Note the two closing curly braces at the end. One closes the while loop, and the other closes the 
do_math() function; the indentation should help make this clear. The parseInt() function 
changes any value the user has typed into an integer, if possible. The parseFloat function per-
formed a similar conversion in javascript3xxx.html in step 13. Save this program as javascrip-
t5xxx.html and run it in a browser. After you enter two numbers and get the result, you should 
see a screen like the one in Lab Figure 15.17.

LAB FIGURE 15.17 JavaScript math program with a repeat option

  Test your loop by entering y and making sure the program runs again.

 Does the prompt appear, allowing you to rerun the program? [ Yes | No ]

Instructor initials: _____________

On Your Own

Note: With all scripting languages, there are multiple ways to solve most programming problems. 
As you become more proficient with writing code, you may find new or more efficient ways to 
solve problems.

21. Run the javascript3xxx.html or javascript4xxx.html program, enter the values 3.3 
and 3.3, and select the option to multiply. What is the result? Did you get what you expected? Why 
or why not? Use the internet to research how floating-point numbers are stored. See if you can ex-
plain why the results of doing math with floating-point numbers is not truly accurate.

 The expected value is 10.89, but the result is more like 10.889999999999999. Floating-point numbers 
are stored as sign-exponent-mantissa, and math done with them can never be 100% accurate because 
of the way decimal (fractional) values are stored. To get a better answer, you would need to specify 
how many decimal places you want the numbers to use.

22. Change the code of your javascript3xxx.html or javascript4xxx.html file to offer the 
user the option to subtract the two numbers. Provide the code that you changed to make this work.

  _________________________________________________________________________________

  _________________________________________________________________________________
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  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

23. Change the input prompts in the javascript3xxx.html file to use integers instead of floating-
point numbers. Save this file as javascript6xxx.html. Use the parseInt() function in-
stead of the parseFloat() function. Make sure the program works when integers are input by the 
user.

 Provide the code that you changed to make this work.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

24. Try entering the following in your javascript6xxx.html program: 4.5, 2, and M. 

 What is the result? Is it what you would expect? Can you explain what happened? Do some research 
on the internet to find out what happens when a floating-point number is entered in JavaScript when 
an integer is expected.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

25. Consider the do_math() function. 

 What special circumstances might arise if you attempt to include the option to divide two numbers?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________





Advanced Windows Labs16

Lab 16.1 Creating a Bootable Windows 10/11 USB Flash Drive

Objective: To be able to create a bootable Windows flash drive. You will need a bootable Windows flash drive in subsequent labs.

Parts: A Windows 10 or Windows 11 computer with access to the internet.

 8 GB or higher flash drive (which will be wiped)

Note: The screens may appear a little differently due to Windows updates.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Ensure that the USB flash drive does not contain any data that needs to be preserved. Note that the contents of the flash drive will 
be erased as part of the process.

 Insert the flash drive into the computer.

2. Open File Explorer > This PC. Make note of the drive letter assigned to the flash drive.

 What is the drive letter assigned to the flash drive?

  _________________________________________________________________________________

3. Visit https://www.microsoft.com/en-us/software-download/windows10 for Windows 10 or  
https://www.microsoft.com/en-us/software-download/windows11 for Windows 11.

4. Find the Create Windows 10 Installation media (or Create Windows 11 Installation Media) section of the page. Click Download 
Now. A file that begins with MediaCreationTool is saved to your computer, most likely in the Downloads folder.

5. Run the file that was downloaded in step 4. If prompted, click Yes in the User Account Control dialog box. The Windows 10 Setup 
(or Windows 11 Setup) window opens.

6. Click Accept in the Applicable notices and license terms dialog box. The message Getting a few things ready appears for a few 
seconds.

7. a.  If you are downloading Windows 10, in the What do you want to do? dialog box, select Create installation media (USB flash 
drive, DVD, or ISO file) for another computer. Click Next. The Select language, architecture, and edition dialog box opens.

 b. If you are downloading Windows 11, the Select language and edition dialog box opens.
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8. If necessary, uncheck Use the recommended options for this PC and then update the options as 
needed. Click Next. The Choose which media to use dialog box opens.

9. Select USB flash drive. Click Next. The Select a USB flash drive dialog box opens.

10. Warning: All the contents of the USB flash drive will be erased in this step. Make sure you choose 
the right flash drive.

 Click the flash drive that you inserted into the computer in step 1. Make sure the drive letter matches 
the drive letter that your recorded in step 2. Click Next.

 The messages Getting a few things ready > Downloading Windows 10 (or Downloading Windows 11) 
> Verifying your download > Creating Windows 10 media (or Creating Windows 11 media) appear in 
succession. The time required for these processes to complete depends on your computer, your flash 
drive, and your internet connection. You can continue to use your computer while the media is being 
created.

 The message Your USB flash drive is ready appears when the creation process is complete. Click 
Finish.

11. Use a safe method to properly eject the flash drive, such as the Safely Remove Hardware and Eject 
Media tool in the notification area or File Explorer > This PC > right-click the flash drive > Eject.

12. Physically remove the flash drive from the PC.

Lab 16.2 Windows 10/11 Installation (Clean Install)

Objective: To install Windows 10/11 on a hard drive partition that does not have an existing operating 
system

Parts: A computer with the minimum hardware requirements for Windows 10/11

 Windows 10/11 installation media, such as a bootable Windows 10/11 installation USB 
flash drive (see Lab 16.1)

Note: The screens may appear a little differently due to Windows updates. 

Procedure: Complete the following procedure and answer the accompanying questions.

1. Insert or attach the Windows 10/11 installation media.

2. Turn on the computer and configure the BIOS/UEFI to boot from the installation media.

3. Turn on or restart the computer. If the BIOS/UEFI is configured correctly, the computer boots from 
the installation media. Watch for the message Press any key to boot from CD or DVD. If you see it, 
immediately press any key on the keyboard. If you don’t press a key quickly enough, you will have to 
restart the computer and try again.

 The Windows Setup program starts. Select the appropriate regional options, such as language, time/
currency, and keyboard/input method and click Next.

4. Select Install now to start the Windows installation.

5. Enter the Windows product key given to you by the instructor and then click Next. If you don’t have a 
product key, you can select the I don’t have a product key option.

6. Select the proper edition of Windows. Check with the instructor if you are unsure. The edition must 
match the Windows product key version. Click Next.

7. Read the Microsoft software license terms. Select (enable) the I accept the license terms checkbox 
and click Next. Two installation options appear for Windows: to upgrade or to perform a custom 
installation.

8. To install Windows as a clean installation, click the Custom: Install Windows only (advanced) option.

9. If a RAID or SCSI driver is needed, click Load driver to install it at this point. Otherwise, delete, cre-
ate, or configure a partition (as needed) on which to install Windows. Select the desired partition and 
then click Next.
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 The Windows Setup program copies the required files and folder to the partition and then restarts the 
computer. When the computer boots up, Windows loads and completes the installation. The computer 
eventually enters the Windows Out of Box Experience (OOBE), which is similar to what a user sees 
if they buy a new computer and turn it on for the first time. The first dialog box in the OOBE is Let’s 
start with region. Is this right?

Instructor initials: _____________

10. Click Yes and continue with the remaining dialog boxes (keyboard, second keyboard, network, ac-
count, and so on). The dialog boxes that are presented to you depend on the edition of Windows that 
you selected in step 6. Contact the instructor or lab assistant for specific options to select on each dia-
log box.

11. Determine the type of access method, such as a username (or Microsoft account) and password. Fin-
gerprint, facial recognition, or PIN can also be used. Contact the instructor or lab assistant for which 
credentials to use on the Let’s add your account dialog box, if necessary.

 Print the username or account name, if applicable.

  _________________________________________________________________________________

 Print the exact password to be used, with appropriate uppercase and lowercase letters, if applicable.

  _________________________________________________________________________________

12. Enter options for the last dialog box, and the Windows logon or the Windows desktop eventually 
appears.

Instructor initials: _____________

Lab 16.3 Windows 11 Upgrade

Objective: To become familiar with upgrading to Windows 11 from Windows 10

Parts: A computer with Windows 10 installed, internet access, and a user ID that has Administra-
tor rights

 Windows 11 installation media, such as a bootable Windows 11 USB flash drive (see Lab 
16.1)

Procedure: Complete the following procedure.

1. Power on the computer that is to be upgraded and verify that Windows 10 loads. Log in using the 
user ID and password provided by the instructor or lab assistant.

2. Before proceeding, back up any important data that is on the computer. If using a virtual machine, 
create a snapshot that you can revert to if you run into problems.

3. Review the Windows 11 minimum requirements to make sure the computer is compatible.

4. Insert or attach the installation media.

5. Run the setup.exe file from the media. If prompted, click Yes on the User Account Control dialog 
box. The Windows 11 Setup window opens.

6. If the installer prompts you to download updates and you need to install updates, click Next.

 If you don’t need to install updates, click Change how Setup downloads update > Not right now > Next.

7. When prompted, click Accept to agree to the Microsoft software license terms. The updates are down-
loaded and installed.

8. When the Ready to install dialog box appears, confirm that Install Windows 11 Pro (or the appropriate 
edition that your instructor specifies) and Keep personal files and apps are checked and then click Install.

 The installation begins. The Windows Setup program updates the required files and folders to con-
vert Windows 10 to Windows 11. This can take a few hours to complete, and during this process, the 
computer may reboot several times. The time required for this process to complete depends on the 
computer, your flash drive, and your internet connection. When the installation finishes, you will be 
at a Windows 11 login screen.
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9. Log in with the same username and password that you used in step 1. The initial login might take 
several minutes. Upon successful login, you will be at the Windows 11 desktop.

Instructor initials: _____________

Lab 16.4 Windows Registry Modification

Objective: To modify the Windows registry when given directions to do so

Parts: A computer with Windows 10 or 11 loaded and a user ID that has Administrator rights

Note: You must be an administrator or a member of the Administrators group to change registry 
settings. Sometimes, Microsoft or another reliable source gives you instructions to edit the 
registry to fix a problem. It is important that you follow the directions exactly as stated.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and verify that Windows loads. Log onto the computer using the user ID and 
password provided by the instructor or lab assistant.

2. Open File Explorer. Right-click any folder within Documents. If no folder exists, create one.

 Which editing options are available for a folder? (Select all that apply.)

 [ Cut | Copy | Paste | Copy To Folder | Move To Folder | Delete | Rename | Send To ]

3. Click the Start button > type regedit > ® > Yes.

4. Expand the Hkey_Classes_Root key by clicking the > (greater-than sign) beside the key.

5. Scroll down to locate and expand AllFileSystemObjects. Note that items beginning with a 
character such as a . (period) appear before the alphabetized list of other objects.

6. Expand the shellex object and locate ContextMenuHandlers. shellex is a shell extension 
key that lets you customize the Windows interface.

7. Right-click ContextMenuHandlers > New > Key. When the new folder (key) appears, type 
Copy To and press ®. This registry modification adds a new option to the right-click menu 
called Copy To.

8. With the Copy To object still selected in the left window, double-click the (Default) name in the right 
panel. The Edit String window appears.

9. In the Value data textbox, type the following value exactly as shown (noting that the 0s are zeros):

 {C2FBB630-2971-11D1-A18C-00C04FD75D13}

 Click OK.

10. To verify that the change has occurred, open File Explorer and right-click any folder. In Windows 11, 
also click Show more options.

 Does Copy To folder appear as an option? [Yes | No ]

 If not, redo the lab.

Instructor initials: _____________

11. Return to the Registry Editor window. Using the same process outlined in steps 4–10, create another 
new key under ContextMenuHandlers and name the key Move To. The value data for the Move 
To key is as follows:

 {C2FBB631-2971-11D1-A18C-00C04FD75D13}

12. Use File Explorer to create two new folders. Using the new Copy To and Move To options you just 
created, place a couple files into each folder.

13. Delete any folders/files that you have created.

14. To delete keys in the Registry Editor, select the Copy To option in the left panel. From the Edit menu op-
tion, select Delete and select Yes when asked to verify. Delete the Move To key using the same process.

Instructor initials: _____________

15. Close the Registry Editor window.
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Lab 16.5 Backup and Restore (Windows 7)

Objective: To back up files, including the operating system, if necessary, using the Backup and Re-
store (Windows 7) utility

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

 A backup destination, such as a USB flash drive, an external hard drive, or a network drive

Procedure: Complete the following procedure and answer the accompanying questions.

Note: Even though only three files are backed up using this process, you can use the same pro-
cess to back up the entire computer.

1. Create a new folder called Stuff under Documents.

2. Create three text files with any names and place them in the new Stuff folder.

3. Access Control Panel > System and Security > Backup and Restore (Windows 7) > Set up backup 
link. Note that if the Set up backup link has already been configured, the Change Settings link can be 
used to complete the lab. The Set up backup link takes a while to initialize.

4. Select a backup destination designated by the instructor or lab assistant > Next > select the Let me 
choose radio button > select Next.

 Note: You can use the Let Windows choose radio button to back up the entire operating system and all 
the files.

5. Deselect all enabled checkboxes > expand Local Disk (C:) by clicking the arrow beside it > expand 
Users > expand the username used to log into the computer > expand Documents > select the Stuff 
folder to enable it for backup > Next > Save settings and run backup button.

6. The backup executes. Show the instructor the Windows Backup has completed successfully dialog 
box.

Instructor initials: _____________

7. Delete the Stuff folder and the three files contained within it.

Lab 16.6 Windows Update Utility

Objective: To configure options for Windows updates.

Parts: A computer with Windows 10 or 11 loaded, a user ID that has Administrator rights, and 
internet access

Note: You must be an administrator or a member of the Administrators group to change Auto-
matic Updates settings.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and verify that Windows loads. Log onto the computer using the user ID and 
password provided by the instructor or lab assistant.

2. Click the Start button > Settings > Windows Update. By default Windows is automatically updated to 
fix functionality, performance, and security issues. However, individual users can use Pause updates 
to temporarily suspend updates. Large organizations may turn off automatic updates altogether and 
apply updates manually.

 Why do you think most large corporations would want to apply updates manually?

  _________________________________________________________________________________

 When was the last Windows update?

  _________________________________________________________________________________

3. Close the Windows Update window.

4. Click the Cancel button to close the Automatic Updates window.
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Lab 16.7 Configuring Windows 10 and 11 for Ease of Access

Objective: To configure Windows 10 or 11 for customers who need a customized environment for 
visual, auditory, and physical reasons

Parts: A computer with Windows 10 or 11 installed

Procedure: Complete the following procedure and answer the accompanying questions. Note that not 
all steps are shown, and you must explore some settings based on the question asked.

1. Access Control Panel > Ease of Access > Ease of Access Center.

2. Select the Let Windows suggest settings link. You should be on the Get recommendations to make 
your computer easier to use window.

 What recommendations does Microsoft make available to someone at the workplace who has trouble 
seeing images on the screen because of the office lighting? You do not have to select an option on 
each of the five screens that presents options. You should only select an option that relates to the sce-
nario given.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Click Cancel when you are done answering the question. You should be at the Ease of Access Center 
window, and you should see the Make your computer easier to use section and the Explore all set-
tings section.

3. Use the Explore all settings options to answer the questions.

 What is the purpose of the Make the mouse easier to use setting?

  _________________________________________________________________________________

 What is the purpose of the Make it easier to focus on tasks setting?

  _________________________________________________________________________________

 Which option do you think might be used on a Microsoft Surface tablet?

  _________________________________________________________________________________

4. Return to the main Ease of Access Control Panel category and reselect the Let Windows suggest set-
tings link. You should be on the Get recommendations to make your computer easier to use window. 
If applicable, disable (uncheck) the Lighting conditions make it difficult to see images on my monitor 
checkbox.

5. Select the Images and text on TV are difficult to see (even when I’m wearing glasses) checkbox. Click 
Next four times and then click Done to view Microsoft’s recommendations.

 What options are recommended (checked) by Microsoft for this situation?

  _________________________________________________________________________________

  _________________________________________________________________________________

6. In the Change the color and size of mouse pointers section, select the Large Inverting radio button. 
Click Apply.

7. Move the mouse and open File Explorer.

 Describe how the mouse pointer changes.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Would office workers who do not have a visual impairment enjoy this feature?

  _________________________________________________________________________________
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8. Change the mouse pointer back to Regular White. Ensure that the Turn on or off High Contrast when 
left ALT + left SHIFT + PRINT SCREEN option and its associated checkboxes are enabled. Click 
Apply.

9. Hold down the left å key, and while keeping the key held down, press and hold the left Í key. 
While holding down both of these keys, press the Â key (å+left Í+Â). Release all 
three keys.

 What audio signal do you hear?

  _________________________________________________________________________________

 Based on information in the message, document how to disable the keyboard shortcut if these keys 
are used for another application.

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Click Yes.

 Describe the difference in screen appearance.

  _________________________________________________________________________________

 Do you like the high contrast?

  _________________________________________________________________________________

11. Use the same keys again to disable the high-contrast setting. Click Cancel in the Recommended Set-
tings window.

12. Select the Get recommendations to make your computer easier to use link. Deselect the checkbox for 
Images and text on TV are difficult to see (even when I’m wearing glasses) and click Next.

13. In the Dexterity window, select the Pens and pencils are difficult to use checkbox. Click Next or Done 
until you reach Microsoft’s recommendations.

 What option or options are recommended (checked) by Microsoft?

  _________________________________________________________________________________

 Turn on Toggle Keys by holding down the ˆ key for five seconds.

 What is the Toggle Keys setting? What happens when a toggle key is pressed?

  _________________________________________________________________________________

14. Open Notepad. Notice the appearance of the blinking cursor in the top-left corner.

15. Leave Notepad open and return to the Recommended Settings window. Notice the setting for Set the 
thickness of the blinking cursor. Change the thickness of the blinking cursor to 5. Click Apply.

16. Return to Notepad and notice the difference in the blinking cursor.

17. Return to the Recommended Settings window and return the thickness to the default setting of 1 and 
click Apply. Close Notepad.

18. Return to the Recommended Settings window.

 What is the Sticky Keys setting?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Who might benefit from the Sticky Keys setting?

  _________________________________________________________________________________

19. Select the Set Up Filter Keys link.

 What is the Filter Keys feature?

  _________________________________________________________________________________
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 What is the default amount of time the Í key has to stay pressed to toggle on Filter Keys?

  _________________________________________________________________________________

 By default, do you see a warning message, do you hear a tone, or do you get both a message and a 
tone when Filter Keys is active?

 [ Warning message | Tone | Both ]

 What is the Bounce Keys feature?

  _________________________________________________________________________________

 What is the default time between keystrokes if the Bounce Keys feature is enabled?

  _________________________________________________________________________________

 Is this setting adjustable? [ Yes | No ]

20. Click in the Type text here to test settings textbox and type hello.

 What happened?

  _________________________________________________________________________________

21. Click the Set up Repeat Keys and Slow Keys link.

22. Click in the Type text here to test settings textbox. Click and hold the h key down until it appears in 
the textbox. Finish typing the word hello in the textbox. Note that in a virtualized environment, this 
option does not work. If you are in such an environment, simply write virtualization used in answer 
to the question below.

 What indication did you get, in addition to seeing it appear in the textbox, that the letter “took”?

  _________________________________________________________________________________

Instructor initials: _____________

23. Click Cancel to return to the Set Up Filter Keys screen.

 What are the other settings this window offers?

  _________________________________________________________________________________

24. Click Cancel to return to the Ease of Access Center.

25. Return to the Ease of Access Control Panel category and select the Let Windows suggest settings link. 
Return to the Dexterity window and clear the checkbox for the Pens and pencils are difficult to use 
option. Click Next.

26. On the Hearing window, select the Conversations can be difficult to hear (even with a hearing aid) 
checkbox. Click Next or Done until you reach the Microsoft recommendations.

 What options are available?

  _________________________________________________________________________________

  _________________________________________________________________________________

27. Enable Turn on visual notifications for sounds (Sound Sentry). Select the visual warning Flash active 
window. Click Apply.

28. Leave that window open and access the Hardware and Sound Control Panel utility in a separate 
window. In the Sound section, select the Change system sounds link. On the Sounds tab, select a Win-
dows notification that has a speaker beside it. Click the Test button.

 Even if your computer does not have speakers, what visual clue do you get that a sound is being 
made? Note that this option may not function in a virtual environment; if you are in such an environ-
ment, simply write virtualization used in answer to the question below.

  _________________________________________________________________________________

29. Close the Sound window. Return to the Recommended Settings window. Remove the check from Turn 
on visual notifications for sounds (Sound Sentry). Click Apply. Click Cancel to return to the Ease of 
Access Center.
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30. Return to the Ease of Access Control Panel category and select the Let Windows suggest settings link. 
Return to the Hearing window and disable the Conversations can be difficult to hear (even with a 
hearing aid) option. Click Next to advance to the Speech Options screen.

31. Enable the Other people have difficulty understanding me in a conversation (but not due to an accent) 
option. Click Next or Done until you reach Microsoft’s recommendations.

 What is Microsoft’s recommendation?

  _________________________________________________________________________________

32. Click the Completing the questionnaire again link. Return to the Speech page and enable the I have a 
speech impairment checkbox. Continue to the recommendations.

 Did this change Microsoft’s recommendations? If so, what are the recommendations?

  _________________________________________________________________________________

33. Return to the questionnaire and disable all options from the Speech page and click Next to advance to 
the Reasoning window. Select the I have a learning disability, such as dyslexia option. Click Done.

 What does Microsoft recommend for this type of person?

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

34. Click Cancel. Ensure that all Ease of Access options are disabled. Close the Ease of Access Center 
window.

Lab 16.8 Windows System Restore Utility

Objective: To configure and use the System Restore utility

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

Note: You must be an administrator to perform a system restore. If the System Restore utility has 
been disabled, this lab may have to be done over two class periods. One class period would 
be used to enable it and schedule a restore point, and the next class period to perform the 
system restore. Also note that an antivirus update or a Windows update might have to be 
reinstalled as a result of the system restore.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and verify that Windows loads. Log onto Windows using the user ID and 
password provided by the instructor or lab assistant.

2. The System Restore utility is disabled by default. In order to use System Restore, system protection 
has to be enabled. Open Settings > System > About > System protection. The System Properties win-
dow opens with the System Protection tab open.

3. In the Protection Settings window, notice that the C: drive has a protection status of off. Select the C: 
drive in the Protection Settings window and click the Configure button.

4. In the Restore Settings section, enable the Turn on system protection radio button. Using the Max Us-
age slide bar, adjust the drive space allocated for restore points to approximately 15% of the drive. 
Click the OK button.

5. On the System Protection tab, click the Create button to create a restore point. A Create a restore 
point dialog box will open. Name the restore point and click Create. The restore point is created.

 What did you name the restore point?

  _________________________________________________________________________________

 What message did you get?

  _________________________________________________________________________________

Instructor initials: _____________
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6. Click the Close button and then the OK button. Close the System > About window.

7. Hold down the  key and press the r key. In the Run box, enter rstrui and click OK. Note 
that an alternate way of bringing up System Restore is to type rstrui in the Type here to search 
textbox.

8. In the System Restore window, read the explanation of System Restore.

 What are two reasons that System Restore might be used?

  _________________________________________________________________________________

 True or false: System Restore does not affect personal data documents. [ T | F ]

 Can a recently installed application be affected by using the System Restore utility? [ Yes | No ]

9. Click the Next button.

 Are any restore points available? If so, list the latest one. [ Yes | No ]

  _________________________________________________________________________________

  _________________________________________________________________________________

 Look at the latest restore point. What type of restore point is it? [ Automatic | System | Manual ]

 Can you create a restore point from this screen? [ Yes | No ]

Instructor initials: _____________

Using a Restore Point

10. To use a restore point to take a system back to an earlier point in time, select the newest restore point 
(the first one in the list) and then click Next.

11. Select Finish to continue. Read the final warning and note.

 Under what conditions can the System Restore changes not be undone?

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

12. Click Yes to start the restore process, which might take several minutes. The computer restarts as part 
of the process.

13. Log into Windows. A System Restore dialog box shows the status of the restoration, including the 
time and date to which the system has been restored. Ensure that the system works. Click the Close 
button.

14. Do not forget that after the system has been restored to an earlier time, you should install any antivi-
rus or Windows updates that have been affected by this system restore.

Lab 16.9 Upgrading a Hardware Driver and Using Roll Back Driver

Objective: To install an updated driver under the Windows operating system

Parts: A computer with Windows 10 or 11 installed, a user ID that has Administrator rights, and 
internet access

Note: In this lab, a new driver is loaded, and then the old driver is reinstalled with the Roll Back 
Driver feature.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user ID 
and password provided by the instructor or lab assistant.

2. Select an installed hardware device whose driver you want to upgrade. 

  What device did you select to upgrade?

  _________________________________________________________________________________
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3. Open Device Manager.

4.  Expand the hardware category that contains the device being upgraded by clicking on the arrow be-
side the category.

5. Right-click the device name and click the Properties selection.

6. Select the Driver tab.

  What are the current Driver Provider, Driver Date, and Driver Version settings?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Download the driver to the hard drive. Note that some drivers may come in a compressed file and 
must be uncompressed before you can continue the procedure. Also note that drivers can have one of 
several extensions, such as inf, exe, dll, or sys.

 What is the full path of the folder where you saved the driver file(s) on your computer?

  _________________________________________________________________________________

 What is the extension on the driver file(s)?

  _________________________________________________________________________________

Instructor initials: _____________

Installing the Driver

8. If your driver file(s) does not have the extension exe:
a. Open Device Manager.
b. Expand the hardware category that contains the device being upgraded by clicking on the arrow 

beside the category.
c. Right-click the device name and click the Properties selection.
d. Select the Driver tab.
e. Click Update driver and then use the Browse my computer for drivers link to locate the driver that 

you downloaded in step 7. 
f. Click Browse and then locate the folder that you recorded in step 7. Click on the folder that contains 

the driver file(s). Click OK.
g. Click Next. The system installs the updated drivers.

 If your driver file(s) has the extension exe:
a. Use File Explorer to open the folder that you recorded in step 7.
b. Double-click the exe file. The system installs the updated drivers. The installation program might 

present dialog boxes to help you configure the new driver. Also, additional software might be in-
stalled during the driver upgrade. You might need to restart the computer.

9. Return to the Driver tab in Device Manager (see steps 3 through 6 in this lab). The Driver Provider, 
Driver Date, and/or Driver Version settings should be different.

 What are the new Driver Provider, Driver Date, and Driver Version settings?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 If the driver was not updated, repeat steps 1 through 9.

Instructor initials: _____________
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Using Roll Back Driver

10. In Device Manager, right-click the device name again and select Properties.

11. Click the Driver tab and click the Roll Back Driver button. Select a reason for the rollback. Click the 
Yes button to roll back the driver. The Driver Provider, Driver Date, and/or Driver Version settings 
should be the same as in step 6.

  What are the Driver Provider, Driver Date, and Driver Version settings now?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

12. Close all windows and power off the computer properly.

Lab 16.10 Disabling a Hardware Driver

Objective: To disable a driver under the Windows operating system

Parts: A computer with Windows 10 or 11, a user ID that has Administrator rights, and a network 
adapter installed

Note: In this lab, a driver is disabled and then re-enabled. Sometimes Windows can install the 
wrong driver, in which case the driver must be disabled and then manually reinstalled.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user ID 
and password provided by the instructor or lab assistant.

2. Using Device Manager, expand the Network adapters category.

 What network adapter is installed in the computer?

  _________________________________________________________________________________

3. Right-click a network adapter and select the Disable device option.

 What message displays on the screen?

  _________________________________________________________________________________

4. Click the Yes button.

 In Device Manager, how is a device that has its driver disabled displayed differently from any other 
device?

  _________________________________________________________________________________

Instructor initials: _____________

5. In Device Manager, right-click the same network adapter and select the Enable device option. The 
device is re-enabled and appears normally in the window.

6. Close the Device Manager window and all other windows.

Lab 16.11 Installing Hardware

Objective: To install a new hardware component under the Windows operating system

Parts: A computer with Windows 10 or 11 installed, a user ID that has Administrator rights, and 
access to the internet

 A new device to install

Note: In this lab, the internet is used to obtain the device’s installation instructions and latest 
device installer and/or driver, and then the new hardware device is installed.

Procedure: Complete the following procedure and answer the accompanying questions.
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1. Ensure that the computer is properly shut down.

2. Using the internet, locate the manufacturer’s instructions for installing the device.

 Who is the device manufacturer?

  _________________________________________________________________________________

3. Using the internet, locate the latest device driver that is compatible with the version of Windows 
being used.

 Does the device have an appropriate driver for the version of Windows being used? [ Yes | No ]

 What device driver version is being downloaded?

  _________________________________________________________________________________

4. Connect the device to the computer or install it inside the computer using the proper installation 
procedures.

5. Boot the computer. Usually, Windows automatically detects the new hardware and begins the Found 
New Hardware Wizard. If it does not present this wizard and if the hardware device vendor supplied 
an installation program, use that program to install the device. If no vendor-supplied installation pro-
gram is available, use Device Manager or the Add a device link in Devices and Printers to install the 
device and install the device driver based on the device type and manufacturer’s instructions.

 Did the Found New Hardware Wizard begin? [ Yes | No ]

6. Test the device.

Instructor initials: _____________

Lab 16.12 Installing and Removing Windows Components

Objective: To install and remove Windows components

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user 
ID and password provided by your instructor or lab assistant. Ensure that the user ID is one that has 
Administrator rights.

Verifying and Installing Windows Features

2. Open File Explorer, right-click This PC, and select Properties. Select the System protection link. If 
necessary, enable system protection as follows: click on the C: drive, select Configure, enable the 
Turn on system protection radio button, and click OK.

3. Create a system restore point by clicking the Create button. In the description textbox, type class 
followed by the current date. Click Create. A dialog box appears when the restore point has been suc-
cessfully created. Click Close.

4. Click OK in the System Properties window.

5. Access the Programs Control Panel category and select the Turn Windows features on or off link in 
the Programs and Features section.

 List three enabled Windows features.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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 List three Windows features that are turned off.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Notice that the Internet Information Services option is controlled through this section. Expand the In-
ternet Information Services option or another option that can be expanded.

7. Check with your instructor or lab assistant for a specific feature to turn on. One option would be to 
turn on the TFTP client if it is not enabled.

 Write the name of the program to be enabled.

  _________________________________________________________________________________

8. Select the checkbox for the feature to be enabled and click OK. Note that enabling the feature might 
take a few minutes.

9. Re-access the Turn Windows features on or off link to verify that the feature now shows as enabled.

Instructor initials: _____________

10. Remove the check from the feature you just enabled and verify that the feature is disabled 
successfully.

11. Access the Programs > Default Programs in the Control Panel. Select the Set your default programs 
link.

 What can be done from this window?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

12. In Windows 10, click Choose defaults by app > Microsoft Edge > Manage. In Windows 11, select 
Microsoft Edge from the Set defaults for applications list. Microsoft Edge is used as an internet 
browser.

 List the extensions that are automatically opened by Microsoft Edge.

  _________________________________________________________________________________

 List protocols that are automatically recognized from the address line in Internet Explorer or Micro-
soft Edge. Note that you might need to scroll down to see the protocols.

  _________________________________________________________________________________

13. Close the Microsoft Edge settings window and return to the Default Programs window.

14. Select the Associate a file type or protocol with a program > Choose default apps by file type (Choose 
defaults by file type in Windows 11).

 List one program extension that does not have a program associated with it (that is, has Choose a de-
fault instead of a program).

  _________________________________________________________________________________

  _________________________________________________________________________________

15. Close the Default Programs window.

16. Create and save a Notepad document called Superdog.txt.

 Document the location where this document is saved.

  _________________________________________________________________________________

17. Open File Explorer and locate the Superdog.txt file. Select the View menu option.

 What is the current view?

  _________________________________________________________________________________
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18. Select the List view. Reselect the View menu option.

 In Windows 10, select Options (located on the far right) > Change folder and search options > View 
tab.

 In Windows 11, click the three dots to the right of View > Options > View tab.

 What is the current setting for Hide extensions for known file types? [ Enabled | Disabled ]

  _________________________________________________________________________________

19. Ensure that the Hide extensions for known file types option is disabled (unchecked). Click OK.

20. Return to File Explorer and ensure that the .txt extension is visible on the Superdog.txt file-
name. Right-click the Superdog.txt filename and select Rename. Rename the .txt extension to 
.cal (or your own initials, if they are not a common file extension). When the message window ap-
pears, select Yes.

 How did the appearance of the file change?

  _________________________________________________________________________________

  _________________________________________________________________________________

21. Right-click the Superdog filename and select Properties.

 What application does Windows assign to open the document?

  _________________________________________________________________________________

22. Click Change > More apps > Notepad > OK > OK.

23. Locate the Superdog file in File Explorer and double-click or double-tap the icon.

 Does the file open? [ Yes | No ]

 If so, what application opens the file?

  _________________________________________________________________________________

Instructor initials: _____________

24. Close the Superdog file. Return to the Change default apps by file type (Change defaults by file 
type in Windows 11) window. Scroll down until you see the extension you used when you renamed 
the Superdog filename. Show your instructor or lab assistant the file extension.

Instructor initials: _____________

25. Permanently delete the file by holding down the Í key while pressing ∂. Click Yes to perma-
nently delete the file.

26. On your own, create another file that ends in the same file extension. Try to open it.

 What happens?

  _________________________________________________________________________________

27. Close the file and permanently delete it.

28. Reopen the System Restore utility. Click Next.

29. Select the classdate restore point that was created at the beginning of the lab and click Next. 
Click Finish. Read the message that appears and click Yes. The System Restore utility restores the 
system to the time before this lab was started. This process can take a long time. The system reboots, 
and a dialog box appears, telling you whether the return to the restore point was successful. Click 
Close.

30. Reopen Default Programs Control Panel > Associate a file type or protocol with a program > Choose 
default apps by file type (Choose defaults by file type in Windows 11).

31. Scroll through the list.

 Is the unique file extension used in this lab located in the list? [ Yes | No ]

32. Close all the windows.
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Lab 16.13 Microsoft Management Console

Objective: To access and use the major utilities available in the Microsoft Management Console

Parts: A computer with Windows 10 or 11 installed, a user ID that has Administrator rights, and 
internet access

Note: You must be an administrator to utilize the Microsoft Management Console utilities.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and verify that Windows loads. Log onto Windows using the user ID and 
password provided by the instructor or lab assistant.

2. Right-click the Start button > select Computer Management.

 Determine the subcategories for each of the major Computer Management sections. Document the 
subcategories in Lab Table 16.1.

LAB TABLE 16.1 Windows Computer Management console

Computer Management section Subcategories

System Tools

Storage

Services and Applications

3. Return to the Computer Management window and, if necessary, select the arrow beside System Tools 
to expand the section. If necessary, select the arrow beside Shared Folders to expand that section. 
Click the Shares folder. When the computer is in a network environment, shares allow other users 
on different computers to access resources on this computer. When networking is enabled, default 
administrative shares are created for each hard drive partition. Administrative shares can be easily 
identified by the $ (dollar sign) after the share name.

 List two default shares located on this machine. If none are available, document the fact.

  _________________________________________________________________________________

4. If necessary, expand Local Users and Groups and click the Users folder.

 List the users shown in the Computer Management window.

  _________________________________________________________________________________

  _________________________________________________________________________________

5. To add a new user who will have access to this computer, click the Action menu option and select 
New User. The New User window opens. Click the ? icon located in the upper-right corner of the 
window. An arrow with an attached question mark appears as a pointer. Move the pointer to inside 
the User name textbox and click. Assuming that you have an internet connection, this launches a web 
browser to docs.microsoft.com with an article on users and groups.

6. In the User name textbox, type Keith Ellison. In the Full name textbox, type William 
Keith Ellison. In the Description textbox, type Brother. In the Password and the Confirm 
password textboxes, type test. Note that if a local policy is applied, you may have to strengthen this 
password to something like Test1234%. Ensure that the User must change password at next logon 
checkbox is disabled (that is, not checked). Select the User cannot change password checkbox to en-
able this option. Select Create > Close. The Keith Ellison user icon appears in the Computer Manage-
ment window.
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 Have a classmate verify the Keith Ellison user icon. Have the classmate double-click the icon to 
verify your settings. Are the settings correct? If not, redo step 6.

 [ Yes | No ]

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

7. Log off the computer and log back on using the Keith Ellison account with the password test (or 
the stronger password Test1234% if it was set).

 Did the login process work correctly? If not, log back in and redo step 6. [ Yes | No ]

8. Log off the computer and log back in using the user ID and password given to you by the lab assis-
tant or instructor (the original user ID and password). Access the Computer Management window and 
double-click the Keith Ellison user icon. Select the Member Of tab.

 To what group does the Keith Ellison user automatically belong?

 [ Administrators | Power users | Staff | Users ]

9. Click the Add button. The Select Groups window opens. In the Enter the object names to select text-
box, type Administrators and click the Check Names button. Click the OK button. The proper-
ties window shows that user Keith Ellison now belongs to both the Users group and the Administrator 
groups.

Instructor initials: _____________

 Click OK.

10. Reopen the Keith Ellison user window and select the Profile tab.

 The Profile tab is used to specify a home directory for the user, run a logon script that sets specific 
parameters for the user, input a path that specifies where the user stores files by default, or input a 
shared network directory where the user’s data is placed.

 The Profile Path textbox is where you type the location of the profile using a universal naming con-
vention (UNC) path. An example is \\users\profiles\kellison.

 The Logon Script textbox is where you type the name of the logon script file (for example, 
startup.bat).

 The Local path textbox is where you type the full path for where the user’s data is stored by default. 
An example is C:\users\kellison. The Connect radio button is used to assign a network drive 
letter and specify the location of a network directory where the user’s data is stored. An example is 
\\users\kellisondata.

 Click the Cancel button to return to the Computer Management window. Notice that users that are 
disabled have a small down arrow on their icon.

 Are any users disabled? [ Yes | No ]

11. In the Computer Management window, select the Groups folder.

 List two default groups.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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12. Double-click the Administrators group icon. The Administrators group has total control of the local 
machine.

 Are any users listed as part of the Administrators group? If so, list them.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Fill in Lab Table 16.2 with the purpose of each group type. Use the Help menu item to get more in-
formation than is shown in the window.

LAB TABLE 16.2 Windows User Groups

Group Description 

Administrators

Backup 
operators

Guests

Users

13. Exit Help and then click the Users folder in the Computer Management window. Select the Keith El-
lison user icon. Click the X icon or click the Action menu item and select Delete. A message appears, 
asking if you are sure that you want to delete this user. Click Yes > Yes.

14. Go into the Administrators group and verify that Keith Ellison no longer appears there.

 Have a classmate verify that the Keith Ellison user icon is deleted. Is the Keith Ellison user icon de-
leted? If not, redo the previous step. [ Yes | No ]

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

 Click Cancel.

15. Select the Device Manager option in the Computer Management window. This utility can also be ac-
cessed by typing devmgmt.msc in a Run box, in a Search textbox, or at a command prompt. Device 
Manager is used to access and manage hardware devices installed on a computer. It is also used to 
load a new driver and to roll back to an older driver.

16. In the right panel, select the arrow by the computer name if the list is not already expanded. Expand 
the Computer category.

 Is this computer 32- or 64-bit based? [ 32-bit | 64-bit ]

17. Expand the Storage category in the left pane of the Computer Management window. Select the Disk 
Management subcategory. The top window in Disk Management shows information about each disk 
partition, including total capacity, file system, free space percentage, and so forth. The bottom win-
dows show the drives and partitions in graphical form.
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18. Right-click the first volume (usually C:) in the upper window and select the Properties option. An al-
ternative method is to select the volume and then click Action > All Tasks > Properties. The local disk 
properties window opens.

19. On an NTFS partition, the General tab contains a Disk Cleanup button that can be used to clean up 
temporary files and delete applications that are not being used, Windows components that are not be-
ing used, log files, and old system restores.

 How much free space is on the selected drive?

  _________________________________________________________________________________

 Which checkboxes are enabled? (Select all that apply.) [ Compress this drive to save disk space | Al-
low files on this drive to have contents indexed in addition to file properties ]

20. Select the Tools tab.

 What tools are listed on the Tools tab?

  _________________________________________________________________________________

 Match each of the following tools with its associated task. 

____ Disk Cleanup a. Scans the disk for damage

____ Error checking b. Used to detect and removed unneeded files

____ Defragmentation c.  Locates file clusters that are not consecutive (contiguous) and places the 
clusters in order

21. Close the volume's properties window. Right-click Disk 0. Note that the Disk Management tool can 
create disk volumes, delete volumes, convert volumes to NTFS, create logical drives, and convert ba-
sic disks to dynamic disks. Chapter 7 explores these tasks in detail. Click the Cancel button.

22. Expand the Services and Applications Computer Management category. Select the Services subcat-
egory. A service is an application that runs in the background; you do not see it on the taskbar. The 
Services window is used to start, stop, pause, resume, or disable a service. You must be a member of 
the Administrators group to use this tool.

 List two services that start automatically and two services that require manual startup.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

23. Double-click the Data Usage service. The General tab is used to start, stop, pause, or resume a ser-
vice (depending on its current state). The buttons in the Service status section are used to control 
these actions. The General tab is also used to set whether the service starts when the computer boots. 
Select the Startup type down arrow to see a menu of startup options.

Instructor initials: _____________

24. Close the Data Usage service’s properties window without making any changes to the service and 
close the Computer Management window.
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Lab 16.14 Exploring Windows Boot Options

Objective: To explore Windows boot options that are used to troubleshoot startup problems

Parts: A computer with Windows 10 or 11 installed that has the capability to boot from a USB 
flash drive

 The user ID of a user that has Administrator rights

 Windows 10 or 11 USB installation flash drive

Note: In this lab, you will boot to Recovery Console, examine commands using the command 
prompt, boot without startup services loaded, boot to Safe Mode, boot to Safe Mode with 
the command prompt, boot with boot logging enabled, and examine the ntbtlog.txt 
file.

Procedure: Complete the following procedure and answer the accompanying questions.

Recovery Environment

1. Power off the computer and insert the Windows installation USB flash drive into the computer. Power 
on the computer. If prompted, press a key to start Windows from the flash drive. A menu appears, 
with default language settings selected. Adjust the settings as needed and click Next. If the computer 
does not boot from the Windows media, the BIOS settings probably need to be adjusted.

2. Select Repair your computer. The Windows Recovery Environment appears. Select Troubleshoot.

 List the recovery tool options.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Which option would be used to repair a system file?

  _________________________________________________________________________________

 Which option do you think would be for advanced technicians who can work without a GUI?

  _________________________________________________________________________________

 Which option configures the system to an earlier time, such as before a Windows update?

  _________________________________________________________________________________

Instructor initials: _____________

3. In steps 1 and 2, you entered the Windows Recovery Environment (WinRE) by booting from the Win-
dows installation media. WinRE is also accessible from within Windows.

 Remove the flash drive from the computer. Click the left arrow at the top of the screen beside Ad-
vanced options. Click Continue to boot into Windows. Log into Windows using the user ID and pass-
word provided by your instructor or lab assistant.

 In Windows 10, select Settings > Update & Security > Recovery. In Windows 11, select Settings > 
System > Recovery.

 In the Advanced startup section, click Restart now. The computer reboots to WinRE.

4. Click the left arrow at the top of the screen beside Advanced options. Click Continue to boot into 
Windows. Do not log into Windows.

5. To access WinRE in a different way, press and hold the Í key. Click the  icon. While con-
tinuing to hold the Í key, click Restart. The computer reboots to WinRE. You can also use this 
method if you’ve already logged into Windows.

6. Click the left arrow at the top of the screen beside Advanced options. Click Continue to boot into 
Windows. Log into Windows using the user ID and password provided by your instructor or lab 
assistant.
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7. To access WinRE via the command prompt, open an elevated (administrator) command prompt and 
enter these commands:

 reagentc /boottore

 shutdown /r

 Click Close. The computer reboots to WinRE.

Using Boot Options

8. Select Troubleshoot > Advanced options > Startup Settings > Restart. After the restart, choose Enable 
Safe Mode. After the computer restarts, log in if necessary. The computer is in Safe Mode.

 When would a technician use the Safe Mode option as opposed to the Safe Mode with Command 
Prompt option?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 How does the look of the screen in Safe Mode differ from the look of the normal Windows desktop?

  _________________________________________________________________________________

  _________________________________________________________________________________

 How can you easily tell you are running in Safe Mode?

  _________________________________________________________________________________

9. Right-click the Start button > Computer Management > expand Services and Applications > access 
the Services option.

10. Notice that quite a few services are automatic services that did not start in Safe Mode.

 List two services that did not automatically start because Safe Mode was used.

  _________________________________________________________________________________

  _________________________________________________________________________________

11. Close Computer Management and any Control Panel windows and restart Windows.

12. Access WinRE and then navigate to Startup Settings again.

 List the boot options available.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  Match each of the following definitions to the appropriate boot option:

____Safe Mode a.  Starts the system with minimum files and drivers, and only 
typed commands can be used

____ Safe Mode with Command 
Prompt

b.  Records the boot process into a text file that can later be 
viewed and used for troubleshooting

____Enable Boot Logging c.  Starts the system with minimal files and drivers, including the 
default video drivers

____ Disable Automatic Restart 
on System Failure

d.  Allows a technician to have time to document an error that 
occurs

13. Select the Enable Boot Logging option.

 How does the desktop appear when using the Enable Boot Logging option?

  _________________________________________________________________________________
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14. Use the Search function to locate and access the ntbtlog.txt file.

 List two drivers that loaded properly.

  _________________________________________________________________________________

  _________________________________________________________________________________

 List two drivers that did not load. Note that you may have to scroll through the list to see these 
drivers.

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

15. Close all windows.

Lab 16.15 Windows System Configuration Utility

Objective: To use the System Configuration utility to troubleshoot boot problems

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

Note: In this lab, you will create a shortcut to an application and then use the System 
Configuration utility to prevent it from loading. You will also explore various options that 
can be used in the System Configuration utility.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user ID 
and password provided by the instructor or lab assistant. Ensure that the user ID is one that has Ad-
ministrator rights.

Creating an Application Shortcut in the Startup Folder

2. Open File Explorer. You need to confirm that hidden items (files and folders) are shown. To do this in 
Windows 10, select the View menu option > ensure that the Hidden items option is enabled. In Win-
dows 11, select the View menu > Show > ensure that the Hidden items option is enabled.

3. Use File Explorer to navigate to the folder C:\Users\username\AppData\Roaming\Mi-
crosoft\Windows\Start Menu\Programs\Startup, where username is the name you 
used to log into the computer.

4. In a separate File Explorer window, use the Search feature to locate the original Notepad application 
(notepad.exe) on the C: drive. It’s likely in C:\Windows. Create a shortcut to the Notepad ap-
plication and place it in the Startup folder that you opened in step 3.

 Have a classmate verify that your shortcut exists and that it is a shortcut and not a copy of the appli-
cation or the application itself.

 Classmate’s printed name: ________________________

 Classmate’s signature: ___________________________

 Is the icon in the Startup folder a shortcut icon? [ Yes | No ]

5. Restart the computer and verify that the Notepad program starts automatically when the computer 
boots. If it does not, redo the lab from the beginning.

Instructor initials: _____________
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System Configuration Utility

6. Hold down the  key and press r; type msconfig and press ®. Alternatively, search for 
msconfig. The System Configuration utility window opens.

 What is the purpose of the System Configuration utility?

  _________________________________________________________________________________

 What tabs are available in the System Configuration utility?

  _________________________________________________________________________________

7. Click the Diagnostic startup button. Click the Apply button and then click the OK button. A System 
Configuration message box appears. Click the Restart button. When the computer restarts, log in with 
the same user ID used previously.

 Did the Notepad application automatically start?

  _________________________________________________________________________________

8. Return to the System Configuration (msconfig) utility. Select Diagnostic startup and then select 
Selective startup. Checkboxes are now available so that you can select the startup files that are to be 
loaded the next time the computer boots. Select the Load startup items checkbox. Click the Apply 
button and then click OK. Click the Restart button, and the system restarts. Log in using the same 
user ID and password as before.

 Did the Notepad application automatically start? Why or why not? [ Yes | No ]

  _________________________________________________________________________________

9. Return to the System Configuration utility and select the Normal startup option on the General tab.

10. Select the Startup tab.

11.  Select the Open Task Manager link. Task Manager (Startup tab) opens. Select Notepad and click the 
Disable button.

12. Restart the computer. When the computer restarts, log in using the same user ID and click OK.

 Did the Notepad application automatically start? Why or why not? [ Yes | No ]

  _________________________________________________________________________________

 Reopen the System Configuration utility to determine what is different about the General tab. Docu-
ment your observations.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Match each System Configuration utility tab to a characteristic. Note that not all characteristics are 
used. Each characteristic that does match a tab is used only once.

____ General a.  Has an Advanced options button so that you can control the number of 
processors used to boot the system.

____ Boot b. Contains applications that begin every time the computer boots

____ Services c.  Contains a section called Boot Loader that details operating system boot options

____ Tools d. Has an option to choose which boot files are processed

____ Startup e. Contains an Application Management option

f.  Provides an easy way to launch System Restore and Registry Editor

13. Select the General tab and select the Normal Startup radio button > click Apply > OK > Restart. Log 
in using the same user ID as before.

14. After the computer reboots, remove the shortcut to the Notepad application from the Startup folder.

 Is the Notepad shortcut (and not the original application) deleted? [ Yes | No ]

Instructor initials: _____________
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Lab 16.16 Halting an Application by Using Task Manager

Objective: To use Task Manager to halt an application

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

Note: At times, it may be necessary to halt an application that is hung or stalled. Windows pro-
vides a method to accomplish this, through the Task Manager utility.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user ID 
and password provided by the instructor or lab assistant. Ensure that the user ID is one that has Ad-
ministrator rights.

2. Open the Notepad utility.

3. Open Task Manager by right-clicking Start button > select Task Manager.

 What type of things can you view from Task Manager?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

4. Select the Processes tab.

 What applications, if any, are listed as open? Note that you might need to click the down arrow by the 
More details option.

  _________________________________________________________________________________

Instructor initials: _____________

5. Select the Notepad item in Task Manager and click the End task button. Notepad closes.

 Could you close the Notepad application from within Task Manager? [ Yes | No ]

6. Close the Task Manager window.

Lab 16.17 Task Manager Features in Windows

Objective: To use Task Manager technical features

Parts: A computer with Windows 10 or 11 installed

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user ID 
and password provided by the instructor or lab assistant. Ensure that the user ID has Administrator 
rights.

2. Open Task Manager by right-clicking Start button > select Task Manager. Note: You might have to 
select the More details link to see the Task Manager data.

 Match each Task Manager tab to a characteristic. Each characteristic matches to only one tab, and all 
characteristics are used.

____ Processes a.  Shows the data usage of a particular application on a metered account

____ App history b.  Displays the impact an app has on the system when the system powers on

____ Users c.  Identifies which user is using a particular app or service and displays the 
process identifier (PID)

____ Services d.  Used to show what apps are open and the amount of CPU, memory, disk 
space, and power usage each one takes, as well as other information about 
each app

____ Performance e. When expanded, shows the apps a particular person is using

____ Startup f. Shows the average response time of the hard disk

____ Details g. Indicates whether a service is running or stopped
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3. Select the Startup tab. This tab gives a technician great insight into apps used as part of the startup 
process and the impact that each one has on the startup process. A device’s boot time can be impacted 
by lengthy profiles and multiple profiles being applied in a corporate environment, but it is also im-
pacted by apps and services during the startup process.

 Do any applications show a high startup impact? If so, list one. [ Yes | No ]

  _________________________________________________________________________________

Instructor initials: _____________

4. Locate the Last BIOS time.

 What is the last BIOS time shown?

  _________________________________________________________________________________

 What do you think is the significance of this value? You might want to search on the internet, if pos-
sible, to see what the value is telling you.

  _________________________________________________________________________________

  _________________________________________________________________________________

5. Select the Users tab.

 A company has two shifts, and some employees use the same computer that a person on the previous 
shift used. Oftentimes to reduce boot times, the users will just log off but not power down the com-
puter. Do you think if two users were logged onto the machine at the same time (but only one was ac-
tually using it), the Task Manager > Users tab would show both users? Why do you think this would 
be important to a technician? Be sure to answer both questions.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Open several apps and then select the Processes tab.

 Which category has the highest percentage of utilization? [ CPU | Memory | Disk | Network | GPU ]

 Why do you think this is the case on this particular computer?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

7. Select the App history tab. 

 A user has complained about computer performance. A technician has been using the App history 
tab to see the applications being used. The technician noticed that the computer is a Windows 10 
computer and noticed some of the app statistics. For example, Cortana has used almost 23 minutes of 
CPU time, and Microsoft Photos has used over 5 hours. The technician also noticed that the user had 
the Firefox browser up and states that this is the browser most often used, but Firefox is not shown in 
the Name list on the App History tab.

 Do you think that the values for each app are relevant to computer performance? Why or why not?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Can the technician specify the point at which app date is collected on the App History tab? [ Yes | No ]

 If yes, how would a technician do that?

  _________________________________________________________________________________
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 Do you think that there is something wrong with the values shown on the App history tab since 
Firefox isn’t showing up there? [ Yes | No ]

 Can you find any way that you might make it appear?

  _________________________________________________________________________________

  _________________________________________________________________________________

8. Use the Options menu option and select Show history for all processes.

 What changed on the App History tab? 

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

9. Select the Details tab. By default, apps and services are listed in alphabetical order. You can click on 
the title of any column in order to view the items sorted by that particular parameter. For example, 
click on the Memory (active private working set) column name, and you see the apps listed, from the 
app that is currently using the most memory to the app that is using the least amount of memory.

 What app is using the most memory and appears at the top of the list?

  _________________________________________________________________________________

10. Select the PID column name. PID stands for process ID. Each Windows process is assigned a unique 
number. You can stop an application by using the taskkill command from the command line 
along with the PID.

11. Select the Name column heading on the Details tab. A technician might use this to see if there are 
multiple instances of a particular application running. Note that multiple browser tabs would result in 
multiple instances of that particular browser being listed, with details about each tab. This is normal 
operation. A technician would also be interested in instances of an app being open but not being used. 
This might be causing poor computer performance, and the particular app instance can be stopped.

12. Right-click on the name of any particular app.

 List an example of when a technician might use the Set priority > High option.

  _________________________________________________________________________________

  _________________________________________________________________________________

13. Right-click on the name of an app and select Analyze wait chain.

 What is the purpose of the Analyze wait chain function?

  _________________________________________________________________________________

  _________________________________________________________________________________

14. Click Cancel. Right-click on the name of an app again.

 Can you terminate the app from the context menu? [ Yes | No ]

 If yes, what option would you use? [ End task | Set affinity | Create dump file ]

15. Select the Services tab. Select the Status column header and scroll to the bottom to see all the services 
that have stopped.

 List any stopped service that you are surprised is stopped or that you are surprised is a Windows 
service.

  _________________________________________________________________________________

16. Close Task Manager.
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Lab 16.18 Using Event Viewer

Objective: To use the Event Viewer program to troubleshoot problems

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

Note: In this lab, you will analyze a computer event to see how to gather information using Event 
Viewer.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user 
ID and password provided by your instructor or lab assistant. Ensure that the user ID is one that has 
Administrator rights.

2. Event Viewer monitors and logs various events, such as when drivers and services load (or fail to load 
and have problems). Right-click the Start button > select Event Viewer. The Event Viewer window 
opens to the Overview and Summary window.

 How many total warning events occurred on this computer in the last 24 hours?

  _________________________________________________________________________________

3. In the left pane, expand the Windows Logs section > select Security. The most recent events are listed 
at the top. You might need to expand the window or reduce the size of the left and right panes in 
order to see the center pane better. Locate and double-click on the most recent event that shows as 
Logon in the Task Category column.

 From the General tab, what was the account name?

  _________________________________________________________________________________

 What time did the logon occur?

  _________________________________________________________________________________

 Was the logon successful? In other words, did Event Viewer show this as an Audit Success or as an 
Audit Failure? [ Yes | No ]

4. Close the logon event’s properties window. The Audit Success line in the center pane is still selected. 
In the right panel, select Attach Task To This Event. Type your first initial and last name as the name 
of the basic task (for example, clee). Click Next on the following two windows.

 What three actions can be taken from this screen?

  _________________________________________________________________________________

5. Click Cancel.

6. In the left panel, select the Application option from the Windows Logs category.

 What application caused the first event?

  _________________________________________________________________________________

7. Select the Windows Logs > Security subcategory from the left panel.

 Scroll through the list of events logged and pay attention to the Task Category column. What type of 
task categories are most common?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Does Windows log an event when a user logs off a Windows computer? [ Yes | No ]

8. Select the Windows Logs > System subcategory from the left panel. Double-click the first event listed.

 List the source of the first event.

  _________________________________________________________________________________
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9. Click the Copy button.

10. Open the Notepad application > access the Edit menu item > select Paste.

 What appears in Notepad?

  _________________________________________________________________________________

Instructor initials: _____________

11. The event information can be saved as a text file and referenced later; this is especially helpful when 
there is a problem. Close Notepad without saving the document. Close the Event Properties window.

12. In Event Viewer, expand Applications and Services Logs. Expand the Microsoft folder and the Win-
dows folder. Expand the Task Scheduler and locate and click the Operational event log.

 What is the first informational Task Scheduler event logged? Note that on a virtual machine, there 
might not be an event. If this is the case, just document that you were in a virtualized environment as 
your answer.

  _________________________________________________________________________________

13. Close Event Viewer.

Lab 16.19 Using Task Manager to View Performance

Objective: To use the Task Manager program to evaluate basic computer performance

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

Note: In this lab, you will evaluate a computer event to see how to gather information using 
Event Viewer.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user ID 
and password provided by the instructor or lab assistant. Ensure that the user ID is one that has Ad-
ministrator rights.

2. Open Task Manager: Right-click the Start button > select Task Manager. Note: You might have to 
select the More details link to see the Task Manager data. Click the Performance tab to view CPU, 
memory, disk, network and power usage.

3. Open Notepad, access the internet (if possible), open a game (if possible), and start other 
applications.

 What happens to the CPU usage, as shown in Task Manager, as each application is opened?

  _________________________________________________________________________________

 What is the memory usage?

  _________________________________________________________________________________

 What is the total physical memory?

  _________________________________________________________________________________

 How much memory is available?

  _________________________________________________________________________________

Instructor initials: _____________

4. Using Task Manager is a great way to see a snapshot of the status of two of the most important pieces 
of hardware: the CPU and RAM (even though the Task Manager application increases both the CPU 
and memory usage). If the CPU and memory utilization stay consistently high, you should add more 
RAM. If the CPU stays consistently level and at a high value, a more powerful processor is in order. 
Close all windows.
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Lab 16.20 Performance and Reliability

Objective: To use Windows tools to verify performance, measure reliability, and troubleshoot startup 
problems

Parts: Access to Windows 10 or 11 with a user ID that has Administrator rights

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log into Windows using the user ID 
and password provided by your instructor or lab assistant. Ensure that this user ID has full Adminis-
trator rights.

2. Access the System and Security Control Panel category > Administrative Tools (Windows Tools in 
Windows 11) > double-click Performance Monitor > select the Open Resource Monitor link. The 
information shown on the Overview tab is known as the key table. It always contains a complete list 
of running (active) processes for the system. You can filter the data and look at the information more 
granularly by using the specific tabs.

3. Select the CPU tab. Notice the individual programs and processes listed in the Processes section. 
Select a particular process by selecting the checkbox by the process name. The top graph shows that 
particular process in relationship to the total CPU usage.

 How many CPU threads are used by the Performance Monitor application (perfmon.exe)?

  _________________________________________________________________________________

4. Deselect any individual process(es) in the Processes section. Expand the Services section. Notice the 
last column, Average CPU, which shows the average percentage of CPU consumption by a particular 
service.

 What service is taking the most CPU power?

  _________________________________________________________________________________

5. Select the Memory tab. Notice the Commit (KB) column, which shows the amount of virtual memory 
reserved by Windows for a particular process.

 List two processes and the amount of virtual memory reserved by the system for each process.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Locate the Working Set (KB) column to see the amount of physical memory used by a particular 
process.

 Which process is using the most motherboard RAM?

  _________________________________________________________________________________

7. Select the Disk tab. Open any file and save it to a different location on the hard drive, if possible. Re-
turn to the Disk tab and notice the disk activity.

8. Select the Network tab. Connect to the internet, if possible, and then return to this tab.

 How many TCP connections are active?

  _________________________________________________________________________________

9. Close the Resource Monitor window and return to the Performance Monitor window.

10. Ensure that the top object, Performance, is selected in the left panel. Notice the System Summary sec-
tion in the center of the right panel.

 What is the available memory, in megabytes?

  _________________________________________________________________________________

 Scroll down to the PhysicalDisk section. What is the percentage of idle time?

  _________________________________________________________________________________
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 Locate the Processor Information section. What is the total percentage of processor time?

  _________________________________________________________________________________

11. Expand the Monitoring Tools object in the left panel. Select the Performance Monitor tool.

 What is the default counter shown?

  _________________________________________________________________________________

12. Select the green plus symbol (+) from the graphical menu at the top of the chart. Scroll through the 
counters list until you locate and select the PhysicalDisk counter down arrow (˘). Click once on 
the Disk Reads/sec counter. In the Instances of Selected Object window, select the number that cor-
responds to your primary hard drive partition. Click Add. Continue using the same process to add the 
following counters:

 PhysicalDisk Disk Writes/sec

 LogicalDisk % Free Space

 Memory Available Bytes

 Memory Cache Bytes

 Processor % Processor Time (All instances)

13. Click OK. If a message appears, saying that one of the counters is already enabled, click OK.

14. Allow the system to run at least two minutes. Do things on the computer during this time. Afterward, 
select the Freeze Display menu icon that looks like a pause button on a media player.

15. In the Change graph type drop-down menu, select Histogram bar. Change graph type is the third 
icon from the left on the graphic menu at the top of the graph. Select the Available Bytes counter.

 What is the average number of available bytes of memory?

  _________________________________________________________________________________

16. Select the Cache Bytes counter row.

 What is the maximum number of bytes in cache memory?

  _________________________________________________________________________________

 Look at the bar graph. Which is higher: the number of disk reads per second or the disk writes per 
second?

  _________________________________________________________________________________

Instructor initials: _____________

17. Change the graph type to the Report view.

 Which one of these views do you think will be most used by a technician?

  _________________________________________________________________________________

  _________________________________________________________________________________

18. Close the Performance Monitor window.

19.  Search for view reliability history and select View reliability history from the resulting 
list.

 Describe any event that the system considered important enough to potentially affect the computer’s 
reliability.

  _________________________________________________________________________________

20. Close all windows.



 LAB 16: Advanced Windows Labs 249

LA
B 1

6

Lab 16.21 Windows Remote Desktop Connection

Objective: To configure a computer for remote access using the Remote Desktop tool

Parts: Two computers with Windows 10 or 11 loaded and connected to the same network

Note: The Remote Desktop tool is disabled by default. You can connect to (take over) computers 
running only Windows Professional, Education, or Enterprise, but all Windows computers 
since Windows 7 can initiate the Remote Desktop connection.

 You must have the ability to create users on the remote computer or must have a user ID 
already created and with a password assigned.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on both computers and verify that Windows loads. Log in using the user ID’s and passwords 
provided by the instructor or lab assistant.

2. If both computers have a user ID with full Administrator rights and a password, this step can be 
skipped. Otherwise, this step needs to be completed on both computers.

 Access Settings > Accounts > Family & other users > Add someone else to this computer (Add ac-
count in Windows 11) > I don’t have this person’s sign-in information > Add a user without a Micro-
soft account.

 Type tester in the Who’s going to use this PC textbox > type tester in the Enter password box 
> type tester in the Re-enter password box. Select three security questions and enter none as the 
password for each question. The tester account is created, and it appears in the Other users sec-
tion of the Family & other users page.

 In Windows 10, click Change account type for the tester account. In Windows 11, select tester 
> Change account type. In Windows 10 or 11, select Administrator as the account type and then click 
OK.

3. On both computers, right-click the Start button > select System.

 Document the full device name for both computers. Note that it is very important to have the full 
computer name.

 Computer 1 (the computer that will remotely control the other computer)

  _________________________________________________________________________________

 Computer 2 (the computer that will be controlled remotely)

  _________________________________________________________________________________

4. On both computers, select Remote desktop. The Remote Desktop window should open.

 What is the current setting for Enable Remote Desktop (simply Remote Desktop in Windows 11)?  
[ Off | On ]

5. On both computers in the Remote Desktop window, set Remote Desktop to On. Click Confirm.

6. On both computers, access File Explorer (not the web browser). In the left panel, select Network. 
A message states that network discovery is turned off. Click OK. Another message appears, stating 
that network discovery and file sharing are turned off. Click inside that message and select Turn on 
network discovery and file sharing > Yes, turn on network discovery and file sharing for all public 
networks. Be sure to do this for both computers.

7. On computer 1, use the search function to search for remote desktop connection and select 
Remote Desktop Connection.

8. On computer 1 in the Remote Desktop Connection window, type the other computer’s full computer 
name in the Computer textbox. Click Connect.
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9. Enter a username/password. Click Yes on the request for a certification or if a certificate warning 
appears.

 What happened to the remote computer?

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Using computer 1 (which is controlling computer 2), add a new shortcut to the desktop of the remote 
computer. When finished, click the Close button (X) in the blue Remote Desktop panel located in the 
top center of the screen. Click OK.

11. Log in directly on the remote computer. That is, use the keyboard and mouse on computer 2 to log in 
to computer 2. Notice the new desktop shortcut.

Instructor initials: _____________

12. Delete the newly installed desktop shortcut on the remote computer.

13. From computer 2, do the same procedure: Remote into computer 1, create a desktop shortcut on com-
puter 1, release control of computer 1, and verify the desktop shortcut on computer 1.

Instructor initials: _____________ 

14. Return the Enable Remote Desktop setting to the original configuration (refer to the step 4 answer).

15. Remove the tester user account from any computer if it was created.

Lab 16.22 Windows Task Scheduler

Objective: To become familiar with the Task Scheduler tool and the at command

Parts: A computer with Windows 10 or 11 installed and a user ID that has Administrator rights

Procedure: Complete the following procedure and answer the accompanying questions.

Using Task Scheduler

1. Create a Notepad file and enter the following text, including the quotation marks:

 msg * "Attention students, faculty, and staff. Our scheduled 
maintenance window will begin in 15 minutes. The server will be 
down for approximately 2 hours. Thanks for your patience."

 Click File > Save > Documents. Type maintenance_message.bat in the Filename textbox. Se-
lect All Files for Save as type. Click Save. Close Notepad.

2. Search for task in the Search textbox and select Task Scheduler from the resulting list. Task Sched-
uler opens.

 Based on the information shown in the Overview of Task Scheduler pane, where are tasks stored?

  _________________________________________________________________________________

3. In the Actions pane, select Create Basic Task. In the Name textbox, type your last name > Next. No-
tice that Trigger is highlighted, and Daily is the default task frequency. Select the One time radio but-
ton > Next > set the time to start to be 5 Minutes from the current date and time > Next.

 What three actions can you take using this wizard?

  _________________________________________________________________________________

4. Select the Start a program radio button and click Next. Click Browse > Documents. Select the 
maintenance_message.bat file (the bat extension might not be visible). Click Open > Next > 
Finish. The message should appear at the selected time.
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5. Create another scheduled task that runs an application one time at a specific time. Show the instructor 
this task’s credentials through the Task Scheduler Library and show the task working.

 Document the scheduled task and start time.

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

Lab 16.23 Windows Steps Recorder

Objective: To become familiar with the Steps Recorder app

Parts: A computer with Windows 10 or 11 installed

Procedure: Complete the following procedure and answer the accompanying questions.

1. In the Search textbox, type steps and open the Steps Recorder app. An alternate method is to run 
the psr command or locate the app through Accessories. The Steps Recorder app can be used to 
show a user how to do something or have a user capture the problem they are having to share it with 
you in order to provide more information. The recorder can record the screen and timestamp the re-
cording, and comments can be added.

2. Select the down arrow by the question mark. Select Settings. Lab Table 16.3 shows the purpose of 
each option.

 Note: Modifications to the Settings options are relevant only while the app is open. They return to the 
default once the app is closed and have to be changed again when the app is reopened.

LAB TABLE 16.3 Steps Recorder Settings options

Option Description 

Output File This is the default location where recordings are saved.

Enable screen capture The Yes option is the default, which captures what is shown on the 
screen. The No option is used to provide a text-based description 
and is commonly used if there is confidential or personal information 
shown on the screen.

Number of recent 
screen captures to store

The number can be lowered to save space or increased when more 
screen captures are needed.

 What is the default number of screen captures to store? [ 5 | 10 | 15 | 25 ]

3. Click OK. Open one of your favorite Windows tools. If you can’t think of one, open Task Manager.

4. In the Steps Recorder window, select Start Record.

 What options do you have while recording? (Select all that apply.)

 [ Continue Recording | Delete Recording | Pause Record | Stop Record | Add Notation | Add 
Comment ]

5. Select the Add Comment option. Point to an interesting area of the screen and drag the window to 
create a rectangle around that interesting area. In the Highlight Area and Comment textbox that ap-
peared, type Help me! And then click OK.

6. Select the Stop Record option. The resulting window has the following main sections: Recorded 
Steps, Steps, and Additional Details, including the day, time, operating system, and applications being 
used.
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7. In the Recorded Steps section, select Review the recorded steps as a slide show.

 Is Microsoft PowerPoint required to view the recording? [ Yes | No ]

 Describe how you think this option might be used in a corporate environment.

  _________________________________________________________________________________

  _________________________________________________________________________________

Instructor initials: _____________

8. Use the Close box in the upper-right corner to close the Steps Recorder app. When prompted to save 
the recording, click No.



macOS and Linux Operating 
Systems Labs17

Lab 17.1 Using the macOS Graphical User Interface

Objective: To work with the macOS graphical user interface, including the Dock, Finder, Notification Center, and widgets

Parts: A computer with macOS installed

Procedure: Complete the following procedure and answer the accompanying questions.

1. Open a Finder window. On the left side, you see a sidebar containing shortcuts to different parts of the file system.

2. Right-click (or, on a trackpad, click or tap with two fingers) the Applications shortcut and select Add to Dock.

 You should now have a new shortcut on the right side of the Dock.

 What happens when you click it?

  _________________________________________________________________________________

 This type of shortcut on the Dock isn’t limited to just the Applications folder. You can create a similar shortcut for nearly any 
folder or application, such as Downloads, Documents, and so on. In addition to using the method described above, you can drag 
and drop items to the Dock to create a shortcut.

 Creating a shortcut is a quick way to get access to your applications, but what other ways could you quickly access your 
applications?

  _________________________________________________________________________________

3. To remove a Dock shortcut, either to a folder or an application, simply drag it off the Dock, hold it with your cursor until it shows 
the word remove above it, and let go of it.

4. Click the time in the menu bar to open the Notification Center. The Notification Center holds widgets, which are usually shortcuts, 
mini applications, or reminders.

5. Scroll to the bottom of the Notification Center and click Edit Widgets.

6. Use the Search field or click a category on the left side of the screen to find a widget.

7. Add the widget to the Notification Center by hovering over the widget and clicking the + button that appears. To remove a widget, 
click the - button.
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8. Scroll to the bottom of the Notification Center and click Done to exit Edit Widgets.

 Which useful widgets did you find on the Apple widget repository?

  _________________________________________________________________________________

Lab 17.2 Introduction to macOS System Preferences

Objective: To explore the macOS System Preferences option

Parts: A computer with macOS installed

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log in.

2. On the Dock that runs along the bottom of the window, select the System Preferences icon (which has 
the gears on it). An alternative way of getting into System Preferences is to click on the Apple icon in 
the upper-left corner > System Preferences.

3. Click once on the General icon.

 Which of these settings is the General icon used for?

 a. To control how many recent items are shown in Documents

 b. To show how much RAM is installed

 c. To set an administrator password

 d. To view installed devices and resources

4. Click the left arrow to return to the main System Preferences window. Access the Desktop & Screen 
Saver settings. To change what the desktop looks like, ensure that the Desktop option at the top of the 
window is selected and choose either Colors or Desktop Pictures from the left menu. Then choose the 
specific option in the right window.

5. To select a screen saver (which is a best practice for protecting your data when you walk away from 
your desk for a moment), select the Screen Saver option from the top center of the window. Specific 
options are available to select on the left, and a preview displays in the right window.

 What is the current setting for the screen saver to start after inactivity?

  _________________________________________________________________________________

6. Click the left arrow to return to the main System Preferences window. Access the Dock and Menu 
Bar settings. Here you can control where the Dock is located on the screen, how big it is, and 
specialized effects for how screens close. You can also control the content and behavior of the menu 
bar and specify which items appear in the Control Center (which you access via the icon to the left of 
the date and time).

7. Click the left arrow to return to the main System Preferences window. Access the Mission Control 
settings. Mission Control gives an overview of all open applications and virtual desktops.

 What keystroke is used to show Mission Control?

  _________________________________________________________________________________

8. Click the left arrow to return to the main System Preferences window. Access the Accessibility 
settings, which make it possible to have the computer speak to you and for you to control the 
computer via voice commands. The Spoken Content option in the left pane allows configuration of 
the system voice, the speed of the voice, and what actions or items are spoken. Use the Voice Control 
option in the same pane to operate the computer by speaking to it (for example, “Undo that”).

9. Click the left arrow to return to the main System Preferences window. Access the Security & Privacy 
settings.

 What is the current setting for requiring a password after the computer goes to sleep?

 [ Enabled | Disabled ]
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10. Access the FileVault option at the top of the screen. This option allows you to encrypt the hard drive.

11. Access the Firewall option at the top of the screen. In order to change these settings, you have to 
click the lock in the bottom-left corner. Go ahead and click the lock and enter the username and 
password required to make changes to the computer.

 What is the current setting for the firewall? [ Off | On ]

12. If the firewall is currently off, select the Turn On Firewall option. Click the Firewall Options button. 
This is where you can block all incoming connections or put the computer in stealth mode. Click 
Cancel.

13. Click the Advanced button.

 What is the default setting for logging out due to inactivity?

 [ Note enabled | 15 minutes | 30 minutes | 60 minutes | 90 minutes ]

14. Click the OK button to return to the Security & Privacy settings. If you turned on the firewall in step 
12, select Turn Off Firewall to disable it.

15. Select the Privacy option. Among other things, you can enable location services here for any apps 
that use your location. Click the lock in the bottom-left corner to lock the system and prevent further 
changes if it was locked when you started.

16. Click the left arrow to return to the main System Preferences window. Access Spotlight. These 
settings allow you to control where searches are performed on your computer.

17. Click the left arrow to return to the main System Preferences window. Double-click the Displays 
icon. You can use Displays to adjust the resolution, brightness, profile (Presets), and refresh rate of 
your display. Presets automatically configures settings that cameras, printers, and other displays use 
to ensure uniform color presentation across devices. If you have multiple displays, you will have 
additional options, such as extending or mirroring the displays.

18. Click the left arrow to return to the main System Preferences window. Access Network settings. This 
is where you can select and configure a wireless network. You can also configure wired, VPN, and 
other types of network connections.

19. Click the left arrow to return to the main System Preferences window. The Users & Groups section 
allows you to configure the computer for another user and to automatically login to apps when you 
login to the computer. Screen Time allows you to implement restrictions for younger children. You 
can set the correct time and configure other time-related options through the Date & Time icon.

20. Click the left arrow to return to the main System Preferences window. Access the Keyboard settings. 
Across the top you see Keyboard, Text, Shortcuts, Input Sources, and Dictation.

21. Select the Text option. Here, you control what typed characters will create other text or special 
symbols (such as the registered trademark symbol). You can also configure spell checking, 
capitalization, and smart quote behavior.

22. Select the Input Sources option from the top of the window. Click + at the bottom left of the window 
to see all the keyboard layouts for different languages and regions.

23. Select the Dictation option from the top of the window. The Dictation option allows the computer to 
convert speech to text wherever you can type.

24. Click the left arrow to return to the main System Preferences window. Review any remaining settings 
that you would like to explore, like Time Machine, Siri, Startup Disk, and Passwords. (See Lab 17.3 
for more on working with Time Machine.)

25. Close the System Preferences window when you are finished by clicking the red circle (in which an 
X appears when you hover over it) in the upper-left corner.
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Lab 17.3 Using the macOS Terminal and Time Machine

Objective: To work with the macOS graphical user interface, including the Dock and Finder, the 
command line, and Time Machine

Parts: A computer with macOS installed and a Time Machine backup drive

Procedure: Complete the following procedure and answer the accompanying questions.

1. Open the Terminal application by selecting Finder > Applications > Utilities > Terminal.

2. Type in the command pwd, and you see that you are located in the /Users/YOURUSERNAME 
directory.

3. Type the command ls to see what folders are in your current directory.

4. Navigate to the Documents folder. (If prompted, allow Terminal to have access to the folder.)

  What command did you use to do this?

  _________________________________________________________________________________

5. Create a blank file with the extension .txt. Name the file something unique that does not already 
exist.

 What command did you use to do this?

  _________________________________________________________________________________

6. If you do not have a Time Machine backup drive set up, follow these steps:

 a. Connect an external drive to the Mac.

 b.  Open the Time Machine preferences by selecting Finder > Applications > System Preferences > 
Time Machine.

 c. Click Select Disk.

 d. Select your external drive.

 e.  Click Use Disk. Answer the prompts to prepare your drive for use by Time Machine. You are re-
turned to the main Time Machine window.

 f.  Disable (that is, remove the check mark from) Back Up Automatically.

 g. Enable (that is, place a check mark by) Show Time Machine in menu bar.

 h. Close Time Machine preferences.

7. In the right corner of the menu bar, click the circular clock icon and select Back Up Now.

8. If this is the first time running a Time Machine backup on this machine, it may take a while to 
complete. You can check the status by clicking the same Time Machine icon in the menu bar. When it 
shows as completing a backup, return to the Terminal application.

9. Make sure you are still in the Documents folder and delete the file you created in step 5.

 What command did you use to do this?

  _________________________________________________________________________________

10. Type the command ls to confirm that the file was removed.

11. Open Finder > Documents as a second confirmation.

12. Open Finder > Applications.

13. Double-click the Time Machine icon. This should bring up the Time Machine interface, which is used 
to recover files.

14. In the Finder window, select the Documents folder on the left side. Then use the timeline on the right 
side to go back to the most recent Time Machine backup. Select the file you created and deleted 
earlier and then select Restore at the bottom of the screen.

 Does the file appear in Documents after you click Restore? [ Yes | No ] If it does not, the Time 
Machine backup did not complete before you tried to delete the file.
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Lab 17.4 Creating a Bootable Ubuntu USB Flash Drive (Live USB) Using 
macOS

Objective: To be able to create a bootable Linux-based flash drive

Parts: A computer with an Intel-based processor and macOS installed

 4 GB or higher flash drive (which will be wiped)

 A downloaded Ubuntu ISO file or access to the internet

 The free balenaEtcher application or access to the internet

Note: This lab is intended only for Macs with Intel-based processors. It will not work on Macs 
with Apple Silicon such as the M1 chip. At the time of this writing, native Linux operating 
systems for Apple Silicon were still in the developmental phase. See Lab 17.5 to learn how 
to install a Linux virtual machine on a Mac with Apple Silicon.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Download an Ubuntu ISO file. The latest ISO can be downloaded from  
http://www.ubuntu.com/download/desktop.

2. Ensure that you have the free open source balenaEtcher application installed. You will use 
balenaEtcher to create the bootable Linux flash drive; this process is called “burning the ISO file 
onto the drive.” If you don’t already have it, download balenaEtcher from https://etcher.io and install 
it on your Mac. You may have to enable the App Store and identified developers option in System 
Preferences > Security & Privacy > General > Allow apps downloaded from.

3. Ensure that the USB flash drive does not contain any data that needs to be preserved and insert it into 
the Mac computer. Note that the contents of the flash drive will be erased as part of the process.

4. Open the Disk Utility tool (by using Finder or Spotlight). Select View > Show All Devices to show the 
physical disks on the Mac.

5. Locate the USB drive in the left pane. You may have to expand the external drives to see it.

6. Select the flash drive (not a volume on the flash drive) from the left menu and select Erase from the 
top toolbar.

7. Set the format type to MS-DOS (FAT). Set the scheme to GUID Partition Map.

 What Disk Utility format types are available as options?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Why do you think the Ubuntu ISO would require the MS-DOS (FAT) option?

  _________________________________________________________________________________

8. Click Erase.

9. Start the balenaEtcher application. Click Flash from file to select the ISO file that was already 
downloaded.

10. Click Select target and select the flash drive as the target device.

11. Click Flash! to begin the burning process. If prompted, enter your password to give balenaEtcher 
privileged access to the flash drive. If you receive a message saying that the disk is not readable, eject 
the drive. Do not select the Initialize option.

12. Reinsert the flash drive, if necessary.

13. Hold down the ø key. Restart the Mac. Select the EFI Boot option.

14. After the USB disc loads, when the two options Install Ubuntu and Try Ubuntu appear, select the Try 
Ubuntu option to load the live USB environment.

 Were you able to boot to the live USB drive? If so, show the instructor. A functioning Ubuntu environment 
is a requirement for subsequent labs. If you cannot get it to work, consult with your instructor.

Instructor’s initials: ____________
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Lab 17.5 Creating a Bootable Ubuntu USB Flash Drive (Live USB) Using 
Windows

Objective: To be able to create a bootable Linux-based flash drive

Parts: A Windows computer with an account that has administrator rights

 4 GB or higher flash drive (which will be wiped)

 A downloaded Ubuntu ISO file or access to the internet 

 The free balenaEtcher application or access to the internet

Note: This lab is intended only for Windows computers. It will not work on Macs. See Lab 17.4 
to learn how to create a bootable Ubuntu flash drive on a Mac with Intel-based processors, 
or Lab 17.6 to learn how to install an Ubuntu virtual machine on a Mac with Apple Silicon 
or Intel-based processors.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Download an Ubuntu ISO file. The latest ISO can be downloaded from http://www.ubuntu.com/
download/desktop.

2. Ensure that you have the free open source balenaEtcher application installed. You will use 
balenaEtcher to create the bootable Linux flash drive; this process is called “burning the ISO file onto 
the drive.” If you don’t already have it, download balenaEtcher from https://etcher.io and install it on 
your PC.

3. Ensure that the USB flash drive does not contain any data that needs to be preserved and insert it into 
the computer. Note that the contents of the flash drive will be erased as part of the process.

4. Start the balenaEtcher application. Click Flash from file to select the ISO file that was already 
downloaded.

5. Click Select target and select the flash drive as the target device.

6. Click Flash! to begin the burning process. If prompted, click Yes on the User Account Control win-
dow. If you receive a message saying that the disk is not readable, eject the drive. Do not select the 
Initialize option.

7. Reinsert the flash drive, if necessary.

8. Restart the PC and enter the BIOS/EUFI. Select the USB drive as the boot device.

9. Restart the PC. The computer boots from the USB drive. When the two options Install Ubuntu and 
Try Ubuntu appear, select the Try Ubuntu option to load the live USB environment.

 Were you able to boot to the live USB drive? If so, show the instructor. A functioning Ubuntu en-
vironment is a requirement for subsequent labs. If you cannot get it to work, consult with your 
instructor.

Instructor’s initials: ____________

Lab 17.6 Linux Virtual Machine on Apple Silicon

Objective: To be able to install a Linux virtual machine on a Mac with Apple Silicon.

Parts: A computer with an Apple Silicon processor and macOS installed

 64 GB or higher free disk space on the hard drive

 A downloaded Ubuntu ISO file for ARM processors or access to the internet

 A UTM hypervisor application or access to the internet

Note: This lab can be modified to install Linux virtual machines on Macs with Intel-based 
processors.

1. Download a Ubuntu ISO file for ARM processors. At the time of this writing, only Ubuntu Server 
was available for ARM processors. Ubuntu Server can be downloaded from  
http://www.ubuntu.com/download/server/arm.
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2. Install the UTM hypervisor application if it is not already installed on the Mac. A hypervisor is used 
to configure and run virtual machines on a virtual host. UTM can be downloaded from  
https://mac.getutm.app.

3. Open UTM. Select Create a New Virtual Machine > Virtualize > Linux.

4. Click Browse and select the Ubuntu Server ISO file that you downloaded in step 1.

5. Click Continue (Hardware dialog opens) > Continue (Storage dialog opens) > Continue (Shared Di-
rectory dialog opens) > Continue (Summary dialog opens). Click Save (UTM home screen opens).

6. Click the play button beside the new Linux virtual machine. The GNU GRUB window opens. After 
several seconds, the Welcome page opens.

7. Press Return on each of the following screens: Welcome > Keyboard configuration > Choose type of 
install > Network connections > Configure proxy > Configure Ubuntu archive mirror.

8. On the Guided storage configuration screen, press † to highlight Done. Press Return.

9. Press Return on the Storage configuration screen. The Confirm destructive action dialog opens. Press 
† and then Return.

10. Enter the requested information on the Profile setup screen. Press † and then Return.

11. On the SSH Setup and Featured Server Snaps screens, press † and then Return.

12. UTM installs the Linux Server operating system on the virtual hard disk that was created in step 5. 
This might take several minutes. When you see Reboot Now at the bottom of the screen, press † 
twice and then press Return. The screen goes blank, and a flashing cursor appears in the upper-left 
corner.

13. Close the Linux virtual machine window to return to the UTM home screen.

14. At the bottom of the UTM home screen, click CD/DVD > Clear.

15. Click the play button beside the new Linux virtual machine.

16. At the ubuntu login: prompt, enter the username and password that you created in step 10.

17. Enter the following commands:

 $ sudo apt update

 $ sudo apt install ubuntu-desktop

 The second command takes several minutes to run. When the Package configuration dialog opens, 
press † and then Return.

18. Enter the following command:

 $ sudo reboot

 The virtual machine reboots with a GUI.

19. Click your user icon. Click the gear icon in the lower-right corner and select Ubuntu on Xorg.

20. Enter your password. The desktop appears.

Lab 17.7 Linux Command-Line Basics

Objective: To learn commands in the Linux environment

Parts: A computer with a Ubuntu Live USB drive (see Lab 17.4 or Lab 17.5) or with Ubuntu 
loaded (Lab 17.6)

Procedure: Complete the following procedure and answer the accompanying questions.

1. Log in with a username and password, as necessary.

2. Open the Terminal application. The onscreen prompt shows your username and the name of the 
computer.

3. Type pwd to determine your current directory.
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4. Notice the time, which is usually displayed in the center of the top of the screen. To determine what 
time zone you are in, type the following commands:

 date

 timedatectl

5. To find any files that have the word timezone in them, use the locate command:

 locate timezone

 You might get a message indicating that the locate command cannot be found. If necessary, run 
the recommended command to install locate, such as sudo apt install plocate, and 
then run the locate command again.

6. Type the following command:

 ls

 This command is used to list files that may be in the home directory. Items in blue are directories.

7. To show hidden files on the screen, add the -a option to the ls command. Type the following to 
verify whether there are any hidden files in the home directory:

 ls -a

 Hidden files and directories in Linux have filenames that begin with a period (.).

 Document any hidden files or directories.

  _________________________________________________________________________________

8. To make a directory, type the following exactly as it is shown, including the capital letters CTS:

 mkdir CTS1133

9. To verify that the directory is there, use the ls command again by typing the following:

 ls

10. To direct the operating system to move or change into that directory, you use the cd command. Type 
the following, ensuring that you type the letters cts in lowercase so you can see how the operating 
system handles this:

 cd cts1133

 What happened?

  _________________________________________________________________________________

11. Now type the command correctly and notice how the prompt changes:

 cd CTS1133

12. To move back one directory to the home directory, you use the cd .. command. Notice the space 
between the command cd and the two periods. You do not need a space like this in the Windows 
environment. Note that you can just type the cd command to return to the home directory no matter 
how many subdirectories down in the directory structure you are. For now, just move back one 
directory by typing the following:

 cd ..

13. Move back into the CTS1133 directory by using a command you have used previously in this lab.

 How can you tell you are in the correct directory?

  _________________________________________________________________________________

  _________________________________________________________________________________

14. From the CTS1133 directory, use the touch command to create a file (that is not going to contain 
any information):

 touch fileone

15. Use a command you have used earlier in this lab to verify that the file has been created.

 What command did you use? [ cd | cd .. | ls | touch ]
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16. Create a second file by copying the first file and renaming the file at the same time, using the cp 
command:

 cp fileone mysecondfile

17. Verify that there are now two files in the CTS1133 directory (fileone and mysecondfile).

18. From the CTS1133 directory, use the rm command to remove the mysecondfile file:

 rm mysecondfile

19. Use a command used previously in the lab to move back to the home directory.

 What command did you use? [ cd | cd .. | ls | cp ]

20. Use the rmdir command to remove the CTS1133 directory:

 rmdir CTS1133

 What happened?

  _________________________________________________________________________________

  _________________________________________________________________________________

21. Use a command previously used in this lab to move back into the CTS1133 directory. Once there, 
remove the file named fileone by using another command you have already used in this lab. 
Finally, return to the home directory and remove the CTS1133 directory.

 List all the commands used in this step.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

22. Close the Terminal program.

Linux Operating System Challenge

23. Access the system settings. There is commonly a desktop icon for this, but you might need to do a 
search. Change the wallpaper to a different setting.

 What setting did you use?

  _________________________________________________________________________________

24. See if there is a setting you can use to configure the mouse for a left-handed person.

 What setting did you use, if any?

  _________________________________________________________________________________

Lab 17.8 Ubuntu Command-Line Challenge

Objective: To demonstrate knowledge of commands in the Ubuntu environment

Parts: A computer with Ubuntu loaded (Lab 17.6) or with an Ubuntu Live USB drive (see Lab 
17.4 or Lab 17.5)

Procedure: Complete the following procedure and answer the accompanying questions.

1. Log in with a username and password, as necessary.

2. Open the Terminal application.

 How did you open the Terminal?

  _________________________________________________________________________________

 What is the current directory your Terminal session started in, and what command did you use to find 
out?

  _________________________________________________________________________________
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3. Notice that the time in the upper-right corner of the screen is likely different from your current local 
time. To find what time zone the system is set to, find the file named timezone and see what is 
written in it.

 How did you find the timezone file, and where was it located? What did it contain?

  _________________________________________________________________________________

  _________________________________________________________________________________

 List the commands you ran to install the locate command, if required.

  _________________________________________________________________________________

  _________________________________________________________________________________

4. Use the man page for the apt-get command to uninstall the screen utility.

 What command did you use?

  _________________________________________________________________________________



Computer and Network 
Security Labs18

Lab 18.1 Encrypting a File and a Folder in Windows

Objective: To provide security for a particular file and folder, enable encryption using Windows 7, 8, 10, or 11.

Parts: A computer with Windows 7, 8, 10, or 11 that has at least one NTFS partition

Note: Two user accounts are needed and possibly created for this exercise: one account that encrypts a file and the other ac-
count to test the encryption. If two user accounts are not available, most of the lab can still be performed or a second 
user account can be added. This lab is best demonstrated with two accounts that have local administrator rights.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on using the user ID and password provided by the instructor or lab assistant.

2. Access the Computer Management console by searching for and opening Computer Management tool.

3. Expand the Storage option and select Disk Management.

 How many disk partitions are available?

  _________________________________________________________________________________

 Do any drive partitions use NTFS?

  _________________________________________________________________________________

 If so, how many?

  _________________________________________________________________________________

 Note that if no drive partitions use NTFS, this exercise cannot be completed.

4. Close the Computer Management window. Open Windows Explorer/File Explorer. Create a text file called Security Test.txt and 
save it in the Documents folder.

5. Right-click on the Security Test.txt file and select Properties. On the General tab, click the Advanced button.



264 Complete A+ Guide to IT Hardware and Software

6. Enable the Encrypt contents to secure data option > OK. Select the Apply button, and the warning 
message shown in Lab Figure 18.1 appears.

LAB FIGURE 18.1 Windows encryption warning message

7. The default would be to encrypt the Security test.txt file and to encrypt the Documents folder. This is 
not what you want to do in this case, so select the Encrypt the File Only radio button > OK > OK.

8. In Windows Explorer/File Explorer, click an empty spot in the right pane.

 Is there any indication that the file is encrypted? If so, what is it? Note that you might need to create 
an unencrypted file to answer this question.

  _________________________________________________________________________________

  _________________________________________________________________________________

9. In Windows Explorer/File Explorer, access the Properties window of the Security Test.txt file again. 
Click the Advanced button. In the Advanced Attributes window, click the Details button. If this is not 
available, ensure that you are on a file (and not a folder).

 What user(s) can access the encrypted file?

  _________________________________________________________________________________

  _________________________________________________________________________________

10. Notice the certificate thumbprint number to the right of the user. EFS can request a digital certificate 
from a CA (certificate authority) such as a server. If a digital certificate from a CA is not available, 
EFS can use a self-signed certificate.

 What are the first 16 hexadecimal digits used for the digital certificate? Note that you may have to 
expand the Certificate Thumbprint area in order to see the digits.

  _________________________________________________________________________________

 Compare these digits with the digits found by a classmate. Are the digital certificates the same? If so, 
why do you think they are the same? If they are different, why do you think they are different?

  _________________________________________________________________________________

  _________________________________________________________________________________

11. Select the Cancel button on three different windows to exit the Properties window.

12. From Windows Explorer/File Explorer, open the Security Test.txt file, modify it, and save it.

 From Windows Explorer/File Explorer, does the file appear to still be encrypted?

  _________________________________________________________________________________

13. Log off the computer and log on as a different user. If a different user does not exist, create one by 
using the User Accounts section of the Control Panel, if possible.
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14. Use Windows Explorer/File Explorer to locate and open the Security Test.txt file located under the 
other username (commonly found in C:\users\username\Documents). Modify the file and save 
it, if possible. Look back to step 9 to determine the username.

 Are there any problems opening, modifying, or saving the file?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 In one or more complete sentences, explain what happened and why you think it occurred this way.

  _________________________________________________________________________________

15. Log off the computer and log on as the original user.

16. Access the Documents folder and create a new folder called Test. Copy the Security Test.txt file into 
the new Test folder.

 Is the copied file encrypted in the Test folder?

  _________________________________________________________________________________

17. Within the Test folder, create a new text file called Security Test2.txt.

 Is the newly created file encrypted?

  _________________________________________________________________________________

Instructor initials: _____________

18. Encrypt the Test folder using the default encryption setting Encrypt the file and its parent folder (rec-
ommended)/Encrypt contents to secure data. Apply changes to folder, subfolders, and files.

 Does encrypting the folder change anything within the folder?

  _________________________________________________________________________________

 If so, what does it change?

  _________________________________________________________________________________

19. Within the Test folder, create and save a new file called Security Test3.txt.

 Is the newly created file encrypted?

  _________________________________________________________________________________

20. Delete the Security Test.txt, Security Test2.txt, and Security Test3.txt files.

 Do you get any indication that the files were encrypted when they were deleted?

  _________________________________________________________________________________

21. Permanently delete the Test folder and any files created in the Documents folder.

Lab 18.2 Using Windows 7/8/10/11 System Protection

Objective: To manually control the settings involved with system restore points using System 
Protection

Parts: A computer with Windows 7, 8, 10, or 11 loaded with at least one NTFS partition

Note: This lab requires local administrator rights.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on using the user ID and password provided by the instructor or lab 
assistant.

2. Access Windows Explorer/File Explorer. Right-click Computer (Windows 7)/This PC (Windows 
8/10/11) > Properties > System Protection link > System Protection tab.

 Look at the Protection Settings section and document the available drives.

  _________________________________________________________________________________
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 Document whether protection is currently on or off for each of the available drives.

  _________________________________________________________________________________

3. Select Configure.

 What options are available for Restore Settings?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Microsoft says, “System Protection can keep copies of system settings and previous versions of files.” 
Do you think this means system files, user data files, or both? Explain your reasoning.

  _________________________________________________________________________________

 Thinking as a technician, which setting is optimum for most users?

  _________________________________________________________________________________

  _________________________________________________________________________________

 What is one situation in which a technician would recommend using the Turn off system protection 
option?

  _________________________________________________________________________________

  _________________________________________________________________________________

4. In Windows 7, ensure that the Restore system settings and previous versions of files radio button is 
selected.

 In Windows 8/10/11, ensure that the Turn on system protection radio button is selected. Note that if 
the option is grayed out, cancel out of the window temporarily. Open PowerShell with the Run as ad-
ministrator option. At the prompt, type the following:  
Enable-ComputerRestore -Drive “C:\”

 Return to the window to enable the Turn on system protection radio button and apply the setting.

 By default, Windows uses a maximum of 10% of the hard drive for system protection. However, the 
system enables you to adjust this amount in the Disk Space Usage section. Note that if you turn off 
system protection, you cannot use system restore points.

 What is the current Max Usage setting?

  _________________________________________________________________________________

 Describe a situation in which a technician would want to configure a machine for more than 10% of 
the hard disk space reserved for system protection.

  _________________________________________________________________________________

  _________________________________________________________________________________

5. Click Cancel.

On Your Own

6. Create a system restore point.

Instructor initials: _____________

7. Close all windows.
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Lab 18.3 Sharing a Folder in Windows 10/11 and Assigning Security 
Permissions

Objective: To share a folder and understand the permissions associated with a network share

Parts: Access to two Windows 10 or 11 computers with a user ID that has administrator rights

Note: You must have a password assigned to the login account for this lab to work.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on both computers and verify that the operating system loads. Log in using the same account 
username and password that has full administrator rights and that is provided by your instructor or lab 
assistant.

 Document the user created on both computers that has the same password.

  Username used that is the same on both computers and used to log in before doing any remaining 
steps: ____________________________________

2. On Computer 1, use File Explorer to create two subfolders within the Documents folder. Name the 
folders READ and WRITE.

3. Within the READ folder, create a text document called readme. Within the WRITE folder, create a text 
file called changeme.

4. Use any and all of the following to discover the computer name/device name as well as the domain or 
workgroup name.

 > System Control Panel

 > PC Settings link

 > System Settings link > About

 > Advanced system settings link (System Properties window)

  Document the current settings. Write None if the information is not shown:

  Original Computer 1 name: ____________________________________

 Original Computer 2 name: ____________________________________

  Original full Computer 1 name: ____________________________________

  Original full Computer 2 name: ____________________________________

  Is Computer 1 on a workgroup or domain? [ workgroup | domain ]

 Is Computer 2 on a workgroup or domain? [ workgroup | domain ]

  Original workgroup/domain name for Computer 1: ____________________

  Original workgroup/domain name for Computer 2: ____________________

5. On Computer 1, use the System Control Panel to access the Advanced system settings link (located in 
the left menu). Use the Computer name tab > Change button and locate the Member of section and 
select the Workgroup radio button > name the workgroup something unique but remember that both 
computers must be within the same workgroup (that is, the workgroup name must be the same). Click 
OK, and a Computer Name/Domain Changes window appears. Click OK and/or Close until prompted 
to Restart Now. Do the same on Computer 2.

 New workgroup name for both Computer 1 and Computer 2: _____________________
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6. When both computers have rebooted, the current IP addresses need to be documented. Open the com-
mand prompt and type ipconfig /all.

  On Computer 1, what is the IPv4 address on the Ethernet adapter?

  _________________________________________________________________________________

  On Computer 1, what is the IPv4 subnet mask?

  _________________________________________________________________________________

  On Computer 1, what is the default gateway?

  _________________________________________________________________________________

 On Computer 2, what is the IPv4 address on the Ethernet adapter?

  _________________________________________________________________________________

  On Computer 2, what is the IPv4 subnet mask?

  _________________________________________________________________________________

  On Computer 2, what is the default gateway?

  _________________________________________________________________________________

7. On both computers close the Command Prompt window. On both computers, access the Network and 
Sharing Center Control Panel > access the Change Advanced Sharing Settings link in the left pane. 
Expand the Private or Home or Work profile section so you can see the sharing options. Also explore 
the All Networks section and expand it as well.

 Document the current sharing and discovery settings for both computers. Note that all options may 
not be available in Windows Home versions, but the lab still works. You may also have to expand 
some sections to find them in the particular type of network currently being used.

Computer 1 Computer 2

Network discovery __________ __________

File sharing __________ __________

Printer sharing __________ __________

Password protected sharing __________ __________

Media sharing/streaming __________ __________

Public folder sharing __________ __________

8. On both computers, select Cancel. On both computers, from the Network and Sharing Center section 
of the Control Panel, select the Change Adapter Settings link. Right-click Local Area Connection or 
Ethernet Adapter > Properties. Locate and select Internet Protocol Version 4 (TCP/IPv4) > Proper-
ties button.

  Document the settings for Computer 1 and Computer 2:

 Is Computer 1 configured with an IP address, mask, and default gateway, OR is Computer 1 
configured to obtain an IP address automatically?

  _________________________________________________________________________________

 Is Computer 1 configured with preferred and alternate DNS server IP addresses, OR does Computer 1 
obtain DNS server address information automatically?

  _________________________________________________________________________________
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 Is Computer 2 configured with an IP address, mask, and default gateway, OR is Computer 2 
configured to obtain an IP address automatically?

  _________________________________________________________________________________

 Is Computer 2 configured with preferred and alternate DNS server IP addresses, OR does Computer 2 
obtain DNS server address information automatically?

  _________________________________________________________________________________

9. On Computer 1, select the Use the following IP address radio button and type in the following 
information:

  IP address: 10.1.1.1

  Subnet mask: 255.255.255.0

  Default gateway: 10.1.1.254

 Click the OK button. Click the OK/Close button at the bottom of the Local Area Connection 
Properties screen.

10. On Computer 2, select the Use the following IP address radio button and type in the following 
information:

  IP address: 10.1.1.2

  Subnet mask: 255.255.255.0

  Default gateway: 10.1.1.254

 Click the OK button. Click the OK/Close button at the bottom of the Local Area Connection Proper-
ties or Ethernet Properties window.

11. On both computers, using previously described procedures, open a command prompt and use the 
ipconfig command to verify that the IPv4 address has been applied. Note that you may have to 
scroll up to see the IPv4 address assigned to the Ethernet adapter.

12.  From a Computer 1 command prompt, type ping 10.1.1.2.

 What was the response? Note that the default Windows Firewall behavior is to deny pings. When File 
and Print Sharing is enabled, the firewall automatically enables ICMP messages that include pings.

  _________________________________________________________________________________

Sharing and Accessing a Shared Folder

Note: This section can take a little patience, depending on the type of network the computer uses.  Also note 
that in some settings, the network status cannot be changed to a private network in Step 13. If you do not 
have these, options, just make a note that it shows as a public network and make sure you use that network 
type to configure the settings in Step 14.

13. To configure a computer to be part of a private network, use the Network and Sharing Center Control 
Panel on both computers to locate the View your active networks section. On the left side, it will say 
Public network or Private network. If possible, select that link to change to Private network as this 
is a trusted network. Another way of putting a computer on a private network is to access the System 
Control Panel > Advanced system settings link on left > Computer Name tab > Network ID button > 
select the This is a home computer, it is not part of a business network radio button > Next > Finish 
> OK > Restart Now button. If the link cannot be selected, just make a note of the type of network as 
that is the profile area you will need to be in for step 14.

 Which sharing options profile is currently being used?  
[ Private | Guest or Public | All networks ]
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14. On both computers, access the Network and Sharing Center Control Panel > Change Advanced 
Sharing Settings link. Configure the following settings in the appropriate profile area:

 > Network Discovery: Turn on Network Discovery

 > File and Print Sharing: Turn on File and Print Sharing

 Click the Save Changes button.

15.  At a Computer 1 command prompt, type ping 10.1.1.2.

 What was the response? Note that the ping should be successful, and you should get a reply from 
10.1.1.2 with a specific number of bytes and a time value.

Instructor initials: _____________

16. On both computers, search for and access the File Explorer Options Control Panel > View tab > from 
within the Advanced Settings window, locate the Use Sharing Wizard (Recommended) option.

 What is the current setting for the Use Sharing Wizard option? [ Enabled | Disabled ]

17. Ensure that the Use Sharing Wizard option is enabled. Apply changes as necessary.

18. In File Explorer on Computer 1, right-click the READ folder (located within the Documents folder) > 
Properties > Sharing tab.

19. Select the Advanced Sharing button > enable the Share this folder checkbox > select the Caching 
button.

 What is the purpose of caching?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Is offline availability enabled by default for a shared folder? [ Yes | No ]

 What command can be used from a command prompt to configure caching options for a shared 
folder? Note that you may have to refer to Chapter 15 to answer this question.

  _________________________________________________________________________________

20. In the Offline Settings window, leave the default settings.

 What is the default setting for offline access?

  _________________________________________________________________________________

21. Select Cancel. In the Advanced Sharing window, click the Permissions button. Notice that the 
Everyone group is listed by default.

 Notes: If you want to share with someone who is not listed, use the User Accounts section of the 
Control Panel to create the account; then select that account name in the Permissions window.

 If the Everyone user account is selected and password protection is used, a user account is still 
needed to gain access.

 What permissions are enabled by default for the Everyone group?  
[ Full Control | Change | Read ]

22. Click OK on two consecutive windows.

 Document the share network path that appears in the window.

  _________________________________________________________________________________

23. Select the Close option at the bottom. While still working on Computer 1, open the Computer 
Management console. In the left window, expand System Tools and Shared Folders. Select Shares in 
the left pane. The READ share (along with other shares) should be listed in the right pane.

 Is the READ share present? [ Yes | No ]

 If the share is missing, redo this lab from the beginning. Close the Computer Management window.
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24. On Computer 2, open File Explorer. Select Network in the left pane. Note that if you don’t have a left 
pane, select the down arrow in the address bar to select Network. Locate and double-click the name 
of Computer 1.

 Notes: If the computer does not show in the list, use the search textbox and enter \\computer_
name (where computer_name is the name of Computer 1). Press ®. You might also need to 
put the full share network path into the search textbox.

25. On Computer 2, locate the readme.txt document within the READ share. Double-click the readme.txt 
file to open it.

 Does the file open? [ Yes | No ]

26. Add a few words to the file. Select the File > Save menu option. Leave the filename the same and 
click the Save button. When asked if you want to replace the file, click Yes.

 Is the file saved? [ Yes | No ]

27. Click OK. Close the file and close the window that contains the file. Note that you cannot save it due 
to the read-only permission you set earlier. Click Don’t save and close all windows.

28. On Computer 2, open File Explorer. Right-click This PC in the left pane and select Map network 
drive. Use the Drive drop-down menu to select a drive letter. In the Folder textbox, type the share 
path for the READ share documented in step 22. Click Finish. The share opens with the drive letter 
documented in the path at the top of the window.

 Which drive letter was selected?

  _________________________________________________________________________________

Instructor initials: _____________

29. On Computer 2, again access File Explorer and locate in the left pane the drive letter that was just 
mapped to a network drive. Note that you may have to expand the left window by moving the pointer 
over the dividing line between the left and right panes. When the pointer changes to a double arrow, 
click and move the line to the right. Because Windows share paths can be lengthy, a common practice 
is to use a mapped network drive for the share.

 How can you easily identify mapped drive letters in File Explorer (in addition to a quite high drive 
letter, in some cases)?

  _________________________________________________________________________________

30. Close all windows on Computer 2.

31. On Computer 1, in File Explorer, locate the WRITE subfolder of Documents. Right-click the WRITE 
folder icon > Properties > Sharing tab.

32. Select the Advanced Sharing button > enable the Share this folder checkbox.

33. Click the Permissions button.

34. Select the correct username or group. Select the Change Allow checkbox. Select OK on two consecu-
tive windows.

 Document the share network path that appears in the window.

  _________________________________________________________________________________

35. Click the Close option at the bottom.

36. On Computer 2, type the full network path in the Search textbox to access the Write folder. Locate 
the changeme.txt document on Computer 1.

37. Open the changeme.txt document, modify the text inside the file, and save the changeme.txt file.

38. On Computer 1, open the changeme.txt file. After answering the question, close the file

 Is the file changed? [ Yes | No ]

39. On Computer 2, try changing the name of the changeme.txt file to changeme2.txt.

 Can you change the name of the changeme.txt file? [ Yes | No ]
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40. Verify whether the filename changed on Computer 1.

 Does the filename change on Computer 1? [ Yes | No ]

 If so, what is the new name?

  _________________________________________________________________________________

Instructor initials: _____________

41. On Computer 1, create a subfolder under the READ folder. Name the folder SUB_READ. Create a 
text file in the SUB_READ folder called sub_file.txt.

42. On Computer 2, type the full network path in the Search textbox to access the Write folder. Locate 
and right-click the SUB_READ shared folder. Select Properties.

 What attributes does this folder have? 
[ Read-only | Hidden | Archive | Compress | Encrypt | None ]

 Based on your reading in the chapter, why does this folder have this particular attribute?

  _________________________________________________________________________________

43. On Computer 2, in File Explorer, locate the sub_file.txt file. Select Properties.

 What attributes, if any, are enabled by default?

 [ Read-only | Hidden | Archive | Compress | Encrypt | None ]

44. Click Cancel. Try to modify the sub_file.txt file.

 Can you change the sub_file.txt file? [ Yes | No ]

Instructor initials: _____________

45. On Computer 1, create a subfolder in the WRITE folder. Create a .txt file within the WRITE folder.

 What did you name the subfolder? _____________________

 What did you name the file within the subfolder?

  _________________________________________________________________________________

46. From Computer 2, access the WRITE subfolder and examine the current permissions. You might try 
to change the file within the subfolder to test whether the permissions are working as they should.

 What did you discover about the permissions for the subfolder and the file located within the 
subfolder?

  _________________________________________________________________________________

  _________________________________________________________________________________

47. On Computer 2, remove the mapped drive (and any drive that you created on your own) by using File 
Explorer to locate the mapped drive letter under This PC in the left pane. Right-click the mapped 
drive and select Disconnect > Yes. Close File Explorer.

48. On Computer 1, permanently delete the READ and WRITE folders and all files and subfolders con-
tained within them.

49. On Computer 1, put the Advanced Sharing Settings options back to the original configuration, as 
documented in steps 7 and 8. Put the Use Sharing Wizard back to the original setting, as documented 
in step 16. Show your lab partner the documented settings and the current profile configuration. Have 
your lab partner use the table that follows to document that the computer has been put back to the 
original configuration.

Computer 1 (permanently deleted folders/sharing settings)

Printed name of lab partner __________________________________

Signature of lab partner __________________________________
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50. On Computer 2, put the Advanced Sharing Settings options back to the original configuration, as 
documented in steps 7 and 8. Put the Use Sharing Wizard back to the original setting, as documented 
in step 16. Show your lab partner the documented settings and the current configuration. Have your 
lab partner use the table that follows to document that the computer has been put back to the original 
configuration.

Computer 2 (permanently deleted folders/sharing settings/IP address)

Printed name of lab partner __________________________________

Signature of lab partner __________________________________

Lab 18.4 Creating a Local Security Policy for Passwords in Windows 10/11
Objective: To provide additional security by requiring certain password parameters as a local com-

puter security policy

Parts: A computer with Windows 10/11 Professional or higher loaded

Notes: Local administrator rights are required for this lab. The computer should be part of a work-
group, not a domain. However, even though domain policy requirements override local 
policy, the lab may still work as written.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log on using the user ID and password provided by the instructor or lab 
assistant.

2. Access the Local Security Policy console by accessing the Administrative Tools (Windows 10) or 
Windows Tools (Windows 11) Control Panel > double-click on Local Security Policy.

3. Expand the Account Policies option in the left pane.

 What two options are available?

  _________________________________________________________________________________

4. Select the Password Policy subcategory. Lab Table 18.1 details these options.

LAB TABLE 18.1 Windows Password Policy option descriptions

Option Description

Enforce password 
history

Specifies the number of unique and new passwords that must be used before 
an old password can be reused.

Maximum password age Specifies the number of days a password must be used before it has to be 
changed.

Minimum password age Specifies the smallest number of days for which a user can use the same password.

Minimum password 
length

Specifies the fewest characters required for the password. The fewest 
characters the password can be is 0. The more characters required, the better 
the security. A common setting is 7 or 8; 14 characters is the most you can 
require in this setting.

Password must 
meet complexity 
requirements

Sets higher standards for the password, such as not being the same as the 
username, being six characters or more, or requiring uppercase and lowercase 
letters, numerals, and symbols such as # or !.

Store passwords using 
reversible encryption for 
all users in the domain

If enabled, passwords are stored using reversible encryption. Used only if an 
application uses a protocol that requires knowledge of a user password for 
authentication purposes.

 Use Lab Table 18.2 to document the current settings.
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LAB TABLE 18.2 Current Password Policy settings

Option Current setting

Enforce password history

Maximum password age

Minimum password age

Minimum password length

Password must meet complexity requirements

Store passwords using reversible encryption

5. Change the password policy settings to the options shown in Lab Table 18.3 by double-clicking on 
each option and selecting the given setting.

LAB TABLE 18.3 New Password Policy settings

Option New setting

Enforce password history One password remembered

Minimum password length Eight characters

Passwords must meet complexity requirements Enabled

6. Select the Account Lockout Policy subcategory. Lab Table 18.4 details these options.

LAB TABLE 18.4 Windows Account Lockout Policy option descriptions

Option Description

Account lockout 
duration

Indicates the number of minutes someone is locked out if a password is 
mistyped. A value of 0 requires an administrator to unlock it. Requires the 
Account lockout threshold to be configured. 

Account lockout 
threshold

Indicates the number of failed logon attempts that can cause a user account to 
be locked. A value of 0 will never lock out a user, no matter how many times 
he mistypes his password.

Reset account 
lockout counter 
after

Indicates the number of minutes that have to pass before the logon attempt 
counter is reset to 0 bad logon attempts. Requires the Account lockout 
threshold option to be configured.

7. Minimize the Local Security Policy console. Create a new user account by accessing Settings > Ac-
counts > select the Family & Other Users link from the left pane > in the Other Users section, select 
the Add someone else to this PC link > type Teststudent for the username and Student234% 
as the password > type student 234 percent in the Password Hint textbox > select the Next 
button.

8. Log off as the current user. Log in as Teststudent with the password Student234%.

 What message appears upon logon?

  _________________________________________________________________________________

9. Try to access the Local Security Policy console Administrative Tools option.

 Can the Teststudent user change the password policy? [ Yes | No ]

10. Log off as Teststudent and log back in using the original user account.
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11. Return to the Local Security Policy console. Expand Local Policies and select Audit Policy.

 What is the current setting for Audit account logon events?

 [ No Auditing | Success | Failure | Success and Failure ]

 List three other items that can be audited.

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

12. Double-click the Audit account logon events option. The two options are Success and Failure, and 
both options can be enabled. Success logs every time someone logs in to the computer. Failure logs 
every failed logon attempt.

 What are the current settings?

 Success [ Enabled | Disabled ]

 Failure [ Enabled | Disabled ]

  _________________________________________________________________________________

13. Enable both the Success and Failure checkboxes > Apply button > OK button.

14. Log off as the current user and log in as Teststudent but using the password CatchMe123. (This is an 
incorrect password—but use it anyway.)

 What message appears upon logon?

  _________________________________________________________________________________

15. Click OK. Log in as Teststudent, using the correct password, Student234%.

16. To see events that have been enabled and logged, such as the ones just set as the local policy, access 
the Administrative/Windows Tools section of the Control Panel > Event Viewer > expand the Windows 
Logs category on the left and select Security.

 Can the Teststudent user access Event Viewer details that were enabled in the local security policy?  
[ Yes | No ]

17. Log off as Teststudent. Log back on as the original computer user.

18. Access the Administrative/Windows Tools Control Panel > Event Viewer > expand the Windows Logs 
category on the left and select Security. Scroll down to select a line that shows as an Audit Failure. 
Note that you may need to expand the Keywords section by moving the pointer over the dividing line 
between the Keywords header and the Date and Time column header. When the pointer changes to 
a bar with two arrows extending from the bar, click and drag the bar to the right to expand the Key-
words section. Look for a lock graphic instead of a key on the left.

19. Notice that when you select a security event, information about that event appears in the bottom 
window.

 What event number is the audit failure?

  _________________________________________________________________________________

 Does the General tab show the computer name for the violation? [ Yes | No ]

Instructor initials: _____________

20. Close Event Viewer. Return to the Local Security Policy console. Set the Audit Account Logon Events 
setting to the original setting (refer to step 11).

 Have a classmate verify your setting and print and sign his or her name on your answer sheet.

 Classmate’s printed name _______________________________________

 Classmate’s signature __________________________________________
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21. Configure the Password Policy settings to their original configuration (refer to step 4).

 Have a classmate verify your password policy settings by printing and signing his or her name.

 Classmate’s printed name _______________________________________

 Classmate’s signature __________________________________________

22. In the Local Security Policy window, expand Local Policies. Select the User Rights Assignment op-
tion. Use Lab Table 18.5 to document the current settings for various commonly used options.

LAB TABLE 18.5 Windows User Rights Assignment settings

Option Current setting

Access this computer from the network

Allow log on through Remote Desktop Services

Deny log on locally

Force shutdown from a remote system

Generate security audits

Load and unload device drivers

Restore files and directories

Shut down the system

Take ownership of files or other objects

23. Select the Security Options in the left pane of the Local Security Policy window. Use Lab Table 18.6 
to document the current settings for various options.

LAB TABLE 18.6 Windows Security settings

Option Current setting

Accounts: Administrator account status

Accounts: Guest account status

Accounts: Rename administrator account

Devices: Allow to format and eject removable media

Devices: Prevent users from installing printer drivers

Interactive logon: Message text for users attempting to log on

Interactive logon: Prompt user to change password before 
expiration

Network access: Let Everyone permissions apply to 
anonymous users

Network access: Shares that can be accessed anonymously

Network security: Force logoff when logon hours expire

Shutdown: Allow system to be shut down without having to 
log on
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24. Close the Security Policy console. Access User Accounts and remove the Teststudent user account by 
selecting the account name > Delete the account link > Delete files > Delete account.

 Have a classmate verify your setting and print and sign his or her name on your answer sheet.

 Classmate’s printed name _______________________________________

 Classmate’s signature __________________________________________

25. Close the User Accounts window and reboot the computer.

Lab 18.5 Using Windows Defender in Windows 10

Objective: To be able to use System Configuration and Windows Defender to troubleshoot boot and 
spyware problems

Parts: Computer with Windows 10 installed

 User logon that has administrator rights

Note: In this lab, you will explore various options that can be used within the System Configu-
ration and Windows Defender windows. If the computer has a third-party security suite 
such as Norton or McAfee that has antispyware or anti-malware, the Windows Defender 
application may not be enabled.

Procedure: Complete the following procedure and answer the accompanying questions.

1. Turn on the computer and verify that the operating system loads. Log in to Windows.

2. Open the File Explorer Options Control Panel > View tab.

 What is the current setting for the Hidden files and folders section?  
[ Do not show hidden files and folders | Show hidden files and folders ]

 What is the current setting for the Hide extensions for known file types option? [ Enabled | Disabled ]

  _________________________________________________________________________________

 What is the current setting for the Hide protected operating system files (Recommended) option?  
[Enabled | Disabled ]

  _________________________________________________________________________________

3. Configure the following File Explorer settings and remember to click the Apply or OK button when 
finished:

 >  Show hidden files, folders, and drives radio button—enabled (checked)

 >  Hide extensions for known file types—disabled (unchecked)

 >  Hide protected operating system files (Recommended)—disabled (unchecked)

4. Access the Windows Defender Firewall section of the Control Panel. If a note appears, saying that 
Windows Defender is turned off, select the Click here to turn it on option. If needed, obtain updates 
before continuing. Expand the Private networks section.

 Was Windows Defender Firewall disabled? [ Yes | No ]

 What is the status for incoming connections?

  _________________________________________________________________________________

  _________________________________________________________________________________

 Are there any active private networks? [ Yes | No ]

 What is the current notification state?

  _________________________________________________________________________________

  _________________________________________________________________________________
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5. Select the Advanced settings link.

 Which three profiles are shown in the Overview section?

  _________________________________________________________________________________

6. From the left pane, select Inbound Rules.

 Scroll to the right and locate an inbound rule that uses a specific local port number (and has a number 
in the Local Port column). Note that you may need to maximize the window to be able to see this 
column. Select that row so that it is highlighted. What is the name of the inbound rule?

  _________________________________________________________________________________

 Does the particular rule use TCP, UDP, or any protocols?

  _________________________________________________________________________________

 What local port number is this inbound rule applied to?

  _________________________________________________________________________________

  _________________________________________________________________________________

7. In the left pane, expand the Monitoring option.

 List the monitoring options.

  _________________________________________________________________________________

8.  Select the Monitoring option from the left pane. Expand the Public Profile is Active section.

 What is the name of the file that contains logged firewall events?

  _________________________________________________________________________________

 Are dropped packets logged when the public profile is in use? [ Yes | No ]

 When a successful connection is made from this computer and the public profile is active, are the 
successful connections logged? [ Yes | No ]

9. Return Windows Defender Firewall to its original state (refer to step 4).

10. Return File Explorer to its original settings (refer to step 2).

11. Close all windows.

Lab 18.6 Sharing Files with Windows 10 Public Folders

Objective: To be able to access a file from another computer that has been shared through a Windows 
10 Public folder

Parts: Two Windows 10 computers on a wired or wireless network

Procedure: Complete the following procedure and answer the accompanying questions.

1. Ensure that the two computers have IP addresses on the same network (so you will be able to ping 
between the computers).

2. On both computers, make a shortcut on the desktop to the Public folder. The public folder is com-
monly located at C:\Users\Public.

3. On Computer 1, create a text document and put it in the Public Documents subfolder.

 What did you name the text document?

  _________________________________________________________________________________

4. Ensure that both computers are visible from File Explorer by accessing Advanced sharing settings 
from the Network and Sharing Center Control Panel and turning on Network discovery and File and 
print sharing. Turn off Password-protected sharing.

5. Ensure that both computers can share files using the public folder by enabling the Turn on sharing so 
anyone with network access can read and write files in the Public folders option in the All Networks 
profile.
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6. From Computer 2, access and change the text document.

 Are you able to change the document across the network? [ Yes | No ] If not, redo the lab.

Instructor initials: _____________

Lab 18.7 Configuring a Secure Wireless Network

Objective: To be able to configure a secure wireless AP (access point) or router and attach it a wire-
less client

Parts: One wireless access point or router

 A computer with an integrated wireless NIC or a wireless NIC installed as well as an 
Ethernet NIC

 One straight-through cable

Procedure: Complete the following procedure and answer the accompanying questions.

1. Obtain the documentation for the wireless AP or router from the instructor or the internet.

2. Reset the wireless AP or router as directed by the wireless device manufacturer.

 Document the current Ethernet NIC IPv4 setting. [ DHCP | Static IP Address ]

 If a static IP address is assigned, document the IP address, subnet mask, default gateway, and DNS 
configuration settings.

  _________________________________________________________________________________

3. Attach a straight-through cable from the computer’s Ethernet NIC to the wireless AP or router.

4. Power on the computer and log on, if necessary.

5. Configure the computer with a static IP address or DHCP, as directed by the wireless device 
manufacturer.

6. Open a web browser and configure the wireless AP or router with the following parameters:

 > Change the default SSID.

 > Disable SSID broadcasting for this lab.

 > Configure the most secure encryption and authentication supported by both the wireless NIC client 
and the wireless AP or router.

 > Change the default password used to access the wireless AP or router.

 Document the settings after you have configured them:

 SSID:

  _________________________________________________________________________________

 Is SSID broadcasting disabled? [ Yes | No ]

 Password for wireless device access:

  _________________________________________________________________________________

 Type of security used:

  _________________________________________________________________________________

7. Save the wireless AP or router configuration.

8. Disconnect the Ethernet cable.

9. Enable the wireless NIC and configure it for the appropriate SSID.

10. Configure the wireless NIC for a static IP address or DHCP, as directed by the wireless AP/router 
manufacturer.
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11. Open a web browser and access the wireless AP or router. If access cannot be obtained, troubleshoot 
as necessary or reset the wireless AP or router to the default configuration and restart the lab.

 What frequency (channel) is being used by the wireless AP or router and the wireless NIC for 
connectivity?

  _________________________________________________________________________________

12. Show the instructor the connectivity.

Instructor initials: _____________

13. Open a command prompt and type netsh wlan show settings to see the wireless network 
settings.

14. Reset the wireless AP or router to the default configuration settings.

15. Reset the computer(s) to the original configuration settings.

Instructor initials: _____________

Lab 18.8 Examining Windows 10/11 Windows Security Options

Objective: To become familiar with common settings applied to Windows Security

Parts: Windows 10/11 computer with administrator access

Procedure: Complete the following procedure and answer the accompanying questions.

1. Sign in to the computer and access the Windows Security Settings link > Open Windows Security 
button.

 Which options are available within the Security at a glance window? (Select all that apply.)  
[ Device security | Event security | Security policy | Device performance & health |  
App & browser control | Logon security ]

2. Select Virus & threat protection.

 What can you do within the Current threats section? (Select all that apply.)  
[ Remediate device | Isolate device | Quick scan | Full scan ]

3. Select the Scan options link. Read the information that describes each option.

 Which option would you use for malware that is proving to be difficult to remove?  
[ Quick scan | Full scan | Custom scan | Microsoft Defender Offline scan ]

4. Select the Protection history link.

 What actions are you able to take regarding OneDrive and file recovery options? 

  _________________________________________________________________________________

5. From the left pane in Windows 10, select the Firewall & network protection link. For Windows 11, 
return to the Windows Security window to select the Firewall & network protection link. Select the 
Allow an app through firewall link. Note that you may be redirected or a blinking icon on the taskbar 
might show that you need to go to a specific Control Panel window.

 From the list shown, which app is enabled for private, but not the public profile?

  _________________________________________________________________________________

 Is Take a Test allowed through the firewall if the public profile is being used?  
[ Yes | No ]

 Is Take a Test allowed through the firewall if the private profile is being used?  
[ Yes | No ]

Instructor initials: _____________



 LAB 18: Computer and Network Security Labs 281

LA
B 1

8

6. Click Cancel. From the left menu in Windows 10, select the Device Security option. For Windows 11, 
return to the Windows Security window to select the Device Security option.

 Does this machine have any TPM capabilities? [ Yes | No ]

 Is standard hardware security supported? [ Yes | No ]

 What is the purpose of core isolation device security? 

  _________________________________________________________________________________

7. Select the Core isolation details link.

 Is memory integrity currently enabled or disabled? [ Enabled | Disabled ]

 What is the purpose of memory integrity core isolation? 

  _________________________________________________________________________________

Instructor initials: _____________

8. From the left menu in Windows 10, select the Device performance & health option. In Windows 11, 
return to the Windows Security window to select the Device performance & health option.

 Are there any recommendations within the health report? 

  _________________________________________________________________________________

 What is the purpose of the Fresh start option?

 a. It allows the system to apply Windows updates and the machine to be restarted.

 b. It allows all security rules to be reset to the default values.

 c. It allows only outbound security rules to be reset to the default values.

 d. It allows a new Windows installation. 

9. Close the Windows Security window and any Control Panel windows that might be open.

Lab 18.9 Configuring Windows 7, 8, 10, or 11 with a DNS Server IP 
Address

Objective: To be able to configure a DNS server IP address on an Ethernet adapter

Parts: Windows 7, 8, 10, or 11 computer with administrator access

Procedure: Complete the following procedure and answer the accompanying questions.

1. Sign in to the computer and access the Network and Sharing Center the Control Panel > Change 
adapter settings link.

2. Right-click on the Ethernet connection > Properties.

3. Double-click on the Internet Protocol Version 4 (TCP/IPv4) option.

 Document the current Ethernet NIC IPv4 settings.

 [ DHCP (Obtain an IP address automatically radio button) |  
static IP address (Use the following IP address radio button) ]

 [ DHCP-provided DNS server (Obtain DNS server address automatically radio button) |  
static DNS server address (Use the following DNS server addresses radio button) ]

 If a static IP address or DNS server address is assigned, document the IP address, subnet mask,  
default gateway, and DNS configuration settings.

  _________________________________________________________________________________
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4. Because a DNS server might be down, might be under attack, or might have been hacked, you might 
be required to manually configure a DNS server IP address. In this case, select the Use the Following 
DNS Server Addresses radio button.

5. In the Preferred DNS Server textbox, type the IP address 208.67.222.222, which is an OpenDNS 
server address hosted by Cisco Systems, Inc. > OK.

6. Open a web browser and access a web page that probably hasn’t been used before. Some suggested 
ones are ThinkGeek.com, uncommongoods.com, and goodreads.com.

 Are you able to access at least one different website by using the new DNS server setting?  
[ Yes | No ]

Instructor initials: _____________

7. Return to the Ethernet connection and set it back to the settings documented in step 3. Ensure that 
you click OK to save the settings.

8. Open a web browser and access a web page that probably hasn’t been used before. Some suggested 
ones are brainyquote.com, wired.com, and codinggame.com.

 Are you able to access at least one different website by using the original DNS server setting?

 [ Yes | No ]

 Are you able to tell the difference in the speed of the access using the new DNS server setting com-
pared to the original setting ? [ Yes | No ]
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